OKI

PRINTING SOLUTIONS

MC361, MC561

Setup Guide

Guide d’installation
Guia de Instalacion
Guia de instalacao

59407701 my.okidata.com






Setup Guide ......
Guide d'Installation

Guia de Instalacion.
Guia de instalacao. .

English
Hardware Installation........... 7 Setting Up User Authentication and
Package Contents. . .. .............. 7 AccessControl ...........0ut 40
Preparea Location . ................ 7 General Information . . ............. 40
Unpack the Machine . .. ............. 8 Before You Start. . ................ 40
Turning the MachineOn . ........... 11 Windows Systems. . . .............. 40
Turning The Machine Off . . . .. ....... 11 MacSystems . ................... 41
Power Save Mode and Sleep Mode . . . .. 12 Authentication by PIN . . .. .......... 41
The Control Panel. . . .............. 12 Authentication by User Name and
Load PrintMedia .. ...ovvonenn 12 Password . ... 44
Prlnt.lng Fhe Conﬂguratlon. Report. .. ... 16 Configuring the Machine for Faxing. 46
Configuring the Tray Settings ........ 16 Basic Settings for Faxing . . . . ... .. ... 46
PrintExits . . . ................... 17
Loading Documents for Scanning. . . . . . 18 USB Installation................ 48
. USB Connection . . ................ 48
Netw_ork Installa_tlon: . USB: Installing a Printer Driver for

Ma!klng Co_nnectlons and Installing Windows. . .« 50

Prlnter.Drlvers TherteEEEEAEEEEEES 20 USB: Installing a Printer Driver for Mac. . 51
Compatible Operating Systems .. ... .. 20
Make the Network Connection . ....... 20
Locate the Setup Form . .. ... ....... 22
Set the Administrative Password . . .. .. 22

Set Up the Network for Windows Systems 22
Set up the Network for Macintosh Systems26

Configuring the Machine for Network
Operation 31
Enter the Machine’s IP Address on the Setup

Form. ......... ... ... .. ... .. ... 31
Set Up Scan To Email and Internet Fax. . 31
Set Up Scan To Network PC. . .. ... ... 33
Profiles for Scan To Network PC. . ... .. 38



Francais

Installation de matériel ........ 55 Configuration de I’Authentification de
Contenu de I'emballage. ... ......... 55 I'utilisateur et du Controle d’'acces. 91
Choisir un emplacement . .. ......... 55 Généralités .. ................... 91
Déballer I'appareil . ............... 56 Avant de commencer .............. 91
Allumer l'appareil . . ... ..o 59 Systemes sous Windows . ........... 91
Eteindre I'appareil . ............... 59 Systémes sous Mac. .. ........... .. 93
Mode d’économie d’énergie et Mode Authentification par

sommeil ... 60 PIN(NIP) . . .o 93
Le panneau de commande. . . ........ 60 Authentification par Nom d’utilisateur
Chargement du support d’impression . . . 60 et Motdepasse ................. 96
e R Gy | Configuration du télécopieur ... .99
Configuration des parametres du bac . .. 64 LEZL??’EZI??JE?:rd.e. t'>a's.e ............ 99
Sorties d'impression. . . ............ 65
Chargement des documents a numériser 67 | InstallationUSB............... 102

. ; Connexion USB. .. ............... 102
Il)stall_atlon en reseau : . USB : Installer un pilote d'imprimante
EFabllr dt’e_s connexions et installer des POUr WINAOWS. + + v v vvvvv s 103
pIIOt?S d lmprlmapte """ SRRt 69 USB : Installer un pilote d'imprimante
Systemes d’exploitation compatibles ... 69 DOUFMAC « v v vt et e e e e 105
Réaliser la connexionréseau . . ....... 69
Trouver le formulaire

de configuration. .. .............. 71
Définir le mot de

passe administrateur . ............ 71
Configurer le réseau pour les systémes

sous Windows . ................. 72
Configurer le réseau pour des systemes

sous Macintosh. . . ............... 75

Configuration de I'appareil pour

une exploitation enréseau....... 81
Saisir I'adresse IP de "appareil sur le
formulaire de configuration . ........ 81
Configurer les fonctions de Numérisation
vers Courriel et Télécopie Internet . ... 81

Configurer la fonction Scan to Network
PC (Numeérisation vers PC en réseau) .. 83

Les profils de la fonction Scan to
Network PC (Numérisation vers PC
ENTESEAU) . « v v v v i it 89



Espaiol

Instalacion de hardware....... 109
Contenidodelacaja............... 109
Prepareellugar.................. 109
Desempacar lamaquina . . .......... 110
Cémo encender el equipo . .. ........ 113
Cémo apagar lamaquina ........... 113
Modo de ahorro de energia y Modo de

SUSPENSION & v v v v it et it e i 114
El paneldecontrol . .. ............. 114
Cargar el medio de impresion ........ 114
Cémo imprimir el informe

de configuracién. . ............... 117
Establecer la configuracién

delabandeja................... 117
Salidas de impresion. . .. ........... 119
Como colocar documentos

para escanear . .. ........ .. 120

Instalacion en redes:
Como hacer conexiones e instalar
los controladores de la impresora 122

Sistemas operativos compatibles . . . . .. 122
Configurar la conexion

dered.......... ... ... 122
Buscar la pagina

de configuracién. . ............... 124
Configurar la contrasefia del

administrador. . . . ...... ... . ..., 124

Configurar la red para sistemas Windows 125

Configurar la red para sistemas Macintosh .
129

Como configurar la maquina para

su funcionamientoenred....... 134

Ingresar la direccién IP de

la maquina en la pagina

de configuracién. . ............... 134
Configurar Escanear a correo

electrénico y Fax en Internet . . ... ... 134
Configurar Escanear a PC

dered.......... ... ... 136
Perfiles para Escanear a PCdered. . ... 142

Como configurar la autenticacion
del usuario y el control de acceso 144

Informacién general . ............. 144
Antesdecomenzar............... 144
Sistemas Windows . .............. 144
SistemasMac. .................. 145
Autenticaciéon por PIN . .. .......... 146
Autenticacion por nombre de usuario
ycontrasefa. . . ................ 149
Como configurar la maquina
para
enviarfax .. ....ciciiiinnnann 152
Configuracion basica para enviar
unfax . ... . 152
Instalacioncon USB............ 154
Conexion USB ... ............... 154
USB: Como instalar un controlador
de la impresora para Windows . ... .. 155
USB: Cémo instalar un controlador
de la impresora paraMac. ......... 157



Portugués

Instalacao do hardware ....... 161
Conteldodopacote . . ............. 161
Prepare o local de instalagao . . . ... ... 161
Desembalar a unidade .. ........... 162
Ligaraunidade . ................. 165
Desligaraunidade . . .. ............ 165
Modo de economia de energia e

mododeespera................. 166
O paineldecontrole. . . ............ 166
Carregar midia de impressd@o. ........ 166
Impressao do Relatério

deconfiguracdo .. ............... 170
Definicdo das configuragoes

debandeja .................... 170
Saidas daimpressora . ............. 171
Colocacao de documentos

para escanear . .. ........ .. 172

Instalacao em rede:
Conexoes e instalacao de drivers

deimpressora..........c.vus.- 175
Sistemas operacionais compativeis. . . . . 175
Fazer a conexaoderede............ 175
Localizar o Formulario de configuracao . .177
Definir a senha administrativa. ... .... 177
Configurar a rede para sistemas

Windows . . ....... ... 177
Configurar a rede para sistemas
Macintosh .. ................... 181
Configuracao da unidade para
operacaoemrede.........c:uu 187
Inserir o enderecgo IP da unidade no
formulario de configuragdo ......... 187
Configurar opgdes de escanear
para e-mail e fax pela Internet. . . . . .. 187
Configurar a opgao de escanear
paraPCderede................. 189
Perfis de funcao de escanear
paraPCderede................. 195

Configuracao da autenticacao do
usuario e do controle de acesso. .
Informagbes gerais. . .............
Antesdecomegar. ...............
Sistemas Windows . ..............
SistemasMac. ..................
Autenticagao por PIN. . . . ..........

Autenticacdo por nome de usuario
esenha . ....... ...

Configuracdao da maquina
parafax ...... i iinnnnrnannn
Configuracdes basicas para fax. . ... ..

InstalagdoUSB. ........... ..t
ConexaoUSB...................

USB: Instalagao de um driver
de impressora para Windows . ... ...

USB: Instalagao de um driver
de impressora paraMac. ..........



Hardware Installation

Package Contents

Prepare a Location

Machine

DVD

Power cable

Telephone cable
Telephone connector cover

UNUHAWN KR

Note

The Ethernet and USB cables are not supplied
with your machine and must be purchased
separately.

We recommend you keep the packing materials,
they are necessary to transport the machine.

Environmental Requirements
e Temperature Range: 50 to 89.6°F (10 to 32°C)

e Humidity: 20 to 80% RH (relative humidity)
If installing your machine where the humidity
is less than 30% RH, use a humidifier or
antistatic mat.

e Maximum wet bulb temperature: 77°F (25°C)
Be careful of condensation. It may cause a
malfunction.

Space Requirements

Power Requirements
¢ 110-127 VAC, or 220-240 VAC
¢ 50/60 Hz

e 1100 watts maximum.

Important!

Do not connect this product to an
uninterruptible power supply (UPS).
If the power source is unstable, use a
voltage regulator.
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2 Remove the outer packing materials.

Unpack the Machine

Important!
At least two people are needed to lift the

machine safely.

g X
th v

24 kg
53 Ib.

3

Note

The illustrations below are representative. The
actual tape/packing materials may differ
somewhat from these illustrated.

Keep the packing materials, they are necessary
to transport the machine.

1 Remove your machine from the box and place
it where it is to be installed.

4 Open the ADF cover and remove any packing
materials.
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9 Open the scanner unit and remove any

5 Lift the document tray and remove any

packing materials.

packing materials.

10 Press the cover release button (1) and open

the top cover (2).

6 Lower the document tray and close the ADF

cover.

7 Open the document glass cover (1) and

remove the packing materials and protective

8 Close the document cover.

Caution!

e The green tube on the image drum is very

delicate. Handle it carefully.
e Do not expose the image drum unit to

direct sunlight or very bright interior light

(approximately more than 1500 lux).

Even under the normal interior light, do
not leave the image drum exposed for

more than 5 minutes.
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13 Slide the blue locking sleeve on each toner

11 Remove the tape and packing materials from

cartridge to the left until it stops.

the toner cartridges.

14 Gently close the top cover and scanner unit.

12 Press the blue lever (1) of the fuser unit in the

direction of the arrow and remove and store

the orange stopper (2).

then open

15 Remove the tape on the MP Tray,

the tray.

Important!

Keep the orange stopper, it is necessary if
you ever need to transport the machine.
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16 Remove the interior tape (1) and protective
sheet (2), then close the MP Tray.

Turning the Machine On

1 Make sure the power switch (on the right side
of the machine) is off <O>.

2 Plug the power cable into the power socket on
the back of your machine.

3 Plug the power cable into a suitable grounded
outlet.

4 Make sure no documents are on the
document glass or ADF, and that the ADF
cover is closed.

5 Turn the printer on.

Turning The Machine Off

Caution!

Do not turn off the power switch suddenly:
this can damage your machine. Always
follow the correct procedure to ensure that
no data is lost.

1 Press <SETTING> on the control panel.

/

e cH o GO

2 Press the down arrow key repetitively to
select [Shutdown], then press <OK>.

Setting

Store Document Settings
Wiew Information

Shutdown

(K}

3 When the confirmation message appears,
press the right arrow key to select [Yes], then
press <OK>.
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4 When the screen prompting you to turn off
the power switch appears, turn the machine
off.

Power Save Mode and Sleep
Mode

Note

See the on-line Basic User Guide on the DVD
supplied with your machine for more information.

Power Save Key

O C O C O C DO CD

(GEDGED) | GED) ) GED) GED)

pec] 98 QK

When your machine is not used for 30 minutes
(the factory default), it automatically enters a
power save mode to reduce the power
consumption.

You can enter (or exit) the power save mode
manually by pressing <POWER SAVE> on the
control panel.

The Control Panel

Voo [h

0P 6T 0 A

For information on
e the control panel
e entering/deleting text/data

see the on-line Basic User’s Guide on the DVD
supplied with your machine.

Load Print Media

For more information on print media, see the
on-line Basic User’s Guide on the DVD supplied
with your machine.

1 Tray 1

2 MP Tray
3 Tray 2 (optional)
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Selectable Weight Ranges 1 Pull out the paper tray.

Weight Range,
Designation

US Bond Metric
Light 17 to 18 Ib. 64 to 74 g/m?
Medium Light 20 to 21 Ib. 75 to 82 g/m?
Medium 22 to 28 Ib. 83 to 104 g/m?2
Heavy 28 to 32 Ib. 105 to 120 g/m?
Ultra Heavyl 32 to 47 Ib. 121 to 176 g/m?
Ultra Heavy?2 47 to 58 Ib. 177 to 220 g/m?

Loading Paper: Tray 1 and
Optional Tray 2

Tray 1

e Takes up to 250 sheets of 20-Ib. US Bond (75
g/m?) paper

e Usable Sizes: Letter, Legal 13/13.5/14,
Executive, A4, A5, A6, B5, 16K, Custom

* Paper Weight range: 17 to 47 Ib. US Bond (64 2 Slide the paper width guides to the width of
to 176 g/m?) paper to be loaded.

Tray 2 (optional)

e Takes up to 530 sheets of 20-lb. US Bond (75
g/m?) paper

e Usable Sizes: Same as Tray 1, but no A6

e Paper Weight range: same as Trayl

Important!

Before printing on custom size paper, you
must first define the size in the printer
driver. See page 16.

The following procedure shows loading paper in
Tray 1. The procedure for Tray 2 is the same.
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3 Adjust the paper stopper (1) for the paper 5 Load the paper with the print side face down.
length: press down lightly on the blue release Keep the stack below the fill line (1).
lever (2), then slide the paper stopper to the
length of paper to be loaded. The length
selected will show in the view window (3).

6 Fine tune the paper width guides and the
paper stopper to be snug, but not tight,
against the paper.

7 Push the paper tray into the printer until it
stops.

Note

If you are loading legal paper, you must slide the
paper stopper out beyond the end of the tray. For
Legal 14 paper, slide it as far out as it will go
(about 2.5 inches, 64 mm). Settings for Legal 13,
Legal 13.5 and Legal 14 will appear in the stopper
window when it is properly positioned.

8 Configure the tray settings in your machine’s
menu. See “Configuring the Tray Settings” on
page 16.

4 Flex the paper back and forth, and then fan it.
Straighten the edges of the paper stack on a
level surface.
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Loading Paper in the MP Tray

e Takes up to 100 sheets of 20-Ib. US Bond (75
g/m?), up to 10 envelopes.

e Usable sizes: Letter; Legal 13/13.5/14";
Executive; A4, A5, A6, B5; C5, DL, Com-9,
Com-10 and Monarch envelopes, 3" x 5" index
cards, photo paper sizes 4" x 6" or 5" x 7",
banners up to 52" (1320 mm) long, custom

e Paper weight range: 17 to 58 |b. US Bond (64
to 220 g/m?)

Important!

Before printing on custom size paper, you
must first define the size in the printer
driver. See page 16.

1 Lower the MP tray.

2 Pull out the paper support and the sub
support.

3 Adjust the paper feed guides to the width of
paper to be loaded.

4 Insert the paper with the print side face up
until its edge touches the paper feed
entrance, then fine tune the position of the
feed guides.

Note

Load envelopes with the short edge into the
machine, flap down and to the right.

5 Press the tray latch button.

6 Register the loaded paper on your machine.
See “Configuring the Tray Settings” on p. 16.
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Note

e Do not load paper above the fill line.

e Do not load paper of different sizes, types
or weights at the same time.

e When adding paper, remove the paper on
the MP tray and straighten the edges of
both stacks of paper, and then load them
again.

e Do not put anything other than paper for
printing. Do not apply too much pressure
on the MP tray.

Printing the Configuration
Report

You can check the detailed information of your
machine, such as the settings and status, by
printing the configuration report.

1 Press <SETTING> on the control panel.

2 Use the down arrow key to select [Reports],
then press <OK>.

3 Use the down arrow key to select
[Configuration], then press <OK>.

4 When the confirmation message appears,
press the left or right arrow key to select
[Yes], then press <OK>.

Configuring the Tray Settings

Standard Size Print Media

Note

To scroll through the various selections on the
display, press the down arrow key repetitively.

Press <SETTING> on the control panel.

2 Use the down arrow key to select [Paper
Setup], then press <OK>.

Setting

3 Use the down arrow key to select the
applicable paper tray, then press <OK>.

4 Use the down arrow key to select [Paper
Size], then press <OK>.

5 Use the down arrow key to select the size of
the loaded paper, then press <OK>.

6 Use the down arrow key to select [Media
Type], then press <OK>.

7 Use the down arrow key to select the type of
media loaded, then press <OK>.

8 Use the down arrow key to select [Media
Weight], then press <OK>.

9 Use the down arrow key to select the weight
of the loaded paper, then press <OK>.

Custom Size Print Media

To load custom size paper, you need to register
the width and length of the paper before printing.

Tray Available size range
Tray 1 Width:
4.1 to 8.5" (105 to 216 mm)
Length:

5.8 to 14.0" (148 to 356 mm)

Tray 2 Width: same as Tray 1
(optional) Length:

8.3 to 14.0” (148 to 356 mm)
MP tray Width:

2.5t0 8.5" (64 to 216 mm)

Length:

5.0 to 52.0" (127 to 1321 mm)
Note

For tray 1 and tray 2, you can configure the
[Custom] setting only when [Paper Size] is set to
[Custom].

Follow steps 1 through 3 at the left.

2 Use the down arrow key to select [Custom],
then press <OK>.

3 Enter the desired value in the Width box using
the keypad.

Tray 1:Paper Size
Width Length

05-216) 145-356)
mm mm
Oancel

4 Press the right arrow key to move to the
Length box, then enter the value using the
keypad.

5 Press <OK>.
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e Takes 100 sheets of 20-Ib. US Bond (75 g/m?)

Print Exits

paper
o Takes 10 envelopes

1 Pull the rear exit on the back of the machine

Important!

and open it toward you.

2 Unfold the stacker.

Do not open or close the rear exit (face up
stacker) while the machine is printing as it

can cause a paper jam.
Using the Top Exit (Face Down

Stacker)

e Delivers documents with the print side face

is enabled when the rear exit is closed.

down.
e Takes up to 150 sheets of 20-

Ib. US Bond (75

2) paper.

g/m

3 Open the paper support.

it (Face Up

the Rear Ex

Using
Stacker)

through path required for

¢ Delivers documents with the print side face up.

The rear exit is enabled when it is opened.
e Provides straight

heavy paper, transparencies, envelopes, and

labels.
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Loading Documents for
Scanning

You can use the auto document feeder (1) or the
document glass (2) to load documents for
copying, scanning or faxing.

Document Requirements

For information on document requirements, see
the on-line Basic User’s Guide on the DVD
supplied with your machine.

Loading Documents on the Auto

Document Feeder (ADF)

o Takes Letter, Legal 13/13.5/14, Executive, A4,
A5, A6, B5.

e Holds 50 sheets of 20-Ib. US Bond (75 g/m?)
e Load documents face up.

Important!

Make sure that any glue, ink, or correction
fluid on documents is completely dry before
loading them.

1 Load the document(s) on the ADF.

a) Load portrait documents with the top edge
in first.

b) Load landscape documents with the left
edge in first.

2 Adjust the document guides to the width of
the pages.

G222

7% Z2

e
NG
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Loading Documents on the
Document Glass

o Takes Letter, Executive, A4, A5, A6, B5

e Usable for documents up to 0.78-inch (20 mm)
thick

Important!

Make sure that any glue, ink, or correction
fluid on documents is completely dry before
loading them.

1 Lift and open the document glass cover.

2 Place a document face down on the document
glass.

a) If your document is portrait, align its top
edge to the upper-left corner of the glass.

b) If your document is landscape, align its
right edge to the upper-left corner of the
glass.

3 Close the document glass cover gently.

Note

If you want to use [N-in-1], [Sort] or
[DuplexCopy] functions, change the [Document
Direction] setting according to the direction of
your document to get the output you want. The
default setting is [Portrait].
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Network Installation:
Making Connections and Installing

Printer Drivers

Compatible Operating Make the Network
Systems Connection
Your machine supports the following operating
systems: Important!
You must connect your machine to a
Windows network with a suitable Ethernet cable
Windows 7 before installing the printer driver.

e Windows 7 64-bit Edition
e Windows Server 2008 R2 64-bit Edition

e Windows Server 2008 Note
e Windows Server 2008 64-bit Edition The Ethernet cable and hub are not included with
your machine. The Ethernet cable must be

* Windows Vista category 5, twisted pair, straight.

e Windows Vista 64-bit Edition

e Windows Server 2003 @
« Windows Server 2003 x64 Edition B >

gﬁ
e Windows XP . 22

o Windows XP x64 Edition
e Windows 2000

- 1 Turn off your machine:
Macintosh

a) Press <SETTING> on the control panel.
e Mac OS X 10.3.9 to 10.6.

b) Use the down arrow key to select

Important! [Shutdown], then press <OK>.
For Mac OS X 10.6 IntelPC users, install c) When the confirmation message appears,
Rosetta before installing the printer driver. press the right arrow key to select [Yes],

then press <OK>.
d) When prompted to, turn the machine off.

2 Turn off the computer.
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3 Depress the latch (1) on the right side of the 5 Secure the Ethernet cable under the hook (1)
machine and remove the access cover (2). on the machine.

6 Fit the tabs on the side cover into the slots (1)
on the machine housing and snap the cover
back into place.

4 Plug one end of the Ethernet cable into the
LAN connection on the machine.

7 Connect the hub to a computer, then plug the
other end of the Ethernet cable into the hub.

21 - English



Locate the Setup Form

meS61@kest.oom

B-z |SMTP smtp.test.com

B-3 [POP3 pap3.testcom

B-4 | Authentication method SMTP

B-5 | SMTP user ID OKIMCS6E1

akimeS61

okimeS61

u

B-10 user@test.com

pC1

mesel

mesel

Sales

uter| SalesDay

ScanData

You will find a Setup Form on page 54. You can
use this form to record needed information about
your network settings, then refer to it when
setting up the machine for network operation.

Set the Administrative
Password

Note

When using the arrow keys to make your
selections, press the key repetitively to go to the
selection.

1 Press <Setting> on the control panel.

e oo W)
0 OO®
@O0

2 Use the down arrow key to select [Admin
Setup], then press <OK>.

|TI’I"IiI‘I Password J
B. 1\ -+#%x=_123[
qwertyuiopdbée
asdfghjkI|788
zxcvbnmdﬂ Bl || Enter

3 Use the down arrow key to select [a], then
press <OK> six times to enter the default
password: aaaaaa.

4 Use the arrow keys to select [Enter] on the
display, then press <OK>.

5 Use the up arrow key to select
[Management], then press <OK>.

6 Use the up arrow key to select [Admin
Password], then press <OK>.

7 Use the arrow keys to select the digits of your
password, pressing <OK> after each digit.

8 When done entering your new password, use
the arrow keys to select Enter on the display,
then press <OK>.

Note

The Admin Password must have at least six digits
and is case sensitive.

9 When you have entered all the digits, use the
arrow keys to select [Enter] on the display,
then press <OK>.

10 Use the left arrow key to back out to the main
screen.

11 Enter the Admin Password on line A-1 of the
Setup Form.

Set Up the Network for
Windows Systems

To complete the network connection with a
Windows computer, first set IP addresses for the
computer and the machine, and then install
printer driver(s) on the computer.
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Set Up the IP Address, if

Necessary

If your network meets either of the following
conditions, an IP address is assigned to the
computer and to the machine automatically.

o If a DHCP or BOOTP server is on the network
e Universal Plug-and-Play

If all the computers connected to the network
are

Windows 7

Windows Vista

Windows XP

Windows 2000

Windows Server 2008 R2

Windows Server 2008

Windows Server 2003,

or your router supports Universal Plug-
and-Play,

an IP address is automatically assigned to the
computer and to the machine even if a DHCP/
BOOTP server is not on the network.

If the network does not meet the conditions
above, or your network administrator or internet
service provider specifies a unique IP address for
the computer and your machine, set the IP
addresses manually.

General Information

e You must enter the administrator password to
complete this procedure.

e When setting an IP address manually, ask the
network administrator or your internet service
provider which IP address to use. If the IP
address is not set correctly, the network might
go down or Internet access could be disabled.

Note
If you are configuring a small network consisting
of only your machine and a computer, set the IP

addresses as shown below (according to
RFC1918):

For the computer
IP address: 192.168.0.1 to 254

Subnet mask: 255.255.255.0

Default gateway: not used
DNS server: not used
For the machine

IP address Set: Manual

IP address: 192.168.0.1 to 254 (select a
different value from the
computer)

Subnet Mask: 255.255.255.0

Default Gateway: 0.0.0.0

Network Scale: Small

To set [Network Scale]:
e Press <SETTING> on the control panel.
e Select [Admin Setup] > [Network Menu]
> [Network Setup] > [Network Scale].

Set Up Your Computer’s IP Address

Important!

If the IP Address for your computer is
already known, skip to the next section “'Set
Up Your Machine’s IP Address.”

The procedure below uses Windows 7 as an
example. The screen images may differ
depending on the operating system.

1 Turn on the computer.

2 Click [Start] > [Control Panel] > [View
network status and tasks].

e For Windows Server 2003, click [Start] >
[Control Panel] > [Network Connections] >
[Local Area Connection].

e For Windows XP, click [Start] > [Control
Panel] > [Network and Internet
Connections] > [Network Connections].

e For Windows 2000, click [Start] >
[Settings] > [Network and Dial-up
Connections].

3 Select [Change adapter settings].
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e For Windows Server 2008 and Windows
Vista, select [Manage network
connections].

e For Windows Server 2003, Windows XP, and
Windows 2000, skip this step.

Double-click [Local Area Connection].

e For Windows Server 2003, skip this step.
Click [Properties].

If the [User Account Control] dialog box

appears, click [Yes]. (For Windows Vista, click
[Continue]).

Select [Internet Protocol Version 4 (TCP/
IPv4)] and then click [Properties].

-
U Local Area Connection Properties ﬁ

MNetworking

Connect using:

LF Atheros ARS121/ARS113/AR8114 PCI-E Bthemet Contro

This connection uses the following tems:

% Cliert for Microsoft Networks

SQDS Packet Scheduler

.@. File and Printer Sharing for Microsoft Networks
<& |ntemet Protocol Version 6 (TCP/1PvE)

_ ACilEY Intemet Protocol Version 4 (TCP/IPv4)
-4 Link-Layer Topology Discovery Mapper /0O Driver
-t Link-Layer Topology Discovery Responder

Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

[ ok || cancel |

e

e For Windows Server 2003, Windows XP, and
Windows 2000, select [Internet Protocol
(TCP/IP)] and then click [Properties].

7

If setting an IP address manually, enter the IP
address, subnet mask, default gateway and
DNS server, and then click [OK].

2 [ |

Internet Protocel Version 4 (TCP/IPv4) Properties

General

‘fou can get IP settings assigned automatically if your network supports
thiz capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

~) Obtain an IP address automatically
@) Use the following IP address:

P P address: 192 .168 . 0 . 3

> Subnet mask: 255 .,255.255. 0

} Default gateway: 192.168. 0 . 1

Obtain DNS server address automatically
@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit

Advanced...

]I Cancel I

[ ox

e If obtaining an IP address from the DHCP
server automatically, select [Obtain an IP
address automatically] and then click [OK].

Important!
Do not enter a default gateway or DNS
server if unnecessary.

8

Close the open windows.

Set Up Your Machine’s IP Address

1
2

Turn on your machine.
Press <SETTING> on the control panel.

Use the down arrow key to select [Easy
Setup], then press <OK>.

Wiew Information
Shutdown

Enter the administrator password. See line
A-1 on your Setup Form

Use the arrow keys to select [Enter], then
press <OK>.

Use the down arrow key to select [Network
Setting], then press the right arrow key.
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7 If setting an IP address manually, use the
down arrow key to select [Manual], then
press <OK>.

3. Basic Setting of Network

hanual

Auto

&

If obtaining an IP address automatically, select
[Auto], and skip down to “Install the Printer
Driver for Windows.”

8 Use the right arrow key to move from box to
box, entering the applicable information in
each box using the keypad, then press <OK>.

3. Basic Setting of Network

9 Enter the DNS server and WIN server if
necessary.

If they are unnecessary for your network
connection, press <OK> until the popup
message appears.

10 Press <OK> to complete the setup.

Install the Printer Driver(s) for

Windows

You can install multiple drivers at the same time.
Selectable drivers for each model:

e PCL

e PS

e FAX

When you install the drivers, the program also
automatically installs the TWAIN driver required

for scanning, as well as the Network Extension
and Color Swatch utilities.

Note

The procedure below uses Windows 7 and Model
MC561 as an example. The actual procedure may
differ somewhat depending on the operating
system.

1 Make sure your computer is turned on and
connected to the machine via the network.

2 Place the DVD suppled with your machine in
the CD/DVD drive.

The DVD auto runs. If it does not, double click
the OKI setup file in the DVD directory.

3 Select your language from the drop-down list
then click [Next].

4 Read the License Agreement, then click [I
Agree].

5 Under Driver Setup, click [Install Drivers
(MC561)].

Note

If the [User Account Control] dialog box
appears, click [Yes]. (For Windows Vista,
click [Continue]).

6 Read and observe the instructions, then click
[Next].

7 Click [Easy Install (Network)].

Note

The Easy Install selection is an easy setup
method. If you want to select a driver to
install manually, install a shared printer, or
use the Oki LPR Utility as a print method,
select [Custom Installation] and then follow
the instruction displayed on the screen.

8 Click [Next].
The device search starts.

9 Select the printer driver(s) you want to
install: PCL, PS, FAX.

10 If your machine is automatically detected and
displayed, select it, then click [Next].

If your machine is not displayed, click [Restart
search] to restart the device search.

Note

To specify the IP address manually, select [IP
address] and enter the IP address assigned
to your machine, then click [Next].

Installation of the driver(s) and utilities starts.
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Notes

e If the [Windows Security] dialog box
appears, click [Install this driver software
anyway].

For Windows Server 2003 and Windows
XP, if the [Hardware Installation] dialog
box appears, click [Continue Anyway].

For Windows 2000, if the [Digital
Signature Not Found] dialog box appears,
click [Yes].

11 Click [Finish] to complete the installation.

Notes

e To set a default printer, select the check
box of the driver you want. You can also
configure the printer settings of the
selected driver by clicking [Open property
dialog].

If the dialog box prompting to restart the

Set up the Network for
Macintosh Systems

To complete the network connection with a Mac
operating system, install a printer driver on the
computer and set your machine as a network
printer.

Install the Printer Driver for

Mac
Only the PS driver is available for Mac systems.

Select the protocol for your network connection
from the following:

e Ethertalk
- for Mac 10.3.9 to 10.4.11, see below

- for Mac 10.5, see page 28.

e Bonjour (Rendezvous)
- for Mac 10.3.9 to 10.4.11, see page 28.

- for Mac 10.5 and 10.6, see page 30.

computer appears, click [Yes]. The

computer automatically restarts. Important!

Disable the anti-virus software before
starting this procedure.

12 Windows 7: click [Start] > [Devices and
Printers].
Windows Server 2008 and Windows Vista:
click [Start] > [Control Panel] > [Printer].
Windows Server 2003 and Windows XP: click
[Start] > [Printers and Faxes].

Windows 2000: click [Start] > [Settings] > Note
[Printers]. The procedure below uses Mac OS X 10.4.11 and

_ o Model MC561 as an example. The actual
13 Check that the OKI MC561 icon is displayed. procedure may differ somewhat depending on the
e For Windows 7, if you have installed

operating system.
multiple drivers, right-click the OKI MC561
icon and select one of the menu items, and

then check that all the printer drivers
installed are displayed in the submenu.

Using Ethertalk,
Mac OS X 10.3.9 to 10.4.11

1 Make sure your machine and Mac are turned
on and connected.

2 From the Apple menu, select [System
Preferences].

3 Select [Network].

0K MCSEL{FAX)
0K MESELIPCL XPS)
0K MCSELIPEL)
O] MCS1 (RS

Create shortcut

Troubleshoot
Remove device

Properties

e For other Windows operating systems,
check that the icon representing each
driver is displayed.

14 Remove the DVD from the computer.

The installation is complete.
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4 Select [Network Port Configurations] from
[Show], then check that [Built-in Ethernet] is
selected.

i 88o Network

[« » ][ showall | Q

Location: | Automatic i !

—-  Show: | Network Port Configurations |3

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

Port Configurations
Bluetooth
Built-in Ethernet

( New... ')
Built-in FireWire
AirPort

AREES

( Rename )

{——Deletesi—)

(_ Duplicate )

U _—
[ !W Click the lock to prevent further changes. (_ Assistme... ) Apply Now

5 Select the [AppleTalk] tab, then check that
[Make AppleTalk Active] is selected.

Close [Network].

7 Insert the DVD supplied with your machine
into the computer.

8 Double-click the [OKI] icon.

9 Double-click the [Driver] folder, then the
[Printer] folder.

10 Double-click [Installer for Mac OSX].

11 Enter the administrator’s name and password,
and then click [OK].

12 Follow the instructions displayed on the
screen to complete the installation.

13 Remove the DVD from the computer.

14 From the [Go] menu, select [Utilities] and
then double-click [Printer Setup Utility].

Note

If [Printer Setup Utility] is already running,
close it and open it again.

15 Click [Add].

Note

If the [You have no printers available] dialog
box appears, click [Add].

16 For Mac OS X 10.3.9, select [AppleTalk].

17 Select the name of your machine whose
[Connection] is [AppleTalk], and then check
that the name of your machine is displayed
under [Print Using].

rg Q 0 Printer Browser (=¥
ey ] =
= — &

Default Browser IP Printer Search

& | Connection

MC561 AppleTalk m
.

Name: MC561

Location: Local Zone

——- Print Using:  OKI MCSE1(PS) [ ]

f;) ( More Printers... ) (  Add

18 For Mac OS X 10.3.9, select the name of your
machine and select [OKI] from [Print Model],
and then select [OKI MC561(PS)] from the
list. Click [Add].

19 If the [Installable Options] window appears,
click [Continue] unless you have already
installed options. If you have installed
options, configure each option before clicking
[Continue].

20 Check that the name of your machine is
displayed in [Printer List], and then close the
window.

21 From the [Go] menu, select [Applications]
and then double-click [TextEdit].

22 Select [File] > [Page Setup].

23 Select the name of your machine from
[Format for].

24 Check that the name of your machine is
displayed correctly under [Format for].

25 Click [OK].

The installation is complete.
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Using Ethertalk
Mac 10.5 (Leopard)

Note

The procedure below uses Model MC561 as an
example.

1 Make sure that your machine and the Mac are
turned on and connected.

2 Insert the DVD supplied with your machine
into the computer.

3 Double-click the [OKI] icon.

Double-click the [Driver] folder, then the
[Printer] folder.

5 Double-click [Installer for MacOSX].

Enter the administrator’s name and password,
and then click [OK].

7 Follow the instructions displayed on the
screen to complete the installation.

Remove the DVD from the computer.

9 From the Apple menu, select [System
Preferences].

10 Click [Print & Fax].
11 Click [+].

ann Print & Fax

[2]> ][ showan | a )

Click  to add a

printer ar fax Mo Printer Selected

—- |

Dafault Printar: | Last Printar Used

Default Pager Size in Page Setup: | A4 3

I Cick the lock 1o prevent furter changes,

12 Click [AppleTalk].

13 Select the name of your machine and then
check that the name of your machine is
displayed in [Print Using].

—- Fint Using: | OKI MCSE1(PS) ]

Ada )

14 Click [Add].

15 If the [Installable Options] window appears,
click [Continue] unless you have already
installed options. If you have installed
options, configure each option before clicking
[Continue].

16 Check that your machine is displayed under
[Printers].

17 Check that the name of your machine is
displayed in [Kind] and then close [Print &
Fax].

The installation is complete.

Note

The name of your machine may not be displayed
if the printer driver does not read the PPD file
correctly.

In this case, click [-] to remove your machine
from [Print & Fax] and then redo the procedure
from step 10.

Using Bonjour (Rendezvous)
Mac 10.3.9 to0 10.4.11

Note

The procedure below uses Mac OS X 10.4.11 and
Model MC561 as an example. The actual
procedure may differ somewhat depending on the
operating system.

1 Make sure that your machine and the Mac are
turned on and connected.

2 From the Apple menu, select [System
Preferences].
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3 Select [Network].

Select [Network Port Configurations] from
[Show], and then check that [Built-in
Ethernet] is selected.

.—6 aon Network

[« » ][ Showal | Q

Location: | Automatic

——» Show: | Network Port Configurations

3]
3]

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

Port Configurations
Bluetooth
Built-in Ethernet
Built-in FireWire
AirPort

( New... ]
\ y

( Rename ]
\ y

RERARERS

( Delete.. :J

€ Duplicate :J

@

n g :
J gl Click the lock to prevent further changes. [ & Assist me... 9 Apply Now

Close [Network].

Insert the DVD supplied with your machine
into the computer.

Double-click the [OKI] icon.

Double-click the [Driver] folder, then the
[Printer] folder.

9 Double-click [Installer for Mac OSX].

10 Enter the administrator’s name and password,
and then click [OK].

11 Follow the instructions displayed on the
screen to complete the installation.

12 Remove the DVD from the computer.

13 From the [Go] menu, select [Utilities] and
then double-click [Printer Setup Utility].

Important!
If [Printer Setup Utility] is already running,
close it and open it again.

14 Click [Add].

Note

If the [You have no printers available] dialog
box appears, click [Add].

15 For Mac OS 10.3.9, select [Rendezvous].

16 Select the name of your machine whose
[Connection] is [Bonjour], and then check
that the name of your machine is displayed in
[Print Using].

Your machine is displayed with the last six
digits of the MAC address in the printer list.

Printer Browser (=]

‘80

(e

i

)
= a-
—

Default Browser IP Printer Search

Printer Name &| Connection

D gl CHIMC-561-ERE1 & Bonjour m

Name: OKI-MC-561-EBOEIA

Location: Local Zone

Print Using: = OKI MC561(PS) X ]

@

(" More Printers... ) ( Add )
4

17 For Mac OS X 10.3.9, select the name of your
machine and select [OKI] from [Print Model],
and then select [OKI MC561(PS)] from the
list.

18 Click [Add].

19 If the [Installable Options] window appears,
click [Continue] unless you have already
installed options. If you have installed
options, configure each option before clicking
[Continue].

20 Check that the name of your machine is
displayed in [Printer List], and then close the
window.

:Q 66 Printer List =
g o =
i add

Name & |Status Kind

# OKI-MC561-EBOEIA OKI MC561(PS)

21 From the [Go] menu, select [Applications] >
[TextEdit].

22 Select the [File] menu > [Page setup].
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23 Select the name of your machine from
[Format for].

24 Check that the name of your machine is
displayed correctly under [Format for].

25 Click [OK].

The installation is complete.

Using Bonjour
Mac 10.5 and 10.6 (Leopard
and Snow Leopard)

Note

The procedure below uses Mac OS X 10.6 and
Model MC561 as an example. The actual
procedure may differ somewhat depending on the
operating system.

1 Make sure your machine and Mac are turned
on and connected.

2 Insert the DVD supplied with your machine in
the computer.

3 Double-click the [OKI] icon.

Double-click the [Driver] folder, then the
[Printer] folder.

5 Double-click [Installer for MacOSX].

Enter the administrator’s name and password,
and then click [OK].

7 Follow the instructions displayed on the
screen to complete the installation.

8 Remove the DVD from the computer.

From the Apple menu, select [System
Preferences].

10 Click [Print & Fax].
11 Click [+].
12 Click [Default].

13 Select the name of your machine whose
[Kind] is [Bonjour], then check that the name
of your machine is displayed in [Print Using].

The name of your machine is displayed with
the last six digits of the MAC address in the
printer list.

8ano Add Printer [a=]
= = N a
Default Fax IP Windows Search
Printer Name & Kind
—
Name: OKI-MC561-EBOE1A
Location:
Print Using: | OKI MC561(PS) [ ]
[ Add )
]

14 Click [Add].

15 If the [Installable Options] window appears,
click [Continue] unless you have already
installed options.

If you have installed options, configure each
option before clicking [Continue].

16 Check that your machine appears under
[Printers].

17 Check that the name of your machine is
displayed in [Kind] and then close [Print &
Fax].

The installation is complete.

Note

The name of your machine may not be displayed
if the printer driver does not read the PPD file
correctly.

If this happens, click [-] to remove your machine
from [Print & Fax] and then add it again (go back
to step 9).
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Configuring the Machine for Network

Operation

Functions such as

e Scan To Email

e Scan To Network PC
e Internet Fax

enable you to send scanned data to a computer
via the network connection. To use them, you
need to set up your machine and the computers
to which you want to send scanned data.

Enter the Machine’s IP
Address on the Setup Form

Note

When using the arrow keys, press the key
repetitively to go to the selection.

Press <SETTING> on the control panel.

2 Use the down arrow key to select [View
Information], then press <OK>.

Setting
Metwork Scan Destination

Store Document Settings

Yiew Information

3 Use the down arrow key to select [Network],
then press <OK>.

4 Enter the IP address under [IPv4 address] on
line A-2 of the Setup Form.

Set Up Scan To Email and
Internet Fax

Check the Email Settings of the
Computer

¢ If a network administrator specifies the values
such as a mail server account, password and
email address for your machine, note them on
the Setup Form.

Note

The procedure below uses Windows Live Mail on
Windows 7. If you are using a different email
software, refer to the manual for the email
software.

Click [Start] > [Windows Live Mail].

2 Select the [Tools] menu > [Accounts].

If the menu bar is not displayed, click the
[Menus] icon and then select [Show menu
bar].

3 Select the default mail account and then click
[Properties].

4 On the [General] tab, enter the content of
[Name] and [E-mail address] on lines B-9 and
B-10 of the Setup Form.

# | pop3testcom Properties =)

General | Servers | Connection | Securty | Advance: d

Mail Accourt
S/l Typethe name by which you would like to refer to these
E indows Live

senvers. Forexample: "Work" or "W

T tmail,

User Information

Name: User

» B-9
» B-10

Orgarizstion:

E-mail address:  user@testcom

Reply address

| Include this account when receiving mail or synchronizing
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5 Click the [Server] tab, and then enter each
setting in the corresponding lines of the Setup

Form.
4| popdtestoom Properties [iE-J
General | Servers | Connection | Security | Advanced
Server Information
My incoming mail serverisa  POP2 server.
Incoming mail (FOP3):  pop3testcom ‘» B'3
Outgaing mail (SMTF):  smiptestcom “’ B-z
Incoming Mail Server
E-mail usemame: user -l» B-7
Password ssesnsee -.* B-8
V| Remember password
@ Log on using cleartext authentication
Log on using secure password authentication
() Log on using autherticated POP (APOP)
Outgoing Mail Server
/| My server requires authertication | Settings... |
[ ok [ canca |[ ooy |

o If the [My server requires authentication]

check box is selected, enter "SMTP” on line
B-4 of the Setup Form.

e If it is not selected, enter “"POP” on line B-4.

6 Select the [My server requires authentication]
check box and click [Settings].

7 In the [Outgoing Mail Server] dialog box:

Outgoing Mail Server [&J
-
Logon Information
@) Use same settings as my incoming mail server
Log on using
Remember password
Log on using Secure Passwe wthentication
Carce
y

o If [Use the same settings as my incoming

of the Setup Form.

mail server] is selected, enter
- the value from line B-7 on line B-5 and

- the value from line B-8 on line B-6

e If [Log on using] is selected, enter

- The [Password] on line B-6
of the Setup Form.

- the [Account name] on line B5 and

Set the Email Address for Your

Machine

Enter an email address to be used by your
machine on line B-1 of the Setup Form.

o If the email address for your machine is
specified by the network administrator, enter
the email address on line B-1.

e If you are using an internet service provider,
obtain an email address for your machine from
the provider and then enter the email address
on line B-1.

¢ If the email address for your machine is neither
specified nor obtained, determine the email
address according to the value you entered on
line B-4 (authentication method):

- If B-4 is "SMTP”, determine an email address
and enter it on line B-1.

- If B-4 is "POP”, enter the same email
address as B-12 on line B-1.

¢ If you want your machine to receive email, you
must obtain an email address for your machine
from a network administrator or your internet
service provider.

Configure The Machine for Scan

To Email and to Internet Fax

Set up the machine for Scan To Email and
Internet Fax using the information in the Setup
Form.

Note

When using the arrow keys, press the key
repetitively to go to the selection.

Press the <SETTING> key on the control panel.

8 Use the down arrow key to select [Easy
Setup] and press <OK>.

Setting
Yiew Information

Shutdown

9 Enter the administrator password, then use
the arrow keys to select [Enter] and press
<OK>.
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10 Use the down arrow key to select [Email
Setting] and press the right arrow key.

|
2. Fax Setting
3. Network Setting
4 Email Setting
Oancel
11 Referring to the Setup Form:

a) Server Address: Press the right arrow key,
then enter the information from line B-2.

b) Use the arrow keys to select [Enter], then
press <OK>.

c) Your machine’s email address: Press the
right arrow key, then enter the information
from line B-1.

d) Select [Enter], press <OK>.

e) Authentication Method: Press the right
arrow key, then use the down arrow kwy
to select the method from line B-4.

f) Continue to follow the on-screen
instructions to enter the requested
information from section B of the Setup
Form.

g) When all the information has been
entered, “"Email Setting was completed”
appears on the display, and the screen
returns to the Setup Menu.

12 When the setup menu screen appears, press
<OK>.

The setup for Scan To Email and Internet Fax is
complete.

For details on how to use Scan To Email and
Internet Fax, see the Basic User Guide on the
DVD supplied with your machine.

Set Up Scan To Network PC

The Scan To Network PC function enables you to
send and save scanned images to the “shared
folder” of a computer on the network. To use this
function, register your machine on the computer
as a user and create a shared folder, and then
create a profile on your machine to register the
settings for the computer.

e Before starting the setup, get permission from
the network administrator to create a shared
folder on the computer by following the
procedure below.

e The CIFS protocol is used in this procedure.

Check the Name of the

Computer

Check the name of the computer following the
procedure below, and fill it in on line C-1 of the
Setup Form.

Windows 7,

Windows Server 2008 R2,
Windows Server 2008
Windows Vista

Note

The procedure below uses Windows 7 as an
example. The display may differ depending on
the operating system.

Click [Start] > [Control Panel].

2 Select [System and Security].

For Windows Server 2008 and Windows Vista,
select [System and Maintenance].

3 Select [See the name of this computer] under
[System].

4 Note the name in [Computer name] on line
C-1 of the Setup Form.

5 Close the window.

Windows Server 2003
Windows XP

1 For Windows Server 2003, click [Start] >
[Control Panel] > [System].

For Windows XP, click [start] > [Control Panel]
> [Performance and Maintenance] >
[System].

2 Select the [Computer Name] tab and then
click [Change].

3 Note the name in [Computer name] on line
C-1 of the Setup Form.

4 Click [Cancel] to close the window.
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Windows 2000
Click [Start] > [Settings] > [Control Panel].
Double-click [System].

Select the [Network Identification] tab and
then click [Properties].

4 Note the name in [Computer name] on line
C-1 of the Setup Form.

5 Click [Cancel] to close the window.

Determine the Names of the
Items Required for Scan To
Network PC

Determine the names of the following items and

fill them in on lines C-2 to C-6 on the Setup Form.

e User name to log into the destination computer
(C-2)

e Password to log into the destination computer
(C-3)

¢ Profile name to register the settings on your
machine (C-4)

e Shared folder name on the destination
computer (C-5)

¢ File name of the scanned data (C-6)

Configure the Computer for
Scan To Network PC

Register your machine on the computer as a user
and then set up a shared folder to which scanned
images are sent and saved.

e Windows 7, see below

e Windows Server 2008 R2, see below
e Windows 2008, see below

e Windows Vista, see below

e Windows Server 2003, see page 35
e Windows XP, see page 36

e Windows 2000, see page 37

Important!

If the computer is in a domain, the
procedure of adding a user account may be
different from the procedure below. Refer to
the Microsoft Windows manual.

Windows 7,
Windows Server 2008 R2,

Windows 2008,
Windows Vista

Note

The procedure below uses Windows 7 as an
example. The display may differ depending on
the operating system.

Click [Start] > [Control Panel].
Select [Add or remove user accounts].

Select [Create a new account].

A W N =

Enter the information from line C-2 of the
Setup Form in the text box.

"l

Ensure that [Standard user] is selected, and
then click [Create Account].

6 Click the icon of the user account created in
the previous step.

7 Select [Create a password].

Enter the information from line C-3 in [New
password] and [Confirm for new password],
then click [Create password].

K3 ) =/8 « Userdccounts » Manage Accounts » Change an Account b Creste Password = |44 |[ 52
Create a password far mc561°s account
meskl
Standiard user
-

sswoed for meSE.
all EFS-encrypted liles. personal certilicates snd stored passwords for Wel

ture, ask a5l Lo make a password reset flopay dek

By every time

9 Close the control panel.

10 Create a new folder on the computer with the
name entered on line C-5.

Note

It is recommended to create a folder in the
local drive, not on the desktop or [My
Documents].

11 Right-click the folder created in step above
and select [Properties].
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12 Select the [Sharing] tab and then click
[Share].

o
SalesDiev Properties ===

Germenl | S0 | Smcusty | Frmvious Versiors | Customine

Netwoss Fle and Folder Shanng

13 Select the user account created in step 5 from
the drop down box, and then click [Add].

=

14 Select the user added in the previous step
and select the permission level, then click
[Share].

==}
{8 File Sharing
Choose peaple to share with

Type & name and then click Add, or click the smow to find somecne.

15 Click [Done].

16 Click [Advanced Sharing] on the [Sharing]
tab.

17 Click [Permissions].

18 Select the user added in step 13 and select
the [Allow] check box for [Full Control], then
click [OK].

19 Close the folder’s property dialog box.

20 Create a profile to complete the setup for
Scan To Network PC. See “Profiles for Scan To
Network PC” on page 38.

For Windows Server 2003

1 Click [Start] > [Administrative Tools] >
[Server Management].

Click [Users].

Select [Add a user].

Enter the value of C-2 in the [First name] text
box and then click [Next].

Uzer Aecount Inlomation
“ioua st spepcly thee infuenation iecuned ho cieste 8 i ccour

ﬁ Exst name: I:-r-ml

Ligst raers [

Logen nama: =3 =]

5 Enter the value of C-3 in [Password] and
[Confirm password].

Uzer Password
Vo st spely @ pasiwond for the ueen

This user.
fumnmwmmumm
1™ Can changs patiwerd & sy ime

« Back I Bt 3 I Cancel

6 Select the [Cannot change password] and

then click [Next].

7 Click [Finish].

Click [Closel].

9 Create a new folder on the computer with the

name entered on line C-5.

Note

It is recommended to create a folder in the
local drive, not on the desktop or [My
Documents].

10 Right-click the folder created in the step
above, and then select [Sharing and
Security].
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11 On the [Sharing] tab, select [Share this
folder] and then click [Permissions].

istproveties TR

Genes

151 | wieb Shating  Shaiing | Securiy |
ou can share this fokder amang ather users an your
network. To snable sharing for this folder. click Share this
folder.
Do ot share this folder
_’LF Shaethsfolder — |

Share name: [SalecDey

Comment |

User limit: % Mazimum allowed

T Allowe _lj Users

Ok Caneel Apply

12 Click [Add].
13 Enter the value of C-2 and then click [Check

Select Users, Computers, or Groups el
Select this obiect type:
ILlsers, Groups, or Builtin security principals Dbject Types.
From this location:
IsmaHhuslnEss local Locations...
Eniter ths obisct names to select (examplesk
_> 561 Check Names ‘_
Advanced Cancel
P

14 Check that the value of C-2 is displayed, and
then click [OK].

15 Select the [Allow] check box for [Full Control],
and then click [OK].

16 Close the folder’s property dialog box.

17 Create a profile to complete the setup for
Scan To Network PC. See page 38.

For Windows XP
1 Click [start] > [Control Panel].
2 Double-click [User Accounts].

3 Select [Create a new account].

4 Enter the value of C-2 in the text box and
click [Next].

MName the new account

Type arame for the rew sccount:
[mestl

Thi et wall s ) U ek o v s Ehom St s,

= =

5 Select [Limited] and click [Create Account].

CEX

Pick an account type

) Compuame pebvrtraeer (5L 4

With. 3 lmied aceounk, you cant
- o remave your passeord
+ Changa your picture, theme, and cther deshiop settngs
Ve i, yas ermato 4

g —pr—— ..x-:...uu [

DA, & s

59, b Windowrs 3P o
lemted accounts. For best resuks, choose programs beering the Designed For Windaws <P logo,
o, ta run okder progranmd, chocds the “comguber sdminsty stor” sccount trpe.

(ema) [Comseimom ] (Coree)

6 Click the icon of the user account created in
the step above.

7 Select [Create a password].

Enter the value of C-3 in [Type a new
password] and [Type the new password again
to confirm], and then click [Create Password].

9 Close the control panel.

10 Create a new folder on the computer with the
name entered on line C-5.

Note

It is recommended to create a folder in the
local drive, not on the desktop or [My
Documents].

11 Right-click the folder created in the step
above, and then select [Sharing and
Security].

12 Click [If you understand the security risks but
want to share files without running the
wizard, click here.].

13 Select [Share this folder] in Windows Firewall,
and then click [OK].
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14 Select the [Share this folder on the network]

and [Allow network users to change my files]
check box, and then click [OK].

General | Shating | Custamize

Local sharing and secuity
1@ To share this folder with other users of this computer
3)5 only, diag it to the Shared Documents folder.

To make this folder and its subfolders private sathat
only you have access, select the following check box

Network sharing and secuity

W Toshare this folder with both network users and other
%) users of this computer. select the first check box below
=7 and ype a share name.

——» ‘Share this folder on the network

Share name:  |MC561

> [ {Blices retwork users to changs, my fiss
Learn more about sharing and security

dJ windows Firewall is configured to allaw this folder to be shared
with other computers on the: networl

Wiew your Windows Firewall settings

ok | [ cancel | [ appl

15 Select the [Allow] check box for [Full Control],

and then click [OK].

16 Create a profile to complete the setup for

Scan To Network PC. See page 38.

For Windows 2000

_’~(-‘ Share this folder

Double-click [User] and check that the user
created in step 4 is displayed.
Close the [Computer Management] window.

Create a new folder on the computer with the
name entered on line C-5.

Note

It is recommended to create the folder in the
local drive, not on the desktop or [My
Documents].

Right-click the folder created in step 6 and
then select [Sharing].

Select [Share this folder] and then click
[Permissions].

tast Properties el
General| Web Shaing Shaing | Securty |
Yo i hsts s Foldet amncg Other Lissrs o ot
ritwork. To anabls sharing for this foder, ik Share this

folder.

" Do not share this folder

Share name: [SalecDer

Comment |

User fimi: % Wakimum alloved

 Bllow _lj Users
To set pemissions for hovs users access this ‘_
folder over the network, click Permissions.

To configure settings for Offfine access t Cachi
this shared faider, click. Caching. _ Cading |

oK Cancel Apply

Note

1 Right-click [My Computer] on the desktop and
then select [Manage].

2 In the right window, double-click [System
Tools] > [Local Users and Groups]. Right-click
[Users] and select [New User].

3 Enter the value of C-2 in [User name] and the
value of C-3 in [Password] and [Confirm
Password].

rewuser 2]
_> U =
Full name: |
Description: |
_> Password [
_> Confimpassword: [~
i
[V Password never expires
™ Account s disabled
Closs

4 Select [User can not change password] and
[Password never expires], and then click
[Create].

5 Click [Close] to close the [New User] dialog.

If [User must change password at next
logon] is selected, clear it so that you can
select [User can not change password] and

[Password never expires].

10 Click [Add].

11 Select the user account created in step 4 and
then click [Add].

(=[]
Lookine [} 200677005 E

In Folder

200611003
#5 Backup Operators 200611-003
5 Gussts 200611003

7 Powier Users 200611-003 J
%% Rreplicator 200611-003
3 Lsers 200811003 =l

_’ Chieck Names

<< Type names separated by semicolons or choose from list »»

Ok Cancel

A

12 Check that the user account is displayed, and
then click [OK].

13 Select the [Allow] check box for [Full Control],
and then click [OK].

14 Ensure that the icon of the shared folder
changes into the icon with a hand, and then
close the window.
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15 Create a profile to complete the setup for
Scan To Network PC. See “Profiles for Scan To
Network PC” on page 38.

Profiles for Scan To Network
PC

Register the information you configured on the
computer as a profile. This is necessary when you
perform Scan To Network PC with the computer.

Creating a Profile

Note

When using the arrow keys, press the key
repetitively to go to the selection.

1 Press the <SETTING> key on the control
panel.

2 Use the down arrow key to select [Profile],
then press <OK>.

Setting
Address Book
Phone Book

Frofile

]

3 Use the down arrow key to select the profile
number you want to register, then press
<OK>.

4 Use the down arrow key to select [Edit], then
press <OK>.

5 Use the down arrow key to select the profile
number you want to register, then press
<OK>.

6 Use the down arrow key to select [Profile
Name], then press <OK>.

7 Enter the information from line C-4 of the
Setup Form.

8 Use the arrow keys to select [Enter], then
press <OK>.

9 Use the down arrow key to select [Target
URL], then press <OK>.

10 Enter the value from lines C-1 and C-5 of the
Setup Form as “\\C-1\C-5"; e.qg.,
\\PC1\SalesDev.

11 Use the arrow keys to select [Enter], then
press <OK>.

12 Use the down arrow key to select [User
Name], then press <OK>.

13 Enter the information from line C-2 of the
Setup Form.
If domain management is done, enter
“C-2@domain name”.

14 Use the arrow keys to select [Enter], then
press <OK>.

15 Use the down arrow key to select [Password],
then press <OK>.

16 Enter the information from line C-3 of the
Setup Form.

17 Use the arrow keys to select [Enter], then
press <OK>.

18 Use the down arrow key to select [File Name]
and then press <OK>.

19 Enter the information on line C-6 on the Setup
Form. You can enter up to 64 characters.

By adding “#n” to the end of the file name, a
serial number is automatically assigned to the
end of the name of sent files.

By adding “#d"” to the end of the file name, a
date is automatically assigned to the end of
the name of sent files.

20 Use the arrow keys to select [Enter], then
press <OK>.

21 Configure other items if necessary.

22 Press <OK> to register the settings.

The setup for Scan To Network PC is complete.

For details how to use Scan To Network PC, see
the online Basic User Guide on the DVD supplied
with your machine.

Modifying a Profile

Note

When using the arrow keys, press the key
repetitively to go to the selection.

1 Press the <SETTING> key on the control
panel.

2 Use the down arrow key to select [Profile] and
then press <OK>.

3 Use the down arrow key to select [Edit] and
then press <OK>.

4 Use the down arrow key to select the profile
you want to modify, then press <OK>,
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5 Use the down arrow key to select the item
you want to modify, then press <OK>,

Modify the item.

7 Use the arrow keys to select [Enter], then
press <OK>.

8 If you want to modify more than one item,
repeat steps 5-7.

9 Press <OK> to register the settings.

Deleting a Profile

Note

When using the arrow keys, press the key
repetitively to go to the selection.

1 Press the <SETTING> key on the control
panel.

2 Use the down arrow key to select [Profile],
then press <OK>.

3 Use the down arrow key to select [Delete],
then press <OK>.

4 Use the down arrow key to select the profile
you want to delete, then press <OK>,

5 Use the left arrow key to select [Yes] on the
confirmation message.

6 If you want to delete more than one profile,
repeat steps 4 and 5.

7 Press <OK>.
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Setting Up User Authentication and

Access Control

General Information

Before You Start

These functions are used to limit access to the
machine. This can help you save toner, paper and
wear and tear on the machine.

User Authentication and Access Control are
password protected and must be set up by the
System Administrator.

The following conditions are required to enable
these functions:

e The machine must be connected to a network.

e For networks with only Windows systems, the
Configuration Tool utility must be installed on a
computer on the network.

e For Macintosh systems, the Job Accounting
Client utility must be installed

User Authentication?

User Authentication allows the System
Administrator to limit use of the machine to
people who have been assigned either

e a PIN (personal identification number)
or
e a user name and password.

This limitation applies to both walk-up use and
using the machine from a computer.

You can assign up to 100 PINs with or without
User Name and Password.

Access Control

Access Control takes it a step further by allowing
the System Administrator to limit the type of
functions each person authorized to use the
machine can perform.

Access control can be applied to the following
functions:

e Copying (Color/Mono)

e Printing (Color/Mono)

e Printing from USB Memory
e Scanning to e-mail

e Scanning to network PC

e Scanning to USB memory
e Faxing

e Faxing via PC

e Internet Faxing

There are several ways to set up access control
for your machine:

e using software
e Using the web page
e through the control panel

This guide includes instructions for configuring
the machine using software.

For more information on using the web page or
the control panel, see the Advanced User’s Guide
at www.my.okidata.com.

Windows Systems

Loading the Configuration Tool

In order to set up User Authentication and Access
Control for Windows, you need to load the
Configuration Utility on your computer.

1 Make sure your computer is turned on and
connected to the machine, then place the
DVD suppled with your machine in the CD/
DVD drive.

The DVD auto runs. If it does not, double click
the OKI setup file on the DVD.

2 Select your language from the drop-down list
then click [Next].

3 Read the License Agreement, then click [I
Agree].

4 Click [MFP Software].
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5 Click [Install Configuration Tool].

SET
OKI D=

PRINTING SOLUTIONS

OKI MC361/561

Driver Setup
Color Software
Network Software
Optional Utilities
MFP Software

= Register your Primter

CREKING this will Al B launch a Wed
Biweser and conniel 1 e intemed

6 Click [Install] and wait for the software to
install.

7 Select your machine model, then click [Next].
8 Click [Close].

Using the Configuration Tool to
Set Up User Authentication/
Access Control

1 Make sure the computer and the machine are

connected through the network and that both
are turned on.

2 Click [Start] > [Programs] > [Okidata] >
[Configuration Tool] > [Configuration Too].

== Configuration Tool =lolx|
File Tools Plug-in  View Help

OKI

Configuration Tool

Selact Davica fram Reglstered Davice Table and maks settings.

Configuration Tool

3 Click [Register Device] in the Tools drop-down
list.

4 Double click your machine model name.
The name appears in the [Registered Device
Table] on the left side of the screen.

5 Double click your machine in the list, then
select the [User Setting] tab.

6 Click [PIN Manager], then enter the
administrator password and click <OK>.

7 To enter a new PIN number and set it up with
the desired access control, click the PIN icon.

To enter a new user with User ID, Password
and PIN number, click the New(User) icon.

8 Repeat the above step for each user on the
network.
9 When done, click the [Save to Device] icon.

The records you have entered are saved to the
machine.

Mac Systems

In order to set up User Authentication and Access
Control for Mac systems, see the Advanced User
Guide at www.my.okidata.com.

Authentication by PIN

Enabling PIN Access Control

Once you have finished setting up PINs and/or
User IDs/Passwords, you must enter the machine
menu and enable Access Control.

Access Control is password protected: you must
know the Admin Password to proceed.

Note

To scroll through the various selections on the
display, press the down (or up) arrow key
repetitively.

Press <SETTING> on the control panel.

2 Use the up arrow key to select [Admin Setup],
then press <OK>.

3 Enter your administrator password: use the
arrow keys to select the digits of the
password, pressing <OK> between digits.

4 When done entering your password, use the
arrow keys to select [Enter] on the display,
then press <OK>.

5 Use the up arrow key to select
[Management], then press <OK>.

6 Use the down arrow key to select [System
Setup], then press <OK>.

7 Make sure that [Access Control] is selected,
then press <OK>.

8 Use the up arrow key to select PIN as the
method of Access Control, then press <OK>.
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9 Use the left arrow key to back out to the main
screen

Access Control is enabled.

Walk Up Operation
Logging In

Login

PN ro.

oK)

General Users

1 Enter your assigned PIN using the ten-key
pad on the control panel.

2 Press <OK>.
The main screen appears.

Administrator

1 Enter "000000” using the ten-key pad on the
control panel, then press <OK>

e The PIN of the administrator is *000000".
You cannot change this value.

2 When the Admin Password screen appears,
enter the administrator password: use the
arrow keys to select the digits of the
password, pressing <OK> after highlighting
each digit.

3 Use the arrow keys to select [Enter] on the
display, then press <OK>.
The main screen appears.

Logging Out
When you have finished using the machine, be
sure to log out.

1 Press the left arrow key until the main screen
appears.

2 Press <RESET/LOGOUT> on the control
panel.

The screen returns to the PIN entry prompt.

Note

After a certain period of time, the machine
automatically logs out users.

Setting Up Operation From a
Computer with Authentication
by PIN

First, make sure the appropriate machine
driver(s) have been installed on the computer
using the DVD.

Second, install Job Accounting (client) software
on the computer. To do this, place the DVD
supplied with the machine in the computer drive
and follow the screen prompts to download the
Job Accounting software from the internet.

M
OKI .

PRINTING SOLUTIONS

OKI MC361/561

Coler Software
Netwerk Software
Optional Utilities
MFP Software

Internet Downloads
[*]

T= Register your Printer

(Clicking this will attempt 1o launch & Web
Eowser and connactin th iomaty

Note

The authentication type specified on the
computer overrides the one specified on the
machine.

Setting Up Windows Computers for
Printing

Note

This procedure uses MC561 and Windows 7 as an
example. The procedures and menus may differ
depending on the operating system you use.

1 Click [Start] > [All Programs] > [Okidata] >
[Print Job Accounting Client] > [Change Job
Accounting Mode].
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2 On the [User Account Control] window, click
[Yes].

3 Select the printer driver you want in [Driver].

Select the [Tab] check box and then click
[Change].

5 Click [OK].
From the [File] menu, select [Close].
7 Click [Start] and select [Devices and

Printers].

e For Windows Server 2008, click [Start] and
select [Control Panel] > [Printers].

e For Windows Vista, click [Start] and select
[Control Panel] > [Printer].

e For Windows Server 2003, click [Start] >
[Printers and Faxes].

e For Windows XP, click [start] > [Printers
and Faxes].

e For Windows 2000, click [Start] >
[Settings] > [Printers].
8 For each driver installed on the computer:

a) Right-click the OKI MC561 icon and select
[Printer properties] > [OKI MC561
(XXX*)].

*XXX = PCL, PS, or FAX
b) Select the [Job Accounting] tab.

c) Enter the user name in [User Name] and
the PIN in [Job Account ID].

= OKI MCS61(PCL) Properties ]
General Sharing Ports Advanced Color Management
Status Job Accourting Securty Device Option
Jab Accounting Setting
User Hame [up to 80 characters]
> Oki
Job Account 1D [1-933333333)
1
OK | [ cancel | [ Aopy

Printing from Windows
1 Open the file you wish to print.
2 Select [Print] from the [File] menu.

3 Select the printer driver, then click [Print].

Setting Up Mac Computers for
Printing

Note

This procedure uses Model MC561 and Mac OS X
10.6 (Snow Leopard) as an example. The
procedures and menus may differ depending on
the operating system you use.

1 Insert the DVD supplied with your machine.

Double-click the OKI icon on the desktop.

Double-click [Utility] > [JA Client] > [Print
JobAccounting].

Click [New].

5 Enter the user name beside [UserName] and
the PIN beside [JobAccountingID].

ALOLO

{ Cancel )
( Cancel )

LoginName : Administrator

ﬁ UserName : Oki
ﬁ JobAccountingID : | 2

C Help )
( Help )

Click [Save].
Click [save].

If prompted, enter the user password and
then click [OK].

Printing from a Mac
1 Open the file you want to print.
2 From the [File] menu, select [Print].

3 Select your machine and then click [Print].

Setting Up Windows Computers for
Faxing

Note

This procedure uses MC561 and Windows 7 as an
example. The procedures and menus may differ
depending on the operating system you use.
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1 Click [Start] > [All Programs] > [Okidata] >
[Print Job Accounting Client] > [Change Job
Accounting Mode]

2 On the [User Account Control] window, click
[Yes].

3 Select the fax driver in [Driver].

Select the [Tab] check box and then click
[Change].

Click [OK].
From the [File] menu, select [Close].

Click [Start] and select [Devices and
Printers].
- For Windows Server 2008, click [Start] and
select [Control Panel] > [Printers].

- For Windows Vista, click [Start] and select
[Control Panel] > [Printer].

- For Windows Server 2003, click [Start] and
select [Printers and Faxes].

- For Windows XP, click [start] and select
[Printers and Faxes].

- For Windows 2000, click [Start] and select
[Settings] > [Printers].

8 Right-click the OKI MC561 icon and select
[Printer properties] > [OKI MC561 (FAX)].

9 Select the [Job Accounting] tab.

10 Enter the user name in [User Name] and the
PIN in [Job Account ID].

11 Click [OK].

Faxing from Windows

1 Open the file you want to fax.

2 From the [File] menu, select [Print].

3 Select the fax driver, then click [Print].

Authentication by User Name
and Password

Enabling User Name/Password

Access Control

Access Control is password protected: you must
know the Admin Password to proceed.

Note

To scroll through the various selections on the
display, press the down (or up) arrow key
repetitively.

Press <SETTING> on the control panel.

2 Use the up arrow key to select [Admin Setup],
then press <OK>.

3 Enter your administrator password: use the
arrow keys to select the digits of the
password, pressing <OK> between digit

4 When done entering your password, use the
arrow keys to select [Enter] on the display,
then press <OK>.

5 Use the up arrow key to select
[Management], then press <OK>.

6 Use the down arrow key to select [System
Setup], then press <OK>.

7 Make sure that [Access Control] is selected,
then press <OK>.

8 Use the up arrow key to select User/Password
as the method of Access Control, then press
<OK>.

9 Use the left arrow key to back out to the main
screen

Access Control is enabled.

Operation from a Computer

Note

The authentication type specified on the
computer overrides the one specified on the
machine.

Printing from Windows

Note

This procedure uses Windows 7 and NotePad as
an example. The procedures and menus may
differ depending on the operating system you
use.

1 Open the file you want to print.

2 From the [File] menu, select [Print].
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3 Select the printer driver you want in [Select
Printer] and click [Preferences].

Select the [Job Options] tab.
5 Click [User Auth].

6 Select the [Use User Authentication] check

box.
[
Usemame Use Windows Login

7 Enter the user name in [Username] and the
password in [Password].
Clicking [Use Windows Login] automatically
enters your login name on Windows.

8 Click [OK].
9 Click [OK] and then click [Print].
Printing from a Mac

Note

This procedure uses Mac OS X 10.6 as an
example. The procedures and menus may differ
depending on the operating system you use.

Open the file you want to print.
From the [File] menu, select [Print].

Select your machine’s printer driver.

A W N =

Select [UserAuth] from the panel menu under
the [Printer] and [Presets] menus.

Printer: | MC561 1]

Presets: | Standard =]
Copies: [1 "] #f Collated (] Two-Sided
Pages: & Al

() From: 1 w1

Paper Size: | A4 ) 20990y 20.70em

Orientation: 'l T

Useruih 7] e

The bundle "UserAuth™ couldn’t be loaded because it doesn't
contain a version for the current architecture.

Cantact the bundie's creator listed hare for the latest version.

@ Cmiv) (Camel) i)

5 Select the [Use User Auth] check box on the
[UserAuth] panel.

:
a

_* [ Use User Auth
User Name :

Password

POF ¥ Preview Cancel ) Prine)

6 Enter the user name in [User Name] and the
password in [Password].

7 Click [Print].

Faxing From Windows

Note

This procedure uses Windows 7 and NotePad as
an example. The procedures and menus may
differ depending on the operating system you
use.

Open the file you want to fax.
From the [File] menu, select [Print].

Select your machine (fax driver) in [Select
Printer] and click [Preferences].

On the [Setup] tab, click [User Auth].

5 Select the [Use User Authentication] check
box.

6 Enter the user name in [Username] and the
password in [Password].

Note

Clicking [Use Windows Login] automatically
enters your login name on Windows.

7 Click [OK].
Click [OK] and then click [Print].
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Configuring the Machine for Faxing

Basic Settings for Faxing

You must configure the following settings before
you transmit faxes.

Connecting a Telephone Line
Important!
Use only the telephone cable supplied with

your machine. Using a different cable may
cause a malfunction.

Connecting for Fax Only

1 Plug one end of the supplied telephone cable
into the LINE connection on the back of your
machine and the other end into an active
telephone jack.

2 Attach the supplied connector cover to the
TEL connection on the back of your machine.

Ko

Connecting for Fax and Telephone

1 Plug one end of the supplied telephone cable
into the LINE connection on the back of your
machine and the other end into an active
telephone jack.

2 Plug the telephone’s cable into the TEL
connection on the back of your machine.
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Specifying Current Time and
Sender Information

Note

You can set up the date and time automatically
using the Webpage. For details, refer to the
Advanced User’s Guide at www.my.okidata.com.

Note

When using the arrow keys, press the key
repetitively to go to the selection.

Press <SETTING> on the control panel.

2 Use the down arrow key to select [Easy
Setup], then press <OK>.

Setting
Wiew Information
Shutdown

3 If prompted, entire the Admin Password, then
use the arrow keys to highlight [Enter] and
press <OK>.

4 With [Date/Time Setting] highlighted, press
the right arrow key.

o1 Date/Tin
2. Fax Setting
o 3 Metwork Setting

5] Cancel @

5 Use the down arrow key to select the
appropriate time zone and then press the
right arrow key.

You can select the time zone between [-12:00]
and [+13:00] in 15 minute increments.

6 Use the down arrow key to select [Not
Summer Time] or [Now Summer Time] for
daylight saving, then press the right arrow
key.

7 Use the down arrow key to select [Manual],
then press the right arrow key.

8 Use the up and down arrow keys to set the
Year, Month and Day, pressing the right arrow
key to move to each successive block. When
done press <OK>.

9 Use the up and down arrow keys to set the
current time (Hour, Minute, Seconds),
pressing the right arrow key to move to each
successive block. When done press <OK>.

"Date/Time Setting was completed” appears
on the display, then the Setup Menu screen
appears.

Specifying Sender Information

Specify the fax number and sender name for your
machine. The sender ID is printed on the top
edge of the fax when it is printed by the recipient.

10 Press the down arrow key to select [Fax
Setting], then press the right arrow key.

|
e 1 Date/Time Setting

2. Fax Setting

o 3 Metwork Setting

Cancel

11 Press <OK> to select [FAX number].

12 Use the keypad to enter the fax number of
your machine.

13 With [Enter] highlighted, press <OK>.
14 Press the right arrow to select [Sender ID].

15 Use the screen keypad to enter your ID, up to
22 digits. When the ID is entered, use the
arrow keys to highlight [Enter], then press
<OK>.

"Fax Setting was completed” appears on the
display, then the Setup Menu screen appears.

16 Press <OK> to complete the setup, then use
the left arrow key to back out to the main
screen.
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USB Installation

4 Depress the lock button (1) on the right side

USB Connection of the machine and remove the access cover
(2).

1 Prepare a USB cable.
A USB cable is not supplied with your machine.

Use a USB 2.0 Hi-Speed cable for a USB 2.0
Hi-Speed connection.

2 Turn off your machine:
a) Press <SETTING> on the control panel.

b) Press the down arrow key repetitively to
scroll to [Shutdown], then press <OK>.

c) When the confirmation message appears,
press the right arrow key to select [Yes],
then press <OK>.

d) When the screen prompts you to turn off
the power switch, turn the machine off.

3 Turn off the computer.

CAUTION!

Do not plug the USB cable into the network
connection. Doing so may cause a
malfunction.
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5 Plug one end of the USB cable into the USB 7 Fit the tabs on the side cover into the slots (1)
connection on the machine. on the machine housing and snap it back into
place.

For Windows installation, go to page
50.

ﬂ For Macintosh installation, go to
page 51.

6 Secure the USB cable under the hook (1) on
the machine.
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USB: Installing a Printer
Driver for Windows

¢ You must be logged in as an administrator to
complete this procedure.

Note

The procedure below uses Windows 7 and Model
MC561 as an example. The display may differ
depending on the operating system.

1 Turn off your machine:
a) Press <SETTING> on the control panel.

b) Press the down arrow key repetitively to
select [Shutdown], then press <OK>.

c) When the confirmation message appears,
press the right arrow key to select [Yes],
then press <OK>.

d) When the screen prompts you to turn off
the power switch, turn the machine off.

2 Place the DVD suppled with your machine in
the CD/DVD drive.

The DVD auto runs. If it does not, double click
the OKI setup file in the DVD directory.

3 Select your language from the drop-down list
then click [Next].

4 Read the License Agreement, then click [I
Agree].

5 Under Driver Setup, click [Install Drivers
(MC561)].

Note

If the [User Account Control] dialog box
appears, click [Yes]. (For Windows Vista,
click [Continue]).

6 Read and observe the instructions, then click
[Next].

Installation starts.

o If the [Windows Security] dialog box appears,
click [Install this driver software anyway].

e For Windows Server 2003 and Windows XP, if

the [Install Hardware] dialog box appears, click
[Continue].

e For Windows 2000, if the [Digital Signature Not

7

8
9

Found] dialog box appears, click [Yes].

When the instruction prompting you to do so
appears, plug the USB cable into the
computer and turn on your machine.

Click [Next].

Follow the on-screen instructions to complete
the installation.

10 When the [Complete] screen appears, click

[Finish].

Check the Installation

1

Click [Start] > [Devices and Printers].
For Windows Server 2008 and Windows Vista,
click [Start] > [Control Panel] > [Printer].

For Windows Server 2003 and Windows XP,
click [Start] > [Printers and Faxes].

For Windows 2000, click [Start] > [Settings]
> [Printers].

Check that the OKI MC561 icon is displayed.

For Windows 7, if you have installed multiple
drivers, right-click the OKI MC561 icon and
select one of the menu item, and then check
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that all the printer drivers installed are
displayed in the submenu.

/ /
! See what's printing . OK1 MCSELIFAG
-i .: et s el printer
= | RP
Micoscft {P5 | OMIMCSEL|  Printing preferences  # OKIMCSELPCL)
Doc \Wiriter Printes properties " OKI MCSELPS)
Delete print queue

0K MCS61(PCL XP5)

Create shareut

Treubleibont

Remeve device

Propertie

For other Windows operating systems, check
that the icon representing each driver is
displayed.

3 Remove the DVD from the computer.

The installation is complete.

Note

[Easy Install (Local)] is an easy setup method. If
you want to select a driver to install manually,
select [Install printer driver completely] and then
follow the instruction displayed on the screen.

USB: Installing a Printer
Driver for Mac

Important!
e Only the PS printer driver is available for
the Mac.

e Disable the anti-virus software before
starting this procedure.

For Mac OS X 10.3.9 to 10.4.11

Note

The procedure below uses Mac OS X 10.4.11 and
Model MC561 as an example.

1 Turn off your machine:
a) Press <SETTING> on the control panel.

b) Press the down arrow key repetitively to
scroll to [Shutdown], then press <OK>.

c) When the confirmation message appears,
press the right arrow key to select [Yes],
then press <OK>.

d) When the screen prompts you to turn off
the power switch, turn the machine off.

2 Turn off the computer.

3 Plug the other end of the USB cable into the
computer’s USB interface connector.

Turn the Mac on.

5 Insert the DVD supplied with your machine
into the computer.

6 Double-click the [OKI] icon > [Driver] folder
> [Printer] folder.

7 Double-click [Installer for Mac OS X].

Enter the administrator’'s name and password,
and then click [OK].

9 Follow the on-screen instructions to complete
the installation.

10 Remove the Driver/Manual DVD from the
computer.

11 From the [Go] menu, select [Applications] >
[Utilities], and then double-click [Printer
Setup Utility].

Important!
If [Printer Setup Utility] is already running,
close it and open it again.

12 Click [Add].

If the [You have no printers available] dialog
box appears, click [Add].
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Note

If the name of your machine is already displayed,
select it and click [Delete], and then click [Add].

13 Select the name of your machine designated
USB, then check that the name of your
machine is displayed in [Print Using].

8one Printer Browser (=)
; )
ae s 0 a
=y =
Default Browser IP Printer Search
Printer Name &| Connection
_> MC561 UsE m

Name: MC561

Location: Administrator’s iMac

Print Using:  OKIMC561(PS) 4 !

@) ( More Printers... ) ( Add )

BN

14 Click [Add].

15 If the [Installable Options] window is
displayed, click [Continue].
If you have installed options before the driver
installation, configure each item and then
click [Continue].

16 Check that the name of your machine is
displayed in [Printer List], and then close the
window.

The installation is complete.

For Mac OS X 10.5 and 10.6

Note

The procedure below uses Mac OS X 10.6 (Snow
Leopard) and the Model MC561 as an example.

Make sure that your machine and the
computer are turned on and connected.

Plug the other end of the USB cable into the
computer’'s USB interface connector.

3 Insert the DVD supplied with the machine into
the computer.

4 Double-click the [OKI] icon > [Driver] folder
> [Printer] folder.

5 Double-click [Installer for MacOSX].
Enter the administrator’s name and password,
and then click [OK].
Follow the on-screen instructions to complete
the installation.

7 Remove the Driver/Manual DVD from the
computer.

8 From the Apple menu, select [System
Preferences].

9 Click [Print & Fax].

10 Click [+].
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11 Select the name of your machine designated
USB, and then check that the name of your
machine is displayed in [Print Using].

ane Add Printer =

- & |Kind

_> OKI DATA CORP MC561 USE

Name: OKI DATA CORP MC561
Location: Administrator’s iMac

Print Using: OKI MC561(PS)

12 Click [Add].

13 If the [Installable Options] window is
displayed, click [Continue].
If you have installed options before the driver
installation, configure each item and then click
[Continue].

14 Check that the name of your machine is
displayed in the printer list, and then close
[Print & Fax].

The installation is complete.
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Setup Form

No. |Item Example Your Value

A: Basic Setup Information

A-1 Administrator password for your machine aaaaaa (the
default)
A-2 IP address of your machine 192.168.0.2
B: Scan To Email and to Internet Fax

B-1 Email address for your machine (up to 80 mc561@test.com
characters)

B-2 SMTP server address smtp.test.com

B-3 POP3 server address pop3.test.com

B-4 Authentication method SMTP

B-5 SMTP user ID OKIMC561

B-6 SMTP password okimc561

B-7 POP user ID user

B-8 POP password okimc561

B-9 Name of the email destination User

B-10 | Email address of the email destination user@test.com

C: Scan To Network PC

C-1 Name of the destination computer PC1

C-2 User name to log into the destination computer | mc561
(up to 32 characters)

C-3 Password to log into the destination computer mc561
(up to 32 characters)

C-4 Profile name to register the settings (up to 16 Sales
characters)

C-5 Shared folder name on the destination computer | SalesDev
(up to 64 characters)

C-6 File name of the scanned data (up to 64 ScanData
characters)
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Installation de matériel

Contenu de I'emballage

Choisir un emplacement

Appareil

DVD

Cordon d'alimentation

Cable téléphonique

Couvercle du connecteur du téléphone

UNUHAWN KR

Remarque

Les cables Ethernet et USB ne sont pas compris avec
votre appareil et doivent étre achetés séparément.

Nous vous conseillons de conserver le matériel
d'emballage, nécessaire au transport de I'appareil.

Exigences environnementales

e Plage de températures : 10 °C a 32 °C (50 °F a
89,6 °F)

e Humidité : HR de 20 % a 80 % (humidité relative)
Si vous installez votre appareil dans un endroit ou
le taux d’humidité est inférieur a 30 % d’HR,
utilisez un humidificateur ou un tapis antistatique.

e Température thermometre humide max. :
25 °C (77 °F)
Prenez garde a la condensation. Elle peut
entrainer des défaillances.

Espace requis

20 cm
8"

Alimentation

e 110-127 V c.a ou 220-240 V c.a
e 50/60 Hz

e 1100 watts maximum

Important!

Ne jamais brancher ce produit sur un bloc
d’alimentation sans interruption (ASI).

Si la source de courant est instable, utilisez
un régulateur de tension.
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2 Retirez le matériau d’emballage extérieur.

Déballer I'appareil

Important!
Un minimum de deux personnes est nécessaire
pour lever I'appareil en toute sécurité.

Remarque

Les illustrations ci-dessous sont représentatives.
Le véritable matériel, ruban adhésif ou
emballage, peut quelque peu différer de celui
indiqué sur les illustrations.

Conservez le matériel d’emballage, nécessaire au
transport de |'appareil.

1 Retirez I'appareil de sa boite et placez-le a
I’endroit ou il doit étre installé.

4 Ouvrez le couvercle de I'alimentateur
automatique et retirez tout matériau d’emballage.
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5 Soulevez le bac a papier et retirez tout
matériau d’emballage.

9 OQuvrez le numériseur et retirez tout
matériau d’emballage.

6 Abaissez le bac a papier et fermez le
couvercle de I'alimentateur automatique.

7 Ouvrez le couvercle de la vitre a documents
(1) et retirez tout matériau d’emballage, ainsi
que le film protecteur.

8 Refermez le capot a documents.

10 Appuyez sur le bouton d’ouverture du capot
(1), puis ouvrez le capot (2).

Attention!

e Le tube vert sur la cartouche du tambour
d’impression est trés fragile. Le manier
avec précaution.

e Ne pas exposer l'unité du tambour
d’impression aux rayons solaires ou a une
lumieére d’intérieur trés forte (environ
plus de 1500 lux). Méme sous une lumiére
d’intérieur normale, le tambour
d’impression ne doit pas étre exposé plus
de 5 minutes.
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13 Faites glisser le manchon bleu de verrouillage

11 Retirez le ruban adhésif et le matériau

sur chaque cartouche toner vers la gauche

jusqu’a son maximum.

d’emballage des cartouches de toner.

unité de

fusion dans la direction indiquée par la fleche,
retirez et conservez la butée orange (2).

14 Fermez délicatement le capot supérieur et
I'unité du numériseur.

’

12 Appuyez sur le levier bleu (1) de |

15 Retirez le ruban adhésif sur le bac a papier

MF, puis ouvrez le bac.

Important!

Conservez la butée orange, elle sera nécessaire

si vous devez transporter I'appareil.
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16 Retirez le ruban adhésif intérieur (1) ainsi que

le film protecteur (2), puis fermez le bac a
papier MF.

2 Branchez le cable d’alimentation dans la prise
d’alimentation au dos de |'appareil.

Branchez le cable d’alimentation dans une
prise de courant mise a la terre.

Allumer l'appareil

1 Vérifiez bien que I'interrupteur d’alimentation 4 \Vérifiez bien qu’aucun document ne se trouve
(sur le coté droit de I'appareil) est éteint <O>. sur la vitre ni dans le CAD, et que le CAD
est fermé.

5 Allumer I'imprimante.

Eteindre I'appareil

Attention!

Ne pas éteindre l'interrupteur
d’alimentation subitement : ceci peut
endommager votre appareil. Toujours suivre
la procédure appropriée pour s'assurer
qu’aucune donnée ne soit perdue.
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1 Appuyez sur <SETTING> (Parameétre) sur le
panneau de commande.

2 Appuyez sur la touche fléchée vers le bas de
facon répétitive jusqu’a sélectionner
[Shutdown] (Arrét), puis appuyez sur <OK>.

Setting

Store Document Settings
Wiew Information

Shutdown

&

3 Quand le message de confirmation s’affiche,
appuyez sur la touche fléchée vers la droite
jusqu'a sélectionner [Yes] (Oui), puis appuyez
sur <OK>,

4 Quand le message vous demandant
d’éteindre I'interrupteur d’alimentation
apparait, éteignez 'appareil.

Mode d’économie d’énergie
et Mode sommeil

Remarque

Pour plus de renseignements, reportez-vous au
Guide de base de I'utilisateur en ligne sur le CD
fourni avec votre appareil.

Touche d’économie d’énergie

O C O C O C DO C D

C o C O CH CH C D

e SRR QK

Quand votre appareil reste inutilisé plus de

30 minutes (durée par défaut définie en usine),
il se met automatiquement en mode
d’économie d’énergie afin de réduire sa
consommation énergétique.

Vous pouvez entrer (ou quitter) le mode
d’économie d’énergie en appuyant sur <POWER
SAVE> (Economie d’énergie) sur le panneau de
commande.

Le panneau de commande

\(.?i_’) ) S G T e ./

Pour plus de renseignements sur
¢ le panneau de commande
e entrer/supprimer du texte ou des données

reportez-vous au Guide de base de |'utilisateur en
ligne sur le CD fourni avec votre appareil.

Chargement du support
d’impression

Pour plus de renseignements relatifs au support
d'impression, reportez-vous au -Guide de base
de l'utilisateur en ligne sur le CD fourni avec
votre appareil.
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Plateaux disponibles Chargement du papier : bac 1
- ou bac 2 optionnel

Tray 1 (Bac 1)
e Peut contenir jusqu’a 250 feuilles de papier
o bond US de 75 g/m? (20 Ib).

e Formats utilisables : lettre, Legal 13/13,5/14,
Executive, A4, A5, A6, B5, 16K, personnalisé

e Plage de grammages de support : bond US de
64 a 176 g/m? (17 a 47 Ib)

Bac 2 (optionnel)

¢ Peut contenir jusqu’a 530 feuilles de papier
bond US de 75 g/m? (20 Ib).

e Formats utilisables : identiques au bac 1 sauf
pour le format A6, non accepté.

e Plage de grammages de support : identique au
Bac 1.

Important!

Avant d’'imprimer sur un papier a format
personnalisé, vous devez tout d’abord
définir le format dans le pilote de
I'imprimante. Voir page 65.

La procédure suivante indique comment charger
du papier dans le Bac 1. La procédure

1 Tray 1 (Bacl) s’appliquant au Bac 2 est identique.

2 MP Tray (Bac MF)
3 Bac 2 (optionnel)

1 Sortez le bac a papier.

Plages de grammage

disponibles

Plage de grammages,
Description -

Bond US Métrique
Léger 17 a 18 Ib. 64 & 74 g/m?2
Medium Light 20 a 21 Ib. 75 & 82 g/m?2
(Mince moyen)
Medium (Moyen) 22 a2 28 Ib. 83 & 104 g/m?2
Lourd 28 a 32 Ib. 105 & 120 g/m?
ULTRA HEAVY1 32347 Ib. 121 4 176 g/m2
(ULTRA LOURD1)
ULTRA HEAVY2 47 3 58 Ib. 177 & 220 g/m2
(ULTRA LOURD2)
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2 En les faisant glisser, ajustez les guides papier
a la largeur du papier a charger.

Remarque

Si vous chargez du papier Legal, vous devez faire
glisser la butée pour papier en dehors du bac.
Pour du papier Legal 14, faites-la glisser aussi
loin que possible (environ 2,5 po, 64 mm). Les
parametres pour le papier Legal 13, Legal 13,5 et
Legal 14 apparaitront dans la fenétre de butée
une fois bien positionné.

3 Ajustez la butée pour papier (1) a la longueur
du papier. Appuyez délicatement sur le levier
bleu de déverrouillage (2), puis faites glisser
la butée de papier a la longueur du papier a
charge,r. La IongueurAséIectionnée sera 4 Pliez le papier d'un sens, de I'autre, puis
indiquee dans la fenétre d'apergu (3). agitez-le. Réajustez les bords de la pile de

papier sur une surface plane.

5 Chargez le papier avec le c6té d'impression
vers le bas. Maintenez la pile sous le trait
de remplissage (1).

6 Ajustez avec précision les guides papier et Ia
butée afin qu'ils touchent délicatement le
papier sans trop le serrer.
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7 Poussez le bac a papier au maximum Charger du papier dans le
dans l'imprimante. bac MF

e Peut contenir jusqu’a 100 feuilles de papier

bond US de 75 g/m? (20 Ib), jusqu’a
10 enveloppes.

e Formats utilisables : lettre, Legal 13/13,5/14;
Executive; A4, A5, A6, B5, C5, DL, Com-9,
Com-10, enveloppes Monarch, 7,62 x 12,7 cm
(3" x 5"), cartes d'index, papier photo format
10x15cm (4" x6") ou 12 x 18 cm (5" x 7"),
banniéres personnalisées jusqu’a 1320 mm
(52") de longueur.

e Plage de grammages de support : bond US de
64 a 220 g/m? (17 a 58 Ib).

Important!

Avant d’'imprimer sur un papier a format
personnalisé, vous devez tout d’abord
définir le format dans le pilote de
I'imprimante. Voir page 65.

8 Configurer les paramétres du bac dans le
menu de votre appareil. Consultez
“Configuration des parameétres du bac” a
la page 64.

1 Abaissez le bac multifonction.
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3 En les faisant glisser, ajustez les guides papier

a la largeur du papier a charger.

4 Insérez le papier avec le coté d'impression
vers le haut jusqu’a ce que ses rebords
touchent I’'entrée de I'alimentation papier,
puis ajustez avec précision les guides papier.

Remarque

Chargez les enveloppes avec le c6té ouvert dans
I’'appareil, face vers le bas et a droite.

5 Appuyez sur le levier de verrouillage du bac.

6 Enregistrez le papier chargé sur votre
appareil. Reportez-vous a “Configuration des
parametres du bac” a la page 64.

Remarque

e Ne chargez pas de papier au-dela du trait
de remplissage.

¢ Ne chargez pas de papier de différents
formats, types ou grammage en
méme temps.

e Quand vous ajoutez du papier, retirez le
papier déja dans le bac MF, réajustez les
bords des deux piles de papier, puis
rechargez le tout.

¢ Ne pas mettre autre chose que du papier a
impression. Ne pas appliquer trop de
pression sur le bac MF.

Imprimer le Rapport
de configuration

Vous pouvez vérifier des renseignements
détaillés concernant votre appareil, comme les
parametres et le statut, en imprimant le Rapport
de configuration.

1 Appuyez sur <SETTING> (Parameétre) sur le
panneau de commande.

2 Utilisez la touche fléchée vers le bas pour
sélectionner [Reports] (Rapports), puis
appuyez sur <OK>.

3 Utilisez la touche fléchée vers le bas pour
sélectionner [Configuration], puis appuyez
sur <OK>.

4 Quand le message de confirmation apparait,
appuyez sur la touche fléchée vers la droite
ou vers la gauche jusqu’a sélectionner [YES]
(Oui), puis appuyez sur <OK>.

Configuration des
parameétres du bac

Format de support standard

Remarque

Pour faire défiler les différentes sélections sur
I'affichage, appuyez sur la touche fléchée vers le
bas de fagon répétitive.

1 Appuyez sur <SETTING> (Parameétre) sur le
panneau de commande.
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2 Utilisez la touche fléchée vers le bas pour
sélectionner [Paper Setup] (Configuration du
papier), puis appuyez sur <OK>.

Setting

Paper Setup

Address Book

3 Utilisez la touche fléchée vers le bas pour
sélectionner le bac, puis appuyez sur <OK>,

4 Utilisez la touche fléchée vers le bas pour
sélectionner [Paper Size] (Format du papier),
puis appuyez sur <OK>.

5 Utilisez la touche fléchée vers le bas pour
sélectionner le format du papier chargé, puis
appuyez sur <OK>.

6 Utilisez la touche fléchée vers le bas pour
sélectionner [Media Type] (type de support),
puis appuyez sur <OK>.

7 Utilisez la touche fléchée vers le bas pour
sélectionner le type de support chargé, puis
appuyez sur <OK>.

8 Utilisez la touche fléchée vers le bas pour
sélectionner [Media Weight] (grammage du
support), puis appuyez sur <OK>.

9 Utilisez la touche fléchée vers le bas pour
sélectionner le grammage du papier chargé,
puis appuyez sur <OK>.

Format de support personnalisé

Pour charger du format papier personnalisé, vous
devez enregistrer la largeur et la longueur du
papier avant l'impression.

Bac Gamme de formats disponibles
Tray 1 (Bac 1) |Largeur :

de 105 a 216 mm (5,1 a 8,5 in)

Longueur :

de 148 a 356 mm (5,8 a 14 in)
Bac 2 Largeur : identique au Bac 1
(optionnel) Longueur :

de 148 a 356 mm (8,3 a 14,0 in)
MP Tray Largeur :
(BAC MF) de 64 a 216 mm (2,5 a 8,5 in)

Longueur :

de 127 a 1321 mm (5 a 52,0 in)
Remarque

Pour les bacs 1 et 2, vous ne pouvez configurer le
parametre [Custom] (personnalisé) que quand
[Paper Size] (format du papier) est établi sur
[Custom] (personnalisé).

Suivez les étapes 1 a 3 a gauche.

2 Utilisez la touche fléchée vers le bas pour
sélectionner [Custom] (personnalisé), puis
appuyez sur <OK>.

3 A l'aide du clavier, saisissez la valeur désirée
dans la case Largeur.

Tray 1:Paper Size
Width Length
05-216) 145-356)
mm mm
Oancel

4 Appuyez sur la touche fléchée vers la droite
pour vous déplacer jusqu’a la case Longueur,
puis saisissez la valeur a l'aide du clavier.

5 Appuyez sur <OK>.

Sorties d'impression

Important!

Ne jamais ouvrir ou fermer la sortie arriere
(empileuse face vers le haut) lorsque
I'appareil est en train d'imprimer, ceci
pouvant provoquer un bourrage papier.

Utiliser la sortie supérieure
(empileuse face vers le bas)

La sortie supérieure (empileuse face vers le bas)

est la sortie par défaut. Elle est activée quand la

sortie arriere est fermée.

e Elle imprime les documents le coté
d’impression vers le bas.

e Peut contenir jusqu’a 150 feuilles de papier
bond US de 75 g/m? (20 Ib).
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2 Dépliez I'empileuse.

-\

Ie arriere

Utiliser la sort

(empileuse face vers le haut)
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La sortie arriére est activée quand elle

est ouverte.

e Elle imprime les documents le coté

d'impression vers le haut.
e Elle permet un chemin de sortie

direct-nécessaire aux papiers lourds,

transparents, enveloppes et étiquettes.
e Peut contenir jusqu’a 100 feuilles de papier

bond US de 75 g/m? (20 Ib).
e Peut contenir 10 enveloppes.

1 Tirez la sortie arriére sur le coté de l'appareil

et ouvrez-la vers vous.
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Chargement des documents
a humeriser

Pour charger des documents a copier, numériser
ou faxer, vous pouvez utiliser I'alimentateur
automatique (1) ou la vitre (2).

Criteres liés aux documents

Pour plus de renseignements relatifs aux critéres
liés aux documents, reportez-vous au -Guide de

base de l'utilisateur en ligne sur le CD fourni avec
votre appareil.

Charger des documents dans
I'alimentateur automatique de

document (CAD)

e Accepte Lettre, Légal 13/13,5/14, Executive,
A4, A5, A6, B5.

e Peut contenir jusqu’a 50 feuilles de papier bond
US de 75 g/m? (20 Ib).

e Chargez les documents face vers le haut.

Important!

Prenez soin de vérifier que la colle, I'encre
ou le liquide correcteur présents sur les
documents sont secs avant le chargement.

1 Chargez le(s) document(s) sur le CAD.

a) Chargez le bord supérieur des documents
en portrait en premier.

b) Chargez le bord gauche des documents en
paysage en premier.

2 Ajustez les guides document a la largeur
des pages.

G222
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Charger des documents sur
la vitre
o Accepte Lettre, Executive, A4, A5, A6, B5.

e Utilisable pour des documents allant jusqu’a
20 mm (0,78 in) d’épaisseur.

Important!

Prenez soin de vérifier que la colle, I’encre
ou le liquide correcteur présents sur les
documents sont secs avant le chargement.

1 Levez et ouvrez le capot de la vitre.

2 Placez un document face vers le bas sur
la vitre.

a) Si votre document est en mode portrait,
alignez le haut avec le coin en haut a
gauche de la vitre.

b) Si votre document est en mode paysage,
alignez son bord droit avec le coin en haut
a gauche de la vitre.

3 Refermez délicatement le capot de la vitre.

Remarque

Si vous souhaitez utiliser les fonctions
[N-in-1](N-en-1), [Sort] (trier) ou [DuplexCopy],
modifiez le paramétre [Document Direction]
(sens du document) selon le sens de votre
document pour obtenir la sortie souhaitée.

Le réglage par défaut est [Portrait].
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Installation en réseau :
Etablir des connexions et installer des

pilotes d'imprimante

Systemes d’exploitation
compatibles

Votre appareil prend en charge les systémes
d’exploitation suivants :

Windows

e Windows 7

¢ Windows 7, édition 64-bit

e Windows Server 2008, édition R2 64-bit
e Windows Server 2008

e Windows Server 2008, édition 64-bit
e Windows Vista

e Windows Vista, édition 64-bit

¢ Windows Server 2003

e Windows Server 2003, édition x64

e Windows XP

e Windows XP, édition x64

e Windows 2000

Macintosh
e Mac OS X 10.3.9 a 10.6

Important!

Pour les utilisateurs de Mac OS X 10.6
IntelPC, installer Rosetta avant d’installer le
pilote de I'imprimante.

Reéaliser la connexion réseau

Important!

Vous devez connecter votre appareil a un
réseau équipé d'un cable Ethernet compatible
avant d’installer le pilote de I'imprimante.

Remarque

Le cable Ethernet et le concentrateur ne sont pas
fournis avec votre appareil. Le cable Ethernet doit
étre de catégorie 5, droit, avec deux paires de
fils torsadés.

@

1 Eteignez votre appareil :

a) appuyez sur <SETTING> (Paramétre) sur
le panneau de commande.

b) Utilisez la touche fléchée vers le bas pour
sélectionner [Shutdown] (Arrét), puis
appuyez sur <OK>.

¢) Quand le message de confirmation
s'affiche, appuyez sur la touche fléchée
vers la droite jusqu’a sélectionner [Yes]
(Oui), puis appuyez sur <OK>.

d) Au signal, éteignez I'appareil.

2 Eteignez I'ordinateur.
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3 Abaissez le loquet (1) sur le coté droit de 5 Bien attacher le cdble Ethernet sous le
I'appareil et retirez le couvercle d’acces (2). crochet (1) de lI'appareil.

6 Introduire les languettes du capot latéral dans
les fentes (1) du boitier de I'appareil et
remettez le capot en place.

4 Branchez une extrémité du cable Ethernet
dans le port LAN de l'appareil.

7 Connectez le concentrateur a un ordinateur,
puis branchez I'autre extrémité du cable
Ethernet dans le concentrateur.
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TI‘OUVEI: le for_mulaire
de configuration

Ne | Option Exemple votre valeur

B-5 | SWTP Usar 1D (Cods da Purilizsteur SMITF) | OKIMCSS1

B-6 | Mot de passe GMTP okimeS61

B-7 |POP User ID (CODE wtilisateur POP) User [Urilisateur]

B-8 |POP Passuor d (Mot de passe POP) okimeS61

B-3 | Mom du destinataire du courriel User [Urilisateur]

Adresse lectranique du destin u courriel user@test.com

Hom de profll pou
Gusqu'd 16 carac

Hom du dossier partagé de Pordinateur
destination Guzqu's 64 caractéres)

C-6 | Mem de fichier des données numérisées ScanData
usqu'3 64 caractéres)

[

Vous trouverez un formulaire de configuration a
la page 108. Vous pouvez utiliser ce formulaire
pour enregistrer les renseignements requis
concernant vos parameétres réseau, puis vous y
référer lors de la configuration de I'appareil pour
une exploitation en réseau.

Définir le mot de
passe administrateur

Remarque

Lors de I'utilisation des touches fléchées pour
faire vos sélections, appuyez a plusieurs reprises
sur la touche jusqu’a atteindre la sélection.

1 Appuyez sur <Setting> (Parametre) sur le
panneau de commande.

e oo W)
0 OO®
(D))

2 Utilisez la touche fléchée vers le bas pour
sélectionner [Admin Setup] (Configuration
Administrateur), puis appuyez sur <OK>.

Admin Password

L |
B. {\ -+ #%k=_123[( )
qwertyuiopdbée
asdfghjkIITBQ
zxcvbnm 0 B || Enter

3 Utilisez la touche fléchée vers le bas pour
sélectionner [a], puis appuyez six fois sur
<OK> pour saisir le mot de passe par
défaut : aaaaaa.

4 Utilisez les touches fléchées jusqu’a ce
que [Enter] (entrer) s’affiche, puis appuyez
sur <OK>,

5 Utilisez la touche fléchée vers le haut pour
sélectionner [Management] (Gestion), puis
appuyez sur <OK>.

6 Utilisez la touche fléchée vers le haut pour
sélectionner [Admin Password] (Mot de passe
Administrateur), puis appuyez sur <OK>.

7 Utilisez les touches fléchées pour sélectionner
les chiffres de votre mot de passe en
appuyant sur <OK> aprés chaque chiffre.

8 Une fois la saisie de votre nouveau mot de
passe terminée, utilisez les touches fléchées
jusqu’a ce que [Enter] (entrer) s’affiche, puis
appuyez sur <OK>.

Remarque

Le mot de passe Administrateur doit au moins
posséder six caractéres et est sensible a la casse.

9 Une fois tous les caractéres saisis, utilisez les
touches fléchées jusqu’a ce que [Enter]
(entrer) s’affiche a I'écran, puis appuyez
sur <OK>.

10 Utilisez la touche fléchée vers la gauche pour
revenir a |'écran principal.

11 Saisissez le mot de passe Administrateur sur
la ligne A-1 du formulaire de configuration.
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Configurer le réseau pour les
systemes sous Windows

Pour réaliser une connexion réseau avec un
ordinateur sous Windows, définissez tout d’abord
les adresses IP de l'ordinateur et de l'appareil,
puis installez le(s) pilote(s) de I'imprimante

sur 'ordinateur.

Configurer lI'adresse IP,
le cas échéant

Si votre réseau remplit I'une des conditions
suivantes, une adresse IP sera attribuée
automatiquement a l'ordinateur et a I'appareil.

e Sj un serveur DHCP ou BOOTP se trouve sur
le réseau

e Universal Plug-and-Play

Si tous les ordinateurs connectés au réseau sont

e Windows 7

Windows Vista

Windows XP

Windows 2000

Windows Server 2008 R2

Windows Server 2008

Windows Server 2003,

ou si votre router prend en charge
I'Universal Plug-and-Play,

une adresse IP est alors automatiquement
attribuée a l'ordinateur et a I'appareil, méme si

un serveur DHCP/BOOTP n’est pas sur le réseau.

Si le réseau ne remplit pas les conditions
ci-dessus, ou si votre administrateur réseau ou
fournisseur de services Internet spécifie une
adresse IP unique pour l'ordinateur et I'appareil,
configurez les adresses IP manuellement.

Généralités
e \ous devez saisir le mot de passe administrateur
pour terminer cette procédure.

e Lorsque vous configurez manuellement une
adresse IP, demandez a I'administrateur réseau
ou a votre fournisseur de services Internet,
quelle adresse utiliser. Si I'adresse IP n’est pas
correctement configurée, il se peut que le
réseau ralentisse ou que l'accés Internet
soit désactivé.

Remarque

Si vous étes en train de configurer un petit
réseau, se limitant a un appareil et a un
ordinateur, configurez les adresses IP comme
indiqué ci-dessous (selon RFC1918) :

Pour l'ordinateur
IP Address (Adresse IP) :

Subnet Mask
(Filtre d’adresse locale) :

192.168.0.1 a 254

255.255.255.0
Default Gateway

(Passerelle par défaut) : non offert
DNS Server
(Serveur DNS) : non offert

Pour I'appareil

IP Address Set
(Jeu d’adresses IP) : Manuel

IP Address (Adresse IP) : 192.168.0.1 a 254 (sélectionnez
une valeur différente de celle
de l'ordinateur)

Subnet Mask

(Filtre d’adresse locale) : 255.255.255.0

Default Gateway
(Passerelle par défaut) : 0.0.0.0

Ngtwork scale
(Echelle de réseau) : petite

Pour configurer [Network Scale] (Echelle de réseau) :

e appuyez sur <SETTING> (Parametre) sur
le panneau de commande.

e Sélectionnez [Admin Setup] (Configuration
d’administrateur) > [Network Menu]
(Menu de réseau) > [Network Setup]
(Configuration Réseau) > [Network Scale]
(Echelle de réseau).

Configurer I'adresse IP de
votre ordinateur

Important!

Si vous connaissez déja I'adresse IP de
votre ordinateur, passez directement a la
section suivante « Set Up Your Machine’s
IP Address » (Configurer I'adresse IP de
votre appareil).

La procédure suivante utilise Windows 7 a titre
d’exemple. Il se peut que les images a |'écran
différent en fonction du systeme d’exploitation.

1 Allumez l'ordinateur.

2 Cliguez sur le bouton [Start] (Démarrer) >
[Control Panel] (Panneau de commande) >
[View network status and tasks] (Apercgu du
statut et des taches réseau).
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e Sur Windows Server 2003, cliquez sur le
bouton [Start] (Démarrer) > [Control Panel]
(Panneau de commande) > [Network
Connections] (Connexions réseau) > [Local
Area Connection] (Connexion réseau local).

e Sur Windows XP, cliquez sur le bouton
[Start] (Démarrer) > [Control Panel]
(Panneau de commande) > [Network and
Internet Connections] (Connexions Réseau
et Internet) > [Network Connections]
(Connexions Réseau).

e Sur Windows 2000, cliquez sur [Start]
(Démarrer) > [Settings] (Paramétres) >
[Network and Dial-up Connections]
(Réseau et connexions téléphoniques).

Sélectionnez [Change adapter settings]
(Modifier les parameétres de |'adaptateur).

e Sur Windows Server 2008 et Windows Vista,
sélectionnez [Manage network connections]
(Gérer les connexions réseau).

e Sur Windows Server 2003, Windows XP et
Windows 2000, ignorez cette étape.

Double-cliquez sur [Local Area Connection]
(Connexion de réseau local).

e Pour le serveur Windows 2003, ignorez
cette étape.

Cliquez sur [Properties] (Propriétés).

Si la boite de dialogue [User Account Control]
(Controle du compte utilisateur) s’affiche,
cliquez sur [Yes] (Oui). (Sur Windows Vista,
cliquez sur [Continue]).

Sélectionnez [Internet Protocol Version 4 (TCP/
IPv4)] (Protocole Internet Version 4 (TCP/IPv4)),
puis cliquez sur [Properties] (Propriétés).

- ~
U Local Area Connection Properties [é]

Metworking

Connect using:

LF  Atheros ARB121/AR8113/AR8114 PCI-E Bthemet Contro

This connection uses the following items:

% Cliert for Microsoft Networks

481305 Packet Scheduler

.@. File and Printer Sharing for Microsoft Networks
-4 |ntemet Protocol Version 6 (TCP/1PvE)

P Intemet Protocol Version 4 (TCP/IPvd)
<& Link-Layer Topology Discovery Mapper /0 Driver
& Link-Layer Topology Discovery Responder

Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networlks.

OK || Cancel

e Sur Windows Server 2003, Windows XP et
Windows 2000, sélectionnez [Internet
Protocol (TCP/IP)] (Protocole Internet
(TCP/IP)), puis cliquez sur
[Properties] (Propriétés).

7 Sivous configurez une adresse IP

manuellement, entrez l'adresse IP, le filtre
d’adresse locale, la passerelle par défaut et le
serveur DNS, puis cliquez sur [OK].

r ~
Internet Protocel Version 4 (TCP/IPv4) Properties &Iéj
General

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

~) Obtain an IP address automatically
@) Use the following IP address:

P 1P acdress: 192 168 . 0 . 3
> Subnet mask: 255,255,255, 0
> Default gateway: 192.168 . 0 . 1

Obtain DMS server address automatically

@) Use the following DNS server addresses:

> Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit [

[ OK ]l Cancel |

e Si vous obtenez une adresse IP du serveur
DHCP automatiquement, sélectionnez
[Obtain an IP address automatically]
(Obtenir une adresse IP automatiquement),
puis cliqguez sur [OK].

Important!
Ne pas saisir de passerelle par défaut ou de
serveur DNS si ce n’est pas nécessaire.

8 Fermez les fenétres ouvertes.

Configurer I'adresse IP de votre appareil

Allumez votre appareil.

Appuyez sur <SETTING> (Parameétre) sur le
panneau de commande.

Utilisez la touche fléchée vers le bas pour
sélectionner [Easy Setup] (Configuration
simplifiée), puis appuyez sur <OK>.

Wiew Information
Shutdown
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4 Entrez le mot de passe administrateur. Voir la
ligne A-1 sur votre formulaire de configuration

5 Utilisez les touches fléchées jusqu’a
sélectionner [Enter] (entrer), puis appuyez
sur <OK>,

6 Utilisez la touche fléchée vers le bas pour
sélectionner [Network Setting] (Parameétre
réseau), puis appuyez sur la touche fléchée
vers la droite.

7 Si vous configurez une adresse IP
manuellement, utilisez la touche fléchée vers
le bas pour sélectionner [Manual] (Manuel),
puis appuyez sur <OK>.

3. Basic Setting of Network

hanual

Auto

I

Si vous obtenez une adresse IP
automatiquement, sélectionnez [Auto] et
passez directement a « Install the Printer
Driver for Windows » (Installer le pilote de
I'imprimante pour Windows).

8 Appuyez sur la touche fléchée vers la droite
pour passer d'une boite a une autre en
saisissant les renseignements applicables a
chaque boite a I'aide du clavier, puis appuyez
sur <OK>.

3. Basic Setting of Network

9 Saisissez le serveur DNS et le serveur WIN
si nécessaire.

S’ils ne sont pas nécessaires a votre connexion
réseau, appuyez sur <OK> jusqu’a ce que le
message éclair s’affiche.

10 Cliquez sur <OK> pour terminer la configuration.

Installer un ou des pilote(s)

d’'imprimante sous Windows

Vous pouvez installer plusieurs pilotes en méme
temps. Les pilotes sélectionnables pour chaque
modeéle sont les suivants :

e PCL

e PC

e FAX

Lorsque vous installez les pilotes, le programme
installe également automatiquement le pilote
TWAIN, nécessaire a la numérisation, ainsi que
I'extension réseau et les utilitaires Color Swatch.

Remarque

La procédure ci-dessous utilise Windows 7 et le
modele MC561 a titre d’exemple. Il se peut que la
véritable procédure differe quelque peu en
fonction du systéme d’exploitation.

1 Vérifiez bien que votre ordinateur est allumé
et connecté a l'appareil par le réseau.

2 Placez le DVD fourni avec votre appareil dans
I'unité de CD/DVD.

Le DVD se met en marche seul. Si ce n’est pas
le cas, double-cliquez sur le fichier de
configuration OKI dans le répertoire du DVD.

3 Sélectionnez votre langue dans la liste
déroulante, puis cliquez sur [Next] (Suivant).

4 Lisez le Contrat de licence, puis cliquez sur
[I Agree] (J'approuve).

5 Sous la configuration du pilote, cliquez sur
[Install Drivers (MC561)] (Installer les
pilotes (MC561)).

Remarque

Si la boite de dialogue [User Account Control]
(Controle du compte utilisateur) s’affiche,
cliquez sur [Yes] (Oui). (Sur Windows Vista,
cliquez sur [Continue]).

6 Lisez et observez les instructions, puis cliquez
sur [Next] (Suivant).

7 Cliquez sur [Easy Install (Network)]
(Installation facile (Réseau)).

Remarque

La sélection d’installation facile est une
méthode de configuration aisée. Si vous
souhaitez sélectionner un pilote a installer
manuellement, installer une imprimante
partagée ou utiliser I'utilitaire Oki LPR comme
méthode d’impression, sélectionnez [Custom
Installation] (Installation personnalisée), puis
suivez les instructions s’affichant a I’écran.
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8 Cliquez sur [Next] (Suivant).
La recherche du périphérique démarre.

9 Sélectionnez le(s) pilote(s) que vous
souhaitez installer : PCL, PS, FAX.

10 Si votre appareil est détecté et s'affiche
automatiquement, sélectionnez-le, puis
cliquez sur [Next] (Suivant).

Si votre appareil n'est pas détecté, cliquez sur
[Restart search] (Recommencer la recherche)
pour relancer la recherche.

Remarque

Pour spécifier I'adresse IP manuellement,
sélectionnez [IP address] (adresse IP) et
saisissez |'adresse IP de votre appareil, puis
cliquez sur [Next] (Suivant).

L'installation du ou des pilotes et des
utilitaires débute.

Remarques

e Sila boite de dialogue [Windows Security]
(Sécurité Windows) s’affiche, cliquez sur
[Install this driver software anyway]
(Installer néanmoins ce logiciel pilote).

e Sur Windows Server 2003 et Windows XP, si
la boite de dialogue [Hardware Installation]
(Installation matériel) s’affiche, cliquez sur
[Continue Anyway] (Continuer).

e Sur Windows 2000, si la boite de dialogue
[Digital Signature Not Found] (Signature
numérique non-trouvée) s’affiche, cliquez
sur [Yes] (Oui).

11 Cliquez sur Finish (Terminer) pour
terminer l'installation.

Remarques

e Pour configurer une imprimante par défaut,
cochez la case correspondante au pilote
désiré. Vous pouvez également configurer
les parameétres de I'imprimante du pilote
sélectionné en cliquant sur [Open property
dialog] (Ouvrir dialogue propriété).

¢ Si une boite de dialogue s’affiche et
demande de redémarrer |'ordinateur,
cliquez sur [Yes] (Oui). L'ordinateur
redémarre automatiquement.

12 Windows 7 : cliquez sur [Start] (Démarrer) >
[Devices and Printers] (Périphériques
et imprimantes).

Windows Server 2008 et Windows Vista :
cliqguez sur le bouton [Start] (Démarrer) >
[Control Panel] (Panneau de commande) >
[Printer] (Imprimante).

Windows Server 2003 et Windows XP : cliquez
sur [Start] (Démarrer) >[Printers and Faxes]
(Imprimantes et télécopieurs).

Windows 2000 : cliquez sur [Start] (Démarrer) >
[Settings] (Parametres) > [Printers] (Imprimantes).

13 Vérifiez bien que I'icone OKI MC561 s’affiche.

e Sur Windows 7, si vous avez déja installé
d’autres pilotes, cliquez avec le bouton droit
de votre souris sur I'icone OKI MC561 et
sélectionnez une des options du menu, puis
vérifiez que tous les pilotes de l'imprimante

installés sont affichés dans le sous-menu.

0K MCSEL{FAX)
0K MESELIPCL XPS)
0K MCSELIPEL)
O] MCS1 (RS

e Pour les systémes d’exploitation autres que
Windows, vérifiez que l'icOne représentant
chaque pilote est affichée.

14 Retirez le DVD de l'ordinateur.

L'installation est terminée.

Configurer le réseau pour
des systemes sous Macintosh

Pour terminer la connexion réseau sous un
systeme d’exploitation Mac, installer un pilote
d’'imprimante sur l'ordinateur et configurer votre
appareil en tant qu’imprimante réseau.

Installer le pilote d'imprimante

sur Mac
Seul le pilote PS est disponible pour les systéemes Mac.
Sélectionnez le protocole de votre connexion réseau
a partir de ce qui suit :
e Ethertalk
- pour les Mac 10.3.9 4 10.4.11, voir ci-dessous.
- pour les Mac 10.5, voir page 77.
e Bonjour (Rendezvous)
- pour les Mac 10.3.9 a 10.4.11, voir page 78.

- pour les Mac 10.5 et 10.6, voir page 79.

Important!
Désactiver le logiciel antivirus avant de
commencer cette procédure.
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Sous Ethertalk,
Mac OS X 10.3.9 a 10.4.11

Remarque

La procédure ci-dessous utilise le Mac 0OS X
10.4.11 et le modele MC561 a titre d’exemple. II
se peut que la véritable procédure différe quelque
peu en fonction du systéme d’exploitation.

1 Vérifiez que votre appareil ainsi que votre Mac
sont bien allumés et connectés.

2 A partir du menu Apple, sélectionnez [System
Preferences] (Préférences systeme).

3 Sélectionnez [Network] (Réseau).

Sélectionnez [Network Port Configurations]

(Configurations des ports réseau) a partir de
[Show] (Afficher), puis vérifiez que [Built-in
Ethernet] (Ethernet intégré) est sélectionné.

rB 8o Network
[« > | [ Showall | Q

Location: | Automatic ﬂ

_> Show: -N.e.t-wu}-k F""ur"-lnéor;ﬁgura_ti-(-ms ﬂ

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

Port Configurations
Bluetooth
Built-in Ethernet
¥ Built-in FireWire
AirPort

( New. )

( Rename )

AEAEES

( Delete.. :‘l

€ Duplicate :"

il ————
'} !W Click the lock to prevent further changes. [ Assistme... ) Apply Now

5 Sélectionnez I'onglet [AppleTalk], puis vérifiez
que [Make AppleTalk Active] (Activer
AppleTalk) est sélectionné.

Fermez [Network] (Réseau).

Insérez le DVD fourni avec votre appareil
dans l'ordinateur.

8 Double-cliquez sur I'icone [OKI].

9 Double--cliquez sur le dossier [Driver] (Pilote),
puis sur le dossier [Printer] (Imprimante).

10 Double-cliquez sur [Installer for Mac OSX]
(Installateur pour Mac OSX).

11 Entrez le nom de I'administrateur et son mot
de passe, puis cliquez sur [OK].

12 Suivez les instructions qui s’affichent a I’écran
pour terminer l'installation.

13 Retirez le DVD de l'ordinateur.

14 A partir du menu [Go] (Aller), sélectionnez
[Utilities] (Utilitaires), puis double-cliquez sur
[Printer Setup Utility] (Utilitaire de
configuration d‘imprimante).

Remarque

Si [Printer Setup Utility] (Utilitaire de
configuration d’imprimante) est déja lancé,
fermez-le et ouvrez-le de nouveau.

15 Cliquez sur [Add] (Ajouter).

Remarque

Si la boite de dialogue [You have no printers
available] (Aucune imprimante disponible)
s'affiche, cliquez sur [Add] (Ajouter).

16 Pour les Mac OS X 10.3.9,
sélectionnez [AppleTalk].

17 Sélectionnez le nom de I'appareil dont la
[Connection] (Connexion) est [AppleTalk], puis
vérifiez que le nom de votre appareil s'affiche
bien dans [Print Using] (Imprimer en utilisant).

'6 (X3 Printer Browser (j1
Y . ——
X ® &
=p =y

Default Browser IP Printer Search

& | Connection

MC551 AppleTalk m
4

Name: MC561

Location: Local Zone

e Print Using: | OKI MCEB1(PS) 3]

15/\ ( More Printers... ) ( Add

BN
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18 Pour les Mac OS X 10.3.9, sélectionnez le nom
de votre appareil et sélectionnez [OKI] a
partir de [Print Model] (Modéle d’impression),
puis sélectionnez [OKI MC561(PS)] dans la
liste. Cliquez sur [Add] (Ajouter).

19 Si la fenétre [Installable Options] (Options
installables) s’affiche, cliquez sur [Continue] a
moins que vous ayez déja installé les options.
Si vous avez déja installé des options,
configurez-les toutes avant de cliquer
sur [Continue].

20 Vérifiez que le nom de votre appareil soit bien
affiché dans [Printer List] (Liste des
imprimantes), puis fermer la fenétre.

21 A partir du menu [Go] (Aller), sélectionnez
[Applications], puis double-cliquez
sur [TextEdit].

22 Sélectionnez [File] (Fichier)> [Page Setup]
(Configuration de la page).

23 Sélectionnez le nom de votre appareil a partir
de [Format for] (Formater pour).

24 Vérifiez que le nom de votre appareil s'affiche
correctement sous [Format for] (Formater pour).

25 Cliquez sur [OK].

L'installation est terminée.

Sous Ethertalk
Mac 10.5 (Leopard)

Remarque

La procédure suivante utilise le modeéle MC561 a
titre d’'exemple.

1 Vérifiez que votre appareil et que votre Mac
sont bien allumés et connectés.

2 Insérez le DVD fourni avec votre appareil
dans l'ordinateur.

3 Double-cliquez sur l'icone [OKI].

Double-cliquez sur le dossier [Driver] (Pilote),
puis sur le dossier [Printer] (Imprimante).

5 Double-cliquez sur [Installer for Mac OSX]
(Installateur pour MAC OSX).

6 Entrez le nom de I'administrateur et son mot
de passe, puis cliquez sur [OK].

7 Suivez les instructions qui s’affichent a I’écran
pour terminer l'installation.

Retirez le DVD de l'ordinateur.

9 A partir du menu Apple, sélectionnez [System
Preferences] (Préférences systeme).

10 Cliquez sur [Print & Fax] (Imprimer et
télécopier).

11 Cliquez sur [+].

ann Print & Fax

al )

Click « to add
ﬂ:"\tﬂlo:{-“\‘ Mo Printer Selected

——- |+

Dafault Printar: | Last Printar Used

Default Pager Size in Page Setup: | Ad 3

@

14" Ciick the tock 1o prevent further changes,

12 Cliquez sur [AppleTalk].

13 Sélectionnez le nom de votre appareil, puis
vérifiez que le nom de votre appareil s'affiche
dans [Print Using] (Imprimer en utilisant).

CEals) —
= -,
Delault  Fax Windows  Bluctooth | AppleTalk  Mare Pristerss Search

—- Fint Using: | OKI MCSE1(PS) 2 )

Ada )

14 Cliquez sur [Add] (Ajouter).

15 Si la fenétre [Installable Options] (Options
installables) s’affiche, cliquez sur [Continue] a
moins que vous ayez déja installé les options. Si
vous avez déja installé des options, configurez-
les toutes avant de cliquer sur [Continue].

16 Assurez-vous que votre appareil soit bien
affiché sous [Printers] (Imprimantes).

17 Vérifiez que le nom de votre appareil soit bien
affiché dans [Kind] (Sorte), puis fermer
[Print & Fax] (Imprimer et télécopier).
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L'installation est terminée.

Remarque

Il se peut que le nom de votre appareil ne soit
pas affiché si le pilote de I'imprimante ne lit pas le
fichier PPD correctement.

Dans ce cas, cliquez sur [=] pour supprimer votre
appareil de [Print & Fax] (Imprimer et télécopier),
puis reprenez la procédure a partir de |'étape 10.

Utilisation de Bonjour
(Rendezvous)
Mac 10.3.9a 10.4.11

Remarque

La procédure ci-dessous utilise le Mac OS X
10.4.11 et le modéle MC561 a titre d’exemple. Il
se peut que la véritable procédure différe quelque
peu en fonction du systéme d’exploitation.

1 Vérifiez que votre appareil et que votre Mac
sont bien allumés et connectés.

2 A partir du menu Apple, sélectionnez [System
Preferences] (Préférences systeme).

3 Sélectionnez [Network] (Réseau).

Sélectionnez [Network Port Configurations]

(Configurations des ports réseau) a partir de
[Show] (Afficher), puis vérifiez que [Built-in
Ethernet] (Ethernet intégré) est sélectionné.

.—6 ao Network

|« » || Showal | Q

Location: | Automatic I+

——» Show: Nefwofic Por’['Conﬁguraii'cns a

Check a configuration te make it active.
Drag configurations into the order you want to try them when
connecting to a network.

Port Configurations
Bluetooth
Built-in Ethernet

New.

i

RERERS

Built-in FireWire ( Rename
&
AirPort

(_ Delete..

(_ Duplicate )

2 -
'] q Click the lock to prevent further changes. (_ Assistme... ) Apply Now

5 Fermez [Network] (Réseau).

6 Insérez le DVD fourni avec votre appareil
dans l'ordinateur.

7 Double-cliquez sur l'icbne [OKI].

Double-cliquez sur le dossier [Driver] (Pilote),
puis sur le dossier [Printer] (Imprimante).

9 Double-cliquez sur [Installer for Mac OSX]
(Installateur pour MAC OSX).

10 Entrez le nom de I'administrateur et son mot
de passe, puis cliquez sur [OK].

11 Suivez les instructions qui s’affichent a I’écran
pour terminer l'installation.

12 Retirez le DVD de l'ordinateur.

13 A partir du menu [Go] (Aller), sélectionnez
[Utilities] (Utilitaires), puis double-cliquez sur
[Printer Setup Utility] (Utilitaire de
configuration d‘imprimante).

Important!

Si [Printer Setup Utility] (Utilitaire de
configuration d'imprimante) est déja lancé,
fermez-le et ouvrez-le de nouveau.

14 Cliquez sur [Add] (Ajouter).

Remarque

Si la boite de dialogue [You have no printers
available] (Aucune imprimante disponible)
s’affiche, cliquez sur [Add] (Ajouter).

15 Pour les Mac OS 10.3.9,
sélectionnez [Rendezvous].

16 Sélectionnez le nom de I'appareil dont la
[Connection] (Connexion) est [Bonjour], puis
vérifiez que le nom de votre appareil s'affiche
bien dans [Print Using] (Imprimer en utilisant).
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Votre machine s’affiche avec les six
derniers chiffres de I'adresse Max dans la
liste d'imprimantes.

866 Printer Browser (=)
a . |
—\?\ i s Q-
—y . —
Default Browser : IP Printer Search
Printer Name & | Connection
— [OKIMCSEIEBOEIA  Bomjour | m

Name: OKI-MC-561-EBOE1A

Location: Local Zone

Print Using: OKI MC561(PS) =] ]

15) ( More Printers... ) ( Add

]

17 Pour les Mac OS X 10.3.9, sélectionnez le nom
de votre appareil et sélectionnez [OKI] a partir
de [Print Model] (Modéle d’'impression), puis
sélectionnez [OKI MC561(PS)] dans la liste.

18 Cliquez sur [Add] (Ajouter).

19 Si |la fenétre [Installable Options] (Options
installables) s’affiche, cliquez sur [Continue] a
moins que vous ayez déja installé les options. Si
vous avez déja installé des options, configurez-
les toutes avant de cliquer sur [Continue].

20 Vérifiez que le nom de votre appareil soit bien
affiché dans [Printer List] (Liste des
imprimantes), puis fermer la fenétre.

i 8oe Printer List (=]

= ~

Add

Name & |Status Kind

# OKI-MC561-EBOELA OKI MC561(PS)

21 A partir du menu [Go] (Aller), sélectionnez
[Applications] > [TextEdit].

22 Sélectionnez le menu [File] (Fichier) >
[Page Setup] (Configuration de la page).

23 Sélectionnez le nom de votre appareil a partir
de [Format for] (Formater pour).

24 Vérifiez que le nom de votre appareil s'affiche
correctement sous [Format for] (Formater pour).

25 Cliquez sur [OK].

L'installation est terminée.

Utilisation de Bonjour
Mac 10.5 et 10.6 (Leopard et
Snow Leopard)

Remarque

La procédure ci-dessous utilise le Mac OS X 10.6
et le modéle MC561 a titre d’exemple. Il se peut
que la véritable procédure différe quelgue peu en
fonction du systéme d’exploitation.

1 Vérifiez que votre appareil ainsi que votre Mac
sont bien allumés et connectés.

2 Insérez le DVD fourni avec votre appareil
dans l'ordinateur.

Double-cliquez sur l'icone [OKI].

Double--cliquez sur le dossier [Driver] (Pilote),
puis sur le dossier [Printer] (Imprimante).

5 Double-cliquez sur [Installer for Mac OSX]
(Installateur pour MAC OSX).

6 Entrez le nom de I'administrateur et son mot
de passe, puis cliquez sur [OK].

7 Suivez les instructions qui s’affichent a I’écran
pour terminer l'installation.

8 Retirez le DVD de l'ordinateur.

9 A partir du menu Apple, sélectionnez [System
Preferences] (Préférences systeme).

10 Cliquez sur [Print & Fax] (Imprimer
et télécopier).

11 Cliquez sur [+].
12 Cliquez sur [Default] (Par défaut).

13 Sélectionnez le nom de I'appareil dont Ia
[Kind] (Sorte) est [Bonjour], puis vérifiez que
le nom de votre appareil s’affiche bien dans
[Print Using] (Imprimer en utilisant).

79 - Frangais



Le nom de votre machine s’affiche avec les
six derniers chiffres de ’'adresse Max dans la
liste d'imprimantes.

8eno Add Printer (e

= =yl 2 a

Fax IP_ wWindows Search

' Printer Name & Kind

— TN Bonjour

Name: OKI-MC561-EBOELA

Location:

Print Using: [ OKI MC561(PS) )

14 Cliquez sur [Add] (Ajouter).

15 Si la fenétre [Installable Options] (Options
installables) s’affiche, cliquez sur [Continue] a
moins que vous ayez déja installé les options.

Si vous avez déja installé des options,
configurez-les toutes avant de cliquer
sur [Continue].

16 Assurez-vous que votre appareil soit bien
affiché sous [Printers] (Imprimantes).

17 Vérifiez que le nom de votre appareil soit bien
affiché dans [Kind] (Sorte), puis fermer
[Print & Fax] (Imprimer et télécopier).

L'installation est terminée.

Remarque

Il se peut que le nom de votre appareil ne soit
pas affiché si le pilote de I'imprimante ne lit pas le
fichier PPD correctement.

Dans ce cas, cliquez sur [-] pour supprimer votre
appareil de [Print & Fax] (Imprimer et télécopier),
puis ajoutez le de nouveau (retournez a I'étape 9).
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Configuration de I'appareil pour une

exploitation en réseau

Des fonctions telles que
e Numérisation vers Courriel

e Scan to Network PC (Numérisation vers PC
en réseau)

e Télécopie Internet

vous permettent d’envoyer et de numériser des
données vers un ordinateur par le biais d’'une
connexion réseau. Pour les utiliser, vous devez
configurer votre appareil et les ordinateurs
vers lesquels vous souhaitez transférer les
données numérisées.

Saisir I’'adresse IP de
I"appareil sur le formulaire
de configuration

Remarque

Lors de I'utilisation des touches fléchées, appuyez
a plusieurs reprises sur la touche jusqu’a
atteindre la sélection.

1 Appuyez sur <SETTING> (Parametre) sur le
panneau de commande.

2 Utilisez la touche fléchée vers le bas pour
sélectionner [View Information] (Afficher les
renseignements), puis appuyez sur <OK>.

Setting
Metwork Scan Destination

Store Document Settings

Yiew Information

3 Utilisez la touche fléchée vers le bas pour
sélectionner [Network] (Réseau), puis
appuyez sur <OK>.

4 Entrez l'adresse IP sous [IPv4 address]
(adresse IPv4) sur la ligne A-2 du formulaire
de configuration.

Configurer les fonctions de
Num,eylsatlon vers Courriel
et Telecopie Internet

Vérifiez les parametres de
courriel de I'ordinateur

¢ Siun administrateur réseau indique des valeurs
telles gqu’un compte de serveur courriel, un mot
de passe et un courriel, notez-les sur le
formulaire de configuration.

Remarque

La procédure ci-dessous utilise Windows Live Mail
sur Windows 7. Si vous utilisez un autre logiciel
de courriel, reportez-vous a son manuel.

1 Cliquez sur [Start] (Démarrer) > [Windows
Live Mail].

2 Sélectionnez le menu [Tools] (outils) >
[Accounts] (comptes).

Si la barre de menu ne s’affiche pas, cliquez
sur l'icone [Menus], puis sélectionnez [Show
menu bar] (Afficher la barre de menu).

3 Sélectionnez le compte courriel par défaut,
puis cliquez sur [Properties] (Propriétés).

4 Sur l'onglet [General] (Général), saisissez le
contenu dans [Name] (Nom) et [E-mail
address] (adresse électronique) sur les lignes
B-9 et B-10 du formulaire de configuration.

r
& popdtestcom Properties X
General | Servers | Connection | Security | Advanced

Mail Accourt
M Type the name by which you would like to refer to these
&, servers For example: "Work" or “Windows Live
7 Hotmail"

User Information
Name: User > B-g
Organization:
E-mail address:  user@testcom -lﬁ B'].O
Reply address:

¥/ Include this account when receiving mail or synchronizing

[Coms
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5 Cliquez sur l'onglet [Server] (Serveur), puis
entrez chaque parameétre sur les lignes
correspondantes du formulaire de configuration.

-
4| popdtestoom Properties 3|

General | Servers | Connection | Security | Advanced

Server Information

My incoming mail serverisa  POP2 server.

Incoming mail (FOP3):  pop3testcom

Outgaing mail (SMTF):  smiptestcom

Incoming Mail Server
E-mail usemame: user
Fassword (TTTTTIT)
V| Remember password
@ Log on using cleartext authentication
Log on using secure password authentication
() Log on using autherticated POP (APOP)

Outgoing Mail Server

/| My server requires authertication | Settings... |

[ ok [ canca |[ ooy |

¢ Sila case [My server requires authentication]
(Mon serveur nécessite d'étre authentifié) est
cochée, entrez « SMTP » sur la ligne B-4 du
formulaire de configuration.

e Sj elle n’est pas cochée, entrez « POP » sur
la ligne B-4.

6 Cochez la case [My server requires
authentication], puis cliquez sur
[Settings] (Parameétres).

7 Dans la boite de dialogue [Outgoing Mail
Server] (Serveur réseau sortant) :

Outgoing Mail Server [&J

Logon Information
@) Use same settings as my incoming mail server

Log on using

e Si [Use the same settings as my incoming
mail server] (Utiliser les mémes
parameétres pour mon serveur réseau
entrant) est coché, entrez

- la valeur de la ligne B-7 sur la ligne B-5 et

- la valeur de la ligne B-8 sur la ligne B6
du formulaire de configuration.

e Si [Log on using] (Connexion lors de
I'utilisation) est coché, entrez

- le numéro de compte [Account name]
sur la ligne B-5 et

- le mot de passe [Password] sur la
ligne B-6 du formulaire de configuration.

Configurer lI'adresse

électronique de votre appareil

Saisissez une adresse électronique a utiliser
par votre appareil sur la ligne B-1 du formulaire
de configuration.

e Si I'adresse électronique de votre appareil est
indiquée par I'administrateur réseau, entrez-la
sur la ligne B-1.

e Si vous utilisez un fournisseur de services
Internet, demandez-lui une adresse
électronique pour votre appareil, puis
saisissez-la sur la ligne B-1.

e Sil’adresse électronique de votre appareil n‘est
ni spécifiée, ni obtenue, déterminez-la en
fonction de la valeur entrée en ligne B-4
(méthode d’'authentification) :

- Si B-4 indique « SMTP », déterminez une
adresse électronique et saisissez-la sur la
ligne B-1.

- Si B-4 indique « POP », saisissez la méme
adresse électronique que B-12 sur la ligne B-1.

¢ Sivous désirez que votre appareil puisse recevoir
des messages électroniques, vous devez obtenir
une adresse électronique pour votre appareil de
la part d’'un administrateur réseau ou de votre
fournisseur de services Internet.

Configurer I'appareil a la
fonction Numeérisation vers

Courriel et Télécopie Internet

Configurez la machine a la fonction Numérisation
vers Courriel et Télécopie Internet a I'aide des
renseignements disponibles sur le formulaire

de configuration.

Remarque

Lors de I'utilisation des touches fléchées, appuyez
a plusieurs reprises sur la touche jusqu’a
atteindre la sélection.

Appuyez sur la touche <SETTING> (Parameétre)
sur le panneau de commande.

8 Utilisez la touche fléchée vers le bas pour
sélectionner [Easy Setup] (Configuration
simplifiée), puis appuyez sur <OK>.

Setting
Yiew Information

Shutdown
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9 Saisissez le mot de passe administrateur, puis
utilisez les touches fléchées pour sélectionner
[Enter] (Entrer) et appuyez sur <OK>.

10 Utilisez la touche fléchée vers le bas pour
sélectionner [Email Setting] (Paramétrage du
courriel), puis appuyez sur la touche fléchée
vers la droite.

|
2. Fax Setting
3. Network Setting
4. Ernail Setting
Cancel

11 En se référant au formulaire de configuration :

a) Adresse du serveur : appuyez sur la touche
fléchée vers la droite, puis saisissez les
renseignements de la ligne B-2.

b) Utilisez les touches fléchées jusqu'a
sélectionner [Enter] (entrer), puis appuyez
sur <OK>.

c) L'adresse électronique de votre appareil :
appuyez sur la touche fléchée vers la droite,
puis saisissez les renseignements de la
ligne B-1.

d) Sélectionnez [Enter] (Entrer), puis appuyez
sur <OK>.

e) Méthode d’authentification : appuyez sur la
touche fléchée vers la droite, puis utilisez la
touche fléchée vers le bas pour sélectionner
la méthode a partir de la ligne B-4.

f) Continuer de suivre les instructions
sur I'écran pour saisir les renseignements
requis de la section B du formulaire
de configuration.

g) Une fois tous les renseignements saisis, le
message « Email Setting was completed »
(le paramétrage du courriel s’est déroulé
avec succes) s'affiche et I'écran retourne au
menu de configuration.

12 Quand I’écran du menu de configuration
s'affiche, appuyez sur <OK>.

La configuration de la fonction Numérisation vers
Courriel et Télécopie Internet est terminée.

Pour de plus amples détails sur I'utilisation de la
fonction de Numérisation vers Courriel et Télécopie
Internet, reportez-vous au Guide de base de
I'utilisateur en ligne sur le DVD fourni avec

votre appareil.

Configurer la fonction Scan
to Network PC (Numerisation
vers PC en réseau)

La fonction Scan to Network PC (Numérisation
vers PC en réseau) permet d’envoyer et de
sauvegarder des images dans le « dossier
partagé » de votre ordinateur sur le réseau. Pour
utiliser cette fonction, enregistrez votre appareil
sur I'ordinateur en tant gu’utilisateur et créez un
dossier partagé, puis créez un profil sur votre
appareil afin d’enregistrer les paramétres pour
I'ordinateur.

e Avant de commencer la configuration, obtenez
la permission de I'administrateur de réseau de
créer un dossier partagé sur l'ordinateur en
suivant la procédure indiquée ci-dessous.

e Le protocole CIFS est celui utilisé dans
cette procédure.

Vérification du nom

de lI'ordinateur

Vérifiez le nom de l'ordinateur en suivant la
procédure indiquée ci-dessous et reportez-le sur
la ligne C-1 du formulaire de configuration.

Windows 7,

Windows Server 2008 R2,
Windows Server 2008,
Windows Vista

Remarque

La procédure suivante utilise Windows 7 a titre
d’exemple. Il se peut que |'affichage differe en
fonction du systéme d’exploitation.

1 Cliquez sur le bouton [Start] (Démarrer) >
[Control Panel] (Panneau de commande).

2 Sélectionnez [System and Security] (Systéme
et sécurité).

Pour Windows Server 2008 et Windows Vista,
sélectionnez [System and Maintenance]
(Systéme et maintenance).

3 Sélectionnez [See the name of this computer]
(voir le nom de cet ordinateur) sous
[System] (systéme).
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4 Notez le nom dans [Computer name] (nom
de l'ordinateur) sur la ligne C-1 du formulaire
de configuration.

5 Fermez la fenétre.

Windows Server 2003
Windows XP

1 Pour Windows Server 2003, cliquez sur le bouton
[Start] (Démarrer) > [Control Panel] (Panneau
de commande) > [System] (systéme).

Pour Windows XP, cliquez sur le bouton [Start]
(Démarrer) > [Control Panel] (Panneau de
commande) > [Performance and Maintenance]
(Performances et maintenance) >

[System] (systeme).

2 Sélectionnez I'onglet [Computer Name]
(Nom de l'ordinateur), puis cliquez sur
[Change] (Modifier).

3 Notez le nom dans [Computer name] (nom
de l'ordinateur) sur la ligne C-1 du formulaire
de configuration.

4 Cliquez sur [Cancel] (Annuler) pour fermer
la fenétre.

Windows 2000

1 Cliquez sur le bouton [Start] (Démarrer) >
[Settings] (Parameétres) > [Control Panel]
(Panneau de commande).

Double-cliquez sur [Systéme] (Systéme).

Sélectionnez I'onglet [Network Identification]
(Identification du réseau), puis cliquez sur
[Properties] (Propriétés).

4 Notez le nom dans [Computer name] (nom
de l'ordinateur) sur la ligne C-1 du formulaire
de configuration.

5 Cliquez sur [Cancel] (Annuler) pour fermer
la fenétre.

Déterminer le nom des Options
requises pour la fonction Scan
To Network PC (Numérisation

vers un PC en réseau)

Déterminez le nom des options suivantes et
reportez-les sur les lignes C-2 a C-6 du formulaire
de configuration.

e Nom d’utilisateur pour se connecter a
I'ordinateur de destination (C-2)

e Mot de passe pour se connecter a l'ordinateur
de destination (C-3)

¢ Nom de profil pour enregistrer les paramétres
sur votre appareil (C-4)

e Nom du dossier partagé de l'ordinateur de
destination (C-5)
e Nom de fichier des données numérisées (C-6)

Configurer l'ordinateur a la
fonction Scan To Network PC

(Numérisation vers PC en réseau).
Enregistrez votre appareil sur I'ordinateur en tant
gu’utilisateur, puis configurez un dossier partagé
dans lequel les images numérisées seront
envoyées et sauvegardées.

e Windows 7, voir ci-dessous

e Windows Server 2008 R2, voir ci-dessous

e Windows 2008, voir ci-dessous

e Windows Vista, voir ci-dessous

e Windows Server 2003, voir page 86

e Windows XP, voir page 86

e Windows 2000, voir page 87

Important!

Si I'ordinateur est dans un domaine, la
procédure d’ajout d’'un compte d’utilisateur
peut étre différente de la procédure
indiquée ci-dessous. Consultez le manuel de
Microsoft Windows.

Windows 7,

Windows Server 2008 R2,
Windows 2008,

Windows Vista

Remarque

La procédure suivante utilise Windows 7 a titre
d’exemple. Il se peut que l'affichage differe en
fonction du systéme d’exploitation.
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1 Cliquez sur le bouton [Start] (Démarrer) >
[Control Panel] (Panneau de commande).

2 Sélectionnez [Add or remove user
accounts] (Ajouter ou supprimer des
comptes d’utilisateurs).

3 Sélectionnez [Create a new account] (Créer
un nouveau compte).

4 Saisissez les renseignements de la ligne C-2
du formulaire de configuration dans la zone
de texte.

5 Assurez-vous que la case [Standard user]
(Utilisateur standard) est cochée, puis cliquez
sur [Create Account] (Créer un compte).

6 Cliquez sur l'icbne du compte utilisateur crée
lors de |'étape précédente.

7 Sélectionner [Create a password] (Créer un
mot de passe).

8 Saisissez les renseignements de la ligne C-3
dans [New password] (Nouveau mot de passe)
et [Confirm for new password] (Confirmer le
nouveau mot de passe), puis cliquez sur
[Create password] (Créer le mot de passe).

e |
K3 =[5 « Userdccounts » Mansge Accounts » Change an Account b Creste Password = |44 |[ 52
Create a password for mc561°s account

me3bl
Stanclard user

Yau are creating a passweed for meSEL.

I you do this, me3b1 will lose all EFS-encrypled liles, personal certilicates and stored passwords lor Wel
sltes ar network resources.

Tor v lising data in e future, ask meSl Lo make a password rese floppy dek,

> Create password | | Caneel

9 Fermez le panneau de commande.

10 Créer un nouveau dossier sur l'ordinateur
avec le nom saisi sur la ligne C-5.

Remarque

Il est recommandé de créer un dossier dans
I’'unité locale, et non sur le bureau ou dans
[My Documents] (Mes documents).

11 Cliquez avec le bouton droit de la souris sur le
dossier crée lors de I'étape précédente et
sélectionnez [Properties] (Propriétés).

12 Sélectionnez I'onglet [Sharing] (Partage), puis
cliquez sur [Share] (Partager).
SalesDiev Properties =]

Gerwenl | S | Sncurty | Frvicns Versicrs: | Customive

Netwoss Fle and Folder Shanng

Siniea Do

oK Cancel

13 Sélectionnez le compte utilisateur crée dans
I’étape 5 dans la liste déroulante, puis cliquez
sur [Add] (Ajouter).

¥ Shaoe Cancel

14 Sélectionnez I'utilisateur ajouté lors de I'étape
précédente et choisissez le niveau de
permission, puis cliquez sur [Share] (Partager).

1 File Sharing
Choose people to share with

Type & name snd then click Add, or click the smow to find semecne

MNarme Permuiusn Lewvel
& ox Owner

¥ Sl Resd/Virke = 4_

15 Cliquez sur [Done] (Effectué).

16 Cliquez sur [Advanced Sharing] (Partage
avancé) dans l'onglet [Sharing] (Partage).

17 Cliquez sur [Permissions].

18 Sélectionnez I'utilisateur ajouté lors de
I’étape 13 et cochez la case [Allow]
(Autoriser) pour un contréle total [Full
Control], puis cliquez sur [OK].

19 Fermez la boite de dialogue Propriétés
du dossier.
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20 Créez un profil pour terminer la configuration de
la fonction Scan To Network PC (Numérisation
vers PC en réseau). Consultez “Les profils de la
fonction Scan to Network PC (Numérisation vers
PC en réseau)” a la page 89.

Pour Windows Server 2003

1 Cliquez sur le bouton [Start] (Démarrer) >
[Administrative Tools] (Outils
d’administration) > [Server Management]
(Gestion du serveur).

Cliquez sure [Users] (utilisateur).

Sélectionnez [Add a user] (Ajouter un utilisateur).

Saisissez la valeur indiquée en C-2 dans la
zone de texte [First Name] (Prénom), puis
cliquez sur [Next] (Suivant).

User Account Infomation
Vs et sy e i ination iecpaed o Cieale 8 wim cciurt
ﬁ Eret name =3
Ligst raers [
Logon nemme: =3 =
-
Lebephone. |
[fheee koceabion: |
« Back Hest 3 gm

5 Saisissez la valeur indiquée en C-3 dans
[Password] (Mot de passe) et [Confirm
password] (Confirmer mot de passe).

User Pasaword
“Vens it sy a pisiwond b the et
—_’ Basswoed  [smess
ﬁ Cgpbmpasewed ~ [ssass

This uses
1 Must change password af nest logon
* [Caneol changs passwoed

1™ Can changs patiwerd & sy ime

« Back Bt 3 I Cancel

6 Sélectionnez [Cannot change password] (Ne
peut pas modifier le mot de passe), puis
cliquez sur [Next] (Suivant).

7 Cliquez sur [Finish] (Terminer).

Cliquez sur [Close] (Fermer).

9 Créer un nouveau dossier dans l'ordinateur
avec le nom saisi sur la ligne C-5.

Remarque

Il est recommandé de créer un dossier dans
I’'unité locale, et non sur le bureau ou dans
[My Documents] (Mes documents).

10 Cliquez avec le bouton droit de la souris sur le
dossier crée lors de I'étape au-dessus, puis
sélectionnez [Sharing and Security] (Partage
et sécurité).

11 Sur l'onglet [Sharing] (Partage), sélectionnez
[Share this folder] (Partager ce dossier), puis
cliquez sur [Permissions].

General | Wweb Sharing  Sharng | Secuiy |
Q “You can share this folder among other users on your

network, Ta enable sharing for tis folder, click Share this
folder.

€ Da not share this folder
_”—G Share this foldar

Share name:  [SalesDev

Comment: |

User limit; * Maximum allowed

© Allaw = Users
To set pemissions for how users access this ‘._
folder ove the network. click Pemiissions.

To cortigure setings for Offine access to Cach
this shared folder, cick Caching. ]

L =

12 Cliquez sur [Add] (Ajouter).

13 Saisissez la valeur indiquée en C-2, puis cliquez
sur [Check Names] (Vérifier les noms).

Select Users, Computers, or Groups 21xl
Select this object type
IUsels, Groupe, or Built-in security principals Dbject Types
Erom this location
Ismallbusmess local Locations.
Enter the obiect names to select [examples)
_’ meS6T Check Names ‘_
Advanced Eaneel
A

14 Vérifiez que la valeur indiquée en C-2
s'affiche, puis cliquez sur [OK].

15 Cochez la case [Allow] (Autoriser) pour un
controle total [Full Control], puis cliquez sur [OK].

16 Fermez la boite de dialogue Propriétés
du dossier.

17 Créez un profil pour terminer la configuration de
la fonction Scan To Network PC (Numérisation
vers PC en réseau). Voir page 89.

Pour Windows XP

1 Cliquez sur le bouton [Start] (Démarrer) >
[Control Panel] (Panneau de commande).
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2 Double-cliquez sur [User Accounts]
(Comptes d’utilisateurs).

3 Sélectionnez [Create a new account]
(Créer un nouveau compte).

4 Saisissez la valeur indiquée en C-2 dans la zone
de texte, puis cliquez sur [Next] (Suivant).

Name the new account

Type arame for the rew sccount:
[mestl

This raeren wal ape o thes ‘wisk som v el s thes S2.t rrowns.

(E=t=] [Goel)

5 Sélectionnez [Limited] (Limité) et cliquez sur
[Create Account] (Créer un nouveau compte).

2 Usor Accounts r_ Iﬁ"hli

Pick an account type

) Compaame gememtrater () Lenknd 4

Wth. 3 Imited accounk, You can:
& Change of remeve your passecrd
+ Changs your pecture, theme, and cther desktop settings
# Vimen Pl ya) rmatmd
# Wiewn Hles i b S Dvarvesrs Foleer

h Mikid Bccourks CAAet Bkvay Capanden on the program, & user
right el ackvirit ton provinges to sl £

£, programs desigred prior b Windoers P or Windows 2000 ok properly wih
or

gtk ot
lmibed accounts. For best resubs, dhoose rograms beanng the Designed for Windowes ' logo,
o6, b ohder prograia, choces the “cormgabiar sdinitr stor” stcourt o

() (s ) ()

6 Cliquez sur l'icone du compte utilisateur crée
lors de I'étape au-dessus.

7 Sélectionner [Create a password] (Créer un
mot de passe).

8 Saisissez les renseignements de la ligne C-3
dans [Type a new password] (Taper un nouveau
mot de passe) et [Type the new password again
to confirm] (Retaper le nouveau mot de passe
pour le confirmer), puis cliquez sur [Create
password] (Créer un mot de passe).

9 Fermez le panneau de commande.

10 Créer un nouveau dossier dans l'ordinateur
avec le nom saisi sur la ligne C-5.

Remarque

Il est recommandé de créer un dossier dans
I’'unité locale, et non sur le bureau ou dans
[My Documents] (Mes documents).

11 Cliquez avec le bouton droit de la souris sur le
dossier crée lors de I'étape au-dessus, puis
sélectionnez [Sharing and Security] (Partage
et sécurité).

12 Cliquez sur [If you understand the security
risks but want to share files without running
the wizard, click here.] (Si vous comprenez
les risques liés a la sécurité, mais souhaitez
partager des fichiers sans utiliser I'assistant,
cliquez ici).

13 Sélectionnez [Share this folder] (Partager ce
dossier) dans le pare-feu de Windows, puis
cliquez sur [OK].

14 Cochez les cases [Share this folder on the
network] (Partager ce dossier sur le réseau)
et [Allow network users to change my files]
(Autoriser les utilisateurs du réseau a modifier
mes fichiers), puis cliquez sur [OK].

MC561 Properties ‘E‘E‘

General| Sharing | Customize|

Local sharing and securiy

(- ! Ta share this folder with other users of this computer

'8 orly. dragit 1o the Shaed Documents folder
Ta make this folder and its subfalders private so that
only you have acosss, select the following check bor
Make this folder private

Hetwork sharing and secuity

Ta share this folder with both netwrk users and ather
users o this camputer, select the fist check bax below
and type a share name.

> Share this folder on the network

Share name: | MCS61

[l llou network users to change my fies

Leamn more ahout sharing and security

A “Windows Firewall is configured to allow this falder ta be shared
with other campLtets on the network,

Views your Windows Firewal settings

0K [ concel | [ appk

15 Cochez la case [Allow] (Autoriser) pour [Full
Control] (Controle total), puis cliquez sur [OK].

16 Créez un profil pour terminer la configuration de
la fonction Scan To Network PC (Numérisation
vers PC en réseau). Voir page 89.

Pour Windows 2000

1 Sur le bureau, cliquez avec le bouton droit de
la souris sur [My Computer] (Mon ordinateur),
puis sélectionnez [Manage] (Gérer).

2 Dans la fenétre de droite, double-cliquez sur

[System Tools] (Outils systeme) > [Local Users
and Groups] (Utilisateurs locaux et groupes).
Cliquez avec le bouton droit de la souris sur
[Users] (Utilisateurs) et sélectionnez [New
User] (Nouvel utilisateur).

87 - Francgais



3 Saisissez la valeur indiquée en C-2 dans [User 9 Sélectionnez [Share this folder] (Partager ce
name] (Nom d’utilisateur) et celle indiquée en dossier), puis cliguez sur [Permissions].
C-3 dans [Password] (Mot de passe) et

[Confirm password] (Confirmer mot de passe) L i
P P * General| Web Shaing Shaing | Securty |
Q Yo i hsts s Foldet amncg Other Lissrs o ot
2| % retwork. To enable sharing for this folder, click Share this
rewuzer 2| e
_> Username: [moSEl © Do not share this folder
——’»—(-‘ Share this falder
Full name |
Share name: [SalecDer
Description: |
Comment |
_> Pcssenad [== Userlimt & Masimum alowed
_> Confimpassword. [ © Alow o Users
To <o pomisions o hw et occess s P | e
I Uss: s cangs pastrd o e on T o P,
¥ User cannot change password
i To configure settings for Offfine access t Cachi
¥ Passuord never aupies this shared faider, click. Caching. _ Cading |
™ Account is disabled
- ok | cencel | apoh |

4 Sélectionnez [User Can not change password] 10 Cliquez sur [Add] (Ajouter).

(L'utilisateur ne peut pas modifier le mot de 11 Sélectionnez le compte utilisateur crée a
passe) et [Password never expires] (Pas I’étape 4, puis cliquez sur [Add] (Ajouter).
d’expiration du mot de passe), puis cliquez sur
[Create] (Créer). 2%
. Lookine [ 200811003 =
5 Cliquez sur [Close] (Fermer) pour fermer
la fenétre de dialogue [New User] T
aye ackup Operators 200611-003
(Nouvel Ut|l|sateur). uests 200511003
ower Users 200611003 J
ot 2ttt o0 =
Remarq ue _’ Theck Nemes

<< Type names separated by semicolons o choose from list >>

Si [User must change password at next logon]
(L'utilisateur devra modifier le mot de passe
lors de la prochaine connexion) est coché,
supprimez-le afin de pouvoir sélectionner [User o |
can not change password] (L'utilisateur ne peut .
pas modifier le mot de passe) et [Password
never expires] (Pas d’expiration

du mot de passe).

12 Vérifiez bien que le compte utilisateur
s'affiche, puis cliquez sur [OK].

13 Cochez la case [Allow] (Autoriser) pour
un contréle total [Full Control], puis cliquez
6 Double-cliquez sur [User] (Utilisateur) et vérifiez sur [OK].
bien que 'utilisateur crée a I'étape 4 s'affiche.
Fermez la fenétre [Computer Management]
(Gestion de l'ordinateur).

14 Assurez-vous que l'icone du dossier partagé
se soit changée en icbne avec une main, puis
fermez la fenétre.

7 Créer un nouveau dossier dans l'ordinateur

avec le nom saisi sur la ligne C-5. 15 Créez un profil pour terminer la configuration de

la fonction Scan To Network PC (Numérisation
vers PC en réseau). Consultez “Les profils de la
Remarque fonction Scan to Network PC (Numérisation vers

, , . PC en réseau)” a la page 89.
Il est recommandé de créer le dossier dans

I’'unité locale, et non sur le bureau ou dans
[My Documents] (Mes documents).

8 Cliquez avec le bouton droit de la souris sur le
dossier crée lors de |'étape 6, puis
sélectionnez [Sharing] (Partage).
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Les profils de la fonction
Scan to Network PC
(Numérisation vers PC
en réseau)

Enregistrer les renseignements que vous avez
configurés sur I'ordinateur comme profil. Ceci est
nécessaire quand vous effectuez la fonction Scan
To Network PC (Numérisation vers PC en réseau)
avec l'ordinateur.

Création d’un profil

Remarque

Lors de l'utilisation des touches fléchées, appuyez
a plusieurs reprises sur la touche jusqu’a
atteindre la sélection.

1 Appuyez sur la touche <SETTING>
(Parametre) sur le panneau de commande.

2 Utilisez la touche fléchée vers le bas pour
sélectionner [Profile] (Profil), puis appuyez
sur <OK>,

Setting
Address Book
Phone Book

&

3 Utilisez la touche fléchée vers le bas pour
sélectionner le numéro de profil que vous
souhaitez enregistrer, puis appuyez sur <OK>.

4 Utilisez la touche fléchée vers le bas pour
sélectionner [Edit] (Afficher), puis appuyez
sur <OK>,

5 Utilisez la touche fléchée vers le bas
pour sélectionner le numéro de profil que
vous souhaitez enregistrer, puis appuyez
sur <OK>,

6 Utilisez la touche fléchée vers le bas pour
sélectionner [Profile Name] (Nom de profil),
puis appuyez sur <OK>.

7 Saisissez les renseignements indiqués dans la
ligne C-4 du formulaire de configuration.

8 Utilisez les touches fléchées jusqu’a
sélectionner [Enter] (entrer), puis appuyez
sur <OK>,

9 Utilisez la touche fléchée vers le bas pour
sélectionner [Target URL] (URL Cible), puis
appuyez sur <OK>.

10 Saisissez les valeurs indiquées sur les lignes
C-1 et C-5 du formulaire de configuration
comme « \\C-1\C-5 » par ex., \\PC1\SalesDev.

11 Utilisez les touches fléchées jusqu’a
sélectionner [Enter] (entrer), puis appuyez
sur <OK>.

12 Utilisez la touche fléchée vers le bas pour
sélectionner [User Name] (Nom d’utilisateur),
puis appuyez sur <OK>.

13 Saisissez les renseignements indiqués dans la
ligne C-2 du formulaire de configuration.

Si la gestion du domaine est effectuée,
saisissez « C-2@domain name ».

14 Utilisez les touches fléchées jusqu'a
sélectionner [Enter] (entrer), puis appuyez
sur <OK>.

15 Utilisez la touche fléchée vers le bas pour
sélectionner [Password] (Mot de passe), puis
appuyez sur <OK>.

16 Saisissez les renseignements indiqués dans la
ligne C-3 du formulaire de configuration.

17 Utilisez les touches fléchées jusqu’a
sélectionner [Enter] (entrer), puis appuyez
sur <OK>,

18 Utilisez la touche fléchée vers le bas pour
sélectionner [File Name] (Nom de fichier),
puis appuyez sur <OK>.

19 Saisissez les renseignements indiqués sur la
ligne C-6 du formulaire de configuration. Vous
pouvez entrer jusqu’a 64 caractéres.

Ajouter « #n » a la fin d'un nom de dossier,
attribuera automatiquement un numéro de
série a la fin du nom des dossiers envoyés.

Ajouter « #d » a la fin d’'un nom de dossier,
attribuera automatiquement une date a la fin
du nom des dossiers envoyés.

20 Utilisez les touches fléchées jusqu’a sélectionner
[Enter] (entrer), puis appuyez sur <OK>.

21 Configurer les autres options si nécessaire.

22 Appuyez sur <OK> pour valider les paramétres.

La configuration de la fonction Scan To Network PC
(Numérisation vers PC en réseau) est terminée.

Pour de plus amples détails sur I'utilisation de la
fonction Scan To Network PC (Numérisation vers
PC en réseau), reportez-vous au Guide de base
de I'utilisateur en ligne sur le DVD fourni avec
votre appareil.
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Modification un profil

Remarque

Lors de I'utilisation des touches fléchées, appuyez
a plusieurs reprises sur la touche jusqu’a
atteindre la sélection.

9

Appuyez sur la touche <SETTING>
(Parameétre) sur le panneau de commande.

Utilisez la touche fléchée vers le bas pour
sélectionner [Profile] (Profil), puis appuyez
sur <OK>,

Utilisez la touche fléchée vers le bas pour
sélectionner [Edit] (Afficher), puis appuyez
sur <OK>,

Utilisez la touche fléchée vers le bas pour
sélectionner le profil que vous souhaitez
modifier, puis appuyez sur <OK>,

Utilisez la touche fléchée vers le bas pour
sélectionner I'option que vous souhaitez
modifier, puis appuyez sur <OK>,

Modifier l'option.

Utilisez les touches fléchées jusqu’a sélectionner
[Enter] (entrer), puis appuyez sur <OK>.

Si vous souhaitez modifier plus d’une option,
répétez les étapes 5 a 7.

Appuyez sur <OK> pour valider les paramétres.

Suppression d’un profil

Remarque

Lors de I'utilisation des touches fléchées, appuyez
a plusieurs reprises sur la touche jusqu’a
atteindre la sélection.

1

2

Appuyez sur la touche <SETTING>
(Parametre) sur le panneau de commande.

Utilisez la touche fléchée vers le bas pour
sélectionner [Profile] (Profil), puis appuyez
sur <OK>.

Utilisez la touche fléchée vers le bas pour
sélectionner [Delete] (Supprimer), puis
appuyez sur <OK>.

Utilisez la touche fléchée vers le bas pour
sélectionner le profil que vous souhaitez
supprimer, puis appuyez sur <OK>,

Utilisez la touche fléchée vers la gauche
pour sélectionner [Yes] (Oui) sur le message
de confirmation.

Si vous souhaitez supprimer plus d’un profil,
répétez les étapes 4 et 5.

Appuyez sur <OK>.
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Configuration de I’Authentification de

I'utilisateur et du Controle d’acces

Généralités

Ces fonctions servent a limiter I'accés a l'appareil.
Ceci afin d’économiser les cartouches, le papier
et limiter 'usure de l'appareil.

L'authentification de l'utilisateur et le contréle d'accés
sont protégés par un mot de passe et doivent étre
configurés par I'administrateur du systéme.

Les conditions suivantes sont requises pour

activer ces fonctions :

e |'appareil doit étre connecté a un réseau.

¢ Pour les réseaux seulement équipés de
systemes Windows, |'utilitaire d’outil de
configuration doit étre installé sur un
ordinateur du réseau.

e Pour les systémes Macintosh, le Client de
comptabilisation des travaux doit étre installé.

Authentification de l'utilisateur?

L'authentification de I'utilisateur permet a

I'administrateur du systéme de limiter 'utilisation

de l'appareil a des personnes qui se sont vues

attribuer soit

e un PIN (NIP - Numéro d’identification personnel)
ou

e un nom d’utilisateur et un mot de passe.

Cette limitation s'applique a la fois a une utilisation

physique de la machine ou depuis un ordinateur.

Vous pouvez attribuer jusqu’a 100 PIN (NIP),
avec ou sans nom d’utilisateur et mot de passe.

Le controle d’acces

Le contrdle d'accés est plus sophistiqué car il
permet a I'administrateur du systéme de limiter le
type de fonctions disponibles que chaque personne
autorisée a utiliser la machine peut effectuer.

Le contrdle d'accés peut étre appliqué aux
fonctions suivantes :

e Copies (couleur/monochromes)

e Impression (couleur/monochrome)

e Impression a partir d’'une clé de mémoire USB
e Numérisation vers Courriel

e Scan to Network PC (Numérisation vers PC
en réseau)

¢ Numérisation vers clé de mémoire USB
e Télécopie

e Télécopie par PC

e Télécopie Internet

Avant de commencer

Il y a plusieurs fagons de configurer le contréle
d’acces a votre appareil :

e Par le biais d’'un logiciel

e Par le biais de la page Web

e Par le panneau de commande

Ce guide comprend les instructions pour la

configuration de I'appareil en utilisant les
utilitaires du logiciel.

Pour plus d’information sur |'utilisation de la page
web ou du panneau de commande, reportez-vous
au Guide de l'utilisateur avancé disponible sur
www.my.okidata.com.

Systemes sous Windows

Chargement de l'outil

de configuration

Afin de configurer 'authentification de |'utilisateur et
le controéle d'accés sous Windows, vous devez installer
I'utilitaire de configuration sur votre ordinateur.

1 Vérifiez bien que votre ordinateur est allumé
et connecté a l'appareil, puis placez le DVD
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fourni avec votre appareil dans l'unité de
CD/DVD.

Le DVD se met en marche seul. Si ce n’est pas
le cas, double-cliquez sur le fichier de
configuration OKI du DVD.

Sélectionnez votre langue dans la liste
déroulante, puis cliquez sur [Next] (Suivant).

Lisez le Contrat de licence, puis cliquez sur
[I Agree] (J'approuve).

Cliquez sur [MFP Software] (Logiciel AMF).

Cliquez sur [Install Configuration Tool]
(Installer Outil de configuration).

2= OKI Printing Solutions =5 x|
OK1 D=

PRINTING SOLUTIONS

OKI MC361/561

Driver Setup
Color Software
Network Software
Optional Utilities
MFP Software

= Register your Primter

CREKING this will Al B launch a Wed
Biweser and conniel 1 e intemed

Cliquez sur [Install] (Installer) et attendez
que le logiciel s’installe.

Sélectionnez le modeéle de votre appareil, puis
cliquez sur [Next] (Suivant).

Cliquez sur [Close] (Fermer).

Se servir de lI'outil de
configuration pour configurer
L'authentification de
I'utilisateur/Controle d’acces

1

Vérifiez que votre appareil et votre ordinateur
soient bien allumés et connectés par le réseau.

Cliquez sur [Start] (Démarrer) > [Programs]
(Programmes) > [Okidata] > [Configuration
Tool] (Outil de configuration) > [Configuration
Too] (Outils de cofiguration).

== Configuration Tool i =lolx|
File Tools Plug-in View Help

Configuration Tool

Configuration Tool Y} _

Cliquez sur [Register Device] (Enregistrer
le périphérique) dans la liste - déroulante
dans Outils.

Double-cliqguez sur le nom du modéle de
votre appareil.

Le nom s‘affiche dans le tableau des
périphériques enregistrés [Registered Device
Table] a gauche de I’écran.

Dans la liste, double-cliquez sur votre
appareil, puis sélectionnez I’'onglet [User
Setting] (Paramétres utilisateur).

Cliquez sur [PIN Manager] (Gestionnaire du
NIP), puis saisissez le mot de passe
administrateur et cliquez sur <OK>.

Pour saisir le numéro de PIN (NIP) et le
configurer avec le contr6le d'accés souhaité,
cliqguez sur l'icone du PIN (NIP).

Pour saisir un nouvel utilisateur avec un code
utilisateur, un mot de passe et un numéro PIN
(NIP), cliquez sur I'icone New (User) (Nouvel
[utilisateur]).

Répétez I'étape ci-dessus pour chaque
utilisateur du réseau.

Une fois terminé, cliquez sur l'icobne [Save to
Device] (Sauvegarder sur le périphérique).

Les résultats que vous avez entrés sont
sauvegardés dans l'appareil.
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Systemes sous Mac

Afin de configurer I'authentification de I'utilisateur et le
controle d’accés sous Mac, reportez-vous au Guide
de l'utilisateur avancé disponible sur
www.my.okidata.com.

Authentification par
PIN (NIP)

Activation du controle d’acces

par PIN (NIP)

Une fois la configuration des PIN (NIP) et/ou des ID
utilisateurs/mots de passe, vous devez aller dans le
menu de 'appareil et activer le controle d’acces.

Le contrble d'accés est protégé par un mot de
passe : vous devez connaitre le mot de passe
administrateur pour continuer.

Remarque

Pour faire défiler les différentes sélections sur
I'affichage, appuyez sur la touche fléchée vers le
bas (ou vers le haut) de facon répétitive.

1 Appuyez sur <SETTING> (Parametre) sur le
panneau de commande.

2 Utilisez la touche fléchée vers le haut pour
sélectionner [Admin Setup] (Configuration
Administrateur), puis appuyez sur <OK>.

3 Entrez votre mot de passe administrateur :
utilisez les touches fléchées pour sélectionner
les chiffres de votre mot de passe en
appuyant <OK> entre les chiffres.

4 Une fois la saisie de votre mot de passe
terminée, utilisez les touches fléchées jusqu’a
ce que [Enter] (entrer) s’affiche, puis appuyez
sur <OK>.

5 Utilisez la touche fléchée vers le haut pour
sélectionner [Management] (Gestion), puis
appuyez sur <OK>.

6 Utilisez la touche fléchée vers le bas pour
sélectionner [System Setup] (Configuration
du systéme), puis appuyez sur <OK>.

7 Vérifiez bien que Contréle d’accés [Access
Control] est sélectionné, puis appuyez sur <OK>.

8 Utilisez la touche fléchée vers le haut pour
sélectionner PIN (NIP) comme méthode de
controle d’acces, puis appuyez sur <OK>,

9 Utilisez la touche fléchée vers la gauche pour
revenir a |'écran principal.

Le contrble d’accés est activé.
Opération a I’'appareil

Se connecter

Login

PN ro.

oK)

Utilisateurs généraux

1 Saisissez le PIN (NIP) qui vous a été attribué
grace au clavier de dix touches situé sur le
panneau de commande.

2 Appuyez sur <OK>.
L’écran principal s’affiche.

Administrateur

1 Saisissez « 000000 » grace au clavier de dix
touches situé sur le panneau de commande,
puis appuyez sur <OK>.

e Le PIN (NIP) de l'administrateur est
« 000000 ». Vous ne pouvez pas modifier
cette valeur.

2 Lorsque I’écran Mot de passe administrateur
s’affiche, saisissez le mot de passe
administrateur : utilisez les touches fléchées
pour sélectionner les chiffres du mot de passe
en appuyant sur <OK> aprés la mise en
évidence de chaque chiffre.

3 Utilisez les touches fléchées jusqu’a ce
que [Enter] (entrer) s’affiche, puis appuyez
sur <OK>,

L’écran principal s‘affiche.

Se déconnecter

Lorsque vous avez terminé d’utiliser I'appareil, ne
pas oublier de vous déconnecter.

1 Appuyez sur la touche fléchée vers la gauche
jusqu’a ce que lI’écran principal s’affiche.
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2 Appuyez sur <RESET/LOGOUT> (Remise
a zéro/Déconnexion) sur le panneau
de commande.

o/ ODOG)

DO®

L'écran revient au message de demande de
PIN (NIP).

Remarque

L'appareil déconnecte automatiquement les
utilisateurs aprés un certain délai.

Configurer un formulaire
d’exploitation a partir d’'un
ordinateur avec une
authentification par PIN (NIP)

Tout d'abord, en vous servant du DVD, contrblez
que le(s) pilote(s) adéquat(s) ai(en)t été bien
installé(s) sur l'ordinateur.

Ensuite, installez le logiciel (client) de
comptabilisation des travaux sur 'ordinateur.
Pour cela, placez le DVD fourni avec l'appareil
dans 'unité de l'ordinateur et suivez les
messages qui s’affichent pour installer le logiciel
de comptabilisation des travaux depuis Internet.

M
OKI .

PRINTING SOLUTIONS

OKI MC361/561

Coler Software
Netwerk Software
Optional Utilities
MFP Software

Internet Downloads

T= Register your Printer

(Clicking this will atiempt bo launch a Wb
Bunwser and CORNMCE10 th wiemen

Remarque

Le type d'authentification spécifié sur I'ordinateur
est prioritaire a celui spécifié sur I'appareil.

Configurer les ordinateurs Windows
pour l'impression

Remarque

Cette procédure se sert du MC561 et de Windows 7
a titre d’'exemple. Il se peut que les procédures et
les menus difféerent en fonction du systeme
d’exploitation que vous utilisez.

1 Cliquez sur [Start] (Démarrer) > [All Programs]
(Tous les programmes) > [Okidata] > [Print Job
Accounting Client] (Client de comptabilisation
des travaux d’'impression) > [Change Job
Accounting Mode] (Modifier le mode de
comptabilisation des travaux).

2 Dans la fenétre [User Account Control]
(Contr6le du compte utilisateur), cliquez sur
[Yes] (Oui).

3 Sélectionnez I'imprimante que vous souhaitez
définir dans [Driver] (Pilote).

4 Cochez la case [Tab] (Onglet), puis cliquez sur
[Change] (Madifier).

5 Cliquez sur [OK].

A partir du menu [File] (Fichier), sélectionnez
[Close] (Fermer).

7 Cliquez sur [Start] (Démarrer) et sélectionnez
[Devices and Printers] (Périphériques
et imprimantes).

e Sous Windows Server 2008, cliquez sur
[Start] (Démarrer) et sélectionnez [Control
Panel] (Panneau de commande) >
[Printers] (Imprimantes).

e Sous Windows Vista, cliquez sur [Start]
(Démarrer) et sélectionnez [Control
Panel] (Panneau de commande) >
[Printer] (Imprimante).

e Sous Windows Server 2003, cliquez sur
[Start] (Démarrer) > [Printers and Faxes]
(Imprimantes et Télécopies).

e Sous Windows XP, cliquez sur [Start]
(Démarrer) > [Printers and Faxes]
(Imprimantes et Télécopies).

e Sous Windows 2000, cliquez sur [Start]
(Démarrer) > [Settings] (Parameétres) >
[Printers] (Imprimantes).
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8 Pour chaque pilote installé sur I'ordinateur :

a) cliquez avec le bouton droit de la souris
sur l'icone OKI MC561 et sélectionnez
[Printer properties] (Propriétés de
I'imprimante) > [OKI MC561 (XXX*)].

*XXX = PCL, PS, ou FAX

b) Sélectionnez I'onglet [Job Accounting]
(Comptabilisation des travaux).

c) Saisissez le nom d’utilisateur dans [User
Name] et le PIN (NIP) dans [Job Account

ID] (Code de comptabilisation des travaux).

= OKI MCSB1(PCL) Properties |

Generd Sharing Poris Advanced Color Managemert
Status Job Accourting Security Device Option

Job ceourting Seting
User Hame [up to B0 characters)

’ Oki
Job Account 1D [1-933393333)

}1
OK | [ Carcal | [ ooy |

d) Cliquez sur [OK].

Effectuer une impression a partir
de Windows

1 Ouvrez le fichier a imprimer.

2 Sélectionner [Print] (Imprimer) dans le menu
[File] (Fichier).

3 Sélectionnez le pilote d’'imprimante, puis
cliquez sur [Print] (Imprimer).

Configurer les ordinateurs Mac
pour I'impression

Remarque

Cette procédure utilise le Mac OS X 10.6 (Snow
Leopard) et le modéle MC561 a titre d’exemple. Il se
peut que les procédures et les menus différent en
fonction du systéme d’exploitation que vous utilisez.

1 Insérez le DVD fourni avec votre appareil.

2 Double-cliquez sur l'icone OKI qui figure sur
le bureau.

3 Double-cliquez sur [Utility] (Utilitaire) >
[JA Client] (Client JA) > [Print JobAccounting]
(Imprimer Comptabilisation des travaux).

Cliquez sur [New] (Nouveau).

5 Saisissez le nom dutilisateur sous [User Name]
et le PIN (NIP) a c6té de [Job Account ID] (Code
de comptabilisation des travaux).

ALOLO

{ Cancel )
( Cancel )

LoginName : Administrator

ﬁ UserName : Oki
ﬁ JobAccountingID : | 2

C Help )
( Help )

Cliquez sur [Save] (Sauvegarder).
7 Cliquez sur [Save] (Sauvegarder).

S'il vous est demandé, saisissez le mot de
passe utilisateur, puis cliquez sur [OK].

Effectuer une impression a partir
d’un Mac

1 Ouvrez le fichier a imprimer.

2 Dans le menu [File] (Fichier), sélectionnez
[Print] (Imprimer).

3 Sélectionnez votre appareil, puis cliquez sur
[Print] (Imprimer).

Configurer les ordinateurs Windows
pour la télécopie

Remarque

Cette procédure se sert du MC561 et de
Windows 7 a titre d’exemple. Il se peut que les
procédures et les menus difféerent en fonction du
systéme d’exploitation que vous utilisez.

1 Cliquez sur [Start] (Démarrer) > [All Programs]
(Tous les programmes) > [Okidata] > [Print Job
Accounting Client] (Client de comptabilisation
des travaux d’impression) > [Change Job
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Accounting Mode] (Modifier le mode de
comptabilisation des travaux).

2 Dans la fenétre [User Account Control]
(Controle du compte utilisateur), cliquez sur
[Yes] (Oui).

3 Sélectionnez le pilote de télécopie dans
[Driver] (Pilote).

4 Cochez la case [Tab] (Onglet), puis cliquez sur
[Change] (Modifier).

5 Cliquez sur [OK].

A partir du menu [File] (Fichier), sélectionnez
[Close] (Fermer).

7 Cliquez sur [Start] (Démarrer) et sélectionnez
[Devices and Printers] (Périphérigues
et imprimantes).
- Sous Windows Server 2008, cliquez sur
[Start] (Démarrer) et sélectionnez
[Control Panel] (Panneau de commande) >
[Printers] (Imprimantes).

- Sous Windows Vista, cliquez sur [Start]
(Démarrer) et sélectionnez [Control
Panel] (Panneau de commande) >
[Printer] (Imprimante).

- Sous Windows Server 2003, cliquez sur
[Start] (Démarrer) et sélectionnez [Printers
and Faxes] (Imprimantes et Télécopies).

- Sous Windows XP, cliquez sur [Start]
(Démarrer) et sélectionnez [Printers and
Faxes] (Imprimantes et Télécopies).

- Sous Windows 2000, cliquez sur [Start]
(Démarrer) et sélectionnez [Settings]
(Parametres) > [Printers] (Imprimantes).

8 Cliquez avec le bouton droit de la souris sur
I'icone OKI MC561 et sélectionnez [Printer
properties] (Propriétés de I'imprimante) >
[OKI MC561 (FAX)].

9 Sélectionnez I'onglet [Job Accounting]
(Comptabilisation des travaux).

10 Saisissez le nom d’utilisateur dans [User
Name] et le PIN (NIP) dans [Job Account ID]
(Code de comptabilisation des travaux).

11 Cliquez sur [OK].

Envoyer des télécopies a partir
de Windows

1 Ouvrez le fichier a faxer.

2 Dans le menu [File] (Fichier), sélectionnez
[Print] (Imprimer).

3 Sélectionnez le pilote de fax, puis cliquez
[Print] (Imprimer).

Authentification par Nom
d’utilisateur et Mot de passe

Activation du controle d’acceés par

Nom d’utilisateur/Mot de passe

Le contrdle d’accés est protégé par un mot de
passe : vous devez connaitre le mot de passe
administrateur pour continuer.

Remarque

Pour faire défiler les différentes sélections sur
I'affichage, appuyez sur la touche fléchée vers le
bas (ou vers le haut) de facon répétitive.

1 Appuyez sur <SETTING> (Paramétre) sur le
panneau de commande.

2 Utilisez la touche fléchée vers le haut pour
sélectionner [Admin Setup] (Configuration
Administrateur), puis appuyez sur <OK>.

3 Entrez votre mot de passe administrateur :
utilisez les touches fléchées pour sélectionner
les chiffres de votre mot de passe en
appuyant sur <OK> entre chaque chiffre.

4 Une fois la saisie de votre mot de passe
terminée, utilisez les touches fléchées jusqu’a
ce que [Enter] (entrer) s’affiche, puis appuyez
sur <OK>.

5 Utilisez la touche fléchée vers le haut pour
sélectionner [Management] (Gestion), puis
appuyez sur <OK>.

6 Utilisez la touche fléchée vers le bas pour
sélectionner [System Setup] (Configuration
du systéme), puis appuyez sur <OK>,

7 Vérifiez bien que Controle d'accés [Access
Control] est sélectionné, puis appuyez
sur <OK>,

8 Utilisez la touche fléchée vers le haut pour
sélectionner Utilisateur/Mot de passe comme
méthode de controle d’accés, puis appuyez
sur <OK>.

9 Utilisez la touche fléchée vers la gauche pour
revenir a |'écran principal.

Le contrble d’accés est activé.
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Exploitation a partir
d’un ordinateur

Remarque

Le type d’authentification spécifié sur I'ordinateur
est prioritaire a celui spécifié sur I'appareil.

Effectuer une impression a partir
de Windows

Remarque

Cette procédure se sert de NotePad et de
Windows 7 a titre d’exemple. Il se peut que les
procédures et les menus difféerent en fonction du
systéme d’exploitation que vous utilisez.

Ouvrez le fichier a imprimer.

2 Dans le menu [File] (Fichier), sélectionnez
[Print] (Imprimer).

3 Sélectionnez le pilote d’imprimante souhaité
dans [Select Printer], puis cliquez
[Preferences] (Préférences).

4 Cliquez sur l'onglet [Job Options] (Options
des travaux).

5 Cliquez sur [User Auth] (Auth. Utilisateur).

6 Cochez la case [Use User Authentication]
(Utiliser Authentification de I'utilisateur).

User Authentication (7 [
_" VI Hse User suthentication

User Authentication

Cancel

7 Saisissez le nom d’utilisateur sous [User
Name] et le mot de passe dans [Password].
Cliquer sur [Use Windows Login] (Utiliser le
nom utilisé pour 'ouverture des sessions
Windows) permet de saisir automatiquement
votre nom d’utilisateur sous Windows.

8 Cliquez sur [OK].
9 Cliquez sur [OK], puis sur [Print] (Imprimer).

Effectuer une impression a partir
d’un Mac

Remarque

Cette procédure utilise le Mac OS X 10.6 a titre
d’exemple. Il se peut que les procédures et les
menus difféerent en fonction du systeme
d’exploitation que vous utilisez.

Ouvrez le fichier a imprimer.

2 Dans le menu [File] (Fichier), sélectionnez
[Print] (Imprimer).

3 Sélectionnez les pilotes d'imprimante de
votre appareil.

4 Sélectionnez [UserAuth] (Auth. utilisateur) a
partir du menu sous les menus [Printer]
(Imprimante) et [Presets] (Préréglages).

&
Eagta)
®

Copies: [1 ] ¥ Collated [ Two-Sided

Pages: & Al
O From: 1 w1

Paper Size: | A4 ) 20990y 20.70em

Orientation: 'l T

The bundle "UserAuth” couldn’t be loaded because it doesn't
contain a version for the current architecture.

Cantact the bundie's creator listed hare for the latest version.

@ (Crore) [ Cancel ) (- Print)

5 Cochez la case [Use User Auth] (Utiliser
Authentification de I'utilisateur) sur le
panneau [UserAuth] (Auth.Utilisateur)

Cancel ) {EPrine )

6 Saisissez le nom d’utilisateur dans [User
Name] et le mot de passe dans [Password].

7 Cliquez sur [Print] (Imprimer).
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Envoyer des télécopies a partir
de Windows

Remarque

Cette procédure se sert de NotePad et de
Windows 7 a titre d’exemple. Il se peut que les
procédures et les menus different en fonction du
systéeme d’exploitation que vous utilisez.

Ouvrez le fichier a faxer.

2 Dans le menu [File] (Fichier), sélectionnez
[Print] (Imprimer).

3 Sélectionnez le (pilote de fax) de votre
appareil dans [Select Printer]
(Sélectionner I'mprimante), puis cliquez sur
[Preferences] (Préférences).

4 Dans l'onglet [Setup], cliquez sur [User Auth]
(Authentification Utilisateur).

5 Cochez la case [Use User Authentication]
(Utiliser Authentification de I'utilisateur).

6 Saisissez le nom d'utilisateur sous [User
Name] et le mot de passe dans [Password].

Remarque

Cliquer sur [Use Windows Login] (Utiliser le
nom utilisé pour 'ouverture des sessions
Windows) permet de saisir automatiquement
votre nom d’utilisateur sous Windows.

7 Cliquez sur [OK].
8 Cliquez sur [OK], puis sur [Print] (Imprimer).
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Configuration du télécopieur

Les parametres de base
pour telecopier

Vous devez configurer les paramétres suivants
avant d’émettre des télécopies.

Raccordement d'une
ligne téléphonique

Important!

N’utilisez que le fil téléphonique fourni avec
votre télécopieur. L'utilisation d’un autre fil
peut entrainer une défaillance.

Connexion pour télécopie uniquement

1 Insérez une extrémité du fil téléphonique
fourni dans la connexion LIGNE au dos de
I'appareil et I'autre dans une prise
téléphonique active.

2 Fixez le couvercle du connecteur livré avec
I'appareil a la connexion TEL au dos de |'appareil.

2

Connexion pour télécopieur
et téléphone

1 Insérez une extrémité du fil téléphonique
fourni dans la connexion LIGNE au dos de
I'appareil et |'autre dans une prise
téléphonique active.

2 Branchez le fil du téléphone dans la connexion

TEL, située au dos de |'appareil.
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Réglage de I’heure courante
et renseighements relatifs
a l'expéditeur

Remarque

Vous pouvez automatiquement définir I'heure et
la date en vous rendant sur la page Internet.
Pour connaitre les détails, reportez-vous au
Guide d'utilisation avancé disponible sur
www.my.okidata.com.

Remarque

Lors de I'utilisation des touches fléchées, appuyez
a plusieurs reprises sur la touche jusqu’a
atteindre la sélection.

1 Appuyez sur <SETTING> (Parameétre) sur le
panneau de commande.

2 Utilisez la touche fléchée vers le bas pour
sélectionner [Easy Setup] (Configuration
simplifiée), puis appuyez sur <OK>.

Setting
Wiew Information

Shutdown

3 Sidemandé, entrez le mot de passe de
I'administrateur, puis utilisez les touches
fléchées pour mettre en surbrillance [Enter]
(entrer) et appuyez sur <OK>.

4 Une fois [Date/Time Setting] (Parameétre
date/heure) mis en surbrillance, appuyez sur
la touche fléchée vers la droite.

o1 Date/Ti
2. Fax Setting
o 3 Metwork Setting

@ Ciancel

5 Utilisez la touche fléchée vers le bas pour
sélectionner le fuseau horaire adéquat, puis
appuyez sur la touche fléchée vers la droite.

Vous pouvez sélectionner un fuseau horaire
entre [-12:00] et [+13:00] en accroissements
de 15 minutes.

6 Utilisez la touche fléchée vers le bas pour
sélectionner [Not Summer Time] (heure
normale) ou [Now Summer Time] (heure
d’été) pour une économie d’énergie, puis
appuyez sur la touche fléchée vers la droite.

7 Utilisez la touche fléchée vers le bas pour
sélectionner [Manual] (Manuel), puis appuyez
sur la touche fléchée vers la droite.

8 Utilisez les touches fléchées vers le haut et vers
le bas pour régler I'année, le mois et le jour, le
fait d’appuyer sur la touche fléchée vers la
droite fait passer successivement d’un bloc a
I'autre. Une fois terminé, appuyez sur <OK>.

9 Utilisez les touches fléchées vers le haut et
vers le bas pour régler I'heure courante
(heure, minute, seconde), appuyer sur la
touche fléchée vers la droite fait passer
successivement d’un bloc a I'autre. Une fois
terminé, appuyez sur <OK>.

Le message « Le paramétrage de I’heure/date
s’est déroulé avec succés » s’affiche, suivi du
menu Configuration.

Indication des renseignements relatifs

a I'expéditeur
Spécifier le numéro de télécopie et le nom
d’expéditeur de votre appareil. Le code de
I'expéditeur est indiqué en haut de la télécopie
imprimée par le destinataire.

10 Utilisez la touche fléchée vers le bas pour
sélectionner [Fax Setting] (Paramétrage du
télécopieur), puis appuyez sur la touche
fléchée vers la droite.

e 1 Date/Time Setting

o 3 Metwork Setting
Cancel

11 Appuyez sur <OK> pour sélectionner
[FAX number] (Numéro du télécopieur).

12 A I'aide du clavier, saisissez le numéro de
votre télécopieur.

13 Une fois [Enter] (entrer) mis en surbrillance,
appuyez sur <OK>.

14 Appuyez sur la touche fléchée vers la
droite pour sélectionner [Sender ID] (code
de I'expéditeur).

15 Utilisez le clavier pour saisir votre code qui
peut comporter jusqu’a 22 caracteres. Une
fois le code saisi, utilisez les touches fléchées
pour mettre en surbrillance [Enter] (entrer) et
appuyez sur <OK>.
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Le message « Le paramétrage du télécopieur
s’est déroulé avec succés » s’affiche, suivi du
menu Configuration.

16 Appuyez sur <OK> pour terminer le
paramétrage, puis retournez a I'écran
principal a I'aide de la touche fléchée vers
la gauche.
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Installation USB

4 Abaissez le bouton de fermeture (1) sur le
Connexion USB cOté droit de I'appareil et retirez le couvercle
d’acces (2).

1 Préparez un céble USB.
Aucun cable USB n’est fourni avec votre appareil.

Utilisez un cdble USB 2.0 Haute vitesse pour
une connexion USB 2.0 Haute vitesse.

2 Fteignez votre appareil :

a) Appuyez sur <SETTING> (Paramétre) sur
le panneau de commande.

b) Appuyez sur la touche fléchée vers le bas de
facon répétitive jusqu’a sélectionner
[Shutdown] (Arrét), puis appuyez sur <OK>.

c) Quand le message de confirmation
s'affiche, appuyez sur la touche fléchée
vers la droite jusqu’a sélectionner [Yes]
(Oui), puis appuyez sur <OK>.

d) Quand un message vous demande
d’éteindre l'interrupteur d’'alimentation,
éteignez I'appareil.

3 Eteignez I'ordinateur.

ATTENTION!

Ne branchez pas le cable USB dans la
connexion réseau. Ceci peut entrainer
une défaillance.

102 - Frangais



5 Branchez une extrémité du cable USB dans le
port USB de l'appareil.

-

6 Bien attacher le cable USB sous le crochet (1)
de l'appareil.

7 Introduire les languettes du couvercle latéral
dans les fentes (1) du boitier de I'appareil et
remettez-le en place.

Pour les installations Windows,
rendez-vous a la page 103.

Pour les installations Macintosh,
rendez-vous a la page 105.

USB : Installer un pilote
d’imprimante pour Windows

e Vous devez étre connecté en tant
gu’administrateur pour réaliser cette procédure.

Remarque

La procédure ci-dessous utilise Windows 7 et
le modele MC561 a titre d’exemple. Il se peut
que l'affichage différe en fonction du

systeme d’exploitation.

1 Eteignez votre appareil :

a) Appuyez sur <SETTING> (Parametre) sur
le panneau de commande.

b) Appuyez sur la touche fléchée vers le bas de
facon répétitive jusqu’a sélectionner
[Shutdown] (Arrét), puis appuyez sur <OK>.,
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c) Quand le message de confirmation 7 Quand un message s’affiche et vous le
s’affiche, appuyez sur la touche fléchée demande, branchez le cable USB dans
vers la droite jusqu’a sélectionner [Yes] I'ordinateur et allumez votre appareil.
(Oui), puis appuyez sur <OK>.

d) Quand un message vous demande
d’éteindre l'interrupteur d'alimentation,
éteignez I'appareil.

2 Placez le DVD fourni avec votre appareil dans
|'unité de CD/DVD.

Le DVD se met en marche seul. Si ce n’est pas
le cas, double-cliquez sur le fichier de
configuration OKI dans le répertoire du DVD.

3 Sélectionnez votre langue dans la liste 8 Cliquez sur [Next] (Suivant).
déroulante, puis cliquez sur [Next] (Suivant). o
] _ o 9 Observez les directives a I'écran pour
4 Lisez le Contrat de licence, puis cliquez sur terminer l'installation.
[I Agree] (J'approuve). ] )
10 Une fois que I'écran [Complete] (Terminég)

5 Sous la configuration du pilote, cliquez sur s’affiche, cliquez sur Finish (Terminer).
[Install Drivers (MC561)] (Installer les
pilotes [MC561]). Vérifier I'installation
1 Cliquez sur [Start] (Démarrer) > [Devices

Remarque _ and Printers] (Périphériques et imprimantes).
Si la boite de dialogue [User Account Pour Windows Server 2008 et Windows Vista,
Control] (Controle du compte utilisateur) cliquez sur [Start] (Démarrer) > [Control
Windows Vista, cliquez sur [Continue]). [Printer] (Imprimante).

Pour Windows Server 2003 et Windows XP,

6 Lisez et observez les instructions, puis cliquez cliquez sur [Start] (Démarrer) > [Printers
sur [Next] (Suivant). and Faxes] (Imprimantes et Télécopies).
Sous Windows 2000, cliquez sur [Start]
L'installation commence. (Démarrer) > [Settings] (Parameétres) >

e Si la boite de dialogue [Windows Security] [Printers] (Imprimantes).

(Sécuritée Windows) s’affiche, cliquez sur 2 Vérifiez bien que I'icdne OKI MC561 s’affiche.
[Install this driver software anyway] (Installer . . fan .
Sur Windows 7, si vous avez deja installé

neanmoms ce logiciel pilote). _ d’autres pilotes, cliquez avec le bouton droit
* Sur Windows Server 2003 et Windows XP, de votre souris sur I'icone OKI MC561 et

si la boite de dialogue [Install Hardware] sélectionnez une des options du menu, puis
(Installer mateériel) s’affiche, cliquez sur
[Continue] (Continuer).

e Sur Windows 2000, si la boite de dialogue
[Digital Signature Not Found] (Signature
numérique non trouvée) s’affiche, cliquez sur
[Yes] (Oui).

104 - Francgais



vérifiez que tous les pilotes de I'imprimante
installés sont affichés dans le sous-menu.

See what's printing . ORI MCSELFR
St ae celaclt printer OKT MCSEL(POL XP5)
Printing preferences b OKIMCSELPCL)
Printer properties v 0K MCSELPS)
Delete print queue

Create shareut

Treubleibont

Remeve device

Propertie

Pour les systémes d’exploitation autres que
Windows, vérifiez que l'icbne représentant
chaque pilote est affichée.

3 Retirez le DVD de l'ordinateur.

L'installation est terminée.

Remarque

[Easy Install (Local)] (Installation facile [Locale])
est une méthode de configuration aisée. Si vous
souhaitez sélectionner un pilote a installer
manuellement, sélectionnez [Install printer driver
completely] (Installer le pilote de I'imprimante
totalement) et suivez les instructions qui
s’affichent a I'écran.

USB : Installer un pilote
d’imprimante pour Mac

Important!
e Seul le pilote pour imprimante PS est
disponible pour Mac.

e Désactiver le logiciel antivirus avant de
commencer cette procédure.

Pour Mac OS X 10.3.9 a 10.4.11

Remarque

La procédure ci-dessous utilise le Mac 0OS X
10.4.11 et le modéle MC561 a titre d’exemple.

1 Eteignez votre appareil :

a) Appuyez sur <SETTING> (Paramétre) sur
le panneau de commande.

b) Appuyez sur la touche fléchée vers le bas de
facon répétitive jusqu’a sélectionner
[Shutdown] (Arrét), puis appuyez sur <OK>.

c) Quand le message de confirmation
s’affiche, appuyez sur la touche fléchée

vers la droite jusqu’a sélectionner [Yes]
(Oui), puis appuyez sur <OK>.

d) Quand un message vous demande
d’éteindre l'interrupteur d’alimentation,
éteignez l'appareil.

Eteignez I'ordinateur.

Branchez une extrémité du cable USB dans le
port USB de I'appareil.

4 Allumez le Mac.

5 Insérez le DVD fourni avec votre appareil
dans l'ordinateur.

6 Double-cliquez sur l'icobne [OKI] >
dossier [Driver] (Pilote) > dossier
[Printer] (Imprimante).

7 Double-cliquez sur [Installer for Mac OS X]
(Installateur pour MAC OS X).

8 Entrez le nom de I'administrateur et son mot
de passe, puis cliquez sur [OK].

9 Observez les directives a I’écran pour
terminer l'installation.

10 Retirez le DVD pilote/manuel de l'ordinateur.

11 A partir du menu [Go] (Aller), sélectionnez
[Applications] > [Utilities] (Utilitaires), puis
double-cliquez sur [Printer Setup Utility]
(Utilitaire de configuration d‘imprimante).
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Important!

Si [Printer Setup Utility] (Utilitaire de
configuration d'imprimante) est déja lancé,
fermez-le et ouvrez-le de nouveau.

12 Cliquez sur [Add] (Ajouter).

Si la boite de dialogue [You have no printers
available] (Aucune imprimante disponible)
s'affiche, cliquez sur [Add] (Ajouter).

Remarque

Si le nom de votre appareil est déja affiché,
sélectionnez-le et cliquez sur [Delete]
(Supprimer), puis sur [Add] (Ajouter).

13 Sélectionnez le nom de I’'USB attribué a votre
appareil, puis vérifiez que le nom de votre
appareil s’affiche dans [Print Using]
(Imprimer en utilisant).

[SXGNs) Printer Browser =
i (T
et 8 a-
b= =
Default Browser | | IP Printer Search
Printer Name &| Connection
_> MC561 USE m

Name: MC561

Location: Administrater’s iMac

Print Using: . OKI MC561(PS) X ]

@

( More Printers... ) ( Add )

BN

14 Cliquez sur [Add] (Ajouter).

15 Si la fenétre [Installable Options] (Options
installables) s'affiche, cliquez sur [Continue].
Si vous avez déja installé des options avant
I'installation du pilote, configurez chaque
élément, puis cliquez sur [Continue].

16 Vérifiez que le nom de votre appareil soit bien
affiché dans [Printer List] (Liste des
imprimantes), puis fermer la fenétre.

L'installation est terminée.

Pour Mac OS 10.5 et 10.6

Remarque

La procédure ci-dessous utiliser le Mac OS X 10.6
(Snow Leopard) et le modéle MC561 a

titre d’exemple.

1 Vérifiez que votre appareil ainsi que votre
ordinateur sont bien allumés.

2 Branchez une extrémité du cable USB dans le
port USB de l'appareil.

3 Insérez le DVD fourni avec votre appareil
dans l'ordinateur.

4 Double-cliquez sur I'icone [OKI] >
dossier [Driver] (Pilote) > dossier
[Printer] (Imprimante).

5 Double-cliquez sur [Installer for Mac OSX]
(Installateur pour MAC OSX).

6 Entrez le nom de I'administrateur et son mot
de passe, puis cliquez sur [OK].
Observez les directives - a I’écran pour
terminer l'installation.

7 Retirez le DVD pilote/manuel de 'ordinateur.

A partir du menu Apple, sélectionnez
[System Preferences] (Préférences systéme).
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9 Cliquez sur [Print & Fax] (Imprimer
et télécopier).

10 Cliquez sur [+].

11 Sélectionnez le nom de I’'USB attribué a votre
appareil, puis vérifiez que le nom de votre
appareil s’affiche dans [Print Using]
(Imprimer en utilisant).

Add Printer =
Q
Printer Name &|Kind |
_> OKI DATA CORP MC561 USB

Name: OKI DATA CORP MC561
Location: Administrator’s iMac

Print Using: OKI MC561(PS)

Add

12 Cliquez sur [Add] (Ajouter).

13 Si la fenétre [Installable Options] (Options
installables) s’affiche, cliquez sur [Continue].
Si vous avez déja installé des options avant
I'installation du pilote, configurez chaque
élément, puis cliquez sur [Continue].

14 Vérifiez que le nom de votre appareil soit bien
affiché dans [Printer List] (Liste des
imprimantes), puis fermer [Print & Fax]
(Imprimer et télécopier).

L'installation est terminée.
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Setup Form (Formulaire de configuration)

Exemple

Votre valeur

A-1 Mot de passe administrateur pour votre appareil | aaaaaa (paramétre
par défaut)
A-2 Adresse IP de votre appareil : 192.168.0.2

: fonctions de Numérisation vers Courriel et Télécopie Internet

B-1 Adresse électronique de votre appareil (jusqu’a | mc561@test.com
80 caractéres)

B-2 Adresse du serveur SMTP smtp.test.com

B-3 Adresse du serveur POP3 pop3.test.com

B-4 Méthode d’authentification SMTP

B-5 SMTP User ID (Code de |'utilisateur SMTP) OKIMC561

B-6 Mot de passe SMTP okimc561

B-7 POP User ID (CODE utilisateur POP) User [Utilisateur]

B-8 POP Password (Mot de passe POP) okimc561

B-9 Nom du destinataire du courriel User [Utilisateur]

B-10 | Adresse électronique du destinataire du courriel | user@test.com

C : Scan to Network PC (Numérisation vers PC en réseau)

(jusqu’a 64 caractéres)

C-1 Nom de l'ordinateur destinataire PC1

C-2 Nom d’utilisateur pour se connecter a I'ordinateur | mc561
de destination (jusqu’a 32 caractéres)

C-3 Mot de passe pour se connecter a l'ordinateur de | mc561
destination (jusqu’a 32 caracteres)

C-4 Nom de profil pour enregistrer les paramétres Ventes
(jusqu’a 16 caractéres)

C-5 Nom du dossier partagé de 'ordinateur de SalesDev
destination (jusqu’a 64 caracteres)

C-6 Nom de fichier des données numérisées ScanData
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Instalacion de hardware

Contenido de la caja Prepare el lugar

Requisitos medioambientales

e Temperatura: 10 a 32 °C (50 a 89,6 °F)

e Humedad: 20 a 80% HR (humedad relativa)
Si instala su equipo en un lugar donde la

humedad es menor al 30% de HR, utilice un
humidificador o un tapete antiestatico.

e Temperatura maxima de termémetro hiumedo:
25 °C (77 °F)
Tenga cuidado con la condensacién. Puede
provocar un funcionamiento incorrecto.

Requisitos de espacio

Equipo

DVD

Cable de alimentacidn

Cable de teléfono

Tapa del conector del teléfono

1
2
3
4
5

Requisitos de energia
e 110-127 V CA 0 220-240 V CA
* 50/60 Hz

e Maximo de 1100 vatios

Nota

Los cables USB y Ethernet no vienen con su
equipo y deben comprarse por separado.

Le recomendamos que guarde los materiales iImportante!
de embalaje, son necesarios para transportar No conecte este equipo a un suministro de
el equipo. energia ininterrumpible (UPS).

Si la fuente de energia es inestable, utilice
un regulador de voltaje.
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2 Retire los materiales de embalaje externos.

Desempacar la maquina

iImportante!
Se necesitan al menos dos personas para
levantar el equipo en forma segura.

3

Nota

Las siguientes ilustraciones son descriptivas. Los
materiales de embalaje o la cinta reales podrian
variar un poco respecto de las ilustraciones.
Guarde los materiales de embalaje, son
necesarios para transportar el equipo.

1 Saque su equipo de la caja y coloquelo en el
lugar donde sera instalado.

4 Abra la cubierta del ADF y retire todo el
material protector.
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10 Presione el botdn de liberacion de la cubierta

5 Levante la bandeja de documentos y retire

(1) y abra la cubierta superior (2).

todo el material protector.

6 Baje la bandeja de documentos y cierre la

cubierta del ADF.

7 Abra la tapa del tope de vidrio (1) y retire el

material protector y la hoja protectora.

I, no deje el tambor de

de 1500 lux
aproximadamente). Incluso bajo la luz

as
interior norma

7

!

imagen expuesto por mas de 5 minutos.
cartuchos de téner.

muy delicado. Maniptlelo con cuidado.
e No exponga el tambor de imagen a la luz
directa del sol o a una luz interna muy

brillante (m
11 Retire la cinta y el material de empaque de los

e El tubo verde del tambor de imagen es

Cuidado

i

8 Cierre la tapa de documentos.

9 Abra la unidad del escaner y retire todo el

material protector.
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14 Cierre con cuidado la cubierta superior y la

12 Presione la palanca azul (1) de la unidad de

unidad del escéner.

fusor en el sentido de la flecha y retire y

guarde el tope anaranjado (2).

P, luego abra

15 Quite la cinta de la bandeja M

(2), luego cierre la bandeja MP.

la bandeja.

izquierda en cada cartucho de téner hasta que

se detenga.

Conserve el tope anaranjado, sera necesario
si alguna vez debe transportar el equipo.
13 Deslice el cilindro de bloqueo azul hacia la

iImportante!
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5 Encienda la impresora.

Como encender el equipo

1 Asegurese de que el interruptor de r
encendido (en la parte derecha del equipo)
esté apagado <O>.

Como apagar la maquina

iCuidado!

No apague de repente el interruptor: esto
podria ocasionar dafos a su equipo. Siga
siempre el procedimiento correcto para
asegurarse de que no se pierdan datos.

1 Presione <SETTING> (Configuracion) en el
panel de control.

| ¥

e oo

2 Enchufe el cable de alimentacién en la toma
de alimentacion que se encuentra en la parte
posterior de su equipo.

2 Presione varias veces la tecla de la flecha
hacia abajo para seleccionar [Shutdown]
(Apagado) y luego presione <OK> (Aceptar).

Setting

Store Document Settings
Wiew Information

Shutdown

®

3 Enchufe el cable de alimentacion en 3 Cuando aparezca el mensaje de confirmacion,
un tomacorriente con conexion a presione la tecla de la flecha hacia la derecha
tierra adecuado. para seleccionar [Yes] (Si) y luego presione

<OK> (Aceptar).

4 Cuando aparezca la pantalla que le indique
apagar el interruptor, apague la maquina.

=i

4 Asegurese de que no haya documentos en el ,
tope de vidrio o en el ADF y que la cubierta
del ADF esté cerrada.
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Modo de ahorro de energia y
Modo de suspension

Nota

Consulte la Guia basica del usuario en linea en
el DVD que viene con su equipo para obtener
mas informacion.

Tecla de ahorro de energia

o C O C O C D C D

C O O CHO CH C D

o] oo QK

Si no utiliza su equipo durante 30 minutos

(el valor predeterminado de fabrica), el equipo
automaticamente se ajusta en el modo de ahorro
de energia para reducir el consumo de energia.

Para entrar (o salir) del modo de ahorro de
energia manualmente, debe presionar
<POWER SAVE> (Ahorro de energia) en

el panel de control.

El panel de control

L eoo) | =

lololo) ;
LIS EET 0 &
Para obtener informacion sobre
¢ ¢l panel de control
e escribir o borrar texto o datos

consulte la Guia basica del usuario en linea en el
DVD que viene con su equipo.

Cargar el medio de impresion

Para obtener mas informacién sobre los medios
de impresién, consulte la Guia basica del usuario
en linea en el DVD que viene con su equipo.

Bandejas disponibles

1 Bandejal

2 Bandeja multiuso MP
3 Bandeja 2 (opcional)

Valores de peso seleccionables

Peso
Designacion

US Bond Métrico
Light (Claro) 17 a 18 Ib. 64 a 74 g/m?2
Medium Light 20 a 21 Ib. 75 a 82 g/m?
(Medio ligero)
Medium (Medio) 22 a 28 Ib. 83 a 104 g/m?
Heavy (Pesado) 28 a 32 Ib. 105 a 120 g/m?
Ultra Heavyl 32 a47lb. 121 a 176 g/m?2
(Ultrapesadol)
Ultra Heavy2 47 a 58 Ib. 177 a 220 g/m?
(Ultrapesado2)

Como cargar papel: bandejaly
bandeja 2 opcional

Bandeja 1
e Capacidad de hasta 250 hojas de papel de
75 g/m? (US Bond de 20 Ib).

e Tamafos utilizables: carta, legal 13/13,5/14,
ejecutivo, A4, A5, A6, B5, 16K, personalizado

e Gramaje del papel: 64 a 176 g/m? (US Bond de
17 a 47 1b)
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Bandeja 2 (opcional) 3 Ajuste el tope para papel (1) segtln la
e Capacidad de hasta 530 hojas de papel de Iongl_tud del papel: presione he_1C|a at?gjo con
75 g/m?2 (US Bond de 20 Ib) suavidad sobre la palanca de liberacion azul
g ) (2), luego deslice el tope para papel hasta la

* Tamafios utilizables: igual que la bandeja 1, longitud del papel que desea cargar. La

a excepcion del A6 longitud seleccionada se mostrara en la
e Gramaje del papel: igual que la bandeja 1 ventana de visualizacion (3).
iImportante!

Antes de imprimir en papel de tamaiio
personalizado, debe definir el tamaio en el
controlador de la impresora. Consulte la
pagina 118.

El siguiente procedimiento muestra la carga de
papel en la bandeja 1. El procedimiento para la
bandeja 2 es el mismo.

1 Saque la bandeja de papel.

Nota

Si carga papel legal, debe deslizar el tope

para papel mas alla del extremo de la bandeja.
Para papel legal 14, deslicelo hacia afuera

todo lo posible (aproximadamente 64 mm

[2,5 pulgadas]). Las configuraciones para papel
legal 13, legal 13,5 y legal 14 apareceran en la
ventana del tope para papel cuando esté colocado
correctamente.

2 Deslice las guias de ancho del papel al ancho
del papel que desea cargar.

4 Flexione el papel hacia atras y hacia adelante,
y luego abaniquelo. Ordene los bordes de la
pila de papel sobre una superficie nivelada.
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5 Cargue el papel con el lado de impresidn cara
abajo. Mantenga la pila por debajo de la linea
de capacidad (1).

6 Ajuste las guias de ancho del papel y el tope
para papel de manera que quede ajustado al
papel, sin apretarlo.

7 Empuje la bandeja de papel hacia la
impresora hasta que se detenga.

8 Defina las configuraciones de la bandeja en el
menu del equipo. Consulte “Establecer la
configuracion de la bandeja” en la pagina
117.

Cargar papel en la
bandeja multiuso
e Capacidad de hasta 100 hojas de papel de
75 g/m? (US Bond de 20 Ib), hasta 10 sobres.

e Tamafos utilizables: carta, legal 13/13,5/14",
ejecutivo, A4, A5, A6, B5, C5, DL, Com-9,
Com-10, sobres Monarch, tarjetas indice
8 x 13 cm (3 x 5 pulgadas), papel de foto
10 x 15 cm (4 x 6 pulgadas) o 13 x 18 cm
(5 x 7 pulgadas), pancartas de hasta 1320 mm
(52 pulgadas de largo), personalizado

e Gramaje del papel: 64 a 220 g/m? (US Bond de
17 a 58 Ib)

iImportante!

Antes de imprimir en papel de tamano
personalizado, debe definir el tamaiio en el
controlador de la impresora. Consulte la
pagina 118.

1 Baje la bandeja MP.

]

7

2 Extraiga el soporte de papel y el
soporte secundario.
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3 Ajuste las guias de alimentacién del papel al
ancho del papel que desea cargar.

4 Inserte el papel con el lado de impresién cara
abajo hasta que el borde toque la entrada de
alimentacion del papel, luego ajuste la
posicidon de las guias de alimentacion.

Nota

Cargue los sobres con el borde corto hacia el
equipo, la solapa hacia abajo y hacia la derecha.

5 Presione el botdn de sujecion de la bandeja.

6 Registre el papel cargado en su equipo.
Ver “Establecer la configuracion de la
bandeja” en pagina 117.

Nota

e No coloque papel por encima de la linea
de capacidad.

¢ No cargue papel de diferentes tipos,
tamafos o pesos al mismo tiempo.

e Cuando agregue papel, quite el papel de la
bandeja MP, ajuste los bordes de ambas
pilas de papel y carguelo nuevamente.

¢ No coloque otra cosa que no sea papel de
impresion. No presione demasiado la
bandeja MP.

Como imprimir el informe
de configuracion

Puede verificar la informacion detallada de su
equipo, como la configuracion y el estado, al
imprimir el informe de configuracién.

1 Presione <SETTING> (Configuracion) en el
panel de control.

2 Utilice la tecla de la flecha hacia abajo para
seleccionar [Reports] (Informes) y luego
presione <OK> (Aceptar).

3 Utilice la tecla de la flecha hacia abajo para
seleccionar [Configuration] (Configuracion) y
luego presione <OK> (Aceptar).

4 Cuando aparezca el mensaje de confirmacion,
presione la tecla de la flecha hacia la
izquierda o la derecha para seleccionar [Yes]
(Si) y luego presione <OK> (Aceptar).

Establecer la configuracion
de la bandeja

Medios de impresion de
tamano estandar

Nota

Para desplazarse en la lista de selecciones de la
pantalla, presione varias veces la tecla de la
flecha hacia abajo.

1 Presione <SETTING> (Configuracién) en el
panel de control.
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Utilice la tecla de la flecha hacia abajo para
seleccionar [Paper Setup] (Configuracion del
papel) y luego presione <OK> (Aceptar).

Setting

Paper Setup

Address Book

Utilice la tecla de la flecha hacia abajo
para seleccionar la bandeja de papel
correspondiente, luego presione
<OK> (Aceptar).

Utilice la tecla de la flecha hacia abajo para
seleccionar [Paper Size] (Tamafo del papel) y
luego presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia abajo para
seleccionar el tamafio del papel cargado,
luego presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia abajo para
seleccionar [Media Type] (Tipo de medio) y
luego presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia abajo para
seleccionar el tipo de medio cargado, luego
presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia abajo para
seleccionar [Media Weight] (Peso del medio) y
luego presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia abajo para
seleccionar el peso del papel cargado, luego
presione <OK> (Aceptar).

Nota

Para la bandeja 1 y la bandeja 2, puede
configurar la configuracion [Custom]
(Personalizado) sélo cuando [Paper Size]
(Tamafio del papel) esta definido en [Custom]
(Personalizado).

Siga los pasos 1 al 3 que se observan a
la izquierda.

Utilice la tecla de la flecha hacia abajo para
seleccionar [Custom] (Personalizado) y luego
presione <OK> (Aceptar).

Introduzca el valor deseado en la casilla Width
(Ancho) mediante el uso del teclado.

Tray 1:Paper Size
Width Length

05-216) 145-356)
mm mm
Oancel

Presione la tecla de la flecha hacia la derecha
para pasar a la casilla Length (Longitud),
luego introduzca el valor mediante el uso

del teclado.

Presione <OK> (Aceptar).

Medios de impresion de

tamano personalizado

Para cargar papel de tamafio personalizado, debe
registrar el ancho y la longitud del papel antes

de imprimir.
Bandeja Tamaios disponibles
Bandeja 1 Ancho:
105 a 216 mm (4,1 a 8,5 pulgadas)
Longitud:
148 a 356 mm (5,8 a 14 pulgadas)
Bandeja 2 Ancho: igual que la bandeja 1
(opcional) Longitud:
148 a 356 mm (8,3 a 14 pulgadas)
Bandeja Ancho:
multiuso MP 64 a 216 mm (2,5 a 8,5 pulgadas)
Longitud:
127 a 1321 mm (5 a 52 pulgadas)
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e Esta salida proporciona el trayecto recto que

Salidas de impresién necesitan los medios como papel pesado,
transparencias, sobres y etiquetas.

e Tiene una capacidad de 100 hojas de papel de

iImportante! _ _ 75 g/m? (US Bond de 20 Ib).

No abra ni cierre la salida posterior + También tiene capacidad para 10 sobres.

(apiladora cara arriba) mientras el equipo

esta imprimiendo ya que puede ocasionar Tire de la salida posterior en la parte trasera

un atasco de papel. del equipo y abrala hacia usted.

[y

Usar la salida superior
(apiladora cara abajo)

La salida superior (apiladora cara abajo) es la
predeterminada. Esta se habilita cuando la salida
posterior esta cerrada.

e Entrega los documentos con el lado de
impresion cara abajo.

e Tiene una capacidad de hasta 150 hojas de
papel de 75 g/m? (US Bond de 20 Ib).

Usar la salida posterior
(apiladora cara arriba)

La salida posterior se habilita cuando se abre.

e Entrega los documentos con el lado de
impresion cara arriba.
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Como colocar documentos
para escanear

Puede utilizar el alimentador automatico de
documentos (1) o el tope de vidrio (2) para
cargar documentos para copia, escaneo o fax.

Requisitos de documento

Para obtener informacion sobre los requisitos de
documento, consulte la Guia basica del usuario
en linea en el DVD que viene con su equipo.

Como cargar documentos en el
Alimentador automatico de

documentos (ADF)

e Papel carta, legal 13/13,5/14, ejecutivo, A4,
A5, A6, B5.

e Capacidad de 50 hojas de papel de 75 g/m?
(US Bond de 20 Ib).

e Cargue los documentos cara arriba.

iImportante!

Si hay pegamento, tinta o liquido corrector
en los documentos, aseglrese de que estén
completamente secos antes de cargarlos.

1 Cargue los documentos en el ADF.

a) Cargue los documentos de retratos con el
borde superior primero.

b) Cargue los documentos de paisajes con el
borde izquierdo primero.

2 Ajuste las guias del documento de acuerdo al
ancho de las paginas.

G222

7% 22

<
NG
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como cargar documentos en el 3 Cierre la tapa del tope de vidrio con cuidado.
tope de vidrio

e Papel carta, ejecutivo, A4, A5, A6, B5. Nota
» Puede utilizarse para documentos de hasta Si desea utilizar las funciones [N-in-1] (N-en-1),
20 mm (0,78 pulgadas) de grosor. [Sort] (Ordenar) o [DuplexCopy] (CopiaDupl.),

cambie la configuracion [Document Direction]

iImportante! (Direccién del documento) de acuerdo con la

Si hay pegamento, tinta o liquido corrector direccién de su documento para obtener la

en los documentos, asegurese de que estén impresion que desea. La configuracion

completamente secos antes de cargarlos. predeterminada es [Portrait] (Retrato).

1 Levante y abra la tapa del tope de vidrio.

2 Coloque un documento cara abajo en el tope
de vidrio.

a) Si su documento es un retrato, alinee el
borde superior con la esquina superior
izquierda del vidrio.

b) Si su documento es un paisaje, alinee el
borde derecho con la esquina superior
izquierda del vidrio.

121 - Espaiiol



Instalacion en redes:

Como hacer conexiones e instalar los

controladores de la impresora

Sistemas operativos
compatibles

Configurar la conexion
de red

Su equipo es compatible con los siguientes
sistemas operativos:

Windows

e Windows 7

e Windows 7 64-bit Edition

e Windows Server 2008 R2 64-bit Edition
e Windows Server 2008

e Windows Server 2008 64-bit Edition
e Windows Vista

e Windows Vista 64-bit Edition

e Windows Server 2003

e Windows Server 2003 x64 Edition

e Windows XP

e Windows XP x64 Edition

e Windows 2000

Macintosh
e Mac OS X 10.3.9 a 10.6.

iImportante!

Los usuarios de Mac OS X 10.6 Intel PC
deben instalar Rosetta antes de instalar el
controlador de la impresora.

iImportante!

Debe conectar su maquina a una red con un
cable Ethernet adecuado antes de instalar el
controlador de la impresora.

Nota

El concentrador y el cable Ethernet no vienen con
su maquina. El cable Ethernet debe ser de
categoria 5, par trenzado y recto.

@

1 Apague su maquina:
a) Presione <SETTING> (Configuracion) en el
panel de control.

b) Utilice la tecla de la flecha hacia abajo para
seleccionar [Shutdown] (Apagado) y luego
presione <OK> (Aceptar).

¢) Cuando aparezca el mensaje de
confirmacion, presione la tecla de la flecha
hacia la derecha para seleccionar [Yes]
(Si) y luego presione <OK> (Aceptar).

d) Cuando se le indique, apague la maquina.

2 Apague la computadora.
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5 Asegure el cable Ethernet debajo del gancho
(1) de la maquina.

3 Presione el sujetador (1) en el costado
derecho de la maquina y retire la tapa
de acceso (2).

las ranuras (1) de la caja de la maquina y

6 Ajuste las lenglietas sobre la tapa lateral en
calce la tapa en su lugar.

///. N
N -

,, -ﬂ%ﬂ%@
M‘I’.v’lvv '.m. 5

en la conexién LAN que se encuentra en

4 Enchufe un extremo del cable Ethernet
la maquina.

7 Conecte el concentrador a una computadora,

luego enchufe el otro extremo del cable

Ethernet en el concentrador.

f

|

5 =i
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Buscar la pagina
de configuracion

No | ftem Ejemplo Su valor

B-4 |Método de Autenticaciin sMTP

B-5 |ID de usuario EMTP OKIMCSEL

B-6 | Claus SMTP akimese L

ambre de s can
computadora de d
€6 [ Mombre de ardiva de datos escaneadus Scanbata
(hasta 64 < 5]

Encontrara una pagina de configuracién en 160.

Puede utilizar esta pagina para registrar la

informacion necesaria sobre la configuracion de
su red y consultarla cuando configure la maquina

para que funcione en red.

Configurar la contrasena del

administrador

Nota
Si utiliza las teclas de flecha para realizar

selecciones, presidnelas varias veces para buscar

la opcidn que desea seleccionar.

1 Presione <Setting> (Configuracién) en el
panel de control.

e oo W)
0 OO®
(D))

Utilice la tecla de la flecha hacia abajo
para seleccionar [Admin Setup]
(Configuracion del administrador) y luego
presione <OK> (Aceptar).

Admin Password J
B. 1\ -+#%x=_123[
qwertyuiopdbée
asdfghjkIITBQ
zxcvbnm 0 B || Enter

Utilice la tecla de la flecha hacia abajo para
seleccionar [a] y luego presione <OK>
(Aceptar) seis veces para ingresar la
contrasefia predeterminada: aaaaaa.

Utilice las teclas de flecha para seleccionar la
opcién [Enter] (Intro) en la pantalla y
presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia arriba para
seleccionar [Management] (Administracion) y
luego presione <OK> (Aceptar).

Utilice la tecla de la flecha hacia arriba para
seleccionar [Admin Password] (Contrasefia
del administrador) y luego presione

<OK> (Aceptar).

Utilice las teclas de flecha para seleccionar
los digitos de su contrasefia y presione
<OK> (Aceptar) después de cada digito.

Cuando haya terminado de ingresar su
contrasefia nueva, utilice las teclas de flecha
para seleccionar la opcion Enter (Intro) en la
pantalla y presione <OK> (Aceptar).

Nota

La contrasefa del administrador debe tener al
menos seis digitos, y es sensible a mayusculas
y minusculas.

Cuando haya ingresado todos los digitos,
utilice las teclas de flecha para seleccionar la
opcion [Enter] (Intro) en la pantalla y
presione <OK> (Aceptar).

10 Utilice la tecla de la flecha hacia la izquierda

para volver a la pantalla principal.

11 Escriba la contrasefia del administrador en la

linea A-1 de la pagina de configuracion.
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Configurar la red para
sistemas Windows

Para finalizar la conexion de red en una
computadora Windows, primero configure las
direcciones IP para la computadora y la maquina;
y luego instale los controladores de la impresora
en la computadora.

Configurar la direccion IP, si

€S necesario

Si su red cumple con cualquiera de las siguientes
condiciones, se asigna una direccién IP a la

computadora y a la maquina de forma automatica.

e Servidor DHCP o BOOTP en la red
e Plug-and-Play universal

Si todas las computadoras conectadas a la
red tienen

e Windows 7

Windows Vista

Windows XP

Windows 2000

Windows Server 2008 R2

Windows Server 2008

Windows Server 2003

0 su router es compatible con
Plug-and-Play universal,

se asignara automaticamente una direcciéon IP a
la computadora y a la maquina, incluso si no
hay un servidor DHCP/BOOTP en la red.

Si la red no cumple con las condiciones anteriores,
0 si su administrador de redes o proveedor de
servicios de Internet especifica una direccion IP
Unica para la computadora y su maquina,
configure la direccion IP de forma manual.

Informacion general

e Para completar este procedimiento, debe
introducir la contrasefia del administrador.

e Cuando configure una direccion IP de forma
manual, pregunte al administrador de redes o a
su proveedor de servicios de Internet qué
direccién IP utilizar. Si la direccién IP no se
configura de la forma correcta, la red podria
quedar incomunicada o el acceso a Internet
podria desactivarse.

Nota

Si configura una red pequefia compuesta de su
maquina y otra computadora, establezca la
direccion IP como se muestra a continuacién
(seguin RFC1918):

Para la computadora
IP address (Direccion IP): 192.168.0.1 a 254

Subnet mask (Mascara

de subred): 255.255.255.0

Default gateway (Puerta de
enlace predeterminada):

DNS server (Servidor DNS):

no se utiliza
no se utiliza
Para la maquina

IP address Set (Ajuste de
direccion IP): Manual

192.168.0.1 a 254
(seleccionar un valor diferente
para la computadora)

IP address (Direccion IP):

Subnet Mask (Mascara

de subred): 255.255.255.0
Default Gateway (Puerta de
enlace predeterminada): 0.0.0.0

Network Scale (Escala de red): Pequefia

Para establecer [Network Scale] (Escala de red):

e Presione <SETTING> (Configuracion) en
el panel de control.

e Seleccione [Admin Setup] (Configuracion
del administrador) > [Network Menu]
(Menu de red) > [Network Setup]
(Configuracién de la red) > [Network
Scale] (Escala de red).

Configurar la direccion IP de
su computadora

iImportante!

Si ya conoce la direccion IP de su
computadora, vaya a la préxima seccién
“Configurar la direccion IP de su maquina”.

El siguiente procedimiento utiliza Windows 7
como ejemplo. Las imagenes de la pantalla
pueden variar segun el sistema operativo.

1 Encienda la computadora.

2 Haga clic en [Start] (Inicio) > [Control Panel]
(Panel de control) > [View network status and
tasks] (Ver el estado y las tareas de red).

e En Windows Server 2003, haga clic en
[Start] (Inicio) > [Control Panel] (Panel de
control) > [Network Connections]
(Conexiones de red) > [Local Area
Connection] (Conexién de area local).
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e En Windows XP, haga clic en [Start] (Inicio) >
[Control Panel] (Panel de control) > [Network
and Internet Connections] (Conexiones de
red e Internet) > [Network Connections]
(Conexiones de red).

e En Windows 2000, haga clic en [Start]
(Inicio) > [Settings] (Configuracién) >
[Network and Dial-up Connections]

(Conexiones de red y de acceso telefénico).

Seleccione [Change adapter settings]
(Cambiar configuracion del adaptador).

e En Windows Server 2008 y Windows Vista,
seleccione [Manage network connections]
(Administrar conexiones de red).

e En Windows Server 2003, Windows XP y
Windows 2000, omita este paso.

Haga doble clic en [Local Area Connection]
(Conexién de area local).

e En Windows Server 2003, omita este paso.

Haga clic en [Properties] (Propiedades).

Si aparece el cuadro de didlogo [User Account
Control] (Control de la cuenta del usuario),
haga clic en [Yes] (Si). En Windows Vista,
haga clic en [Continue] (Continuar).

Seleccione [Internet Protocol Version 4
(TCP/1IPv4)] (Protocolo Internet Version 4
[TCP/IP]) y luego haga clic en
[Properties] (Propiedades).

r ~
U Local Area Connection Properties &J

MNetworking

Connect using:

LF Atheros ARS121/ARS113/ARS114 PCI-E Bthemet Contro

This connection uses the following items:

"% Cliert for Microsoft Networks

@QDS Packet Scheduler

E; File and Printer Sharing for Microsoft Networks
- |rtemet Protocol Version & (TCP/IPvE)

i Link-Layer Topology Discovery Mapper /0 Driver
-4 Link-Layer Topology Discovery Responder

Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected netwarks.

[ ok || cancel |

A

e En Windows Server 2003, Windows XP y
Windows 2000, seleccione [Internet
Protocol (TCP/IP)] (Protocolo de Internet
[TCP/IP]) y luego haga clic en
[Properties] (Propiedades).

7 Si configura una direccion IP de forma
manual, introduzca la direccién IP, la
mascara de subred, la puerta de enlace
predeterminada y el servidor DNS, y luego
haga clic en [OK] (Aceptar).

Internet Protocel Version 4 (TCP/IPv4) Properties @Iéj
General

‘fou can get IP settings assigned automatically if your network supports
thiz capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

~) Obtain an IP address automatically
@) Use the following IP address:

P P address: 192 .168 . 0 . 3
> Subnet mask: 255 ,255.255. 0
} Default gateway: 192.168. 0 . 1

Obtain DNS server address automatically
@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit

Advanced...

[ OK ]l Cancel |

¢ Si necesita obtener una direccion IP del
servidor DHCP de forma automatica,
seleccione [Obtain an IP address
automatically] (Obtener una direccion IP
automaticamente) y luego haga clic en
[OK] (Aceptar).

iImportante!

No introduzca una puerta de enlace
predeterminada ni un servidor DNS si no
son necesarios.

8 Cierre la ventana abierta.

Configurar la direccion IP de
su maquina

1 Encienda su maquina.

2 Presione <SETTING> (Configuracion) en el
panel de control.

3 Utilice la tecla de la flecha hacia abajo para
seleccionar [Easy Setup] (Configuracién facil)
y luego presione <OK> (Aceptar).

Wiew Information
Shutdown

4 Introduzca la contrasefia del administrador.

Consulte la linea A-1 de su pagina
de configuracién.
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5 Utilice las teclas de flecha para
seleccionar [Enter] (Intro), luego presione
<OK> (Aceptar).

6 Utilice la tecla de la flecha hacia abajo para
seleccionar [Network Setting] (Configuracién
de la red), luego presione la tecla de la flecha
hacia la derecha.

7 Sidesea configurar una direcciéon IP de forma
manual, utilice la tecla de la flecha hacia
abajo para seleccionar [Manual] (Manual);
luego presione <OK> (Aceptar).

> Setting of Metwork

hanual

Auto

®

Si desea obtener una direccion IP de forma
automatica, seleccione [Auto] (Automatico) y
vaya a “Install the Printer Driver for Windows”
(Instalar el controlador de la impresora

para Windows).

8 Utilice la tecla de la flecha hacia la derecha
para pasar de una casilla a la otra casilla e
introduzca la informacién correspondiente en
cada casilla mediante el uso del teclado, luego
presione <OK> (Aceptar).

3. Basic Setting of Network

9 Introduzca el servidor DNS vy el servidor WIN
Si son necesarios.

Si no los necesita para su conexion de red,
presione <OK> (Aceptar) hasta que aparezca
el mensaje emergente.

10 Presione <OK> (Aceptar) para finalizar
la configuracion.

Instalar los controladores de la

impresora para Windows

Puede instalar varios controladores a la vez.
Controladores seleccionables para cada modelo:
e PCL

e PS

e FAX

Cuando instale los controladores, el programa
también instala automaticamente el controlador
TWAIN requerido para escanear, asi como las

utilidades Network Extension (Extension de red)
y Color Swatch (Muestrario de colores).

Nota

El siguiente procedimiento utiliza Windows 7
y el modelo MC561 como ejemplo. El
procedimiento en si puede variar un poco
segun el sistema operativo.

1 Asegurese de que su computadora esté
encendida y conectada a la maquina a través
de la red.

2 Inserte el DVD que vino con su maquina en la
unidad de CD/DVD.

El DVD se ejecuta automaticamente. Si no lo
hace, haga doble clic en el archivo de
configuracion OKI en el directorio DVD.

3 Seleccione su idioma de la lista desplegable y
haga clic en [Next] (Siguiente).

4 Lea el Contrato de licencia, luego haga clic en
[I Agree] (Acepto).

5 En la configuracién del controlador, haga clic
en [Install Drivers (MC561)] (Instalar
controladores [MC561]).

Nota

Si aparece el cuadro de didlogo

[User Account Control] (Control de la
cuenta del usuario), haga clic en [Yes] (Si).
En Windows Vista, haga clic en

[Continue] (Continuar).

6 Lea y observe las instrucciones, luego haga
clic en [Next] (Siguiente).

7 Haga clic en [Easy Install (Network)]
(Instalacién facil [Red]).
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9

Nota

La seleccion Easy Install (Instalacion facil) es
un método sencillo de configuracién. Si
desea seleccionar un controlador para
instalarlo manualmente, instale una
impresora compartida o use la utilidad OKki
LPR como método de impresidn, seleccione
[Custom Installation] (Instalacion
personalizada) y luego siga las instrucciones
que se muestran en la pantalla.

Haga clic en [Next] (Siguiente).
Comienza la busqueda de dispositivos.

Seleccione los controladores de la impresora
que desea instalar: PCL, PS, FAX.

10 Si su maquina es detectada y aparece

automaticamente, selecciénela y luego haga
clic en [Next] (Siguiente).

Si su maquina no aparece, haga clic en
[Reiniciar busqueda] para reiniciar la

busqueda de dispositivos.

Nota

Para especificar la direccién IP de forma
manual, seleccione [IP address] (Direccion
IP) e introduzca la direccién IP asignada

a su maquina; luego haga clic en

[Next] (Siguiente).

Comienza la instalacién de los controladores y
las utilidades.

Notas

e Si aparece el cuadro de didlogo [Windows
Security] (Seguridad de Windows), haga
clic en [Install this driver software
anyway] (Instalar el software de este
controlador de todas maneras).

e Sien Windows Server 2003 y Windows XP
aparece el cuadro de didlogo [Hardware
Installation] (Instalacién de hardware),
haga clic en [Continue Anyway]
(Continuar de todas maneras).

e Si en Windows 2000 aparece el cuadro de
didlogo [Digital Signature Not Found]
(Firma digital no encontrada), haga clic en
[Yes] (Si).

11 Haga clic en [Finish] (Finalizar) para finalizar

la instalacion.

Notas

e Para configurar una impresora
predeterminada, seleccione la casilla del
controlador que desea. También, puede
establecer la configuracion de la
impresora del controlador seleccionado al
hacer clic en [Open property dialog] (Abrir
el cuadro de didlogo de propiedades).

e Si aparece el cuadro de didlogo que le
solicita reiniciar la computadora, haga clic
en [Yes] (Si). La computadora se reinicia
automaticamente.

12 Windows 7: haga clic en [Start]

(Inicio) > [Devices and Printers]
(Dispositivos e impresoras).

Windows Server 2008 y Windows Vista: haga
clic en [Start] (Inicio) > [Control Panel] (Panel
de control) > [Printer] (Impresora).

Windows Server 2003 y Windows XP: haga clic
en [Start] (Inicio) > [Printers and Faxes]
(Impresoras y faxes).

Windows 2000: haga clic en [Start]
(Inicio) > [Settings] (Configuracion) >
[Printers] (Impresoras).

13 Aseglrese de que aparezca el icono

OKI MC561.

e En Windows 7, si ha instalado varios
controladores, haga clic con el botdn
derecho en el icono OKI MC561 y
seleccione un item del menu; luego
verifique que todos los controladores
de la impresora instalados aparezcan

en el submendu.

0K MCSEL{FAX)
0K MESELIPCL XPS)
0K MCSELIPEL)
O] MCS1 (RS

e En otros sistemas operativos de Windows,
verifique que aparezca el icono que
representa cada controlador.

14 Retire el DVD de la computadora.

Se ha completado la instalacion.
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Configurar la red para
sistemas Macintosh

Para finalizar la conexion de red con un sistema
operativo Mac, instale un controlador de la
impresora en la computadora y configure su
maquina como una impresora en red.

Instalar el controlador de la

impresora para Mac

Para los sistemas Mac, so6lo se encuentra
disponible el controlador PS.

Seleccione el protocolo para su conexion de red
entre los siguientes:

e Ethertalk
- Para Mac 10.3.9 a 10.4.11, consultar
a continuacién
- Para Mac 10.5, consultar la pagina 130

e Bonjour (Rendezvous)
- Para Mac 10.3.9 a 10.4.11, consultar la
pagina 131

- Para Mac 10.5 y 10.6, consultar la pagina
132

iImportante!
Desactive el programa antivirus antes de
iniciar este procedimiento.

Mediante el uso de Ethertalk,
MacO0S X 10.3.9a 10.4.11

Nota

El siguiente procedimiento utiliza Mac OS X
10.4.11 y el modelo MC561 como ejemplo. El
procedimiento en si puede variar un poco segun
el sistema operativo.

1 Asegurese de que su maquina y la Mac estén
encendidas y conectadas.

2 Desde el menu Apple, seleccione [System
Preferentes] (Preferencias del sistema).

3 Seleccione [Network] (Red).

4 Seleccione [Network Port Configurations]

(Configuraciones del puerto de red) en
[Show] (Mostrar), luego verifique que esté
seleccionada la opcion [Built-in Ethernet]
(Ethernet integrada).

i 8eeon Network

| < | | Show all | Q

Location: = Automatic |

ﬁ Show: | Network bo;l-CunF-\gura;i-(.:nE m

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On | Port Configurations

Bluetooth >

—— ¥ Built-in Ethernet ([ New..
#  Built-in FireWire ( Rename

M AirPort

(Delete... )

(_ Duplicate )

'] q Click the lock to prevent further changes. (_ Assist me... ) Apply Now

°]

5 Seleccione la ficha [AppleTalk], luego verifique
que esté seleccionada la opcién [Make
AppleTalk Active] (Activar AppleTalk).

Cierre [Network] (Red).

7 Inserte el DVD que vino con su maquina en

la computadora.

8 Haga doble clic en el icono [OKI].

9 Haga doble clic en la carpeta [Driver]

(Controlador), luego en la carpeta
[Printer] (Impresora).

10 Haga doble clic en [Installer for Mac OSX]
(Instalador de Mac OSX).

11 Escriba el nombre y la contrasefia del
administrador, y luego haga clic en
[OK] (Aceptar).

12 Siga las instrucciones que aparecen en
pantalla para finalizar la instalacién.

13 Retire el DVD de la computadora.

14 Desde el menu [Go] (Ir), seleccione [Utilities]
(Utilidades) y luego haga doble clic en [Printer
Setup Utility] (Utilidad de configuracién
de impresora).
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Nota

Si la Utilidad de configuracion de
impresora ya esta ejecutandose, ciérrela y
abrala nuevamente.

15 Haga clic en [Add] (Agregar).

Nota

Si aparece el cuadro de didlogo [You have no
printers available] (No hay impresoras
disponibles), haga clic en [Add] (Agregar).

16 Para Mac OS X 10.3.9, seleccione [AppleTalk].

17 Seleccione el nombre de su maquina cuya
[Connection] (Conexién) es [AppleTalk] y
luego verifique que el nombre de su maquina
aparezca en [Print Using] (Impresora en uso).

'6 [s)s) Printer Browser =N
< | @
o a-
= . —
Default Browser  IP Printer Search
& | Connec tion
MCS61 AppleTalk
|
F
Name: MC561
Location: Local Zone
e Print Using: | OKI MCSG1(PS) =]

ri}\ ( More Printers. ',l ( Add

18 Para Mac OS X 10.3.9, seleccione el nombre
de su maquina y seleccione [OKI] en [Print
Model] (Modelo de impresora), y luego
seleccione [OKI MC561(PS)] de la lista. Haga
clic en [Add] (Agregar).

19 Si aparece la ventana [Installable Options]
(Opciones instalables), haga clic en
[Continue] (Continuar) a menos que ya haya
instalado opciones. Si instala opciones,
configure cada opcién antes de hacer clic en
[Continue] (Continuar).

20 Verifique que el nombre de su maquina
aparezca en [Printer List] (Lista de
impresoras) y luego cierre la ventana.

21 Desde el menu [Go] (Ir), seleccione
[Applications] (Aplicaciones) y luego haga
doble clic en [TextEdit].

22 Seleccione [File] (Archivo) > [Page Setup]
(Configuracion de pagina).

23 Seleccione el nombre de su maquina en
[Format for] (Formato para).

24 Verifique que el nombre de su maquina
aparezca correctamente en [Format for]
(Formato para).

25 Haga clic en [OK] (Aceptar).

Se ha completado la instalacion.

Mediante el uso de Ethertalk
Mac 10.5 (Leopard)

Nota

El siguiente procedimiento utiliza el modelo
MC561 como ejemplo.

1 Asegurese de que su maquina y la Mac estén
encendidas y conectadas.

2 Inserte el DVD que vino con su maquina en
la computadora.

3 Haga doble clic en el icono [OKI].

Haga doble clic en la carpeta [Driver]
(Controlador), luego en la carpeta
[Printer] (Impresora).

5 Haga doble clic en [Installer for MacOSX]
(Instalador de MacOSX).

6 Escriba el nombre y la contrasefia del
administrador, y luego haga clic en
[OK] (Aceptar).

7 Siga las instrucciones que aparecen en
pantalla para finalizar la instalacion.

Retire el DVD de la computadora.

9 Desde el menu Apple, seleccione [System
Preferentes] (Preferencias del sistema).

10 Haga clic en [Print & Fax] (Impresora y fax).
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11 Haga clic en [+].

CIEIS Print & Fax
no iy C—
Click « to add a
srinter of i No Printer Selected
—- |+
Default Printar: | Last Printer Used 2]
Default Paper Size in Page Setup: | A4 )
n @
I lick the lock to prevent Further changes. ?

12 Haga clic en [AppleTalk].

13 Seleccione el nombre de su maquina, y luego
verifique que el nombre de su maquina
aparezca en [Print Using] (Impresora en uso).

Cale) =)
e o a = -
Drlault  Fax 1P Wisdows Blurtooth  ApcleTalk Mo Pristers Search
Local Zon
--------- St et ouac 2
Name: MC561
Location: Local Zone
—- Fint Using: | OKI MCSE1(PS) )
g )

14 Haga clic en [Add] (Agregar).

15 Si aparece la ventana [Installable Options]
(Opciones instalables), haga clic en
[Continue] (Continuar) a menos que ya haya
instalado opciones. Si instala opciones,
configure cada opcién antes de hacer clic en
[Continue] (Continuar).

16 Verifigue que su maquina aparezca en
[Printers] (Impresoras).

17 Verifique que el nombre de su maquina
aparezca en [Kind] (Tipo) y luego cierre
[Print & Fax] (Impresora y fax).

Se ha completado la instalacion.

Nota

Es posible que el nombre de su maquina no
aparezca si el controlador de la impresora no lee
el archivo PPD correctamente.

En este caso, haga clic en [-] para quitar su
magquina de [Print & Fax] (Impresora y fax) y
luego vuelva a realizar el procedimiento desde
el paso 10.

Mediante el uso de
Bonjour (Rendezvous)
Mac 10.3.9a 10.4.11

Nota

El siguiente procedimiento utiliza Mac OS X
10.4.11 y el modelo MC561 como ejemplo. El
procedimiento en si puede variar un poco segun
el sistema operativo.

1 Asegurese de que su maquina y la Mac estén
encendidas y conectadas.

2 Desde el menu Apple, seleccione [System
Preferentes] (Preferencias del sistema).

3 Seleccione [Network] (Red).

Seleccione [Network Port Configurations]
(Configuraciones del puerto de red) en
[Show] (Mostrar), y luego verifique que esté
seleccionada la opcion [Built-in Ethernet]
(Ethernet integrada).

'8 8o Network
| 4 » || Showall | Q

Location: | Automatic i

——»Shcw: Net]/vc}irl’*c?["Cor;ﬁgnra'Eiréns T]

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configurations
@ Bluetooth —_—
ﬁ E Built-in Ethernet '&.'
Built-in FireWire € Rename )
¥ AirPort —
(——Delete::—)
(_ Duplicate )

@

il ———
[ !W Click the lock to prevent further changes. (_ Assistme... ) Apply Now

Cierre [Network] (Red).

Inserte el DVD que vino con su maquina en la

computadora.
I

Q

7 Haga doble clic en el icono [OKI].
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8 Haga doble clic en la carpeta [Driver]
(Controlador), luego en la carpeta
[Printer] (Impresora).

9 Haga doble clic en [Installer for Mac OSX]
(Instalador de Mac OSX).

10 Escriba el nombre y la contrasena del
administrador, y luego haga clic en
[OK] (Aceptar).

11 Siga las instrucciones que aparecen en
pantalla para finalizar la instalacion.

12 Retire el DVD de la computadora.

13 Desde el menu [Go] (Ir), seleccione [Utilities]
(Utilidades) y luego haga doble clic en [Printer
Setup Utility] (Utilidad de configuracién
de impresora).

iImportante!

Si la Utilidad de configuracion de
impresora ya esta ejecutandose, ciérrela
y abrala nuevamente.

14 Haga clic en [Add] (Agregar).

Nota

Si aparece el cuadro de didlogo [You have no
printers available] (No hay impresoras
disponibles), haga clic en [Add] (Agregar).

15 Para Mac OS 10.3.9, seleccione [Rendezvous].

16 Seleccione el nombre de su maquina cuya
[Connection] (Conexidn) es [Bonjour] y luego
verifique que el nombre de su maquina

aparezca en [Print Using] (Impresora en uso).

Su maquina se muestra con los Ultimos
seis digitos de la direccion MAC en la lista
de impresoras.

PQ O &) Printer Browser =M
= L
9 I a-
=] A —
Default Browser : IP Printer Search
Printer Name 4| Connection
—_— m
Name: OKI-MC-561-EBOE1A
Location: Local Zone
Print Using: | OKI MC561(PS) i)

15/\ ( More Printers... ) [ Add l

17 Para Mac OS X 10.3.9, seleccione el nombre
de su maquina y seleccione [OKI] en [Print
Model] (Modelo de impresora), y luego
seleccione [OKI MC561(PS)] de la lista.

18 Haga clic en [Add] (Agregar).

19 Si aparece la ventana [Installable Options]
(Opciones instalables), haga clic en
[Continue] (Continuar) a menos que ya haya
instalado opciones. Si instala opciones,
configure cada opcidn antes de hacer clic en
[Continue] (Continuar).

20 Verifique que el nombre de su maquina
aparezca en [Printer List] (Lista de
impresoras) y luego cierre la ventana.

-—e e G Printer List =
e~ =5 ®
i Add

Name & |Status Kind

# OKI-MC561-EBOE1A OKI MC561(PS)

21 Desde el menu [Go] (Ir), seleccione
[Applications] (Aplicaciones) > [TextEdit].

22 Seleccione el menu [File] (Archivo) >
[Page Setup] (Configuracion de pagina).

23 Seleccione el nombre de su maquina en
[Format for] (Formato para).

24 Verifique que el nombre de su maquina
aparezca correctamente en [Format for]
(Formato para).

25 Haga clic en [OK] (Aceptar).

Se ha completado la instalacion.

Mediante el uso de Bonjour
Mac 10.5y 10.6 (Leopard y
Snow Leopard)

Nota

El siguiente procedimiento utiliza Mac OS X 10.6
y el modelo MC561 como ejemplo. El
procedimiento en si puede variar un poco segun
el sistema operativo.

1 Asegurese de que su maquina y la Mac estén
encendidas y conectadas.
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2 Inserte el DVD que vino con su maquina en
la computadora.

3 Haga doble clic en el icono [OKI].

Haga doble clic en la carpeta [Driver]
(Controlador), luego en la carpeta
[Printer] (Impresora).

5 Haga doble clic en [Installer for MacOSX]
(Instalador de MacOSX).

6 Escriba el nombre y la contrasefia del
administrador, y luego haga clic en
[OK] (Aceptar).

7 Siga las instrucciones que aparecen en
pantalla para finalizar la instalacion.

8 Retire el DVD de la computadora.

Desde el menu Apple, seleccione [System
Preferentes] (Preferencias del sistema).

10 Haga clic en [Print & Fax] (Impresora y fax).

11 Haga clicen [+].
12 Haga clic en [Default] (Predeterminado).

13 Seleccione el nombre de su maquina cuyo
[Kind] (Tipo) es [Bonjour], luego verifique
que el nombre de su maquina aparezca en
[Print Using] (Impresora en uso).

El nombre de su maquina se muestra con los
ultimos seis digitos de la direccion MAC en la

lista de impresoras.

NSNS Add Printer (=]
Elea -
Default  Fax IP Windows Search
Printer Name & Kind
L . mgl OH}-MC551-EBOE1A Bonjour
Name: OKI-MC561-EBOE1A
Location:
Print Using: | OKI MC561(PS) = ]
Add ) |
7

14 Haga clic en [Add] (Agregar).

15 Si aparece la ventana [Installable Options]
(Opciones instalables), haga clic en
[Continue] (Continuar) a menos que ya haya
instalado opciones.

Si instala opciones, configure cada opcion
antes de hacer clic en [Continue] (Continuar).

16 Verifique que su maquina aparezca en
[Printers] (Impresoras).

17 Verifique que el nombre de su maquina
aparezca en [Kind] (Tipo) y luego cierre
[Print & Fax] (Impresora y fax).

Se ha completado la instalacion.

Nota

Es posible que el nombre de su maquina no
aparezca si el controlador de la impresora no lee
el archivo PPD correctamente.

Si esto sucede, haga clic en [-] para quitar su
maquina de [Print & Fax] (Impresora y fax) y
luego agréguela nuevamente (regrese al paso 9).
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Como configurar la maquina para su

funcionamiento en red

Las funciones como

e Escanear a correo electrénico
e Escanear a PC de red

e Fax en Internet

le permiten enviar datos escaneados a una
computadora a través de la conexion de red. Para
utilizar estas funciones, debe configurar su
equipo y las computadoras a las cuales desea
enviar los datos escaneados.

Ingresar la direccion IP de
la maquina en la pagina
de configuracion

Nota

Si utiliza las teclas de flecha, presidnelas varias
veces para buscar la opcion que desea seleccionar.

1 Presione <SETTING> (Configuracion) en el
panel de control.

2 Utilice la tecla de la flecha hacia abajo
para seleccionar [View Information] (Ver
informacion) y luego presione <OK> (Aceptar).

Setting
Metwork Scan Destination

Store Document Settings

Yiew Information

3 Utilice la tecla de la flecha hacia abajo para
seleccionar [Network] (Red) y luego presione
<OK> (Aceptar).

4 Escriba la direccién IP en [IPv4 address]
(Direccién IPv4) en la linea A-2 de la pagina
de configuracion.

Configurar Escanear a correo
electronico y Fax en Internet

Verificar la configuracion
del correo electronico en
la computadora

¢ Si un administrador de redes especifica valores
como una cuenta de servidor de correo, la
contrasefia y la direccién de correo electrénico
para su equipo, anote estos datos en la pagina
de configuracion.

Nota

El siguiente procedimiento utiliza Windows Live
Mail en Windows 7. Si usted utiliza otro software
de correo electrénico, consulte el manual para
obtener informacidn sobre éste.

1 Haga clic en [Start] (Inicio) > [Windows
Live Mail].

2 Seleccione el menu [Tools] (Herramientas) >
[Accounts] (Cuentas).

Si no aparece la barra del menu, haga clic en
el icono [Menus] (Menus) y luego seleccione
[Show menu bar] (Mostrar la barra del menu).

3 Seleccione la cuenta de correo
predeterminada y luego haga clic en
[Properties] (Propiedades).
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4 En la ficha [General] (General), introduzca el

contenido de [Name] (Nombre) y [E-mail
address] (Direccién de correo electrénico)
en las lineas B-9 y B-10 de la pagina

de configuracién.

& popitestoom Properties G|
General | Servers | Connection | Securty | Advanced
Mail Account
S/M__ Type the name by which you would like to refer to these
&, | serven. For example: "Work™ or "Windows Live
7 Hotmail"
[popiestoom ]
User Information
Name: User > B-9
Organization
Exmail address:  user@testcom -.ﬁ B-10
Reply address:
V| Include this account when receiving mail or synchronizing
o |

5 Haga clic en la ficha [Server] (Servidor) y

luego introduzca cada configuracién en
las lineas correspondientes de la pagina
de configuracién.

4| popdtestoom Properties [&J

General | Servers | Connection | Security | Advanced

Server Information

My incoming mail serverisa  POP2 server.

Incoming mail (FOP3):  pop3testcom ‘» B'3

Outgaing mail (SMTF):  smiptestcom > B-z
Incoming Mail Server

E-mail usemame: user -l» B-7

Password oy -I* B.B

V| Remember password
@ Log on using cleartext authentication
Log on using secure password authentication
() Log on using autherticated POP (APOP)

Outgoing Mail Server

/| My server requires authertication Settings...

[ ok [ canca |[ ooy |

¢ Si esta seleccionada la casilla [My server
requires authentication] (Mi servidor

requiere autenticacién), escriba “SMTP” en

la linea B-4 de la pagina de configuracion.

e Si esa casilla no esta seleccionada, escriba

“POP” en la linea B-4.

6 Seleccione la casilla [My server

requires authentication] (Mi servidor
requiere autenticacion) y haga clic en
[Settings] (Configuracion).

7 En el cuadro de dialogo [Outgoing Mail

Server] (Servidor de correo saliente):

Qutgoing Mail Server lﬂhj
-

Logon Information

@ Use same settings as my incoming mail server

Log on using

Remember password

wthertication

Cen

Log on using Secure Pas:

e Si esta seleccionada la opcion [Use the
same settings as my incoming mail server]
(Utilizar la misma configuracién que para
mi servidor de correo entrante), introduzca

- el valor de la linea B-7 en la linea B-5 y
- el valor de la linea B-8 en la linea B-6

de la pagina de configuracion.

e Si esta seleccionada la opcion [Log on
using] (Iniciar sesién con), introduzca

- el [Account name] (Nombre de la
cuenta) en la linea B5 y

- la [Password] (Contrasefa) en la
linea B-6

de la pagina de configuracion.

Configurar la direccion de correo

electronico para su maquina

Escriba la direccion de correo electréonico que
utilizara su equipo en la linea B-1 de la pagina
de configuracion.

e Si el administrador de redes especifico la
direccién de correo electrénico para su equipo,
ingrese la direccion de correo electrénico en la
linea B-1.

e Si utiliza un proveedor de servicios de Internet,
solicite una direccidn de correo electrdnico para
su equipo al proveedor y luego escribala en la
linea B-1.

e Si el correo electrénico para su equipo no ha
sido especificado ni puede solicitarlo,
determinelo segun el valor que ingresoé en la
linea B-4 (método de autenticacién):

- Si B-4 es “"SMTP”, determine una direccion
de correo electrénico e ingrésela en la
linea B-1.

- Si B-4 es “POP”, ingrese en la linea B-1 la
misma direccién de correo electréonico que
aparece en B-12.

e Si desea que su equipo reciba correos
electronicos, debe solicitar una direccion de
correo electrénico para su equipo a un
administrador de redes o a su proveedor de
servicios de Internet.
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Configurar la maquina para
utilizar Escanear a correo

electronico y Fax en Internet

Configure el equipo para utilizar las funciones
Escanear a correo electronico y Fax en Internet
mediante el uso de la informacion en la pagina
de configuracion.

Nota

Si utiliza las teclas de flecha, presidnelas
varias veces para buscar la opcién que
desea seleccionar.

Presione la tecla <SETTING> (Configuracién) en
el panel de control.

8 Utilice la tecla de la flecha hacia abajo para
seleccionar [Easy Setup] (Configuracion facil)
y presione <OK> (Aceptar).

Setting

Yiew Information
Shutdown

9 Escriba la contraseia del administrador,
luego utilice las teclas de flecha para
seleccionar la opcion [Enter] (Intro) y
presione <OK> (Aceptar).

10 Utilice la tecla de la flecha hacia abajo para
seleccionar [Email Setting] (Configuracién del
correo electrénico) y presione la tecla de la
flecha hacia la derecha.

|
2. Fax Setting
3. Metwork Setting
4 Email Setting
Cancel

11 En referencia a la pagina de configuracion:

a) La direccion del servidor: Presione la tecla
de la flecha hacia la derecha, luego escriba
la informacion de la linea B-2.

b) Utilice las teclas de flecha para
seleccionar [Enter] (Intro), luego presione
<OK> (Aceptar).

c) La direccién de correo electrénico de su
equipo: Presione la tecla de la flecha hacia
la derecha, luego escriba la informacién de
la linea B-1.

d) Seleccione [Enter] (Intro), presione
<OK> (Aceptar).

e) El método de autenticacion: Presione la
tecla de la flecha hacia la derecha, luego
utilice la tecla de la flecha hacia abajo para
seleccionar el método de la linea B-4.

f) Siga las instrucciones en pantalla para
ingresar la informacion solicitada en la
seccién B de la pagina de configuracion.

g) Cuando haya ingresado toda la
informacion, en la pantalla aparecera
“Email Setting was completed” (Ha
finalizado la configuracion del correo
electrénico) y la pantalla regresara al
Menu de configuracion.

12 Cuando aparezca la pantalla del menu de
configuracién, presione <OK> (Aceptar).

Ha finalizado la configuracion de Escanear a
correo electrénico y Fax en Internet.

Para obtener detalles sobre cdmo utilizar las
funciones Escanear a correo electrénico y Fax en
Internet, consulte la Guia basica del usuario en el
DVD que vino con su equipo.

Configurar Escanear a PC
de red

La funcidén Escanear a PC de red le permite enviar
y guardar imagenes escaneadas en la “carpeta
compartida” de una computadora de la red. Para
utilizar esta funcion, registre su equipo en la
computadora como un usuario y cree una carpeta
compartida, luego cree un perfil en su equipo
para registrar la configuracion del equipo.

e Antes de comenzar la configuracion, obtenga
autorizacion del administrador de redes para
crear una carpeta compartida en la
computadora y siga el siguiente procedimiento.

e En este procedimiento se utiliza el protocolo CIFS.

Verificar el nombre de

la computadora

Verifique el nombre de la computadora con el
siguiente procedimiento y complete la linea
C-1 de la pagina de configuracion.

Windows 7
Windows Server 2008 R2
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Windows Server 2008
Windows Vista

Nota

El siguiente procedimiento utiliza Windows 7
como ejemplo. La pantalla puede variar segun el
sistema operativo.

1 Haga clic en [Start] (Inicio) > [Control Panel]
(Panel de control).

2 Seleccione [System and Security] (Sistema
y seguridad).
En Windows Server 2008 y Windows Vista,
seleccione [System and Maintenance]
(Sistema y mantenimiento).

3 Seleccione [See the name of this computer]
(Ver el nombre de esta computadora) en
[System] (Sistema).

4 Escriba el nombre en [Computer name]
(Nombre de la computadora) en la linea C-1
de la pagina de configuracién.

5 Cierre la ventana.

Windows Server 2003
Windows XP

1 En Windows Server 2003, haga clic en [Start]
(Inicio) > [Control Panel] (Panel de control) >
[System] (Sistema).

En Windows XP, haga clic en [Start] (Inicio) >
[Control Panel] (Panel de control) >
[Performance and Maintenance] (Rendimiento
y mantenimiento) > [System] (Sistema).

2 Seleccione la ficha [Computer Name]
(Nombre de la computadora) y luego haga clic
en [Change] (Cambiar).

3 Escriba el nombre en [Computer name]
(Nombre de la computadora) en la linea
C-1 de la pagina de configuracién.

4 Haga clic en [Cancel] (Cancelar) para cerrar
la ventana.

Windows 2000

1 Haga clic en [Start] (Inicio) > [Settings]
(Configuracién) > [Control Panel] (Panel
de control).

Haga doble clic en [System] (Sistema).

Seleccione la ficha [Network Identification]
(Identificacion de la red) y luego haga clic en
[Properties] (Propiedades).

4 Escriba el nombre en [Computer name]
(Nombre de la computadora) en la linea
C-1 de la pagina de configuracion.

5 Haga clic en [Cancel] (Cancelar) para cerrar
la ventana.

Determinar los nombres de los
items necesarios para escanear
a PC de red

Determine los nombres de los siguientes items
y complete las lineas C-2 a C-6 de la pagina
de configuracion.

e Nombre de usuario para conectarse a la
computadora de destino (C-2).

e Contrasefa para conectarse a la computadora
de destino (C-3).

e Nombre del perfil para registrar la
configuracion en su equipo (C-4).

e Nombre de la carpeta compartida en la
computadora de destino (C-5).

e Nombre del archivo de datos escaneados (C-6).

Configurar la computadora para

escanear a PC de red

Registre su equipo en la computadora como
un usuario y luego configure una carpeta
compartida a donde se enviaran y guardaran
las imagenes escaneadas.

e Windows 7, consultar a continuacion.

e Windows Server 2008 R2, consultar
a continuacion.

e Windows 2008, consultar a continuacion.

e Windows Vista, consultar a continuacion.

e Windows Server 2003, consultar la pagina 139.
e Windows XP, consultar la pagina 140.

e Windows 2000, consultar la pagina 141.
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iImportante!

Si la computadora es un dominio, el
procedimiento para agregar una cuenta del
usuario podria ser diferente al siguiente
procedimiento. Consulte el manual de
Microsoft Windows.

Windows 7

Windows Server 2008 R2
Windows 2008

Windows Vista

Nota

El siguiente procedimiento utiliza Windows 7
como ejemplo. La pantalla puede variar segun el
sistema operativo.

1 Haga clic en [Start] (Inicio) > [Control Panel]
(Panel de control).

2 Seleccione [Add or remove user accounts]
(Agregar o quitar cuentas del usuario).

3 Seleccione [Create a new account] (Crear una
cuenta nueva).

4 Escriba la informacion de la linea C-2 de la
pagina de configuracion en el cuadro de texto.

5 Asegurese de que esté seleccionada la opcién
[Standard user] (Usuario normal) y luego

haga clic en [Create Account] (Crear cuenta).

6 Haga clic en el icono de la cuenta del usuario
creada en el paso anterior.

7 Seleccione [Create a password] (Crear
una contrasefia).

8 Escriba la informacion de la linea C-3 en [New
password] (Contrasefia nueva) y [Confirm for
new password] (Confirmar contrasefa
nueva), luego haga clic en [Create password]
(Crear contrasefia).

K3 =[5 o UserAccounts + Mansge Accounts » Changs an Account b Creste Passwerd = [ 4s || 52

Create a password far mc561°s account

me3bl
Stanclard user

Yau are creating a passwned for me3A1.

IF you do this, meb] will lose all EFS-encrypted liles, personal certilicates snd stored passwords lor Wel
slites ar netwerk resaurces.

Tor v lising data in the fidure, ask meSil Lo make a password reset llopay desk.

» Create password | | Caneel

9 Cierre el panel de control.

10 Cree una carpeta nueva en la computadora
con el nombre que ingresé en la linea C-5.

Nota

Se recomienda crear una carpeta en el
disco local, no en el escritorio ni en
[My Documents] (Mis documentos).

11 Haga clic con el botdn derecho en la carpeta
creada en el paso anterior y seleccione
[Propiedades] (Propiedades).

12 Seleccione [Sharing] (Uso compartido) y
luego haga clic en [Share] (Compartir).
SalesDev Properties &

Gerwenl | S | Sncurty | Frvicns Versicrs: | Customive

Netwoss Fle and Folder Shanng

rrudbisle shares. ol sed st

Pasyword Protecton

Frcple musd hurvw 3 ooae accourt and password lor s
computer L becess o

Tochange ths sstting, use the Nt and

oK Cancel
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13 En el cuadro desplegable, seleccione la cuenta
del usuario creada en el paso 5 y luego haga
clic en [Add] (Agregar).

|||||

14 Seleccione el usuario que agrego en el
paso anterior y el nivel de autorizacién, luego
haga clic en [Share] (Compartir).

[—=)]

3 File Sharing

Choose people to share with

Type & name snd then click Add, or click the smow to find semecne

15 Haga clic en [Done] (Listo).

16 Haga clic en [Advanced Sharing]
(Uso compartido avanzado) en la ficha
[Sharing] (Compartir).

17 Haga clic en [Permissions] (Autorizaciones).

18 Seleccione el usuario que agregé en el
paso 13 vy la casilla [Allow] (Permitir) para
obtener [Full Control] (Control total), luego
haga clic en [OK] (Aceptar).

19 Cierre el cuadro de didlogo de las propiedades
de la carpeta.

20 Cree un perfil para finalizar la configuracion
de Escanear a PC de red. Consulte “Perfiles
para Escanear a PC de red” en la pagina 142.

Windows Server 2003

1 Haga clic en [Start] (Inicio) > [Administrative
Tools] (Herramientas administrativas) >
[Server Management] (Administracion
de servidores).

Haga clic en [Users] (Usuarios).

Seleccione [Add a user] (Agregar un usuario).

4 Ingrese el valor de C-2 en el cuadro de texto

[First name] (Nombre) y luego haga clic en
[Next] (Siguiente).

Uzer Arcount Infomation
o st sy e infoenation teguined 10 Clasle & uist scCourt.
ﬁ [ I:'{‘HI
Ligst raers [
Logon nemme: =3 =
r
Lebephone. |
[fheee koceabion: |
« Back tiets | canesl

5 Ingrese el valor de C-3 en [Password]
(Contrasefia) y [Confirm password]
(Confirmar contrasefia).

User Passward
Vo it gty 8 passvnd o e .
ﬁ Paswed [ewess
—q Corlmpasewned. [esass

This uses
1 Must change password af nest logon
* [Caneol changs passwoed

1™ Can changs patiwerd & sy ime

« Back Bt 3 I Cancel

6 Seleccione [Cannot change password] (No se
puede cambiar la contrasefia) y luego haga
clic en [Next] (Siguiente).

7 Haga clic en [Finish] (Finalizar).
Haga clic en [Close] (Cerrar).

9 Cree una carpeta nueva en la computadora
con el nombre que ingresé en la linea C-5.

Nota

Se recomienda crear una carpeta en el
disco local, no en el escritorio ni en
[My Documents] (Mis documentos).

10 Haga clic con el botén derecho en la carpeta
creada en el paso anterior y luego seleccione
[Sharing and Security] (Uso compartido
y seguridad).
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11 En la ficha [Sharing] (Uso compartido),
seleccione [Share this folder] (Compartir
esta carpeta) y luego haga clic en
[Permissions] (Autorizaciones).

istproveties TR

Genersl | web Shaing  Shaiing | Securiy |
Q “You can share this folder amang olher users on your

network. To enable sharing for this folder. click Share this
folder.

© Do not share this falder
_”—r-‘ Share this folder

Share name: [SalecDey

Comment |

User limit: % Mazimum allowed

© Alow = Users
T set parmissions for how sers access this ‘._
folder over the network, click Pemissions.

To configurs ssttings or Offine snosss to Cachi
sz ey, @l B EE

ok | cacd | eow |

12 Haga clic en [Add] (Agregar).

13 Ingrese el valor de C-2 y luego haga clic en
[Check Names] (Verificar nombres).

Select Users, Computers, or Groups el
Select this obiect type:
ILlserS, Groups, or Buillin security principals Obiect Types.
From this location:
IsmaHhuslnEss local Locations...
Eniter ths obisct names to select (examplesk
_> 561 Check Names ‘_
ke el
P

14 Verifique que aparezca el valor de C-2 y luego
haga clic en [OK] (Aceptar).

15 Seleccione la casilla [Allow] (Permitir) para
obtener [Full Control] (Control total) y luego
haga clic en [OK] (Aceptar).

16 Cierre el cuadro de didlogo de las propiedades
de la carpeta.

17 Cree un perfil para finalizar la configuracion
de Escanear a PC de red. Consulte la
pagina 142.

Windows XP

1 Haga clic en [Start] (Inicio) > [Control Panel]
(Panel de control).

2 Haga doble clic en [User Accounts] (Cuentas
del usuario).

3 Seleccione [Create a new account] (Crear una
cuenta nueva).

4 Ingrese el valor de C-2 en el cuadro de texto
y haga clic en [Next] (Siguiente).

Name the new account

Type arame for the rew sccount:
[mestl

This raeren wal ape o thes ‘wisk som v el s thes S2.t rrowns.

5 Seleccione [Limited] (Limitado) y haga clic en
[Create Account] (Crear cuenta).

2 Licar Accounts [- B

Pick an account type

) Compuame pebvrtraeer (5L 4

T e p—]
w Siewr i i b e Docasrets kder

h lited sccounts cannct shiy - Diapendeeg on the program, & usr
gt o) ackvirts tin grovigns b el £

A, programs designed price b Windoers XP o 'Windows 2000 Mght rest weork Ercerty with
lmibed accounts. For best resubs, dhoose rograms beanng the Designed for Windowes ' logo,
o6, b ke prograi, chodes the “cormgubar sdinitr stor” BECOUR trid.

() (s ) ()

6 Haga clic en el icono de la cuenta del usuario
creada en el paso anterior.

7 Seleccione [Create a password] (Crear
una contrasefia).

8 Ingrese el valor de C-3 en [Type a new
password] (Escribir una contrasefia nueva) y
[Type the new password again to confirm]
(Volver a escribir la contrasefia nueva para
confirmar) y luego haga clic en [Create
password] (Crear contrasefia).

9 Cierre el panel de control.

10 Cree una carpeta nueva en la computadora
con el nombre que ingresé en la linea C-5.

Nota

Se recomienda crear una carpeta en el disco
local, no en el escritorio ni en [My
Documents] (Mis documentos).

11 Haga clic con el botén derecho en la carpeta
creada en el paso anterior y luego seleccione
[Sharing and Security] (Uso compartido
y seguridad).
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12 Haga clic en [If you understand the security
risks but want to share files without running
the wizard, click here.] (Si entiende los
riesgos de seguridad pero desea compartir
archivos sin ejecutar el asistente, haga
clic aqui).

13 Seleccione [Share this folder] (Compartir
esta carpeta) en Windows Firewall
(Firewall de Windows) y luego haga clic en
[OK] (Aceptar).

14 Seleccione las casillas [Share this folder on
the network] (Compartir esta carpeta en la
red) y [Allow network users to change my
files] (Permitir a los usuarios de la red
cambiar mis archivos), y luego haga clic en
[OK] (Aceptar).

MC561 Properties @@

Genersl | Sharing | Customize

Local sharing and security
I To share this folder with other users of this computer
J)‘ﬂ orly. diag it ta the Shared Documents folder.

To make this folder and its subfolders private so that
arlp yau hawe access, select the following check bax.

Metwark sharing and security

i) Toshare this folder with both network users and other
%) users of this computer, select the first check box below
T and ype a share name.

——> ‘Share this folder on the retwork

Share name:  |MCEET

[ licwy etk users ta change my fle
Lean mare about sharing and securty
j# Windows Firewall is configured to allow this folder to be shared
with ather computers on the network,
View your Windows Fiewall setings

ok ][ cancel ][ pel

15 Seleccione la casilla [Allow] (Permitir) para
obtener [Full Control] (Control total) y luego
haga clic en [OK] (Aceptar).

16 Cree un perfil para finalizar la configuracion
de Escanear a PC de red. Consulte la
pagina 142.

Windows 2000

1 Haga doble clic en [My Computer] (Mi PC)
en el escritorio y luego seleccione
[Manage] (Administrar).

2 En la ventana derecha, haga doble clic en
[System Tools] (Herramientas del sistema) >
[Local Users and Groups] (Usuarios y grupos
locales). Haga clic con el botén derecho en
[Users] (Usuarios) y seleccione [New User]
(Usuario nuevo).

_> Username  [moB51

ﬁ Password |‘
_> Confim passward. [

Ingrese el valor de C-2 en [User name]
(Nombre de usuario) y el valor de C-3 en
[Password] (Contrasefia) y [Confirm
Password] (Confirmar contrasefa).

remuser x|

Fullname |

Descritior: |

= Wser must change password 2t rest lagan
J¥ User cannot change password

¥ Password never supites

™ Account is disabled

Create Close:
[ Em |

4 Seleccione [User can not change password]

(El usuario no puede cambiar la contrasefa) y
[Password never expires] (La contrasefia
nunca caduca), y luego haga clic en

[Create] (Crear).

Haga clic en [Close] (Cerrar) para cerrar
el cuadro de didlogo [New User]
(Usuario nuevo).

Nota

Si esta seleccionada la opcidén [User must
change password at next logon] (El usuario
debe cambiar la contrasefia en el siguiente
inicio de sesidn), desmarquela para poder
seleccionar [User can not change password]
(El usuario no puede cambiar la contrasefia)
y [Password never expires] (La contrasefia
nunca caduca).

Haga doble clic en [User] (Usuario) y verifique
que se muestre el usuario creado en el

paso 4. Cierre la ventana [Computer
Management] (Administracidon de equipos).

Cree una carpeta nueva en la computadora
con el nombre que ingresé en la linea C-5.

Nota

Se recomienda crear la carpeta en el disco
local, no en el escritorio ni en [My
Documents] (Mis documentos).

8 Haga clic con el botén derecho en la carpeta

creada en el paso 6 y luego seleccione
[Sharing] (Uso compartido).
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9 Seleccione [Share this folder] (Compartir
esta carpeta) y luego haga clic en
[Permissions] (Autorizaciones).

test Properties 21x]
General| e Shaiing Sharig | Secury|
Yot £ st i fricler amaing other Lssts on yewr
natwork. T snabls shring for this folder, ik Shre this
feider

" Do ot share this folder

_’»—r:' Share this folder

Share name: | SalesDiev

Comment: |

User limit: & Maximum allowed

 Allow _,3 Users
il ‘_

seftings for Difine access to Bl

To configue
this shared folder, click, Caching.

ok | cencel | tooh |

10 Haga clic en [Add] (Agregar).

11 Seleccione la cuenta del usuario creada en el
paso 4 y luego haga clic en [Add] (Agregar).

2%
Lookin  [=Z00671.005 =l
200611-003
200611-003
200611-003
200611003
200511-003 J
200611003
Users 200611-003 =
— Check Hames
<< Type names separated by semicolons o choose from list >>
oK Cancel
A

12 Verifique que aparezca la cuenta del usuario y
luego haga clic en [OK] (Aceptar).

13 Seleccione la casilla [Allow] (Permitir) para
obtener [Full Control] (Control total) y luego
haga clic en [OK] (Aceptar).

14 Asegurese de que el icono de la carpeta
compartida cambie al icono con una mano y
luego cierre la ventana.

15 Cree un perfil para finalizar la configuracién
de Escanear a PC de red. Consulte “Perfiles
para Escanear a PC de red” en la pagina 142.

Perfiles para Escanear a PC
de red

Registre la informacion que configurd en la
computadora como un perfil. Es necesario cuando
emplea la funcidon Escanear a PC de red en

la computadora.

Como crear un perfil

Nota

Si utiliza las teclas de flecha, presionelas varias
veces para buscar la opcidn que desea seleccionar.

1 Presione la tecla <SETTING> (Configuracién)
en el panel de control.

2 Utilice la tecla de la flecha hacia abajo para
seleccionar [Profile] (Perfil) y luego presione
<OK> (Aceptar).

Setting
Address Book
Phone Book

]

3 Utilice la tecla de la flecha hacia abajo para
seleccionar el niumero de perfil que desea
registrar, luego presione <OK> (Aceptar).

4 Utilice la tecla de la flecha hacia abajo para
seleccionar [Edit] (Editar) y luego presione
<OK> (Aceptar).

5 Utilice la tecla de la flecha hacia abajo para
seleccionar el nUmero de perfil que desea
registrar, luego presione <OK> (Aceptar).

6 Utilice la tecla de la flecha hacia abajo para
seleccionar [Profile Name] (Nombre del perfil)
y luego presione <OK> (Aceptar).

7 Escriba la informacion de la linea C-4 de la
pagina de configuracién.

8 Utilice las teclas de flecha para seleccionar
[Enter] (Intro), luego presione <OK> (Aceptar).

9 Utilice la tecla de la flecha hacia abajo para
seleccionar [Target URL] (URL Destino) y
luego presione <OK> (Aceptar).

10 Ingrese el valor de las lineas C-1 y C-5 de la
pagina de configuracion con el formato
"\\C-1\C-5"; por ejemplo, \\PC1\SalesDev.

11 Utilice las teclas de flecha para seleccionar
[Enter] (Intro), luego presione <OK> (Aceptar).

12 Utilice la tecla de la flecha hacia abajo para
seleccionar [User Name] (Nombre de usuario)
y luego presione <OK> (Aceptar).

13 Escriba la informacion de la linea C-2 de la
pagina de configuracion.

Si se ha realizado la administracion de
dominios, ingrese “C-2@domain name”.
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14 Utilice las teclas de flecha para seleccionar
[Enter] (Intro), luego presione <OK> (Aceptar).

15 Utilice la tecla de la flecha hacia abajo para
seleccionar [Password] (Contrasefia) y luego
presione <OK> (Aceptar).

16 Escriba la informacion de la linea C-3 de la
pagina de configuracion.

17 Utilice las teclas de flecha para seleccionar
[Enter] (Intro), luego presione <OK> (Aceptar).

18 Utilice la tecla de la flecha hacia abajo para
seleccionar [File Name] (Nombre de archivo)
y luego presione <OK> (Aceptar).

19 Escriba la informacion en la linea C-6 de la
pagina de configuracién. Puede entrar un total
de 64 caracteres.

Al agregar “#n" al final del nombre de archivo, se
asignara automaticamente un niimero de serie al
final del nombre de los archivos enviados.

Al agregar “#d" al final del nombre de archivo,
se asignara automaticamente una fecha al
final del nombre de los archivos enviados.

20 Utilice las teclas de flecha para seleccionar
[Enter] (Intro), luego presione <OK> (Aceptar).

21 Configure otros items si es necesario.

22 Presione <OK> (Aceptar) para registrar
la configuracion.

Ha finalizado la configuracién de Escanear a
PC de red.

Para obtener detalles sobre como utilizar la
funcidn Escanear a PC de red, consulte la Guia
basica del usuario en linea en el DVD que vino
con su equipo.

Como modificar un perfil

Nota

Si utiliza las teclas de flecha, presidnelas varias
veces para buscar la opcidén que desea seleccionar.

1 Presione la tecla <SETTING> (Configuracion)
en el panel de control.

2 Utilice la tecla de la flecha hacia abajo para
seleccionar [Profile] (Perfil) y luego presione
<OK> (Aceptar).

3 Utilice la tecla de la flecha hacia abajo para
seleccionar [Edit] (Editar) y luego presione
<OK> (Aceptar).

4 Utilice la tecla de la flecha hacia abajo para
seleccionar el perfil qgue desea modificar,
luego presione <OK> (Aceptar).

5 Utilice la tecla de la flecha hacia abajo para
seleccionar el item que desea modificar, luego
presione <OK> (Aceptar).

Modifique el item.

Utilice las teclas de flecha para seleccionar
[Enter] (Intro), luego presione <OK> (Aceptar).

8 Si desea modificar mas de un item, repita los
pasos del 5 al 7.

9 Presione <OK> (Aceptar) para registrar
la configuracion.

Como borrar un perfil

Nota

Si utiliza las teclas de flecha, presionelas varias
veces para buscar la opcidn que desea seleccionar.

1 Presione la tecla <SETTING> (Configuracién)
en el panel de control.

2 Utilice la tecla de la flecha hacia abajo para
seleccionar [Profile] (Perfil) y luego presione
<OK> (Aceptar).

3 Utilice la tecla de la flecha hacia abajo para
seleccionar [Delete] (Borrar) y luego presione
<OK> (Aceptar).

4 Utilice la tecla de la flecha hacia abajo para
seleccionar el perfil que desea borrar, luego
presione <OK> (Aceptar).

5 Utilice la tecla de la flecha hacia abajo
para seleccionar [Yes] (Si) en el mensaje
de confirmacién.

6 Si desea borrar mas de un perfil, repita los
pasos 4 y 5.

7 Presione <OK> (Aceptar).
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Como configurar la autenticacion del

usuario y el control de acceso

Informacion general

Estas funciones se usan para limitar el acceso al
equipo. Esto puede ayudarlo a ahorrar téner,
papel y el desgaste del equipo.

La autenticacion del usuario y el control de acceso
estan protegidos con una contrasefia y deben ser
configurados por el administrador del sistema.

Se requieren las siguientes condiciones para

habilitar estas funciones:

e El equipo debe estar conectado a una red.

e En redes Unicamente con sistemas Windows, la
utilidad Configuration Tool (Herramienta de
configuracién) debe estar instalada en una
computadora en la red.

e En sistemas Macintosh, debe estar instalada la
utilidad Job Accounting Client (Cliente de
contabilidad de trabajos).

éAutenticacion del usuario?

La autenticacion del usuario permite al
administrador del sistema limitar el uso del equipo
a las personas a las que se les ha asignado
e un PIN (nimero de identificaciéon personal)
o bien,
e un nombre de usuario y contrasefia.
Esta limitacion rige tanto para el acceso
manual como para el uso del equipo desde
una computadora.

Puede asignar hasta 100 PIN con o sin nombre de
usuario y contrasefia.

Control de acceso

El control de acceso va aln mas lejos ya que
permite al administrador del sistema limitar el
tipo de funciones que puede realizar cada
persona autorizada a usar el equipo.

El control de acceso puede aplicarse a las
siguientes funciones:

e Fotocopiado (Color/Mono)

e Impresion (Color/Mono)

e Impresion desde la memoria USB

e Escanear a correo electrénico

e Enviar escaneo a computadora en la red
e Enviar escaneo a memoria USB

e Envio por fax

e Enviar fax a través de una PC

e Enviar fax por Internet

Antes de comenzar

Hay varias maneras de configurar el control de
acceso de su equipo:

e Mediante el uso de software
e Mediante el uso de la pagina web
e A través del panel de control

Esta guia incluye instrucciones para configurar el
equipo mediante el uso de software.

Para obtener mas informacion sobre el uso de la
pagina web o el panel de control, consulte la Guia
avanzada del usuario en www.my.okidata.com.

Sistemas Windows

Como cargar la Herramienta de

configuracion

A fin de configurar la autenticacién del usuario y
el control de acceso en Windows, usted debe
cargar la utilidad Configuration (Configuracion)
en su computadora.

144 - Espaiiol



1 Asegurese de que su computadora esté
encendida y conectada al equipo, luego
coloque el DVD que vino con su equipo en la
unidad de CD/DVD.

El DVD se ejecuta automaticamente. Si no lo
hace, haga doble clic en el archivo de
configuracion OKI en el DVD.

2 Seleccione su idioma de la lista desplegable y
haga clic en [Next] (Siguiente).

3 Lea el Contrato de licencia, luego haga clic en
[I Agree] (Acepto).

Haga clic en [MFP Software] (Software de la MFP).

5 Haga clic en [Install Configuration Tool]
(Instalar Herramienta de configuracion).

SET
OKI D=

PRINTING SOLUTIONS

OKI MC361/561

Driver Setup
Color Software

Network Software
Optional Utilities
MFP Software

= Register your Primter

CREKING this will Al B launch a Wed
Biweser and conniel 1 e intemed

6 Haga clic en [Install] (Instalar) y espere a que
se instale el software.

7 Seleccione el modelo de su equipo, luego
haga clic en [Next] (Siguiente).

8 Haga clic en [Close] (Cerrar).

Como utilizar la herramienta de
configuracion para establecer
la autenticacion del usuario o el
control de acceso

1 Asegurese de que la computadora y el equipo

estén conectados a través de la red y que
ambos estén encendidos.

2 Haga clic en [Start] (Inicio) > [Programs]
(Programas) > [Okidata] > [Configuration Tool]
(Herramienta de configuracion) > [Configuration
Tool] (Herramienta de configuracidén).

== Configuration Tool =lolx|
File Tools Plug-in  View Help

Configuration Tool

Configuration Tool }

3 Haga clic en [Register Device] (Registrar
dispositivo) en la lista desplegable
Tools (Herramientas).

4 Haga doble clic en el modelo de su equipo.

El nombre aparece en [Registered Device
Table] (Tabla de dispositivos registrados) en la
parte izquierda de la pantalla.

5 Haga doble clic sobre su equipo en la lista, luego
seleccione la ficha [User Setting] (Configuracion
del usuario).

6 Haga clic en [PIN Manager] (Administrador de
PIN), luego introduzca la contrasefa de
administrador y haga clic en <OK> (Aceptar).

7 Para ingresar un numero de PIN nuevo y
configurarlo con el control de acceso deseado,
haga clic en el icono del PIN.

Para ingresar un usuario nuevo con ID de usuario,
contrasefa y numero de PIN, haga clic en el icono
New (User) (Nuevo [usuario]).

Repita el paso anterior para cada usuario de la red.

Cuando termine, haga clic en el icono [Save to
Device] (Guardar en dispositivo).

Los registros que haya ingresado se guardaran en
el equipo.

Sistemas Mac

A fin de configurar la autenticacion del usuario y
el control de acceso en Mac, consulte la Guia
avanzada del usuario en www.my.okidata.com.
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Autenticacion por PIN

Como habilitar el control de

acceso por PIN

Cuando haya terminado de configurar los PIN o
las ID de usuario y contrasefas, debe entrar al
menu del equipo y habilitar el control de acceso.

El control de acceso esta protegido con una
contrasefa: debe conocer la contrasena del
administrador para continuar.

Nota

Para desplazarse en la lista de selecciones de la
pantalla, presione varias veces la tecla de la
flecha hacia abajo (o hacia arriba).

1 Presione <SETTING> (Configuracion) en el
panel de control.

2 Utilice la tecla de la flecha hacia arriba para
seleccionar [Admin Setup] (Configuracién
del administrador) y luego presione
<OK> (Aceptar).

3 Escriba su contrasefia de administrador:
utilice las teclas de flecha para seleccionar los
digitos de la contrasefia y presione <OK>
(Aceptar) entre digitos.

4 Cuando haya terminado de ingresar su
contrasefia, utilice las teclas de flecha para
seleccionar la opcion [Enter] (Intro) en la
pantalla y presione <OK> (Aceptar).

5 Utilice la tecla de la flecha hacia arriba para
seleccionar [Management] (Administracion) y
luego presione <OK> (Aceptar).

6 Utilice la tecla de la flecha hacia abajo para
seleccionar [System Setup] (Configuracion
del sistema) y luego presione
<OK> (Aceptar).

7 Asegurese de que [Access Control] (Control
de acceso) esté seleccionado y luego presione
<OK> (Aceptar).

8 Utilice la tecla de la flecha hacia arriba para
seleccionar PIN como método de control de
acceso y luego presione <OK> (Aceptar).

9 Utilice la tecla de la flecha hacia la izquierda
para volver a la pantalla principal.

El control de acceso esta habilitado.

Acceso desde la unidad

Inicio de sesion

Login

PN ro.

oK)

Usuarios generales

1 Introduzca su PIN asignado mediante el uso
del teclado de 10 digitos en el panel de control.

2 Presione <OK> (Aceptar).
Aparece la pantalla principal.

Administrador

1 Introduzca “"000000” mediante el uso del
teclado de 10 digitos en el panel de control,
luego presione <OK> (Aceptar).

e EI PIN del administrador es *000000”. No
puede cambiar este valor.

2 Cuando aparezca la pantalla Admin Password
(Contrasefia del administrador), ingrese la
contrasefia del administrador: utilice las
teclas de flecha para seleccionar los digitos de
la contrasena y presione <OK> (Aceptar)
después de resaltar cada digito.

3 Utilice las teclas de flecha para seleccionar la
opcion [Enter] (Intro) en la pantalla y
presione <OK> (Aceptar).

Aparece la pantalla principal.

Cierre de sesion

Cuando haya terminado de usar el equipo,
asegulrese de cerrar sesion.

1 Presione la tecla de la flecha hacia la izquierda
hasta que aparezca la pantalla principal.

2 Presione <RESET/LOGOUT> (Reiniciar/Cerrar
sesion) en el panel de control.

e o' WD)
m— 0 ®O®
_ DO

| [slole)

La pantalla regresa al mensaje para ingresar el PIN.
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Nota

Después de un tiempo determinado, el equipo
cierra automaticamente la sesién del usuario.

Como configurar el
funcionamiento desde una
computadora con autenticacion
por PIN

Primero, asegulrese de que se hayan instalado en
la computadora los controladores del equipo
adecuados mediante el uso del DVD.

Segundo, instale el software Job Accounting
(Contabilidad de trabajos) (cliente) en la
computadora. Para ello, coloque el DVD que vino
con el equipo en la unidad de la computadora y
siga las instrucciones en pantalla para descargar
el software Job Accounting (Contabilidad de
trabajos) desde Internet.

= OKI Printing Solutions =lol x|
OKI 9

PRINTING SOLUTIONS

OKI MC361/561

Coler Software
Netwerk Software
Optional Utilities
MFP Software

Internet Downloads

T= Register your Printer

(Clicking this will atiempt bo launch a Wb
Bunwser and CORNMCE10 th wiemen

Nota

El tipo de autenticacion especificado en la
computadora anula al especificado en el equipo.

Como configurar computadoras
Windows para imprimir

Nota

Este procedimiento utiliza MC561 y Windows 7
como ejemplo. Los procedimientos y menus

pueden variar segun el sistema operativo en uso.

Haga clic en [Start] (Inicio) > [All Programs]
(Todos los programas) > [Okidata] >

[Print Job Accounting Client] (Cliente de
contabilidad para trabajos de impresién) >
[Change Job Accounting Mode] (Cambiar
modo de contabilidad de trabajos).

En la ventana [User Account Control] (Control de
la cuenta del usuario), haga clic en [Yes] (Si).

Seleccione el controlador de la impresora que
necesita en [Driver] (Controlador).

Seleccione la casilla [Tab] (Ficha) y luego
haga clic en [Change] (Cambiar).

Haga clic en [OK] (Aceptar).

Del menu [File] (Archivo), seleccione
[Close] (Cerrar).

Haga clic en [Start] (Inicio) y seleccione [Devices
and Printers] (Dispositivos e impresoras).

e En Windows Server 2008, haga clic en
[Start] (Inicio) y seleccione [Control Panel]
(Panel de control) > [Printers] (Impresoras).

e En Windows Vista, haga clic en [Start]
(Inicio) y seleccione [Control Panel] (Panel
de control) > [Printer] (Impresora).

e En Windows Server 2003, haga clic en
[Start] (Inicio) > [Printers and Faxes]
(Impresoras y faxes).

e En Windows XP, haga clic en [Start] (Inicio) >
[Printers and Faxes] (Impresoras y faxes).

e En Windows 2000, haga clic en [Start]
(Inicio) > [Settings] (Configuracidon) >
[Printers] (Impresoras).

Por cada controlador instalado en
la computadora:

a) Haga clic con el boton derecho en el icono
OKI MC561 y seleccione [Printer properties]
(Propiedades de la impresora) > [OKI
MC561 (XXX*)].

*XXX = PCL, PS o FAX

b) Seleccione la ficha [Job Accounting]
(Contabilidad de trabajos).
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c) Introduzca el nombre de usuario en [User
Name] (Nombre de usuario) y el PIN en [Job
Account ID] (ID de cuenta de la tarea).

= OKI MCSB1(PCL) Properties |
Generd Sharing Poris Advanced Color Managemert
Status Job Accourting Security Device Option
Job ceourting Seting
User Hame [up to B0 characters)
’ Oki
Job Account 1D [1-933393333)
}1
OK | [ Carcal | [ ooy |

d) Haga clic en [OK] (Aceptar).
Impresion bajo Windows
1 Abra el archivo que desea imprimir.

2 Del menu [File] (Archivo), seleccione
[Print] (Imprimir).

3 Seleccione el controlador de la impresora,
luego haga clic en [Print] (Imprimir).

Como configurar computadoras Mac
para imprimir

Nota

Este procedimiento utiliza el modelo MC561 y
Mac OS X 10.6 (Snow Leopard) como ejemplo.
Los procedimientos y menus pueden variar segin
el sistema operativo en uso.

1 Inserte el DVD que vino con su equipo.

Haga doble clic en el icono OKI en su escritorio.

Haga doble clic en [Utility] (Utilidad) > [JA
Client] (Cliente de CT) > [Print JobAccounting]
(Contabilidad para trabajos de impresion).

4 Haga clic en [New] (Nuevo).

5 Introduzca el nombre de usuario al lado de
[User Name] (Nombre de usuario) y el PIN al
lado de [Job Accounting ID] (ID de
Contabilidad de trabajos).

OO

( Cancel )

LoginName : Administrator

ﬁ UserName : Oki
ﬁ JobAccountingID : | 2

C Help )
( Help )

Haga clic en [Save] (Guardar).
Haga clic en [Save] (Guardar).

Si es necesario, introduzca la contrasefa de
usuario y luego haga clic en [OK] (Aceptar).

Impresion bajo Mac
1 Abra el archivo que desea imprimir.

2 Del menu [File] (Archivo), seleccione
[Print] (Imprimir).

3 Seleccione su equipo y luego haga clic en
[Print] (Imprimir).

Como configurar computadoras
Windows para enviar un fax

Nota

Este procedimiento utiliza MC561 y Windows 7
como ejemplo. Los procedimientos y menus
pueden variar segun el sistema operativo en uso.

1 Haga clic en [Start] (Inicio) > [All Programs]
(Todos los programas) > [Okidata] > [Print
Job Accounting Client] (Cliente de
contabilidad para trabajos de impresién) >
[Change Job Accounting Mode] (Cambiar
modo de contabilidad de trabajos).

2 Enlaventana [User Account Control] (Control de
la cuenta del usuario), haga clic en [Yes] (Si).

3 Seleccione el controlador de fax en
[Driver] (Controlador).

4 Seleccione la casilla [Tab] (Ficha) y luego
haga clic en [Change] (Cambiar).

5 Haga clic en [OK] (Aceptar).

Del menu [File] (Archivo), seleccione
[Close] (Cerrar).
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7 Haga clic en [Start] (Inicio) y seleccione [Devices
and Printers] (Dispositivos e impresoras).
- En Windows Server 2008, haga clic en
[Start] (Inicio) y seleccione [Control Panel]

(Panel de control) > [Printers] (Impresoras).

- En Windows Vista, haga clic en [Start]
(Inicio) y seleccione [Control Panel] (Panel
de control) > [Printer] (Impresora).

- En Windows Server 2003, haga clic en
[Start] (Inicio) y seleccione [Printers and
Faxes] (Impresoras y faxes).

- En Windows XP, haga clic en [Start] (Inicio)
y seleccione [Printers and Faxes]
(Impresoras y faxes).

- En Windows 2000, haga clic en [Start]
(Inicio) y seleccione [Settings]
(Configuracion) > [Printers] (Impresoras).

8 Haga clic con el botdn derecho en el icono
OKI MC561 y seleccione [Printer properties]
(Propiedades de la impresora) > [OKI
MC561 (FAX)].

9 Seleccione la ficha [Job Accounting]
(Contabilidad de trabajos).

10 Introduzca el nombre de usuario en [User
Name] (Nombre de usuario) y el PIN en [Job
Account ID] (ID de cuenta de la tarea).

11 Haga clic en [OK] (Aceptar).
Como enviar un fax con Windows
1 Abra el archivo que desea enviar por fax.

2 Del menu [File] (Archivo), seleccione
[Print] (Imprimir).

3 Seleccione el controlador de fax, luego haga
clic en [Print] (Imprimir).

Autenticacion por nombre de
usuario y contrasena

Como habilitar el control de
acceso por nombre de usuario

o contrasena

El control de acceso esta protegido con una
contrasefa: debe conocer la contrasefa del
administrador para continuar.

Nota

Para desplazarse en la lista de selecciones de la
pantalla, presione varias veces la tecla de la
flecha hacia abajo (o hacia arriba).

1 Presione <SETTING> (Configuracion) en el
panel de control.

2 Utilice la tecla de la flecha hacia arriba para
seleccionar [Admin Setup] (Configuracion
del administrador) y luego presione
<OK> (Aceptar).

3 Escriba su contrasefia de administrador:
utilice las teclas de flecha para seleccionar los
digitos de la contrasefia y presione <OK>
(Aceptar) entre digitos.

4 Cuando haya terminado de ingresar su
contrasefia, utilice las teclas de flecha para
seleccionar la opcion [Enter] (Intro) en la
pantalla y presione <OK> (Aceptar).

5 Utilice la tecla de la flecha hacia arriba para
seleccionar [Management] (Administracion) y
luego presione <OK> (Aceptar).

6 Utilice la tecla de la flecha hacia abajo para
seleccionar [System Setup] (Configuracion
del sistema) y luego presione
<OK> (Aceptar).

7 Asegurese de que [Access Control] (Control
de acceso) esté seleccionado y luego presione
<OK> (Aceptar).

8 Utilice la tecla de la flecha hacia arriba para
seleccionar User/Password (Usuario y
contrasefia) como método de control de
acceso y luego presione <OK> (Aceptar).

9 Utilice la tecla de la flecha hacia la izquierda
para volver a la pantalla principal.

El control de acceso esta habilitado.

Operacion desde una
computadora

Nota

El tipo de autenticacion especificado en la
computadora anula al especificado en el equipo.
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Impresion bajo Windows

Nota

Este procedimiento utiliza Windows 7 y NotePad
como ejemplo. Los procedimientos y menus
pueden variar segun el sistema operativo en uso.

Abra el archivo que desea imprimir.

2 Del menu [File] (Archivo), seleccione
[Print] (Imprimir).

3 Seleccione el controlador de la impresora
que desea utilizar en [Select Printer]
(Seleccionar impresora) y haga clic en
[Preferences] (Preferencias).

4 Haga clic en la ficha [Job Options] (Opciones
de trabajo).

5 Haga clic en [User Auth] (Autenticacion
del usuario).

6 Seleccione la casilla [Use User Authentication]
(Usar autenticacién de usuario).

User Authentication [
_’» e Uiser Buhariictior

User Authentication

Username Use Windaws Lagin

Passward

Cancel

7 Introduzca el nombre de usuario en
[Username] (Nombre de usuario) y la
contrasena en [Password] (Contrasefia).

Al hacer clic en [Use Windows Login] (Utilizar
inicio de sesién de Windows), su nombre de
inicio de sesidn se introduce
automaticamente en Windows.

8 Haga clic en [OK] (Aceptar).

9 Haga clic en [OK] (Aceptar) y luego en
[Print] (Imprimir).

Impresion bajo Mac

Nota

Este procedimiento utiliza Mac OS X 10.6 como
ejemplo. Los procedimientos y menus pueden
variar segun el sistema operativo en uso.

1 Abra el archivo que desea imprimir.

2 Del menu [File] (Archivo), seleccione
[Print] (Imprimir).

3 Seleccione el controlador de impresora de
Su equipo.

4 Seleccione [UserAuth] (Autenticacién de
usuario) en el menu del panel debajo de
los menus [Printer] (Impresora) y
[Presets] (Configuracion).

&
&
®

From: 1 w1

) 20990y 20.70em

The bundle "UserAuth” couldn’t be loaded because it doesn't
contain a version for o it

the current architecture.

Cantact the bundie's creator listed hare for the latest version.

@ (Crore) (Cancel ) (CPrimt)

5 Seleccione la casilla [Use User Auth] (Usar
autenticacién de usuario) en el panel
[UserAuth] (Autenticacién de usuario).

[EIRETRES)

ﬁ ¥ Use User Auth

User Name :

Password

POF ¥ Preview Cancel ) Prine)

6 Introduzca el nombre de usuario asignado en
[User Name] (Nombre de usuario) y la
contrasefia en [Password] (Contrasefia).

7 Haga clic en [Print] (Imprimir).

Como enviar un fax con Windows

Nota

Este procedimiento utiliza Windows 7 y NotePad
como ejemplo. Los procedimientos y menus
pueden variar segun el sistema operativo en uso.

Abra el archivo que desea enviar por fax.

2 Del menu [File] (Archivo), seleccione
[Print] (Imprimir).

3 Seleccione el (controlador de fax) de su equipo
en [Select Printer] (Seleccionar impresora) y
haga clic en [Preferences] (Preferencias).

4 En la ficha [Setup] (Configuracién), haga clic
en [User Auth] (Autenticacion de usuario).

5 Seleccione la casilla [Use User Authentication]
(Usar autenticacion de usuario).
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Introduzca el nombre de usuario en
[Username] (Nombre de usuario) y la
contrasefna en [Password] (Contrasefia).

Nota

Al hacer clic en [Use Windows Login]
(Utilizar inicio de sesiéon de Windows), su
nombre de inicio de sesidn se introduce
automaticamente en Windows.

Haga clic en [OK] (Aceptar).

Haga clic en [OK] (Aceptar) y luego en
[Print] (Imprimir).
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Como configurar la maquina para

enviar fax

Configuracion basica para
enviar un fax

Debe configurar los siguientes valores antes de
transmitir un fax.

Como conectar una
linea telefonica

iImportante!

Utilice inicamente el cable de teléfono que
vino con su maquina. Si utiliza otro cable,
podria provocar un funcionamiento incorrecto.

Como conectar solamente el fax

1 Enchufe un extremo del cable de,teléfono
suministrado en la conexion de LINEA que se
encuentra en la parte posterior de su maquina y
el otro extremo en un enchufe telefénico activo.

2 Coloque la tapa del conector suministrada en
la conexion de TELEFONO que se encuentra
en la parte posterior de su maquina.

=

Como conectar el fax y el teléfono

1 Enchufe un extremo del cable de,teléfono
suministrado en la conexién de LINEA que se
encuentra en la parte posterior de su maquina y
el otro extremo en un enchufe telefénico activo.

2 Enchufe el cable de teléfono en la conexién de
TELEFONO que se encuentra en la parte
posterior de su maquina.
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Como especificar la
informacion del remitente y la
fecha y hora actual

Nota

Puede configurar la fecha y la hora de forma
automatica mediante el uso de la pagina web.
Para conocer detalles, consulte la Guia del
usuario avanzado en www.my.okidata.com.

Nota

Si utiliza las teclas de flecha, presionelas varias
veces para buscar la opcidon que desea seleccionar.

1 Presione <SETTING> (Configuracion) en el
panel de control.

2 Utilice la tecla de la flecha hacia abajo para
seleccionar [Easy Setup] (Configuracion facil)
y luego presione <OK> (Aceptar).

Setting
Wiew Information
Shutdown

3 Si es necesario, ingrese la contrasefa del
administrador; luego, utilice las teclas de
flecha para resaltar la opcion [Enter] (Intro) y
presione <OK> (Aceptar).

4 Teniendo [Date/Time Setting] (Configuracion
de fecha y hora) resaltado, pulse la tecla de la
flecha hacia la derecha.

o1 Date/Time

2. Fax Setting
o 3 Metwork Setting

@ Ciancel

5 Utilice la tecla de la flecha hacia abajo para
seleccionar la zona horaria adecuada y luego

presione la tecla de la flecha hacia la derecha.

Puede seleccionar la zona horaria entre
[-12:00] y [+13:00] en incrementos de
15 minutos.

6 Utilice la tecla de la flecha hacia abajo para
seleccionar [Not Summer Time] (Sin horario
de verano) o [Now Summer Time] (Horario de
verano) para ahorrar luz diurna, luego

presione la tecla de la flecha hacia la derecha.

7 Utilice la tecla de la flecha hacia abajo para
seleccionar [Manual] (Manual), luego presione
la tecla de la flecha hacia la derecha.

8 Utilice las teclas de las flechas hacia arriba y
hacia abajo para configurar el afio, el mes y el
dia; presione la tecla de la flecha hacia la
derecha para moverse al bloque siguiente.
Cuando termine, presione <OK> (Aceptar).

9 Utilice las teclas de las flechas hacia arriba y
hacia abajo para configurar la hora actual
(hora, minutos y segundos); presione la tecla
de la flecha hacia la derecha para moverse al
bloque siguiente. Cuando termine, presione
<OK> (Aceptar).

En la pantalla aparecera el mensaje “"Date/Time
Setting was completed” (Ha finalizado la
configuracion de fecha y hora), luego aparecera
la pantalla de configuracion del mend.

Como especificar la informacion del remitente

Especifique el nimero de fax y el nombre del
remitente de su maquina. La ID del remitente se
encuentra impresa en el borde superior del fax
cuando el destinatario lo imprime.

10 Presione la tecla de la flecha hacia abajo para
seleccionar [Fax Setting] (Configuracién de
fax), luego presione la tecla de la flecha hacia
la derecha.

.|
e 1 Date/Time Setting
2. Fax Setting
o 3 Metwork Setting
Cancel

11 Presione <OK> (Aceptar) para seleccionar
[FAX number] (nimero de FAX).

12 Utilice el teclado para introducir el nimero de
fax de su maquina.

13 Teniendo [Enter] (Intro) resaltado, presione
<OK> (Aceptar).

14 Pulse el botdn con flecha hacia la derecha para
seleccionar [Sender ID] (ID de remitente).

15 Use el teclado en pantalla para ingresar su ID de
hasta 22 digitos. Cuando haya ingresado la ID,
utilice las teclas de flecha para resaltar la opcién
[Enter] (Intro) y presione <OK> (Aceptar).

En la pantalla aparecera el mensaje “Fax
Setting was completed” (Ha finalizado la
configuracion de fax), luego aparecera la
pantalla de configuracion del menda.

16 Presione <OK> (Aceptar) para finalizar la
configuracién, luego utilice la tecla de la
flecha hacia la izquierda para volver a la
pantalla principal.
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Instalacion con USB

4 Presione el boton de bloqueo (1) en el
Conexion USB costado derecho de la maquina y retire la
tapa de acceso (2).

1 Prepare un cable USB.
Su maquina no viene con un cable USB.

Utilice un cable de alta velocidad USB 2.0 para
una conexion de alta velocidad USB 2.0.

2 Apague su maquina:

a) Presione <SETTING> (Configuracion) en el
panel de control.

b) Presione varias veces la tecla de la flecha
hacia abajo para deslizarse hasta
[Shutdown] (Apagado), luego presione
<OK> (Aceptar).

c) Cuando aparezca el mensaje de
confirmacion, presione la tecla de la flecha
hacia la derecha para seleccionar [Yes]
(Si) y luego presione <OK> (Aceptar).

d) Cuando se indique en la pantalla que debe
apagar el interruptor, apague la maquina.

3 Apague la computadora.

iCUIDADO!

No enchufe el cable USB en la conexion de
red. Si lo hace, puede provocar un
funcionamiento incorrecto.
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5 Enchufe un extremo del cable USB en la

conexion USB que se encuentra en la maquina.

-

6 Asegure el cable USB debajo del gancho (1)
de la maquina.

7 Ajuste las lengletas sobre la tapa lateral en
las ranuras (1) de la caja de la maquina y
calcelas en su lugar.

Para la instalacion en Windows, vaya
a la pagina 155.

Para la instalacion en Macintosh,
vaya a la pagina 157.

USB: Como instalar un
controlador de la impresora
para Windows

e Para completar este procedimiento, debe estar
conectado como administrador.

Nota

El siguiente procedimiento utiliza Windows 7 y el
modelo MC561 como ejemplo. La pantalla puede
variar segun el sistema operativo.

1 Apague su maquina:

a) Presione <SETTING> (Configuracion) en el
panel de control.
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b) Presione varias veces la tecla de la flecha
hacia abajo para seleccionar [Shutdown]
(Apagado) y luego presione <OK> (Aceptar).

¢) Cuando aparezca el mensaje de
confirmacion, presione la tecla de la flecha
hacia la derecha para seleccionar [Yes]
(Si) y luego presione <OK> (Aceptar).

d) Cuando se indique en la pantalla que debe
apagar el interruptor, apague la maquina.

Inserte el DVD que vino con su maquina en la
unidad de CD/DVD.

I

El DVD se ejecuta automaticamente. Si no lo
hace, haga doble clic en el archivo de
configuracion OKI en el directorio DVD.

Seleccione su idioma de la lista desplegable y
haga clic en [Next] (Siguiente).

Lea el Contrato de licencia, luego haga clic en
[I Agree] (Acepto).

En la configuracion del controlador, haga clic
en [Install Drivers (MC561)] (Instalar
controladores [MC561]).

Nota

Si aparece el cuadro de didlogo [User Account
Control] (Control de la cuenta del usuario),
haga clic en [Yes] (Si). En Windows Vista,
haga clic en [Continue] (Continuar).

6 Lea y observe las instrucciones, luego haga

clic en [Next] (Siguiente).

Comienza la instalacién.
e Si aparece el cuadro de didlogo [Windows

Security] (Seguridad de Windows), haga clic en
[Install this driver software anyway] (Instalar el

software de este controlador de todas maneras).

Si en Windows Server 2003 y Windows XP
aparece el cuadro de didlogo [Install
Hardware] (Instalar hardware), haga clic en
[Continue] (Continuar).

Si en Windows 2000 aparece el cuadro de
didlogo [Digital Signature Not Found] (Firma
digital no encontrada), haga clic en [Yes] (Si).

7 Cuando aparezcan las instrucciones que lo
indiquen, enchufe el cable USB en la
computadora y encienda su maquina.

8 Haga clic en [Next] (Siguiente).

9 Siga las instrucciones en pantalla para

finalizar la instalacion.

10 Cuando aparezca la pantalla [Complete]

(Completo), haga clic en [Finish] (Finalizar).

Verificar la instalacion

1

2

Haga clic en [Start] (Inicio) > [Devices and
Printers] (Dispositivos e impresoras).

En Windows Server 2008 y Windows Vista,
haga clic en [Start] (Inicio) > [Control Panel]
(Panel de control) > [Printer] (Impresora).

En Windows Server 2003 y Windows XP, haga
clic en [Start] (Inicio) > [Printers and Faxes]
(Impresoras y faxes).

En Windows 2000, haga clic en [Start]
(Inicio) > [Settings] (Configuracién) >
[Printers] (Impresoras).

Aseglrese de que aparezca el icono
OKI MC561.

En Windows 7, si ha instalado varios
controladores, haga clic con el botén derecho
en el icono OKI MC561 vy seleccione un item del
menu; luego verifique que todos los
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controladores de la impresora instalados
aparezcan en el submend.

See what's printimg . ORI MCSBLFAX)
St a6 delanlt prinber ORI MCSELPCL XPS)
Printing preferences » ORI MCSELIPCL)
Printer properties » 0K MCSELIPS)
Delete print quewe

Create shareut

Treubleibont

Remeve device

Propertie

En otros sistemas operativos de Windows,
verifique que aparezca el icono que
representa cada controlador.

3 Retire el DVD de la computadora.

Se ha completado la instalacion.

Nota

El método [Easy Install (Local)] (Instalacién facil
[Local]) es un método de instalacion sencillo. Si
desea seleccionar un controlador para instalarlo
manualmente, seleccione [Install printer driver
completely] (Instalar completamente el
controlador de la impresora) y luego siga las
instrucciones que se muestran en la pantalla.

USB: Como instalar un
controlador de la impresora
para Mac

iImportante!

e Para Mac, solo se encuentra disponible el
controlador de impresora PS.

e Desactive el programa antivirus antes de
iniciar este procedimiento.

Para Mac 0OS X 10.3.9a 10.4.11

Nota

El siguiente procedimiento utiliza Mac OS X
10.4.11 y el modelo MC561 como ejemplo.

1 Apague su maquina:

a) Presione <SETTING> (Configuracion) en el
panel de control.

b) Presione varias veces la tecla de la flecha
hacia abajo para deslizarse hasta
[Shutdown] (Apagado), luego presione
<OK> (Aceptar).

¢) Cuando aparezca el mensaje de
confirmacion, presione la tecla de la flecha
hacia la derecha para seleccionar [Yes]
(Si) y luego presione <OK> (Aceptar).

d) Cuando se indique en la pantalla que debe
apagar el interruptor, apague la maquina.

Apague la computadora.

Enchufe el otro extremo del cable USB en el
conector de interfaz USB de la computadora.

4 Encienda la Mac.

5 Inserte el DVD que vino con su maquina en
la computadora.

6 Haga doble clic en el icono [OKI] >
carpeta [Driver] (Controlador) > carpeta
[Printer] (Impresora).

7 Haga doble clic en [Installer for Mac OS X]
(Instalador para Mac OS X).

8 Escriba el nombre y la contrasefia del
administrador, y luego haga clic en
[OK] (Aceptar).

9 Siga las instrucciones en pantalla para
finalizar la instalacién.

10 Retire el DVD del manual o controlador de
la computadora.
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11 Desde el menu [Go] (Ir), seleccione Para Mac OS X 10.5y 10.6
[Applications] (Aplicaciones) > [Utilities]
(Utilidades) y luego haga doble clic en [Printer
Setting Utility] (Utilidad de configuracién

de impresora). Not.a ] o -

El siguiente procedimiento utiliza Mac OS X 10.6
iImportante! (Snow Leopard) y el modelo MC561 como ejemplo.
Si la Utilidad de configuracion de
impresora ya esta ejecutandose, ciérrela
y abrala nuevamente. 1 Aseglrese de que su maquina y la

computadora estén encendidas y conectadas.
12 Haga clic en [Add] (Agregar). 2 Enchufe el otro extremo del cable USB en el
Si aparece el cuadro de diadlogo [You have no conector de interfaz USB de la computadora.

printers available] (No hay impresoras
disponibles), haga clic en [Add] (Agregar).

Nota

Si ya aparece el nombre de su maquina,
seleccidnelo y haga clic en [Delete] (Borrar);
luego, haga clic en [Add] (Agregar).

13 Seleccione el nombre del USB designado de
su maquina, luego verifique que el nombre de
su maquina aparezca en [Print Using]
(Impresora en uso).

i 8ose Printer Browser =
B ]
=5 2 S
Default Browser IP Printer Search
A ERNE B Connecaon 3 Inserte el DVD que viene con la maquina en
—_— . a
[U la computadora.

Name: MC561

Location: Administrater’s iMac

Print Using: . OKI MC561(PS) X ]

P oy 4 Haga doble clic en el icono [OKI] >
carpeta [Driver] (Controlador) > carpeta
[Printer] (Impresora).

14 Haga clic en [Add] (Agregar). 5 Haga doble clic en [Installer for MacOSX]
15 Si aparece la ventana [Installable Options] (Instalador de MacOSX).
(Opciones instalables), haga clic en
[Continue] (Continuar).

@

BN

6 Escriba el nombre y la contrasefia del

Si ha instalado otras opciones antes de administrador, y luego haga clic en

; ) ; [OK] (Aceptar).

instalar el controlador, configure cada item y ] ] ] o

luego haga clic en [Continue] (Continuar). Siga las instrucciones en pantalla para finalizar
la instalacion.

16 Verifique que el nombre de su maquina _

impresoras) y luego cierre la ventana. la computadora.

8 Desde el menu Apple, seleccione [System

Se ha completado la instalacion. Preferentes] (Preferencias del sistema).
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9 Haga clic en [Print & Fax] (Impresora y fax).
10 Haga clic en [+].

11 Seleccione el nombre del USB designado de
su maquina y luego verifique que el nombre
de su maquina aparezca en [Print Using]
(Impresora en uso).

Add Printer =
Q
Printer Name &|Kind |
_> OKI DATA CORP MC561 USB

Name: OKI DATA CORP MC561
Location: Administrator’s iMac

Print Using: OKI MC561(PS)

Add

12 Haga clic en [Add] (Agregar).

13 Si aparece la ventana [Installable Options]
(Opciones instalables), haga clic en
[Continue] (Continuar).

Si ha instalado otras opciones antes de instalar
el controlador, configure cada item y luego
haga clic en [Continue] (Continuar).

14 Verifique que el nombre de su maquina
aparezca en la lista de impresoras y luego
cierre [Print & Fax] (Impresora y fax).

Se ha completado la instalacion.
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Pagina de configuracion

Ne |item Ejemplo Su valor

A: Informacion basica de configuracion

A-1 Contrasena del administrador para su maquina | aaaaaa (el valor
predeterminado)

A-2 Direccién IP de su maquina 192.168.0.2

B: Escanear a correo electronico y Fax en Internet

B-1 Direccion de correo electronico de su maquina mc561@test.com
(hasta 80 caracteres)

B-2 Direccidn del servidor SMTP smtp.test.com
B-3 Direccion del servidor POP3 pop3.test.com
B-4 Método de Autenticacién SMTP

B-5 ID de usuario SMTP OKIMC561
B-6 Clave SMTP okimc561

B-7 ID de usuario POP usuario

B-8 Clave POP okimc561

B-9 Nombre del correo electrénico de destino Usuario

B-10 | Direccion de correo electrénico del destino user@test.com
C-1 Nombre de la computadora de destino PC1

C-2 Nombre de usuario para conectarse a la mc561

computadora de destino (hasta 32 caracteres)

C-3 Contrasefia para conectarse a la computadora de | mc561
destino (hasta 32 caracteres)

C-4 Nombre del perfil para registrar la configuracion | Ventas
(hasta 16 caracteres)

C-5 Nombre de la carpeta compartida en la SalesDev
computadora de destino (hasta 64 caracteres)

C-6 Nombre del archivo de datos escaneados ScanData
(hasta 64 caracteres)
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Instalacao do hardware

Conteldo do pacote Prepare o local de instalacao

Requisitos ambientais

e Faixa de temperatura: 50 a 89,6 °F
(10 a 32 °C)

e Umidade: umidade relativa entre 20 e 80 %
Se a sua unidade for instalada em um local
com umidade relativa inferior a 30 %, use um
umidificador ou tapete antiestatico.

e Temperatura de bulbo Umido maxima:

77 °F (25 °QC)
Tenha cuidado com a condensacédo. Ela pode
causar um funcionamento incorreto.

Requisitos de espaco

Unidade

DVD

Cabo de alimentacao

Cabo de telefone

Cobertura do conector do telefone

UNUHAWN KR

Nota o Requisitos de energia
Os cab_os Ethernet e_USB nao sao e 110-127 VAC ou 220-240 VAC
fornecidos com a unidade e devem ser

e 50/60 Hz (42 mm)

adquiridos separadamente.
e 1100 watts no maximo

E recomendéavel que vocé guarde as Importante!
embalagens, elas sdo necessarias para o N3&o conecte este produto a um sistema de
transporte da unidade. energia ininterrupto (UPS).

Se a fonte de alimentacgdo for instavel, use
um regulador de voltagem.
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2 Remova os materiais de embalagem externos.

Desembalar a unidade

Importante!

7

A0 necessarias

para erguer a unidade com seguranga.

Pelo menos duas pessoas s

3 Remova a fita de embalagem externa.

Nota

feréncia. As

fitas e o material de embalagem podem diferir

um pouco da ilustracao.
Guarde as embalagens
transportar a unidade.

do para re

~

As ilustracOes a seguir s

30 necessarias para

elas s

4

1 Remova a unidade da caixa e coloque-a onde

sera instalada.

4 Abra a tampa do AAD e remova o material

de embalagem.
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9 Abra o scanner e remova o material

5 Levante a bandeja de documentos e remova o

de embalagem.

material de embalagem.

10 Pressione o botdo de liberacdo da tampa (1) e

abra a tampa superior (2).

6 Abaixe a bandeja de documentos e feche a

tampa do AAD.

7 Abra a tampa do scanner (1) e remova o

material de embalagem e a folha protetora.

8 Feche a tampa do scanner.

e O tubo verde no cilindro OPC é mui

Cuidado!

to

-0 com cuidado.

delicado. Manipule
e Nao exponha o cilindro OPC

luz solar

a

incidente ou a luz de interior muito

intensa (aproximadamente superior a

deixe o cilindro OPC exposto

1.500 lux). Mesmo quando sob luz interior

%
S
=]
£
g
1
Q
"o
S
~Iaa
g E
L.
Q0
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13 Deslize a luva de travamento azul em cada

11 Remova as fitas e o material de embalagem

cartucho de toner para a esquerda até que

ela pare.

dos cartuchos de toner.

14 Feche com cuidado a tampa superior e

12 Pressione a alavanca azul (1) da unidade

0 scanner.

da seta e remova e guarde

ao
o batente laranja (2).

~

fusora na direg

15 Remova a fita na bandeja multifuncional e

abra a bandeja.

Importante!
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16 Remova a fita do interior (1) e a folha

protetora (2) e feche a bandeja multifuncional.

Ligar a unidade

Conecte o cabo de alimentacdao a uma tomada
aterrada adequada.

Certifique-se de que nao haja documentos no
vidro ou no AAD e de que a tampa do AAD
esteja fechada.

Ligue a impressora.

B

1 Verifique se a chave liga/desliga (no lado
direito da unidade) esta desligada <O>.

Desligar a unidade

2 Conecte o cabo de alimentacdo a tomada na

parte traseira da unidade.

Cuidado!

Nao desligue a chave liga/desliga de
repente: isso pode danificar a unidade.
Sempre siga o procedimento correto para
assegurar que nenhum dado seja perdido.

1 Pressione <SETTING> (Ajuste) no painel

de controle.

2 Pressione a tecla de seta para baixo

repetidamente para selecionar [Shutdown]
(Desligar) e pressione <OK>.

Setting
Store Document Settings |i

Wiew Information

Shutdown

(K}

Quando a mensagem de confirmacao for
exibida, pressione a tecla de seta para a
direita para selecionar [Yes] (Sim) e
pressione <OK>.
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4 Quando for exibida na tela a solicitagdo para
desligar a unidade, desligue-a.

Modo de economia de
energia e modo de espera

Nota

Consulte o Manual Basico do Usuario online
no DVD fornecido com a unidade para obter
mais informacgoes.

Tecla de economia de energia

O C O C O C DO CD

(GEDGED) | GED) ) GED) GED)

pec] 98 QK

Quando a unidade ndo é usada por 30 minutos
(o padréo de fabrica), ela automaticamente entra
em modo de economia de energia para reduzir o
consumo de energia.

Vocé pode entrar no modo de economia

de energia (ou sair dele) pressionando
<POWER SAVE> (Economia de energia) no
painel de controle.

O painel de controle

BN\ 000 | oo

“(c) cee

SrCT R0 e

Para obter informacgdes sobre
e 0 painel de controle
e como inserir/excluir texto/dados

consulte o Manual Basico do Usuario online no
DVD fornecido com a unidade.

Carregar midia de impressao

Para obter mais informacGes sobre midia de
impressdo, consulte o Manual Basico do Usuario
online no DVD fornecido com a unidade.

1 Bandejal

2 Bandeja multifuncional
3 Bandeja 2 (opcional)
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Faixas de gramatura
selecionaveis

Faixa de gramatura

Designacao

Papel Medida

comum
Leve 17 a 18 |b. 64 a 74 g/m?
Leve médio 20 a 21 Ib. 75 a 82 g/m?
Médio 22 a281b. 83 a 104 g/m?
Pesado 28a 32 Ib. 105 a 120 g/m?
Ultrapesado 1 32 a47lb. 121 a 176 g/m?
Ultrapesado 2 47 a 58 Ib. 177 a 220 g/m?

Colocacao do papel: Bandeja 1
e bandeja 2 opcional

Bandeja 1

e Capacidade para até 250 folhas de papel de
20 Ib. Papel comum (75 g/m?)

e Tamanhos permitidos: Carta, Oficio 13/13,5/14,
Executivo, A4, A5, A6, B5, 16 K, Personalizado

e Faixa da gramatura do papel: 17 a 47 |b. Papel
comum (64 a 176 g/m?)

Bandeja 2 (opcional)
e Capacidade para até 530 folhas de papel de
20 Ib. Papel comum (75 g/m?)

e Tamanhos permitidos: os mesmos da
Bandeja 1, com excecdo do A6

e Faixa da gramatura do papel: a mesma da
Bandeja 1

Importante!

Antes de imprimir em tamanho de papel
personalizado, vocé primeiro deve definir o
tamanho no driver da impressora. Consulte
a pagina 170.

O procedimento a seguir mostra como colocar
papel na bandeja 1. O procedimento para a
bandeja 2 é igual.

1 Puxe a bandeja para papel para fora.

2 Deslize as guias de ajuste até a largura do
papel a ser carregado.

167 - Portugués



3 Ajuste o batente do papel (1) para o 5 Coloque o papel com o lado destinado a

comprimento adequado: pressione impressao para baixo. Mantenha a pilha
ligeiramente a alavanca de soltura azul (2) abaixo da linha indicadora de nivel maximo de
para baixo e deslize o batente até o papel (1).

comprimento do papel a ser colocado. O
comprimento selecionado sera mostrado na
janela de exibicdo (3).

6 Ajuste a guia de largura e o batente para
que figuem bem encostados no papel,
sem aperta-lo.

7 Empurre a bandeja para papel para dentro da
impressora até que pare.

Nota

Se vocé estiver colocando papel oficio, deslize o
batente do papel além do final da bandeja. Para
papel oficio 14, deslize-o o0 maximo possivel
(cerca de 2,5 pol., 64 mm). As configuragdes
para Oficio 13, Oficio 13,5 e Oficio 14 aparecerao
na janela do batente quando ele estiver
posicionado corretamente.

8 Defina as configuracdes da bandeja no menu
da unidade. Consulte “Definicao das
4 Flexione o papel para frente e para tras e configuragbes de bandeja” na pagina 170.
ventile-o. Endireite as bordas da pilha de
papéis em uma superficie nivelada.

> %
\_&M
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Co|ocag§o de papel na 3 Ajuste as guias de alimentagdo para a largura

- . . do papel a ser colocado.
bandeja multifuncional Pap
e Capacidade para até 100 folhas de papel de
20 Ib. Papel comum (75 g/m?), até 10 envelopes.
e Tamanhos permitidos: Carta; Oficio 13/13,5/
14"; Executivo; A4, A5, A6, B5; C5, DL,
envelopes Com-9, Com-10 e Monarch, cartdes
de 3 x 5 pol., papel fotografico tamanhos 4 x 6
ou 5 x 7 pol., faixas de até 52 pol. (1320 mm)
de comprimento, personalizado
e Faixa da gramatura do papel: 17 a 58 Ib. Papel
comum (64 a 220 g/m?)

Importante! 4
Antes de imprimir em tamanho de papel
personalizado, vocé primeiro deve definir o
tamanho no driver da impressora. Consulte

a pagina 170.

Insira o papel com o lado destinado a
impressdo para cima até que a borda toque a
entrada de alimentacdo do papel e ajuste a
posicao das guias de alimentacao.

1 Abaixe a bandeja multifuncional.

8

Nota

Coloque envelopes com a borda curta na
unidade, com a aba para baixo e a direita.

2 Puxe o suporte para papel e o subsuporte
para fora.

5 Pressione a trava da bandeja.

6 Registre o papel colocado na unidade.
Consulte a secao “Definicao das configuragdes
de bandeja” na p. 170.
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Nota

e N3o coloque transparéncias acima da
linha que indica a capacidade maxima
da bandeja.

e Ndo coloque papéis de tamanhos, tipos ou
gramaturas diferentes ao mesmo tempo.

e Ao adicionar papel, remova o papel da
bandeja multifuncional e endireite as
bordas de ambas as pilhas de papel
e recoloque-as.

e Ndo coloque nada diferente de papel para
impressao. Nao aplique muita pressao na
bandeja multifuncional.

Impressao do Relatorio de
configuracao

Vocé pode verificar as informagoes detalhadas da
sua unidade, como as configuragdes e o status,
imprimindo o Relatério de configuracao.

1 Pressione <SETTING> (Ajuste) no painel
de controle.

2 Use a tecla de seta para baixo para selecionar
[Reports] (Relatérios) e pressione <OK>.

3 Use a tecla de seta para baixo para
selecionar [Configuration] (Configuragao) e
pressione <OK>.

4 Quando a mensagem de confirmacgao
aparecer, pressione a tecla de seta para a
direita ou para a esquerda para selecionar
[Yes] (Sim) e depois pressione <OK>.

Definicao das configuracoes
de bandeja

Midia de impressao de
tamanho padrao

Nota

Para percorrer as varias selecbes na tela,
pressione a tecla de seta para baixo
repetidamente.

1 Pressione <SETTING> (Ajuste) no painel
de controle.

2 Use a tecla de seta para baixo para selecionar
[Paper Setup] (Configuracao do papel) e
pressione <OK>.

Setting

Paper Setup

Address Book

3 Use a tecla de seta para baixo para
selecionar a bandeja de papel aplicavel
e pressione <OK>.

4 Use a tecla de seta para baixo para
selecionar [Paper Size] (Tamanho do papel)
e pressione <OK>.

5 Use a tecla de seta para baixo para
selecionar o tamanho do papel carregado
e pressione <OK>.

6 Use a tecla de seta para baixo para
selecionar [Media Type] (Tipo de midia) e
pressione <OK>.

7 Use a tecla de seta para baixo para selecionar
o tipo de midia carregada e pressione <OK>.

8 Use a tecla de seta para baixo para selecionar
[Media Weight] (Gramatura da midia) e
pressione <OK>.

9 Use a tecla de seta para baixo para
selecionar a gramatura do papel carregado
e pressione <OK>.

Midia de impressao de

tamanho personalizado

Para colocar papel de tamanho personalizado,
VOCé precisa registrar a largura e o comprimento
dele antes de imprimir.

Bandeja Faixa de tamanhos disponiveis
Bandeja 1 Largura:

4,1 a 8,5 pol. (105 a 216 mm)

Comprimento:

5,8 a 14,0 pol. (148 a 356 mm)
Bandeja 2 Largura: o mesmo que a Bandeja 1
(opcional) Comprimento:

8,3 a 14,0 pol. (148 a 356 mm)
Bandeja Largura:
multifuncional |2,5a 8,5 pol. (64 a 216 mm)

Comprimento:

5,0 a 52,0 pol. (127 a 1321 mm)
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Nota

Para a bandeja 1 e a bandeja 2, s6 é possivel
definir a configuracdo [Custom] (Personalizado)
quando [Paper Size] (Tamanho do papel) estiver
definido como [Custom].

Siga as etapas de 1 a 3 na esquerda.

2 Use a tecla de seta para baixo para selecionar
[Custom] (Personalizado) e pressione <OK>.

3 Insira o valor desejado na caixa Width
(Largura) usando o teclado.

Trany 1: Paper Size

Width Length
q05-216) {145-356)
mm mm
Cancel

4 Pressione a tecla da seta para a direita para
mover para a caixa Length (Comprimento) e
insira o valor usando o teclado.

5 Pressione <OK>.

Saidas da impressora

Importante!

Nao abra ou feche a saida traseira
(escaninho de saida de face para cima)
enquanto a unidade estiver imprimindo para
nao causar um atolamento de papel.

Uso da saida superior
(escaninho de saida de face
para baixo)

A saida superior (escaninho de face para baixo) é
o padrdo. Ela é ativada quando a saida traseira
é fechada.

e Entrega documentos com o lado destinado a
impressao para baixo.

e Capacidade para até 150 folhas de papel de
20 Ib. Papel comum (75 g/m?).

Uso da saida traseira
(escaninho de saida de face
para cima)

A saida traseira é habilitada quando aberta.

e Entrega documentos com o lado destinado a
impressao para cima.

e Proporciona um percurso reto para papel de
alta gramatura, transparéncias, envelopes
e etiquetas.

e Capacidade para 100 folhas de papel de 20 Ib.
Papel comum (75 g/m?).
e Capacidade para 10 envelopes.
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1 Abra a saida traseira na parte posterior da
unidade puxando-o na sua direcdo.

Colocacao de documentos
para escanear

Vocé pode usar o alimentador automatico de
documentos (1) ou o vidro do scanner (2) para
colocar documentos para cépia, escaneamento
ou fax.

Requisitos do documento

Para obter informacgdes sobre os requisitos do
documento, consulte o Manual Basico do Usuario
online no DVD fornecido com a unidade.

Colocacao de documentos no
alimentador automatico de

documentos (AAD)

e Capacidade para Carta, Oficio 13/13,5/14,
Executivo, A4, A5, A6, B5.

e Capacidade para 50 folhas de papel de 20 Ib.
Papel comum (75 g/m?).

e Coloque os documentos com a face para cima.

Importante!

Certifique-se de que qualquer resquicio de
cola, tinta ou liquido corretivo nos
documentos esteja completamente seco
antes de carrega-los.

1 Coloque o(s) documento(s) no AAD.
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a) Coloque os documentos na orientagao CO|OC3(}50 de documentos no
retrato com a borda superior primeiro.

vidro do scanner

e Capacidade para Carta, Executivo, A4, A5,
A6, B5

e Sdo aceitos documentos com até 0,78 pol.
(20 mm) de espessura

Importante!

Certifique-se de que qualquer resquicio de
cola, tinta ou liquido corretivo nos
documentos esteja completamente seco
antes de carrega-los.

1 Levante e abra a tampa do scanner.

b) Coloque os documentos na orientacao
paisagem com a borda esquerda primeiro.

2 Coloque um documento com a face para baixo
no vidro do scanner.

a) Se o documento estiver na orientacao

2 Ajuste as guias de acordo com a largura retrato, alinhe a borda superior com o
das paginas. canto superior esquerdo do vidro.
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b) Se o documento estiver na orientacao
paisagem, alinhe a borda direita com o
canto superior esquerdo do vidro.

3 Feche a tampa do scanner com cuidado.

Nota

Se vocé quiser usar as fungdes [N-in-1]
(N-em-1), [Sort] (Classificar) ou [DuplexCopy]
(Copia duplex), altere a configuragdo [Document
Direction] (Direcdao do documento) de acordo
com a direcdo do seu documento para obter o
resultado desejado. A configuragdo padrdo é
[Portrait] (Retrato).
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Instalacao em rede:
Conexoes e instalacao de drivers

de impressora

Sistemas operacionais
compativeis

A unidade oferece suporte aos
seguintes operacionais:

Windows

e Windows 7

e Windows 7 64-bit Edition

e Windows Server 2008 R2 64-bit Edition
e Windows Server 2008

e Windows Server 2008 64-bit Edition
e Windows Vista

e Windows Vista 64-bit Edition

e Windows Server 2003

e Windows Server 2003 x64 Edition

e Windows XP

e Windows XP x64 Edition

e Windows 2000

Macintosh
e Mac OS X 10.3.9 a 10.6.

Importante!

Os usuarios do Mac OS X 10.6 IntelPC
devem instalar o Rosetta antes de instalar o
driver de impressora.

Fazer a conexao de rede

Importante!

Vocé deve conectar a unidade a uma rede
com um cabo Ethernet adequado antes de
instalar o driver de impressora.

Nota

O hub e o cabo Ethernet ndo sdo incluidos
na unidade. O cabo Ethernet deve ser da
categoria 5, de pares trangados.

@

1 Desligue a unidade:

a) Pressione <SETTING> (Ajuste) no painel
de controle.

b) Use a tecla de seta para baixo para
selecionar [Shutdown] (Desligar) e
pressione <OK>.

¢) Quando a mensagem de confirmacao for
exibida, pressione a tecla de seta para a
direita para selecionar [Yes] (Sim) e
pressione <OK>.

d) Quando solicitado, desligue a unidade.

2 Desligue o computador.
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ranhuras (1) da caixa da unidade e deslize a
outra extremidade do cabo Ethernet no hub.

tampa para o lugar.

na unidade.
7 Conecte o hub a um computador e conecte a

5 Prenda o cabo Ethernet no gancho (1)
6 Encaixe as linguetas da tampa lateral nas

\ !
AR
> =\

LAN na unidade.

unidade e remova a tampa de acesso (2).
na conexao

4 Conecte uma extremidade do cabo Ethernet

3 Pressione a trava (1) no lado direito da
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Localizar o Formulario
de configuracao

A: Informacses basicas de configuracio

meSe 1 @rast.com

smtp.test.com

pap3.test.com

B-4 | Mérodo de autenticag o SMTP
B-5 |ID do usudric do SMTP OKIMCSEL

B-8 |Senhs POR akimcSe1

o do destine do e-mail

Vocé encontrara um Formulario de configuragdo
na pagina 213. Vocé pode usar esse formulario
para registrar as informagdes necessarias
sobre as suas configuracdes de rede e depois
consulta-lo ao configurar a unidade para
operagao em rede.

Definir a senha administrativa

Nota

Ao usar as teclas de seta para fazer as suas
selecOes, pressione a tecla repetidamente para ir
para a selecdo.

1 Pressione <Setting> (Ajuste) no painel
de controle.

e oo W)
0 OO®
@O0

2 Use a tecla de seta para baixo para selecionar
[Admin Setup] (Configuracdo de
administrador) e pressione <OK>.

Admin Password

L |
B. {\ -+ #%k=_123[( )
qwertyuiopdbée
asdfghjkIITBQ
zxcvbnm 0 B || Enter

3 Use a tecla de seta para baixo para selecionar
[a] e pressione <OK> seis vezes para inserir
a senha padrdo: aaaaaa.

4 Use as teclas de seta para selecionar [Enter]
na tela e pressione <OK>.

5 Use a tecla de seta para cima para
selecionar [Management] (Gerenciamento)
e pressione <OK>.

6 Use a tecla de seta para cima para selecionar
[Admin Password] (Senha de administrador) e
pressione <OK>.

7 Use as teclas de seta para selecionar os
digitos da sua senha, pressionando <OK>
apos cada digito.

8 Quando terminar de inserir a nova senha, use
as teclas de seta para selecionar Enter na tela
e pressione <OK>.

Nota

A senha de administrador deve ter pelo menos
seis digitos e diferencia mailsculas e mindsculas.

9 Depois de inserir todos os digitos, use as
teclas de seta para selecionar [Enter] na tela
e pressione <OK>.

10 Use a tecla de seta para a esquerda para
voltar a tela principal.

11 Insira a senha de administrador na linha A-1
do Formulario de configuragao.

Configurar a rede para
sistemas Windows

Para concluir a conexdo de rede com um
computador com Windows, defina o enderego
IP do computador e da unidade e instale o(s)
driver(s) da impressora no computador.
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Configurar o endereco IP,

se nhecessario

Se a sua rede atender as seguintes condigoes,
um endereco IP sera atribuido ao computador e a
unidade automaticamente.

e Se um servidor DHCP ou BOOTP estiver
na rede

e Plug-and-Play universal

Se todos os computadores conectados a
rede tiverem

e Windows 7

Windows Vista

Windows XP

Windows 2000

Windows Server 2008 R2

Windows Server 2008

Windows Server 2003

ou se o roteador oferecer suporte a
plug-and-play universal,

um endereco IP sera atribuido
automaticamente ao computador e a unidade
mesmo que nao haja um servidor DHCP/BOOTP
na rede.

Se a rede ndo atender as condigdes acima, ou se
o administrador da rede ou provedor de servigos
de Internet especificar um enderecgo IP exclusivo
para o computador e a unidade, defina os
enderecos IP manualmente.

Informacoes gerais

e \océ deve inserir a senha de administrador
para concluir este procedimento.

e Ao definir um endereco IP manualmente,
pergunte ao administrador da rede ou ao
provedor de servigos de Internet qual enderego
IP usar. Se o endereco IP ndo for definido
corretamente, a rede pode cair ou 0 acesso a
Internet pode ser desabilitado.

Nota

Se vocé estiver configurando uma pequena rede
que consista apenas da sua unidade e de um
computador, defina os enderecos IP como
mostrado a seguir (de acordo com a RFC1918):

Para o computador
Enderecgo IP: 192.168.0.1 a 254
Mascara de subrede: 255.255.255.0

Gateway padrao: ndo usado
Servidor DNS: ndo usado
Para a unidade

Endereco IP Manual

definido:

Endereco IP: 192.168.0.1 a 254 (selecione um

valor diferente do computador)
Mascara de subrede: 255.255.255.0

Gateway padrdo: 0.0.0.0

Escala de rede: Pequena

Para definir [Network Scale] (Escala de rede):

e Pressione <SETTING> (Ajuste) no painel
de controle.

e Selecione [Admin Setup] (Configuracdo do
administrador) > [Network Menu]
(Menu de rede) > [Network Setup]
(Configuracdo de rede) > [Network Scale]
(Escala de rede).

Configurar o endereco IP
do computador

Importante!

Se o endereco IP do seu computador ja for
conhecido, pule para a proxima segao
“Configurar o endereco IP da unidade”.

O procedimento a seguir usa o Windows 7 como
exemplo. As imagens na tela podem diferir
dependendo do sistema operacional.

1 Ligue o computador.

2 Clique em [Start] (Iniciar) > [Control Panel]
(Painel de controle) > [View network status
and tasks] (Exibir o status e as tarefas
da rede).

e No Windows Server 2003, clique em [Start]
(Iniciar) > [Control Panel] (Painel de
controle) > [Network Connections]
(Conexdes de rede) > [Local Area
Connection] (Conexao de rede local).
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e No Windows XP, clique em [Start]
(Iniciar) > [Control Panel] (Painel de
controle) > [Network and Internet
Connections] (Conexdes de rede e
Internet) > [Network Connections]
(Conexdes de rede).

e No Windows 2000, clique em [Start]
(Iniciar) > [Settings] (Configuragoes) >
[Network and Dial-up Connections]
(Conexoes dial-up e de rede).

Selecione [Change adapter settings] (Alterar
configuragdes do adaptador).

e No Windows Server 2008 e no Windows
Vista, selecione [Manage network

connections] (Gerenciar conexdes de rede).

e No Windows Server 2003, Windows XP e
Windows 2000, pule esta etapa.

Clique duas vezes em [Local Area Connection]
(Conexao de rede local).

e No Windows Server 2003, pule esta etapa.

Clique em [Properties] (Propriedades).

Se a caixa de diadlogo [User Account Control]
(Controle da conta do usuario) for exibida,
cliqgue em [Yes] (Sim). (No Windows Vista,
clique em [Continue] (Continuar)).

Selecione [Internet Protocol Version 4
(TCP/1Pv4)] (Versao de protocolo de Internet 4)
e clique em [Properties] (Propriedades).

r ~
U Local Area Connection Properties &J

MNetworking

Connect using:

LF Atheros ARS121/ARS113/ARS114 PCI-E Bthemet Contro

This connection uses the following items:

"% Cliert for Microsoft Networks

@QDS Packet Scheduler

E; File and Printer Sharing for Microsoft Networks
- |rtemet Protocol Version & (TCP/IPvE)

> : :
i Link-Layer Topology Discovery Mapper /0 Driver
-4 Link-Layer Topology Discovery Responder

Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected netwarks.

[ ok || cancel |

A

e No Windows Server 2003, Windows XP e
Windows 2000, selecione [Internet Protocol
(TCP/IP)] (Protocolo da Internet) e clique
em [Properties] (Propriedades).

7 Se estiver configurando um enderecgo IP
manualmente, insira o endereco IP, a mascara
de subrede, o gateway padrdo e o servidor
DNS e clique em [OK].

rInternet Protocol Version 4 (TCP/IPv4) Properties l ? &]1
General
‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.
~) Obtain an IP address automatically
@) Use the following IP address:
P P address: 192 .168 . 0 . 3
> Subnet mask: 255 .,255.255. 0
} Default gateway: 192.168. 0 . 1
Obtain DNS server address automatically
@) Use the following DNS server addresses:
Preferred DNS server:
Alternate DNS server:
[T validate settings upon exit Advanced. ..
[ OK ] | Cancel |
e Se estiver obtendo um endereco IP do
servidor DHCP automaticamente, selecione
[Obtain an IP address automatically] (Obter
um enderecgo IP automaticamente) e clique
em [OK].
Importante!

Nao insira um gateway padrao ou servidor
DNS se ndo for necessario.

8

Feche as janelas abertas.

Configurar o endereco IP da unidade

1
2

Ligue a unidade.

Pressione <SETTING> (Ajuste) no painel
de controle.

Use a tecla de seta para baixo para
selecionar [Easy Setup] (Configuracdo facil)
e pressione <OK>.

Wiew Information
Shutdown

Digite a senha do administrador. Veja a linha
A-1 do Formulario de configuragao

Use as teclas de seta para selecionar [Enter]
e pressione <OK>.
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6 Use a tecla de seta para baixo para selecionar
[Network Setting] (Configuragao da rede) e
pressione a tecla de seta para a direita.

7 Se estiver definindo um enderego IP
manualmente, use a tecla de seta para baixo
para selecionar [Manual] e pressione <OK>.

3. Basic Setting of Network

hanual

Auto

=

Se estiver obtendo um endereco IP
automaticamente, selecione [Auto] e
pule para “Instalar o driver de impressora
para Windows”.

8 Use a tecla de seta para a direita para mover-
se entre as caixas, inserindo as informagdes
aplicaveis em cada caixa usando o teclado e
pressione <OK>.

3. Basic Setting of Network

9 Insira o servidor DNS e o servidor WIN,
se necessario.

Se eles ndo forem necessarios para a sua
conexao de rede, pressione <OK> até que a
mensagem pop-up apareca.

10 Pressione <OK> para concluir a configuragao.

Instalar o(s) driver(s) de

impressora para Windows

Vocé pode instalar varios drivers ao mesmo
tempo. Drivers selecionaveis para cada modelo:

e PCL

e PS

e FAX

Quando vocé instala os drivers, o programa
também instala automaticamente o driver TWAIN
necessario para escanear, assim com os utilitarios

Network Extension (Extensao de rede) e Color
Swatch (Amostra de cores).

Nota

O procedimento a seguir usa o Windows 7 e o
modelo MC561 como exemplo. O procedimento
real pode diferir um pouco dependendo do
sistema operacional.

1 Verifique se o computador esta ligado e
conectado a unidade através da rede.

2 Insira o DVD fornecido com a maquina na
unidade de CD/DVD.

O DVD é executado automaticamente. Caso
néo seja, clique duas vezes no arquivo de
configuracdo do OKI no diretério do DVD.

3 Selecione o seu idioma na lista suspensa e
clique em [Next] (Avancar).

4 Leia o Contrato de Licencga e clique em

[T Agree] (Eu concordo).

5 Em Driver Setup (Configuracao do driver),
clique em [Install Drivers (MC561)]
(Instalar drivers).

Nota

Se a caixa de didlogo [User Account Control]
(Controle da conta do usuario) for exibida,
clique em [Yes] (Sim). (No Windows Vista,
clique em [Continue] (Continuar)).

6 Leia e observe as instrugdes e clique em
[Next] (Avangar).

7 Clique em [Easy Install (Network)]
(Instalagao facil — Rede).

Nota

A selegdo Easy Install (Instalacdo facil) € um
método de configuracdo facil. Se vocé
desejar selecionar o driver a ser instalado
manualmente, instale uma impressora
compartilhada ou use o utilitario Oki LPR
como método de impressao, selecione
[Custom Installation] (Instalacdo
personalizada) e siga as instrugdes exibidas
na tela.

8 Clique em [Next] (Avangar).
A pesquisa do dispositivo é iniciada.

9 Selecione o(s) driver(s) de impressora que
deseja instalar: PCL, PS, FAX.
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10 Se a sua unidade for detectada e exibida
automaticamente, selecione-a e clique em
[Next] (Avangar).

Se a sua unidade ndo for exibida, clique em
[Restart search] (Reiniciar pesquisa) para
reiniciar a pesquisa de dispositivo.

Nota

Para especificar o endereco IP manualmente,
selecione [IP address] (Endereco IP) e insira
o endereco IP atribuido a sua unidade e
cligue em [Next] (Avancgar).

A instalacao do(s) driver(s) e dos utilitarios
¢ iniciada.

Notas

e Se a caixa de didlogo [Windows Security]
(Seguranga do Windows) for exibida,
clique em [Install this driver software
anyway] (Instalar este software de driver
mesmo assim).

e No Windows Server 2003 e no Windows
XP, se a caixa de didlogo [Hardware
Installation] (Instalagao de hardware) for
exibida, clique em [Continue Anyway]
(Continuar assim mesmo).

e No Windows 2000, se a caixa de didlogo
[Digital Signature Not Found] (Assinatura
digital ndo encontrada) for exibida, clique
em [Yes] (Sim).

11 Clique em [Finish] (Concluir) para completar
a instalacgao.

Notas

e Para definir uma impressora padrao,
marque a caixa de selecdo do driver
desejado. Vocé também pode definir
as configuracdes de impressora do
driver selecionado clicando em [Open
property dialog] (Abrir caixa de dialogo
de propriedades).

e Se a caixa de dialogo solicitando para
reiniciar o computador for exibida, clique
em [Yes] (Sim). O computador é
reiniciado automaticamente.

12 Windows 7: clique em [Start] (Iniciar) >
[Devices and Printers] (Dispositivos
e impressoras).
Windows Server 2008 e Windows Vista: clique

em [Start] (Iniciar) > [Control Panel] (Painel
de controle) > [Printer] (Impressora).

Windows Server 2003 e Windows XP: clique
em [Start] (Iniciar) > [Printers and Faxes]
(Impressoras e faxes).

Windows 2000: clique em [Start] (Iniciar) >
[Settings] (Configuragdes) >
[Printers] (Impressoras).

13 Verifique se o icone OKI MC561 ¢é exibido.

¢ No Windows 7, se vocé tiver instalado
varios drivers, cligue com o botdo direito do
mouse no icone do OKI MC561 e selecione
um dos itens de menu e verifique se todos
os drives de impressora instalados séo
exibidos no submenu.

0K MCSEL{FAX)
0K MESELIPCL XPS)
0K MCSELIPEL)
O] MCS1 (RS

e Em outros sistemas operacionais Windows,
verifique se o icone que representa cada
driver é exibido.

14 Remova o DVD do computador.

A instalacdo esta concluida.

Configurar a rede para
sistemas Macintosh

Para concluir a conexdo de rede com um sistema
operacional Mac, instale um driver de impressora
no computador e defina a sua unidade como a
impressora em rede.

Instalar o driver de impressora

para Mac

Apenas o driver PS esta disponivel para
sistemas Mac.

Selecione um destes protocolos para a sua
conexdo de rede:

e Ethertalk
- para Mac 10.3.9 a 10.4.11, veja abaixo.
- para Mac 10.5, veja a pagina 183.

e Bonjour (Rendezvous)

- para Mac 10.3.9 a 10.4.11, veja a pagina
184.

- para Mac 10.5 e 10.6, veja a pagina 185.

Importante!
Desabilite o software antivirus antes de
iniciar este procedimento.
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Uso de Ethertalk,
Mac 0S X 10.3.9a 10.4.11

Nota

O procedimento a seguir usa o Mac OS X 10.4.11
e 0 modelo MC561 como exemplo. O
procedimento real pode diferir um pouco
dependendo do sistema operacional.

1 Verifique se a sua unidade e o Mac estao
ligados e conectados.

2 No menu Apple, selecione [System Preferences]
(Preferéncias do sistema).

3 Selecione [Network] (Rede).

Em [Show] (Mostrar), selecione [Network Port
Configurations] (Configuragdes de porta de
rede) e verifique se a opgao [Built-in Ethernet]
(Ethernet embutido) esta selecionada.

rB 8o Network
[« > | [ Showall | Q

Location: | Automatic ﬂ

_> Show: -N.e.t-wu}-k F""ur"-lnéor;ﬁgura_ti-(-ms ﬂ

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configurations
Bluetooth
Built-in Ethernet

( New. )

—

Built-in FireWire

(" Rename :‘l
AirPort

e i Pt

REAER

( Delete.. :‘l

€ Duplicate :"

(~)

il ————
'} !W Click the lock to prevent further changes. [ Assistme... ) Apply Now

5 Selecione a guia [AppleTalk] e verifique se
a opcao [Make AppleTalk Active] (Tornar
AppleTalk ativa) esta selecionada.

Feche [Network] (Rede).

Insira o DVD fornecido com a unidade
no computador.

8 Clique duas vezes no icone [OKI].

9 Clique duas vezes na pasta [Driver] e, em
seguida, na pasta [Printer] (Impressora).

10 Cligue duas vezes em [Installer for Mac OSX]
(Instalador para Mac OSX).

11 Insira o nome e a senha de administrador e
clique em [OK].

12 Siga as instrucdes exibidas na tela para
concluir a instalagao.

13 Remova o DVD do computador.

14 No menu [Go] (Ir), selecione [Utilities]
(Utilitarios) e clique duas vezes em [Printer
Setup Utility] (Utilitario de configuracao
da impressora).

Nota

Se o [Printer Setup Utility] (Utilitario de
configuragdo da impressora) ja estiver sendo
executado, feche e abra-o novamente.

15 Clique em [Add] (Adicionar).

Nota

Se a caixa de diadlogo [You have no printers
available] (Ndo ha impressoras disponiveis)
for exibida, clique em [Add] (Adicionar).

16 No Mac OS X 10.3.9, selecione [AppleTalk].

17 Selecione o nome da sua unidade cuja
[Connection] (Conexao) seja [AppleTalk] e
verifique se o nome da sua unidade é exibido
em [Print Using] (Imprimir usando).

'6 (X3 Printer Browser (j1
= -
X ® &
= =2

Default Browser IP Printer Search

& | Connec tion

MC551 AppleTalk m
4

Name: MC561

Location: Local Zone

e Print Using: | OKI MCEB1(PS) 3]

15/\ ( More Printers... ) ( Add

BN

18 No Mac OS X 10.3.9, selecione o nome da sua
unidade e selecione [OKI] de [Print Model]
(Modelo de impressora) e selecione
[OKI MC561(PS)] da lista. Clique em
[Add] (Adicionar).
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19 Se a janela [Installable Options] (Opgdes
instalaveis) for exibida, clique em [Continue]
(Continuar) a menos que vocé ja tenha
instalado opgOes. Se vocé tiver instalado
opcOes, configure cada uma delas antes de
clicar em [Continue] (Continuar).

20 Verifique se o nome da unidade é exibido em
[Printer List] (Lista de impressoras) e feche
a janela.

21 No menu [Go] (Ir), selecione [Applications]
(Aplicativos) e clique duas vezes em
[TextEdit] (Edicao de texto).

22 Selecione [File] (Arquivo) > [Page Setup]
(Configuragdo de pagina).

23 Selecione 0 nome da sua unidade em [Format
for] (Formato para).

24 Verifique se o0 nome da sua unidade é
exibido corretamente em [Format for]
(Formato para).

25 Clique em [OK].

A instalagdo esta concluida.

Uso do Ethertalk
Mac 10.5 (Leopard)

Nota

O procedimento a seguir usa o modelo MC561
como exemplo.

1 Verifique se a sua unidade e o Mac estdo
ligados e conectados.

2 Insira o DVD fornecido com a unidade
no computador.

3 Clique duas vezes no icone [OKI].

Clique duas vezes na pasta [Driver] e, em
seguida, na pasta [Printer] (Impressora).

5 Clique duas vezes em [Installer for MacOSX]
(Instalador do Mac 0OS X).

6 Insira o nome e a senha de administrador e
clique em [OK].

7 Siga as instrugdes exibidas na tela para
concluir a instalagao.

8 Remova o DVD do computador.

9 No menu Apple, selecione [System
Preferences] (Preferéncias do sistema).

10 Clique em [Print & Fax] (Impressora e fax).

11 Clique em [+].

ann Print & Fax

al )

Click  to add a
or fax Mo Printer Selected

—-

Dafault Printar: | Last Printar Used

Default Pager Size in Page Setup: | Ad 3

@

14" Ciick the tock 1o prevent further changes,

12 Clique em [AppleTalk].

13 Selecione o0 nome da sua unidade e verifique
se 0 nome da mesma ¢é exibido em [Print
Using] (Imprimir usando).

ano =
= 20
Delault  Fax P Windowi Bluctooth  ApgleTalk  Mare Prisers Search
o Zon
s ac 1
Mame: MCSE1
Location: Local Zone
—- Frint Using: | 0K MCSE1(PE) )
—ada )

14 Clique em [Add] (Adicionar).

15 Se a janela [Installable Options] (Opgoes
instalaveis) for exibida, clique em [Continue]
(Continuar) a menos que vocé ja tenha
instalado opgOes. Se vocé tiver instalado
opgoes, configure cada uma delas antes de
clicar em [Continue] (Continuar).

16 Verifique se a sua unidade é exibida em
[Printers] (Impressoras).

17 Verifique se o nome da sua unidade é exibido
em [Kind] (Tipo) e feche [Print & Fax]
(Impressora e fax).

A instalagdo esta concluida.

183 - Portugués



Nota

O nome da sua unidade pode ndo ser exibido se o
driver da impressora nao ler o arquivo PPD
corretamente.

Nesse caso, clique em [-] para remover a sua
unidade de [Print & Fax] (Impressora e fax) e
refaga o procedimento da etapa 10.

Uso do Bonjour (Rendezvous)
Mac 10.3.9a 10.4.11

Nota

O procedimento a seguir usa o Mac OS X 10.4.11
e 0 modelo MC561 como exemplo. O
procedimento real pode diferir um pouco
dependendo do sistema operacional.

1 \Verifique se a sua unidade e o Mac estao
ligados e conectados.

2 No menu Apple, selecione [System
Preferences] (Preferéncias do sistema).

3 Selecione [Network] (Rede).

Em [Show] (Mostrar), selecione [Network Port
Configurations] (Configuracdes de porta de
rede) e verifique se [Built-in Ethernet]
(Ethernet embutido) esta selecionado.

'6 eo Network
| < | | Show all | Q

Location: = Automatic |

ﬁ Show: | Network bo;l-CunF-\gura;i-(.:nE m

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

Port Configurations
Bluetooth

On

g {
—— (V| Built-in Ethernet (_ New...

[

4

Built-in FireWire

(_ Rename
AirPort

(Delete... )

(_ Duplicate )

'] q Click the lock to prevent further changes. (_ Assist me... ) Apply Now

°]

5 Feche [Network] (Rede).

6 Insira o DVD fornecido com a unidade
no computador.

7 Clique duas vezes no icone [OKI].

Clique duas vezes na pasta [Driver] e, em
seguida, na pasta [Printer] (Impressora).

9 Clique duas vezes em [Installer for Mac OSX]
(Instalador para Mac OSX).

10 Insira o nome e a senha de administrador e
clique em [OK].

11 Siga as instrucdes exibidas na tela para
concluir a instalagao.

12 Remova o DVD do computador.

13 No menu [Go] (Ir), selecione [Utilities]
(Utilitarios) e clique duas vezes em [Printer
Setup Utility] (Utilitario de configuracao
da impressora).

Importante!

Se o [Printer Setup Utility] (Utilitario de
configuracdo da impressora) ja estiver sendo
executado, feche e abra-o novamente.

14 Clique em [Add] (Adicionar).

Nota

Se a caixa de didlogo [You have no printers
available] (Ndo ha impressoras disponiveis)
for exibida, clique em [Add] (Adicionar).

15 No Mac OS 10.3.9, selecione [Rendezvous].

16 Selecione o0 nome da sua unidade cuja
[Connection] (Conexao) seja [Bonjour] e
verifique se o0 nome da unidade é exibido em
[Print Using] (Imprimir usando).
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A sua unidade é exibida com os seis
ultimos digitos do enderegco MAC na lista
de impressoras.

866 Printer Browser (=)
a . |
—\?\ i s Q-
—y . —
Default Browser : IP Printer Search
Printer Name & | Connection
— [OKIMCSEIEBOEIA  Bomjour | m

Name: OKI-MC-561-EBOE1A

Location: Local Zone

Print Using: OKI MC561(PS) =] ]

15) ( More Printers... ) ( Add

]

17 No Mac OS X 10.3.9, selecione o nome da sua
unidade e selecione [OKI] de [Print Model]
(Modelo de impressora) e selecione [OKI
MC561(PS)] da lista.

18 Clique em [Add] (Adicionar).

19 Se a janela [Installable Options] (Opgdes
instalaveis) for exibida, clique em [Continue]
(Continuar) a menos que vocé ja tenha
instalado opgOes. Se vocé tiver instalado
opcOes, configure cada uma delas antes de
clicar em [Continue] (Continuar).

20 Verifique se o nome da unidade é exibido em
[Printer List] (Lista de impressoras) e feche
a janela.

i 8oe Printer List (=]

= ~

Add

Name & |Status Kind

# OKI-MC561-EBOELA OKI MC561(PS)

21 No menu [Go] (Ir), selecione [Applications]
(Aplicativos) > [TextEdit] (Edicdo de texto).

22 Selecione o menu [File] (Arquivo) > [Page
setup] (Configuracao de pagina).

23 Selecione 0 nome da sua unidade em [Format
for] (Formato para).

24 Verifique se o nome da sua unidade é
exibido corretamente em [Format for]
(Formato para).

25 Clique em [OK].

A instalagdo esta concluida.

Uso do Bonjour
Mac 10.5 e 10.6 (Leopard e
Snow Leopard)

Nota

O procedimento a seguir usa o Mac OS X 10.6 e o
modelo MC561 como exemplo. O procedimento
real pode diferir um pouco dependendo do
sistema operacional.

1 \Verifique se a sua unidade e o Mac estao
ligados e conectados.

2 Insira o DVD fornecido com a unidade
no computador.

3 Clique duas vezes no icone [OKI].

Clique duas vezes na pasta [Driver] e, em
seguida, na pasta [Printer] (Impressora).

5 Clique duas vezes em [Installer for MacOSX]
(Instalador do Mac 0OS X).

6 Insira o nome e a senha de administrador e
clique em [OK].

7 Siga as instrucoes exibidas na tela para
concluir a instalagao.

8 Remova o DVD do computador.

9 No menu Apple, selecione [System
Preferences] (Preferéncias do sistema).

10 Clique em [Print & Fax] (Impressora e fax).
11 Clique em [+].
12 Clique em [Default] (Padrao).

13 Selecione o0 nome da sua unidade cujo [Kind]
(Tipo) seja [Bonjour] e verifique se 0 nome
da mesma ¢é exibido em [Print Using]
(Imprimir usando).
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O nome da sua unidade é exibido com os
ultimos seis digitos do endereco MAC na lista
de impressoras.

8eno Add Printer (e

= =yl 2 a

Fax IP_ wWindows Search

' Printer Name & Kind

— TN Bonjour

Name: OKI-MC561-EBOELA

Location:

Print Using: [ OKI MC561(PS) )

14 Clique em [Add] (Adicionar).

15 Se a janela [Installable Options] (Opgdes
instalaveis) for exibida, clique em [Continue]
(Continuar) a menos que vocé ja tenha
instalado opgoes.

Se vocé tiver instalado opgoes, configure
cada uma delas antes de clicar em
[Continue] (Continuar).

16 Verifique se a sua unidade aparece em
[Printers] (Impressoras).

17 Verifique se o nome da sua unidade é exibido
em [Kind] (Tipo) e feche [Print & Fax]
(Impressora e fax).

A instalagdo esta concluida.

Nota

O nome da sua unidade pode ndo ser exibido se
o driver da impressora ndo ler o arquivo

PPD corretamente.

Se isso acontecer, clique em [-] para remover a
unidade de [Print & Fax] (Impressora e fax) e
adicione-a novamente (volte para a etapa 9).
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Configuracao da unidade para operacao

em rede

Funcdes como

e Escanear para e-mail

e Escanear para PC de rede
e Fax pela Internet

permitem que vocé envie dados escaneados para
um computador através da conexdo de rede. Para
usa-las, vocé precisa configurar a unidade e os
computadores para os quais deseja enviar os
dados escaneados.

Inserir o endereco IP da
unidade no formulario
de configuracao

Nota

Ao usar as teclas de seta, pressione a tecla
repetidamente para ir para a selegao.

1 Pressione <SETTING> (Ajuste) no painel
de controle.

2 Use a tecla de seta para baixo para selecionar
[View Information] (Exibir informacdes) e
pressione <OK>.

Setting
Metwork Scan Destination

Store Document Settings

Yiew Information

3 Use a tecla de seta para baixo para selecionar
[Network] (Rede) e pressione <OK>.

4 Insira o endereco IP em [IPv4 address]
(Endereco IPv4) na linha A-2 do Formulario
de configuracgao.

Configurar opcoes de
escanear para e-mail e fax
pela Internet

Verificar as configuracoes de
e-mail do computador

e Se um administrador de rede especificar
valores como a conta do servidor de e-mail,
senha e o endereco de e-mail da unidade,
anote-os no Formulario de configuracédo.

Nota

O procedimento a seguir usa o Windows Live Mail
no Windows 7. Se vocé estiver usando um
software de e-mail diferente, consulte o manual
do software de e-mail.

1 Clique em [Start] (Iniciar) > [Windows
Live Mail].

2 Selecione o menu [Tools] (Ferramentas) >
[Accounts] (Contas).

Se a barra de menus nao for exibida, clique no
icone [Menus] e selecione [Show menu bar]
(Mostrar barra de menus).

3 Selecione a conta de e-mail padrao e clique
em [Properties] (Propriedades).
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4 Na guia [General] (Geral), insira o conteludo 5 Clique na guia [Server] (Servidor) e insira

de [Name] (Nome) e [E-mail address] cada configuracgao nas linhas correspondentes
(Enderecgo de e-mail) nas linhas B-9 e B-10 do do Formulario de configuragao.
Formulario de configuragao. )
;: pop3testcom Properties Ié]
a1 popatestcom Properties @q | General | Servers |Ccnnedicn I Security | Ad\ranced|
General | Servers | Connection | Securty | Advanced | Server Information
Maﬂﬁa:cuunl My incoming mail serverisa  POP3 SEMVer.
;, ;Eﬁrz:;“j Poarmaiah;;izc“w;ﬂi'Y\Ionru"'l‘j.\:lwﬁgdéi-fmf(hgse Incoming mal (FOP3):  pop3testcom " B'3
m Outgoing mal (SMTP):  smtptestoom " B-2
User Information Incoming Mail Server
Name Yser > B'9 E-mail usemame: user -Il» B-7
Organizaﬁon - SERBRNEN -
E-mail address:  user@testoom > B_10 Fassmord > B 8

Remember password
@ Log on using clear text authertication

Reply address:
Include this account when receiving mail or synchronizing - P—
@ 9 o . ) Log on using secure password authentication

() Log on using authenticated POP (APOP)

Outgoing Mail Server

My server requires authertication Settings...

o [ e ] [ o]

e Se a caixa de selecao [My server requires
authentication] (Meu servidor requer
autenticacao) estiver marcada, insira
“SMTP” na linha B-4 do Formulario de
configuracgao.

¢ Se ela nao estiver marcada, insira "POP” na
linha B-4.

6 Marque a caixa de selegao [My server
requires authentication] (Meu servidor
requer autenticagdo) e clique em
[Settings] (Configuracdes).

7 Na caixa de didlogo [Outgoing Mail Server]
(Servidor de saida de e-mails):

Qutgoing Mail Server - Lé]

Logon Information

‘@ Use same settings as my incoming mail server

" Log on using

Remember password

Log on using Secure Password Authentication

e Se [Use the same settings as my incoming
mail server] (Usar as mesmas
configuragoes do servidor de entrada de
e-mails) estiver selecionada, insira

- o valor da linha B-7 na linha B-5 e
- o valor da linha B-8 na linha B-6
do Formulario de configuragao.

e Se [Log on using] (Fazer logon usando)
estiver selecionada, insira

- 0 [Account name] (Nome da conta) na
linha B5 e

- a [Password] (Senha) na linha B-6
do Formulario de configuracao.
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Definir o endereco de e-mail

da unidade

Insira um endereco de e-mail a ser usado
pela unidade na linha B-1 do Formulario
de configuracgao.

e Se 0 endereco de e-mail da unidade for
especificado pelo administrador da rede, insira
0 endereco de e-mail na linha B-1.

e Se vocé estiver usando um provedor de
servicos de Internet, obtenha um endereco de
e-mail para a unidade do provedor e insira o
endereco de e-mail na linha B-1.

e Se 0 endereco de e-mail da unidade nao for
especificado ou obtido, determine o endereco
de e-mail de acordo com o valor inserido na
linha B-4 (método de autenticagdo):

- Se B-4 for "SMTP”, determine um enderego
de e-mail e insira-o na linha B-1.

- Se B-4 for “"POP”, insira 0 mesmo enderego
de e-mail de B-12 na linha B-1.

e Se vocé desejar que a unidade receba e-mails,
devera obter um endereco de e-mail para a
unidade de um administrador de rede ou do
provedor de servigos de Internet.

Configurar a unidade para as
opcoes de escanear para e-mail

e fax pela Internet

Configure a unidade para as opgdes de escanear
para e-mail e fax pela Internet usando as
informagdes no Formulario de configuragao.

Nota

Ao usar as teclas de seta, pressione a tecla
repetidamente para ir para a selegao.

Pressione o botdao <SETTING> (Ajuste) no painel
de controle.

8 Use a seta para baixo para selecionar
[Easy Setup] (Configuragdo facil) e
pressione <OK>.

Setting
Yiew Information

Shutdown

9 Insira a senha de administrador e use as
teclas de seta para selecionar [Enter] e
pressione <OK>.

10 Use a tecla de seta para baixo para selecionar
[Email Setting] (Configuracao de email) e
pressione a tecla de seta para a direita.

|
2. Fax Setting
3. Network Setting
4 Emall Setting
%) Cancel

11 Consulta do Formulario de configuragao:

a) Endereco do servidor: Pressione a tecla de
seta para a direita e insira as informagdes
da linha B-2.

b) Use as teclas de seta para selecionar
[Enter] e pressione <OK>.

c) O enderego de e-mail da unidade:
Pressione a tecla de seta para a direita e
insira as informagdes da linha B-1.

d) Selecione [Enter] e pressione <OK>.

e) Método de autenticacao: Pressione a tecla
de seta para a direita e use a seta para
baixo para selecionar o método da
linha B-4.

f) Continue seguindo as instrugdes na tela
para inserir as informacdes solicitadas da
secdo B do Formulario de configuragao.

g) Quando todas as informacdes forem
inseridas, a mensagem “Email Setting was
completed” (A configuracdo do e-mail foi
concluida) sera exibida e a tela retornara
ao menu de configuragao.

12 Quando a tela do menu de configuracao for
exibida, pressione <OK>.

A configuragao das opgdes de escanear para e-
mail e fax pela Internet esta completa.

Para obter detalhes sobre o uso das opcdes de
escanear para e-mail e fax pela Internet, consulte
o0 Manual Basico do Usuario no DVD fornecido
com a unidade.

Configurar a opcao de
escanear para PC de rede

A fungao de escanear para PC de rede permite
que vocé envie e salve imagens escaneadas para
a “pasta compartilhada” de um computador na
rede. Para usar esta funcdo, registre a unidade
no computador como um usuario e crie uma
pasta compartilhada. Em seguida, crie um perfil
na unidade para registrar as configuragoes

do computador.
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¢ Antes de iniciar a configuracao, obtenha
permissao do administrador da rede para criar
uma pasta compartilhada no computador
seguindo o procedimento a seguir.

e O protocolo CIFS é usado neste procedimento.

Verificar o nome do

computador
Verifique 0 nome do computador seguindo o

procedimento abaixo e preencha-o na linha C-1
do Formulario de configuragao.

Windows 7,

Windows Server 2008 R2,
Windows Server 2008,
Windows Vista

Nota

O procedimento a seguir usa o Windows 7 como
exemplo. A exibicdo pode variar dependendo do
sistema operacional.

1 Clique em [Start] (Iniciar) > [Control Panel]
(Painel de Controle).

2 Selecione [System and Security] (Sistema
€ seguranga).
No Windows Server 2008 e no Windows Vista,
selecione [System and Maintenance] (Sistema
e manutencdo).

3 Selecione [See the name of this computer]
(Ver o nome deste computador) em
[System] (Sistema).

4 Anote o nome em [Computer name] (Nome
do computador) na linha C-1 do Formulario
de configuracdo.

5 Feche a janela.

Windows Server 2003
Windows XP

1 No Windows Server 2003, clique em [Start]
(Iniciar) > [Control Panel] (Painel de controle) >
[System] (Sistema).

No Windows XP, clique em [Start] (Iniciar) >
[Control Panel] (Painel de controle) >
[Performance and Maintenance]
(Desempenho e manutengao) >

[System] (Sistema).

2 Selecione a guia [Computer Name] (Nome do
computador) e clique em [Change] (Alterar).

3 Anote o nome em [Computer name] (Nome
do computador) na linha C-1 do Formulario
de configuracao.

4 Clique em [Cancel] (Cancelar) para fechar
a janela.

Windows 2000

1 Clique em [Start] (Iniciar) > [Settings]
(Configuragdes)> [Control Panel] (Painel
de controle).

Clique duas vezes em [System] (Sistema).

Selecione a guia [Network Identification]
(Identificagao da rede) e clique em
[Properties] (Propriedades).

4 Anote o nome em [Computer name] (Nome
do computador) na linha C-1 do Formulario
de configuracao.

5 Clique em [Cancel] (Cancelar) para fechar
a janela.

Determinar os nhomes dos itens
necessarios para a funcao de

escanear para PC de rede

Determine os nomes dos seguintes itens e
preencha-os nas linhas C-2 a C-6 no Formulario
de configuracao.

e Nome de usuario para fazer logon no
computador de destino (C-2)

e Senha para fazer logon no computador de
destino (C-3)

e Nome do perfil para registrar as configuragdes
na unidade (C-4)

e Nome da pasta compartilhada no computador
de destino (C-5)

¢ Nome do arquivo dos dados escaneados (C-6)

190 - Portugués



Configurar o computador para
a funcao de escanear para PC

de rede

Registre a unidade no computador como usuario
e depois defina uma pasta compartilhada para
enviar e salvar as imagens escaneadas.

e Windows 7, ver a seguir

e Windows Server 2008 R2, ver a seguir

e Windows 2008, ver a seguir

e Windows Vista, ver a seguir

e Windows Server 2003, ver pagina 192

e Windows XP, ver pagina 193

e Windows 2000, ver pagina 194

Importante!

Se o computador estiver em um dominio,

o procedimento de adicao de uma conta de
usuario pode ser diferente do procedimento
a seguir. Consulte o manual do

Microsoft Windows.

Windows 7,

Windows Server 2008 R2,
Windows 2008,

Windows Vista

Nota

O procedimento a seguir usa o Windows 7 como
exemplo. A exibicdo pode variar dependendo do
sistema operacional.

1 Clique em [Start] (Iniciar) > [Control Panel]
(Painel de Controle).

2 Selecione [Add or remove user accounts]
(Adicionar ou remover contas de usuario).

3 Selecione [Create a new account] (Criar uma
nova conta).

4 Insira as informacgodes da linha C-2 do
Formulario de configuracdo na caixa de texto.

5 Verifique se [Standard user] (Usuario padrao)
esta selecionado e clique em [Create Account]
(Criar conta).

6 Clique no icone da conta de usuario criada na
etapa anterior.

7 Selecione [Create a password] (Criar
uma senha).

8 Insira as informagdes da linha C-3 em [New
password] (Nova senha) e [Confirm for new
password] (Confirmar nova senha) e clique
em [Create password] (Criar senha).

Q j® B o Userfccounts » Manage Acccunts » Change an Account b Creste Password - | b

Create a password far mc561°s account

me3bl
Stanclard user
Wou are crea woed for me!
3

9 Feche o painel de controle.

10 Crie uma nova pasta no computador com o
nome inserido na linha C-5.

Nota

E recomendavel que vocé crie uma pasta na
unidade local, ndo na area de trabalho ou
em [My Documents] (Meus documentos).

11 Clique com o botdo direito do mouse na
pasta criada na etapa acima e selecione
[Properties] (Propriedades).

12 Selecione a guia [Sharing]
(Compartilhamento) e clique em
[Share] (Compartilhar).
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13 Selecione a conta de usuario criada na
etapa 5 da caixa suspensa e clique em
[Add] (Adicionar).

|||||

14 Selecione o usuario adicionado na etapa
anterior, selecione o nivel de permissado e
clique em [Share] (Compartilhar).

[—=)]

3 File Sharing

Choose people to share with

Type & name snd then click Add, or click the smow to find semecne

15 Clique em [Done] (Concluir).

16 Clique em [Advanced Sharing]
(Compartilhamento avancado) na guia
[Sharing] (Compartilhamento).

17 Clique em [Permissions] (Permissoes).

18 Selecione o usuario adicionado na etapa 13 e
marque a caixa de selegao [Allow] (Permitir)

para [Full Control] (Controle total) e clique
em [OK].

19 Feche a caixa de didlogo de propriedades
da pasta.

20 Crie um perfil para concluir a configuracao da
funcao de escanear para PC de rede. Consulte

“Perfis de funcdao de escanear para PC de
rede” na pagina 195.

No Windows Server 2003

1 Clique em [Start] (Iniciar)> [Administrative

Tools] (Ferramentas administrativas)>
[Server Management] (Gerenciamento
do servidor).

Clique em [Users] (Usuarios).

Selecione [Add a user] (Adicionar
um usuario).

4

5

—_—
el i st

Insira o valor de C-2 na caixa de texto [First
name] (Nome) e clique em [Next] (Avancgar).

Uzer Aceount Inlomabion
“Fious st sy the irfoenaion iecuined 1o Cleale & et Acoun.

ﬁ Exst name: I:'{‘HI

Ligst raers [

Lopta namne: [rez&r =l

« Back Bt 3 I Cancel

Insira o valor de C-3 em [Password] (Senha)
e [Confirm password] (Confirmar senha).

Uzer Password
Vo st spely @ pasiwond for the ueen

This uses
1 Must change password af nest logon
* [Caneol changs passwoed

1™ Can changs patiwerd & sy ime

« Back Bt 3 I Cancel

Selecione [Cannot change password] (Nao
é possivel alterar senha) e clique em
[Next] (Avangar).

Clique em [Finish] (Concluir).
Cligue em [Close] (Fechar).

Crie uma nova pasta no computador com o
nome inserido na linha C-5.

Nota

E recomendavel que vocé crie uma pasta na
unidade local, ndo na area de trabalho ou
em [My Documents] (Meus documentos).

10 Clique com o botdo direito do mouse na pasta

criada na etapa acima e selecione [Sharing
and Security] (Compartilhamento
e seguranga).
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11 Na guia [Sharing] (Compartilhamento),
selecione [Share this folder]
(Compartilhar esta pasta) e clique em
[Permissions] (Permissdes).

istproveties TR

Genersl | web Shaing  Shaiing | Securiy |
Q “You can share this folder amang olher users on your

network. To enable sharing for this folder. click Share this
folder.

© Do not share this falder
_”—r-‘ Share this folder

Share name: [SalecDey

Comment |

User limit: % Mazimum allowed

© Alow = Users
T set parmissions for how sers access this ‘._
folder over the network, click Pemissions.

To configurs ssttings or Offine snosss to Cachi
sz ey, @l B EE

ok | cacel | heow

12 Clique em [Add] (Adicionar).

13 Insira o valor de C-2 e clique em [Check
Names] (Verificar nomes).

Select Users, Computers, or Groups el
Select this obiect type:
ILlserS, Groups, or Buillin security principals Obiect Types.
From this location:
IsmaHhuslnEss local Locations...
Eniter ths obisct names to select (examplesk
_> 561 Check Names ‘_
ke el
P

14 Verifique se o valor de C-2 é exibido e clique
em [OK].

15 Marque a caixa de selegao [Allow] (Permitir)
para [Full Control] (Controle total) e clique
em [OK].

16 Feche a caixa de didlogo de propriedades
da pasta.

17 Crie um perfil para concluir a configuracao da
funcdo de escanear para PC de rede. Consulte
a pagina 195.

No Windows XP

1 Clique em [Start] (Iniciar) > [Control Panel]
(Painel de controle).

2 Clique duas vezes em [User Accounts]
(Contas de usuario).

3 Selecione [Create a new account] (Criar uma
nova conta).

4 Insira o valor de C-2 na caixa de texto e
clique em [Next] (Avancar).

Name the new account

Type arame for the rew sccount:
[mestl

This raeren wal ape o thes ‘wisk som v el s thes S2.t rrowns.

= =

5 Selecione [Limited] (Limitado) e clique em
[Create Account] (Criar conta).

T p— CIE&

Pick an account type

) Computm gvawtrater (5 Uk 4

T e p—]
w Siewr i i b e Docasrets kder

sk canck iy e DOrAt, & bl
gt o) ackvirts tin grovigns b el £

59, b Windowrs 3P o
lemted accounts. For best resuks, choose programs beering the Designed For Windaws <P logo,
o, b run okder prograne, chooss the “camputer adminetrtor” sccount troe.

6 Clique no icone da conta de usuario criada na
etapa acima.

7 Selecione [Create a password] (Criar
uma senha).

8 Insira o valor de C-3 em [Type a new
password] (Digitar uma nova senha) e [Type
the new password again to confirm] (Digitar a
nova senha novamente para confirmar) e
cliqgue em [Create Password] (Criar senha).

9 Feche o painel de controle.

10 Crie uma nova pasta no computador com o
nome inserido na linha C-5.

|
Nota

E recomendéavel que vocé crie uma pasta na
unidade local, ndo na area de trabalho ou
em [My Documents] (Meus documentos).

11 Clique com o botédo direito do mouse na
pasta criada na etapa acima e selecione
[Sharing and Security] (Compartilhamento
e seguranga).
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12 Clique em [If you understand the security
risks but want to share files without running
the wizard, click here.] (Se vocé entende os
riscos de segurancga, mas deseja compartilhar
0S arquivos sem executar o assistente,
clique aqui).

13 Selecione [Share this folder] (Compartilhar
esta pasta) no Firewall do Windows e clique
em [OK].

14 Marque as caixas de selegao [Share this folder
on the network] (Compartilhar esta pasta na
rede) e [Allow network users to change my
files] (Permitir que usuarios da rede alterem
0S meus arquivos) e clique em [OK].

MC561 Properties @@

Genersl | Sharing | Customize

Local sharing and security

T To share this falder vith other users of this computer
J)ﬂ anly, drag it ta the Shared Documents folder.

To make this folder and its subfolders private so that
arlp yau hawe access, select the following check bax.

Metwark sharing and security

i) Toshare this folder with both network users and other
%) users of this computer, select the first check box below
FT2 and type & share name.

——> ‘Share this folder on the retwork

Share name:  |MCEET

[ licwy etk users ta change my fle
Lean mare about sharing and securty
j# Windows Firewall is configured to allow this folder to be shared
with ather computers on the network,
View your Windows Fiewall setings

ok ][ cancel ][ pel

15 Marque a caixa de selegao [Allow] (Permitir)
para [Full Control] (Controle total) e clique
em [OK].

16 Crie um perfil para concluir a configuragao da
funcao de escanear para PC de rede. Consulte
a pagina 195.

No Windows 2000

1 Clique com o botdo direito do mouse em [My
Computer] (Meu computador) na area de
trabalho e selecione [Manage] (Gerenciar).

2 Na janela da direita, clique duas vezes em
[System Tools] (Ferramentas do sistema) >
[Local Users and Groups] (Usuarios e grupos
locais). Clique com o botao direito do mouse
em [Users] (Usuarios) e selecione [New User]
(Novo usuario).

_> Username  [moB51

ﬁ Password |‘
_> Confim passward. [

Insira o valor de C-2 em [User name]
(Nome de usuario) e o valor de C-3 em
[Password] (Senha) e [Confirm Password]
(Confirmar senha).

remuser x|

Fullname |

Descritior: |

= Wser must change password 2t rest lagan
J¥ User cannot change password

¥ Password never supites

™ Account is disabled

Create Close:
[ Em |

4 Selecione [User can not change password]

(O usuario ndo pode alterar a senha) e
[Password never expires] (A senha nunca
expira) e clique em [Create] (Criar).

Clique em [Close] para fechar a caixa de
didlogo [New User] (Novo usuario).

Nota

Se [User must change password at next
logon] (O usuario deve alterar a senha no
préoximo logon) estiver marcada,
desmarque-a para que vocé possa selecionar
[User can not change password] (O usuario
ndo pode alterar a senha) e [Password never
expires] (A senha nunca expira).

Clique duas vezes em [User] (Usuario) e
verifique se o usuario criado na etapa 4
é exibido.

Feche a janela [Computer Management]
(Gerenciamento do computador).

Crie uma nova pasta no computador com o
nome inserido na linha C-5.

Nota

E recomendavel que a pasta seja criada na
unidade local, ndo na area de trabalho ou
em [My Documents] (Meus documentos).

Clique com o botdo direito do mouse na
pasta criada na etapa 6 e selecione
[Sharing] (Compartilhamento).
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9 Selecione [Share this folder]
(Compartilhar esta pasta) e cligue em
[Permissions] (Permissoes).

test Properties 21x]
General| e Shaiing Sharig | Secury|
Yot £ st i fricler amaing other Lssts on yewr
natwork. T snabls shring for this folder, ik Shre this

falder.

" Do ot share this folder

_’»—r:' Share this folder

Share name: | SalesDiev

Comment: |

User limit: & Maximum allowed

 Allow _|; Users
To set pemissions for how users acoess this ‘_
folder aver the network, click Permissions.

To configure setings for Dffiine access to Cachi
this shared folder, click Caching, _Custig_|

ok | cencel | tooh |

10 Clique em [Add] (Adicionar).

11 Selecione a conta de usuario criada na
etapa 4 e clique em [Add] (Adicionar).

21x
Lookin  [=Z00671.005 =

200811003
istrators 200611-003
ackup Operators 200611-003
200511-003

200511-003 J
200611003
T sers 200611-003 =

_> Check Names

<< Type names separated by semicolons or choose fiom fst 5>

oK Cancel

v

12 Verifique se a conta de usuario é exibida e
clique em [OK].

13 Marque a caixa de selecdo [Allow] (Permitir)
para [Full Control] (Controle total) e clique
em [OK].

14 Verifique se o icone da pasta compartilhada é
alterado para o icone com uma mao e feche
a janela.

15 Crie um perfil para concluir a configuracao da
fungao de escanear para PC de rede. Consulte
“Perfis de fungao de escanear para PC de
rede” na pagina 195.

Perfis de funcao de escanear
para PC de rede

Registre as informacgdes configuradas no
computador como um perfil. Isso é necessario ao
escanear para PC de rede com o computador.

Criacao de um perfil

Nota

Ao usar as teclas de seta, pressione a tecla
repetidamente para ir para a selegao.

1 Pressione o botdo <SETTING> (Ajuste) no
painel de controle.

2 Use a tecla de seta para baixo para selecionar
[Profile] (Perfil) e pressione <OK>.

Setting
Address Book
Phone Book

]

3 Use a tecla de seta para baixo para selecionar
o numero do perfil a ser registrado e
pressione <OK>.

4 Use a tecla de seta para baixo para selecionar
[Edit] (Editar) e pressione <OK>.

5 Use a tecla de seta para baixo para selecionar
o numero de perfil a ser registrado e
pressione <OK>.

6 Use a tecla de seta para baixo para
selecionar [Profile Name] (Nome do perfil)
e pressione <OK>.

7 Insira as informacdes da linha C-4 do
Formulario de configuragao.

8 Use as teclas de seta para selecionar [Enter]
e pressione <OK>.

9 Use a tecla de seta para baixo para
selecionar [Target URL] (URL de destino)
e pressione <OK>.

10 Insira o valor das linhas C-1 e C-5 do
Formulario de configuragdo como
"\\C-1\C-5"; por ex., \\PC1\DesVendas.

11 Use as teclas de seta para selecionar [Enter]
e pressione <OK>.
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12 Use a tecla de seta para baixo para
selecionar [User Name] (Nome de usuario)
e pressione <OK>.

13 Insira as informacdes da linha C-2 do
Formulario de configuragao.

Se houver gerenciamento de dominio, insira
“C-2@nome do dominio”.

14 Use as teclas de seta para selecionar [Enter]
e pressione <OK>.

15 Use a tecla de seta para baixo para selecionar
[Password] (Senha) e pressione <OK>.

16 Insira as informacdes da linha C-3 do
Formulario de configuragao.

17 Use as teclas de seta para selecionar [Enter]
e pressione <OK>.

18 Use a tecla de seta para baixo para
selecionar [File Name] (Nome do arquivo)
e pressione <OK>.

19 Insira as informacgdes na linha C-6 do
Formulario de configuracdo. Pode-se digitar
até 64 caracteres.

Quando “#n” é adicionado no final do nome do
arquivo, um numero de série é atribuido
automaticamente ao final do nome dos
arquivos enviados.

Quando “#d” é adicionado no final do nome do
arquivo, uma data é atribuida
automaticamente ao final do nome dos
arquivos enviados.

20 Use as teclas de seta para selecionar [Enter]
e pressione <OK>.

21 Configure os outros itens, se necessario.

22 Pressione <OK> para registrar
as configuragoes.

A configuracdo da funcdo de escanear para PC de
rede esta concluida.

Para obter detalhes sobre como usar a funcdo de
escanear para PC de rede, consulte o Manual
Basico do Usuario online no DVD fornecido com a
unidade.

Modificacao de um perfil

Nota

Ao usar as teclas de seta, pressione a tecla
repetidamente para ir para a selecao.

1 Pressione o botdo <SETTING> (Ajuste) no
painel de controle.

2 Use a tecla de seta para baixo para selecionar
[Profile] (Perfil) e pressione <OK>.

3 Use a tecla de seta para baixo para selecionar
[Edit] (Editar) e pressione <OK>.

4 Use a tecla de seta para baixo para selecionar
o perfil a ser modificado e pressione <OK>,

5 Use a tecla de seta para baixo para selecionar
o item a ser modificado e pressione <OK>,

Modifique o item.

Use as teclas de seta para selecionar [Enter]
e pressione <OK>.

8 Se desejar modificar mais de um item, repita
as etapasde5a 7.

9 Pressione <OK> para registrar
as configuragoes.

Exclusao de um perfil

Nota

Ao usar as teclas de seta, pressione a tecla
repetidamente para ir para a selegao.

1 Pressione o botdo <SETTING> (Ajuste) no
painel de controle.

2 Use a tecla de seta para baixo para selecionar
[Profile] (Perfil) e pressione <OK>.

3 Use a tecla de seta para baixo para selecionar
[Delete] (Excluir) e pressione <OK>.

4 Use a tecla de seta para baixo para selecionar
o perfil a ser excluido e pressione <OK>,

5 Use a tecla de seta para a esquerda para
selecionar [Yes] (Sim) na mensagem
de confirmacgdo.

6 Se desejar excluir mais de um perfil, repita as
etapas 4 e 5.

7 Pressione <OK>,
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Configuracao da autenticacao do usuario

e do controle de acesso

Informacoes gerais

Estas fungdes sao utilizadas para limitar o acesso
a unidade. Isso pode ajuda-lo a economizar
toner, papel e evitar o desgaste da unidade.

A autenticagdo do usuario e o controle de acesso
sdo protegidos por senha e devem ser
configurados pelo administrador do sistema.

As condicOes a seguir sdo necessarias para a
ativacdo dessas fungoes:

¢ A unidade deve estar conectada a uma rede.

e Em redes apenas com sistemas Windows, o
utilitdrio Configuration Tool (Ferramenta de
configuracdo) deve ser instalado em um
computador na rede.

e Em sistemas Macintosh, o utilitario Job
Accounting Client (Cliente de Contabilidade de
Trabalhos de Impressao) deve ser instalado.

Autenticacao do usuario?

A Autenticagdo do usuario permite que o
Administrador do sistema limite o uso da unidade
as pessoas que receberam

e um PIN (personal identification number,
numero de identificacdo pessoal)

ou
e um nome de usuario e senha.

Essa limitagao aplica-se ao uso direto e ao uso da
unidade de um computador.

Vocé pode atribuir até 100 PINs com ou sem
nome de usuario e senha.

Controle de acesso

O controle de acesso vai além ao permitir que
o Administrador limite o tipo de fungao que
cada pessoa autorizada a utilizar a unidade
pode executar.

O controle de acesso pode ser aplicado as
seguintes fungdes:

e Copying (Color/Mono) (Cépia (Cor/Mono))
e Printing (Color/Mono) (Impressao (Cor/Mono))

¢ Printing from USB Memory (Impressao a partir
de memodria USB)

e Scanning to e-mail (Escanear para e-mail)

e Scanning to network PC (Escanear para PC
de rede)

e Scanning to USB memory (Escaneamento para
memoaria USB)

e Modo de fax
e Faxing via PC (Envio de fax pelo PC)
e Internet Faxing (Envio de fax pela Internet)

Antes de comecar

Ha varias maneiras de configurar o controle de
acesso para a unidade:

¢ usando software
e usando a pagina da web
e através do painel de controle

Este manual inclui instrugdes para configurar a
unidade usando os utilitarios de software.

Para obter mais informacdes sobre o uso da
pagina da Web ou do painel de controle, consulte
o0 Manual do Usuario Avancado em
www.my.okidata.com.

Sistemas Windows

Carregar a Configuration Tool

(Ferramenta de configuracao)

Para configurar a autenticacdo do usuario e o
controle de acesso no Windows, é preciso
carregar o Configuration Utility (Utilitario de
configuracao) no seu computador.
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8

Verifique se o computador esta ligado e
conectado a unidade e coloque o DVD
fornecido com a maquina na unidade
de CD/DVD.

O DVD é executado automaticamente. Se ndo
for, clique duas vezes no arquivo de
configuracdo do OKI no DVD.

Selecione o seu idioma na lista suspensa e
cligue em [Next] (Avancar).

Leia o Contrato de Licenca e clique em
[I Agree] (Eu concordo).

Cliqgue em [MFP Software] (Software MFP).

Clique em [Install Configuration Tool]
(Instalar ferramenta de configuragao).

2= OKI Printing Solutions =5 x|
OK1 D=

PRINTING SOLUTIONS

OKI MC361/561

Driver Setup
Color Software
Network Software
Optional Utilities
MFP Software

= Register your Primter

CREKING this will Al B launch a Wed
Biweser and conniel 1 e intemed

Clique em [Install] (Instalar) e aguarde que o
software seja instalado.

Selecione o0 modelo da unidade e clique em
[Next] (Avancar).

Clique em [Close] (Fechar).

Uso da Configuration Tool
(Ferramenta de configuracao)
para configurar a autenticacao
do usuario/o controle de acesso

1

Verifique se o computador e a unidade estdo
conectados através da rede e se ambos
estdo ligados.

Clique em [Start] (Iniciar) > [Programs]
(Programas) > [Okidata] > [Configuration
Tool] > [Configuration Tool] (Ferramenta
de configuracdo).

== Configuration Tool i =lolx|
File Tools Plug-in View Help

Configuration Tool

Configuration Tool Y} _

Cligue em [Register Device] (Registrar
dispositivo) na lista suspensa
Tools (Ferramentas).

Cligue duas vezes no nome do modelo
da unidade.

O nome é exibido na [Registered Device Table]
(Tabela de dispositivos registrados) no lado
esquerdo da tela.

Clique duas vezes na sua unidade na lista e
selecione a guia [User Setting] (Configuragao
do usuario).

Cliqgue em [PIN Manager] (Gerenciador de
PIN), insira a senha de administrador e clique
em <OK>,

Para inserir um novo nimero PIN e configura-
lo com o controle de acesso desejado, clique
no icone do PIN.

Para inserir um novo usuario com ID de
usuario, senha e niumero PIN, clique no icone
New(User) (Novo usuario).

Repita a etapa acima para cada usuario
na rede.

Quando terminar, clique no icone [Save to
Device] (Salvar no dispositivo).

Os registros inseridos sdo salvos na unidade.
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Sistemas Mac

Para configurar a autenticagdo do usuario e o
controle de acesso no Mac, consulte o Manual do
Usuario Avancado em www.my.okidata.com.

Autenticacao por PIN

Habilitacao do controle de
acesso por PIN

Quando vocé terminar de configurar os PINs e/ou
as IDs de usuario/senhas, entre no menu da
unidade e habilite o controle de acesso.

O controle de acesso é protegido por senha:
vocé deve saber a senha de administrador
para prosseguir.

Nota

Para percorrer as varias selecbes na tela,
pressione a tecla de seta para baixo (ou
cima) repetidamente.

1 Pressione <SETTING> (Ajuste) no painel
de controle.

2 Use a tecla de seta para cima para selecionar
[Admin Setup] (Configuracdo do
administrador) e pressione <OK>.

3 Insira a senha de administrador: use as teclas
de seta para selecionar os digitos da senha
pressionando <OK> entre digitos.

4 Quando terminar de inserir a senha, use as
teclas de seta para selecionar [Enter] na tela
e pressione <OK>.

5 Use a tecla de seta para cima para
selecionar [Management] (Gerenciamento)
e pressione <OK>.

6 Use a tecla de seta para baixo para selecionar
[System Setup] (Configuracao do sistema) e
pressione <OK>.

7 \Verifique se [Access Control] (Controle de
acesso) esta selecionado e pressione <OK>.

8 Use a tecla de seta para cima para selecionar
PIN como o método de controle de acesso e
pressione <OK>.

9 Use a tecla de seta para a esquerda para
voltar para a tela principal.

O controle de acesso esta habilitado.
Operacao direta
Login

Login

PN ro.

oK)

Usuarios em geral

1 Insira o seu PIN atribuido usando o teclado
numeérico no painel de controle.

2 Pressione <OK>.
A tela principal é exibida.

Administrador

1 Insira “000000” usando o teclado numérico
no painel de controle e pressione <OK>

e O PIN do administrador é “000000”. Nao é
possivel alterar esse valor.

2 Quando a tela da senha de administrador for
exibida, insira a senha do administrador: use
as teclas de seta para selecionar os digitos da
senha, pressionando <OK> ap0ds realgar
cada digito.

3 Use as teclas de seta para selecionar [Enter]
na tela e pressione <OK>.

A tela principal é exibida.

Procedimento de logout

Quando terminar de usar a unidade, nao deixe
de fazer logout.

1 Pressione a tecla de seta para a esquerda até
que a tela principal apareca.

2 Pressione <RESET/LOGOUT> (Reinicializar/
Fazer logout) no painel de controle.

e oo W)

) GCOOD

A tela retorna ao prompt de entrada de PIN.

Nota

ApOs certo periodo de tempo, a unidade faz o
logout dos usuarios automaticamente.
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Configuracao da operacao de
um computador com

autenticacao por PIN

Primeiro, verifique se o(s) driver(s) apropriado(s)
da unidade foi(ram) instalado(s) no computador
usando o DVD.

Depois, instale o software Job Accounting Cliente
(Cliente de contabilidade de trabalhos de
impressao) no computador. Para fazer isso,
coloque o DVD fornecido com a unidade no
computador e siga os avisos na tela para baixar o
software Job Accounting (Contabilidade de
trabalhos) da Internet.

M
OKI .

PRINTING SOLUTIONS

OKI MC361/561

Coler Software
Netwerk Software
Optional Utilities
MFP Software

Internet Downloads

T= Register your Printer

(Clicking this will attempt 1o launch & Web
Eowser and connactin th iomaty

Nota

O tipo de autenticacdo especificado no
computador substitui o especificado na unidade.

Configuracao de computadores com
Windows para impressao

Nota

Este procedimento usa o MC561 e o Windows 7
como exemplo. Os procedimentos e menus
podem diferir dependendo do sistema
operacional usado.

1 Clique em [Start] (Iniciar) > [All Programs]
(Todos os programas) > [Okidata] > [Print
Job Accounting Client] (Cliente de
contabilidade de trabalhos de impressao) >
[Change Job Accounting Mode] (Alterar modo
de contabilidade de trabalhos).

2 Na janela [User Account Control] (Controle de

conta de usuario), clique em [Yes] (Sim).

Selecione o driver de impressora desejado
em [Driver].

Marque a caixa de selecao [Tab] e clique em
[Change] (Alterar).

Clique em [OK].

No menu [File] (Arquivo), selecione
[Close] (Fechar).

Clique em [Start] (Iniciar) e selecione
[Devices and Printers] (Dispositivos
e impressoras).

No Windows Server 2008, clique em [Start]
(Iniciar) e selecione [Control Panel] (Painel
de controle) > [Printers] (Impressoras).

No Windows Vista, clique em [Start]
(Iniciar) e selecione [Control Panel] (Painel
de controle) > [Printer] (Impressora).

No Windows Server 2003, clique em [Start]
(Iniciar) > [Printers and Faxes]
(Impressoras e faxes).

No Windows XP, clique em [Start]
(Iniciar) > [Printers and Faxes]
(Impressoras e faxes).

No Windows 2000, cligue em [Start]
(Iniciar) > [Settings] (Configuragbes) >
[Printers] (Impressoras).
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8 Para cada driver instalado no computador:

a) Clique com o botdo direito do mouse no
icone do OKI MC561 e selecione [Printer
properties] (Propriedades da impressora) >
[OKI MC561 (XXX*)].

*XXX = PCL, PS ou FAX

b) Selecione a guia [Job Accounting]
(Contabilidade de trabalhos).

c) Insira o nome de usuario em [User Name]
(Nome de usuario) e o PIN em [Job
Account ID] (ID da conta dos trabalhos).

= OKI MCSB1(PCL) Properties |
Generd Sharing Poris Advanced Color Managemert
Status Job Accourting Security Device Option
Job ceourting Seting
User Hame [up to B0 characters)
’ Oki
Job Account 1D [1-933393333)
}1
OK | [ Carcal | [ ooy |

d) Clique em [OK].
Impressao do Windows

1 Abra o arquivo a ser impresso.

2 Selecione [Print] (Imprimir) do menu
[File] (Arquivo).

3 Selecione o driver de impressora e clique em
[Print] (Imprimir).

Configuracao de computadores com
Mac para impressao

Nota

Este procedimento usa o modelo MC561 e o
Mac OS X 10.6 (Snow Leopard) como exemplo.
Os procedimentos e menus podem diferir
dependendo do sistema operacional usado.

1 Insira o DVD fornecido com a unidade.

2 Clique duas vezes no icone do OKI na area
de trabalho.

3 Clique duas vezes em [Utility] (Utilitario) >
[JA Client] (Cliente de contab. de trabalhos) >
[Print JobAccounting] (Contabilidade de
trabalhos de impressao).

Cliqgue em [New] (Novo).

5 Insira o nome de usuario ao lado de
[UserName] (Nome do usuario) € o PIN ao
lado de [JobAccountingID] (ID da
contabilidade de trabalhos).

ALOLO

{ Cancel )
( Cancel )

LoginName : Administrator

ﬁ UserName : Oki
ﬁ JobAccountingID : | 2

C Help )
( Help )

Clique em [Save] (Salvar).
7 Clique em [Save] (Salvar).

Se solicitado, insira a senha do usuario e
clique em [OK].

Impressao de um Mac

1 Abra o arquivo que deseja imprimir.

2 No menu [File] (Arquivo), selecione
[Print] (Imprimir).

3 Selecione a sua unidade e clique em
[Print] (Imprimir).

Configuracao de computadores com
Windows para fax

Nota

Este procedimento usa o MC561 e o Windows 7
como exemplo. Os procedimentos e menus
podem diferir dependendo do sistema
operacional usado.
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Clique em [Start] (Iniciar) > [All Programs]
(Todos os programas) > [Okidata] > [Print
Job Accounting Client] (Cliente de
contabilidade de trabalhos de impressao) >
[Change Job Accounting Mode] (Alterar modo
de contabilidade de trabalhos).

N

Na janela [User Account Control] (Controle de
conta de usuario), clique em [Yes] (Sim).

W

Selecione o driver de fax em [Driver].

H

Marque a caixa de selegdo [Tab] e clique em
[Change] (Alterar).

Clique em [OK].

6 No menu [File] (Arquivo), selecione
[Close] (Fechar).

(4]

N

Clique em [Start] (Iniciar) e selecione
[Devices and Printers] (Dispositivos
e impressoras).
- No Windows Server 2008, clique em [Start]
(Iniciar) e selecione [Control Panel] (Painel
de controle) > [Printers] (Impressoras).

- No Windows Vista, clique em [Start] (Iniciar)
e selecione [Control Panel] (Painel de
controle) > [Printer] (Impressora).

- No Windows Server 2003, clique em [Start]
(Iniciar) e selecione [Printers and Faxes]
(Impressoras e faxes).

- No Windows XP, clique em [Start] (Iniciar) e
selecione [Printers and Faxes] (Impressoras
e faxes).

- No Windows 2000, clique em [Start] (Iniciar)
e selecione [Settings] (Configuragdes) >
[Printers] (Impressoras).

8 Cliqgue com o botdo direito do mouse no icone
do OKI MC561 e selecione [Printer properties]
(Propriedades da impressora) >
[OKI MC561 (FAX)].

9 Selecione a guia [Job Accounting]
(Contabilidade de trabalhos).

10 Insira o nome de usuario em [User Name]
(Nome de usuario) e o PIN em [Job Account
ID] (ID da conta dos trabalhos).

11 Clique em [OK].
Fax do Windows

1 Abra o arquivo que deseja enviar por fax.

2 No menu [File] (Arquivo), selecione
[Print] (Imprimir).

3 Selecione o driver de fax e clique em
[Print] (Imprimir).

Autenticacao por nome de
usuario e senha

Habilitacao de controle de
acesso por nome de
usuario/senha

O controle de acesso € protegido por senha:
vocé deve saber a senha de administrador
para prosseguir.

Nota

Para percorrer as varias seleces na tela,
pressione a tecla de seta para baixo (ou
cima) repetidamente.

1 Pressione <SETTING> (Ajuste) no painel
de controle.

2 Use a tecla de seta para cima para selecionar
[Admin Setup] (Configuragao do
administrador) e pressione <OK>.

3 Insira a senha de administrador: use as teclas
de seta para selecionar os digitos da senha,
pressionando <OK> entre os digitos.

4 Quando terminar de inserir a senha, use as
teclas de seta para selecionar [Enter] na tela
e pressione <OK>.

5 Use a tecla de seta para cima para
selecionar [Management] (Gerenciamento)
e pressione <OK>.

6 Use a tecla de seta para baixo para selecionar
[System Setup] (Configuragcao do sistema) e
pressione <OK>.

7 Verifique se [Access Control] (Controle de
acesso) esta selecionado e pressione <OK>,

8 Use a tecla de seta para cima para selecionar
usuario/senha como o método de controle de
acesso e pressione <OK>.

9 Use a tecla de seta para a esquerda para
voltar para a tela principal.

O controle de acesso esta habilitado.
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Operacao a partir de
um computador

Nota

O tipo de autenticacao especificado no
computador substitui o especificado na unidade.

Impressao do Windows

Nota

Este procedimento utiliza o Windows 7 e o Bloco
de Notas como exemplo. Os procedimentos e
menus podem diferir dependendo do sistema
operacional usado.

Abra o arquivo que deseja imprimir.

2 No menu [File] (Arquivo), selecione
[Print] (Imprimir).

3 Selecione o driver de impressora desejado em
[Select Printer] (Selecionar impressora) e
cligue em [Preferences] (Preferéncias).

4 Selecione a guia [Job Options] (Opgdes
do trabalho).

5 Cligue em [User Auth] (Autenticacao
do usuario).

6 Marque a caixa de selegdo [Use User
Authentication] (Usar autenticagao
do usuario).

User Authentication ==

——l

User Authentication

Username Use Windaws Lagin

Password

7 Insira o nome de usuario em [Username]
(Nome de usuario) e a senha em
[Password] (Senha).

Cligue em [Use Windows Login] (Usar login
do Windows) para que o seu home de login
no Windows seja inserido automaticamente.

8 Clique em [OK].
9 Clique em [OK] e em [Print] (Imprimir).

Impressao de um Mac

Nota

Este procedimento usa o Mac OS X 10.6 como
exemplo. Os procedimentos e menus podem
diferir dependendo do sistema operacional usado.

Abra o arquivo que deseja imprimir.

2 No menu [File] (Arquivo), selecione
[Print] (Imprimir).

3 Selecione o driver de impressora da
sua unidade.

4 Selecione [UserAuth] (Autenticacao do
usuario) do menu do painel nos menus
[Printer] (Impressora) e [Presets]
(Config. pred.).

&
Eagta)
®

Copies: |1 ™ Collated [_] Two-Sided

Pages: & Al
O From: 1 w1

Paper Size: | A4 ) 20990y 20.70em

Orientation: 'l T

Useruih —;14_

The bundle "UserAuth” couldn’t be loaded because it doesn't
contain a version for the current architecture.

Cantact the bundie's creator listed hare for the latest version.

@ (Crore) [ Cancel ) (- Print)

5 Marque a caixa de selecao [Use User Auth]
(Usar autenticacdo do usuario) no painel
[UserAuth] (Autenticagdo do usuario).

Cancel ) {EPrine )

6 Digite o nome de usuario em [User Name]
(Nome de usuario) e a senha em
[Password] (Senha).

7 Cligue em Print (Imprimir).
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Fax do Windows

Nota

Este procedimento utiliza o Windows 7 e o Bloco
de Notas como exemplo. Os procedimentos e
menus podem diferir dependendo do sistema
operacional usado.

Abra o arquivo que deseja enviar por fax.

2 No menu [File] (Arquivo), selecione
[Print] (Imprimir).

3 Selecione a sua unidade (driver de fax) em
[Select Printer] (Selecionar impressora) e
clique em [Preferences] (Preferéncias).

4 Na guia [Setup] (Configuracao), clique em
[User Auth] (Autenticacdo do usuario).

5 Marque a caixa de selegdo [Use User
Authentication] (Usar autenticacdo
do usuario).

6 Insira o nome de usuario em [Username]
(Nome de usuario) e a senha em
[Password] (Senha).

Nota

Clique em [Use Windows Login] (Usar login
do Windows) para que o seu nome de login
no Windows seja inserido automaticamente.

Clique em [OK].
Clique em [OK] e em [Print] (Imprimir).
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Configuracao da maquina para fax

Configuracoes basicas
para fax

Vocé deve definir as seguintes configuragoes
antes de enviar faxes.

Conexao a uma linha
de telefone

Importante!

Use apenas o cabo de telefone fornecido
com a unidade. O uso de um cabo diferente
pode resultar em funcionamento incorreto.

Conexao apenas para fax

1 Conecte uma extremidade do cabo de
telefone fornecido a conexao de LINHA
na parte traseira da unidade e a outra
extremidade em uma tomada de
telefone ativa.

2 Conecte a cobertura do conector fornecida
a conexao de TELEFONE na parte traseira
da unidade.

D=
R g,

Conexao para fax e telefone

1 Conecte uma extremidade do cabo de
telefone fornecido a conexdo de LINHA
na parte traseira da unidade e a outra
extremidade em uma tomada de
telefone ativa.

2 Conecte o cabo do telefone na conexao de
TELEFONE na parte traseira da unidade.
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Especificacao da hora atual e
das informacoes do remetente

Nota

Vocé pode definir a data e a hora
automaticamente usando a pagina da Web. Para
obter detalhes, consulte o Manual do Usuério
Avancgado no site www.my.okidata.com.

Nota

Ao usar as teclas de seta, pressione a tecla
repetidamente para ir para a selegao.

1 Pressione <SETTING> (Ajuste) no painel
de controle.

2 Use a tecla de seta para baixo para
selecionar [Easy Setup] (Configuragao facil)
e pressione <OK>.

Setting

Wiew Information
Shutdown

3 Se solicitado, insira a senha de administrador
e use as teclas de seta para realgar [Enter] e
pressione <OK>.

4 Com a opcdo [Date/Time Setting] (Ajuste de
data/hora) realgada, pressione a tecla de seta
para a direita.

o1 Date/Time
2. Fax Setting
o 3 Metwork Setting

5] Cancel @

5 Use a tecla de seta para baixo para selecionar
o fuso horario apropriado e pressione a tecla
de seta para a direita.

Vocé pode selecionar o fuso horario entre
[-12:00] e [+13:00] em incrementos de
15 minutos.

6 Use a tecla de seta para baixo para selecionar
[Not Summer Time] (Sem horario de verdo)
ou [Now Summer Time] (Com horario de
verao) para a configuragcao do horario de
verao e pressione a tecla de seta para
a direita.

7 Use a tecla de seta para baixo para selecionar

[Manual] e pressione a tecla de seta para
a direita.

8 Use as teclas de seta para cima e para baixo

para definir o ano, més e dia, pressionando a
tecla de seta para a direita para
movimentagao sucessiva em cada bloco.
Quando terminar, pressione <OK>.

9 Use as teclas de seta para cima e para baixo

para definir a hora atual (hora, minuto,
segundos), pressionando a tecla de seta
para a direita para movimentagao sucessiva
em cada bloco. Quando terminar,

pressione <OK>.

A mensagem "Date/Time Setting was
completed” (A configuracdo de data/hora foi
concluida) é exibida, e a tela do menu de
configuracdo é exibida em seguida.

Especificagdao das informagdes do remetente

Especifique o niumero de fax e o nome do
remetente da unidade. A ID do remetente é
impressa na borda superior do fax quando ele é
impresso pelo destinatario.

10 Pressione a tecla de seta para baixo para
selecionar [Fax Setting] (Configuracao do fax)
e pressione a tecla de seta para a direita.

Cancel

11 Pressione <OK> para selecionar [FAX
number] (nimero do fax).

12 Use o teclado para inserir o nimero de fax
da unidade.

13 Com a opcao [Enter] realgada,
pressione <OK>.

14 Pressione a tecla de seta para a direita para
selecionar [Sender ID] (ID do remetente).

15 Use o teclado virtual para inserir a sua ID,
com até 22 digitos. Quando a ID for inserida,
use as teclas de seta para realcar [Enter] e
pressione <OK>.

A mensagem “Fax Setting was completed” (A
configuracdo de fax foi concluida) é exibida, e
a tela do menu de configuracao é exibida

em seguida.

16 Pressione <OK> para concluir a configuracao
e use a tecla de seta para a esquerda para
voltar para a tela principal.
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Instalacao USB

4 Pressione o botdo de trava (1) no lado direito
Conexao USB da unidade e remova a tampa de acesso (2).

1 Prepare um cabo USB.
Um cabo USB ndo é fornecido com a unidade.

Use um cabo USB 2.0 de alta velocidade para
uma conexao USB 2.0 de alta velocidade.

2 Desligue a unidade:

a) Pressione <SETTING> (Ajuste) no painel
de controle.

b) Pressione a tecla de seta para baixo
repetidamente para rolar até [Shutdown]
(Desligar) e pressione <OK>.

c) Quando a mensagem de confirmacao for
exibida, pressione a tecla de seta para a
direita para selecionar [Yes] (Sim) e
pressione <OK>.

d) Quando for exibida na tela a solicitacao
para desligar a unidade, desligue-a.

3 Desligue o computador.

CUIDADO!

N3ao conecte o cabo USB na conexao de
rede. Isso pode resultar em
funcionamento incorreto.
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5 Conecte uma extremidade do cabo USB na 7 Encaixe as linguetas da tampa lateral nos
soquetes (1) na caixa da unidade e deslize-a

para o lugar.

conexao USB da unidade.

Para obter informacoes sobre a
instalacdao do Windows, va para a

% pagina 209.

Para obter informacoes sobre a
instalacdao do Macintosh, va para a
pagina 210.

6 Prenda o cabo USB no gancho (1) na unidade.
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USB: Instalacao de um driver
de impressora para Windows

e Vocé deve se conectar como administrador
para concluir este procedimento.

Nota

O procedimento a seguir usa o Windows 7 e o
modelo MC561 como exemplo. A exibicdao pode
variar dependendo do sistema operacional.

1 Desligue a unidade:

a) Pressione <SETTING> (Ajuste) no painel
de controle.

b) Pressione a tecla de seta para baixo
repetidamente para selecionar [Shutdown]
(Desligar) e pressione <OK>.

c) Quando a mensagem de confirmacgao for
exibida, pressione a tecla de seta para a
direita para selecionar [Yes] (Sim) e
pressione <OK>.

d) Quando for exibida na tela a solicitacdo
para desligar a unidade, desligue-a.

2 Insira o DVD fornecido com a maquina na
unidade de CD/DVD.

O DVD é executado automaticamente. Caso
néo seja, clique duas vezes no arquivo de
configuracdo do OKI no diretério do DVD.

3 Selecione o seu idioma na lista suspensa e
clique em [Next] (Avancar).

4 Leia o Contrato de Licenca e clique em
[I Agree] (Eu concordo).

5 Em Driver Setup (Configuracao do driver),
clique em [Install Drivers (MC561)]
(Instalar drivers).

Nota

Se a caixa de didlogo [User Account Control]
(Controle da conta do usuario) for exibida,
clique em [Yes] (Sim). (No Windows Vista,
clique em [Continue] (Continuar)).

6 Leia e observe as instrugoes e clique em

[Next] (Avangar).

A instalagdo é iniciada.

7

8
9

Se a caixa de didlogo [Windows Security]
(Seguranga do Windows) for exibida, clique em
[Install this driver software anyway] (Instalar
este software de driver mesmo assim).

No Windows Server 2003 e no Windows XP,
se a caixa de didlogo [Install Hardware]
(Instalar hardware) for exibida, clique em
[Continue] (Continuar).

No Windows 2000, se a caixa de dialogo
[Digital Signature Not Found] (Assinatura
digital ndo encontrada) for exibida, clique em
[Yes] (Sim).

Quando receber a solicitacao para tal, conecte
0 cabo USB no computador e ligue a unidade.

Cligue em [Next] (Avancar).

Siga as instrucdes na tela para concluir
a instalacao.

10 Quando a tela [Complete] (Completar)

aparecer, clique em [Finish] (Concluir).

Verificar a instalacao

1

Clique em [Start] (Iniciar) > [Devices and
Printers] (Dispositivos e impressoras).

No Windows Server 2008 e Windows Vista,
cliqgue em [Start] (Iniciar) > [Control Panel]
(Painel de controle) > [Printer] (Impressora).

No Windows Server 2003 e Windows XP,
cliqgue em [Start] (Iniciar) > [Printers and
Faxes] (Impressoras e faxes).

No Windows 2000, clique em [Start]
(Iniciar) > [Settings] (Configuragdes) >
[Printers] (Impressoras).
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2 Verifique se o icone OKI MC561 é exibido.

No Windows 7, se vocé tiver instalado varios
drivers, clique com o botdo direito do mouse
no icone OKI MC561 e selecione um dos itens
do menu e verifique se todos os drivers de
impressora instalados sao exibidos

no submenu.

OK1 MCSELIFAG
O MCSELPCL X95)
OKI MCSELIPCL)

0K MCSELIPS)

Em outros sistemas operacionais Windows,
verifique se o icone que representa cada
driver é exibido.

3 Remova o DVD do computador.

A instalagdo esta concluida.

Nota

[Easy Install (Local)] (Instalacdo facil - local) é
um método de configuracdo facil. Se vocé desejar
selecionar um driver para ser instalado
manualmente, selecione [Install printer driver
completely] (Instalar driver da impressora
completamente) e siga as instrugdes exibidas

na tela.

USB: Instalacao de um driver
de impressora para Mac

Importante!
e Somente o driver de impressora PS esta
disponivel para Mac.

e Desabilite o software antivirus antes de
iniciar este procedimento.

Para Mac OS X 10.3.9a 10.4.11

Nota

O procedimento a seguir usa o Mac OS X 10.4.11
e 0 modelo MC561 como exemplo.

1 Desligue a unidade:

a) Pressione <SETTING> (Ajuste) no painel
de controle.

b) Pressione a tecla de seta para baixo
repetidamente para rolar até [Shutdown]
(Desligar) e pressione <OK>.

¢) Quando a mensagem de confirmacdo for
exibida, pressione a tecla de seta para a
direita para selecionar [Yes] (Sim) e
pressione <OK>.

d) Quando for exibida na tela a solicitacao
para desligar a unidade, desligue-a.

Desligue o computador.

Conecte a outra extremidade do cabo USB no
conector de interface USB do computador.

4 Ligue o Mac.

5 Insira o DVD fornecido com a unidade
no computador.

6 Clique duas vezes no icone [OKI] > pasta
[Driver] > pasta [Printer] (Impressora).

7 Cligue duas vezes em [Installer for Mac OS X]
(Instalador do Mac 0OS X).

8 Insira o nome e a senha de administrador e
clique em [OK].

9 Siga as instrugdes na tela para concluir
a instalacao.

10 Remova o DVD manual/driver do computador.

11 No menu [Go] (Ir), selecione [Applications]
(Aplicativos) > [Utilities] (Utilitarios) e clique
duas vezes em [Printer Setup Utility]
(Utilitario de configuragdo da impressora).
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Importante!

Se o [Printer Setup Utility] (Utilitario
de configuracao da impressora) ja
estiver sendo executado, feche e
abra-o novamente.

12 Clique em [Add] (Adicionar).

Se a caixa de diadlogo [You have no printers
available] (Ndo ha impressoras disponiveis)
for exibida, clique em [Add] (Adicionar).

Nota

Se o0 nome da unidade ja estiver sendo exibido,
selecione-o e clique em [Delete] (Excluir) e em
[Add] (Adicionar).

13 Selecione o nome do USB designado da
unidade e verifique se o nome da unidade é
exibido em [Print Using] (Imprimir usando).

[SXGNs) Printer Browser =
r T —————————
et 8 a-
b= =
Default Browser | | IP Printer Search
Printer Name &| Connection
_> MC561 USE m

Name: MC561

Location: Administrater’s iMac

Print Using: . OKI MC561(PS) X ]

@

( More Printers... ) ( Add )

BN

14 Clique em [Add] (Adicionar).

15 Se a janela [Installable Options] (Opgdes
instalaveis) for exibida, clique em
[Continue] (Continuar).

Se vocé tiver instalado componentes
adicionais antes da instalacdo do driver,
configure cada item e clique em
[Continue] (Continuar).

16 Verifique se 0 nome da unidade é exibido em
[Printer List] (Lista de impressoras) e feche
a janela.

A instalagdo esta concluida.

Para Mac OS X 10.5e 10.6

Nota

O procedimento a seguir usa o Mac OS X 10.6
(Snow Leopard) e o modelo MC561
como exemplo.

1 Verifique se a unidade e o computador estao
ligados e conectados.

2 Conecte a outra extremidade do cabo USB no
conector de interface USB do computador.

3 Insira o DVD fornecido com a unidade
no computador.

4 Clique duas vezes no icone [OKI] > pasta
[Driver] > pasta [Printer] (Impressora).

5 Clique duas vezes em [Installer for MacOSX]
(Instalador do Mac 0OS X).

6 Insira o nome e a senha de administrador e
clique em [OK].

Siga as instrucdes na tela para concluir
a instalagao.

7 Remova o DVD manual/driver do computador.

No menu Apple, selecione [System
Preferences] (Preferéncias do sistema).

9 Clique em [Print & Fax] (Impressora e fax).

10 Clique em [+].
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11 Selecione o nome do USB designado da
unidade e verifique se o nome da unidade é
exibido em [Print Using] (Imprimir usando).

8anNne Add Printer =
= =G
ault| Fax P Windows Search
Printer Name & | Kind
_> OKI DATA CORP MC561 USB

Name: OKI DATA CORP MC561
Location: Administrator’s iMac

Print Using: OKI MC561(PS)

~Add

12 Clique em [Add] (Adicionar).

13 Se a janela [Installable Options] (Opgdes
instalaveis) for exibida, clique em
[Continue] (Continuar).

Se vocé tiver instalado componentes
adicionais antes da instalacdo do driver,
configure cada item e clique em
[Continue] (Continuar).

14 Verifique se o0 nome da unidade é exibido na
lista de impressoras e feche [Print & Fax]
(Impressora e fax).

A instalagdo esta concluida.
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Formulario de configuracao

No Item Exemplo Seu valor

A: Informacoes basicas de configuracgao

A-1 Senha de administrador da unidade aaaaaa (o padrao)

A-2 Enderecgo IP da unidade 192.168.0.2

B: Escanear para e-mail e para fax pela Internet

B-1 Endereco de e-mail da unidade mc561@test.com
(até 80 caracteres)

B-2 Enderego do servidor SMTP smtp.test.com

B-3 Endereco do servidor POP3 pop3.test.com

B-4 Método de autenticagado SMTP

B-5 ID do usuario do SMTP OKIMC561

B-6 Senha SMTP okimc561

B-7 ID do usuario do POP usuario

B-8 Senha POP okimc561

B-9 Nome do destino do e-mail Usuario

B-10 | Enderego do destino do e-mail user@test.com

C-1 Nome do computador de destino PC1

C-2 Nome de usuario para fazer logon no mc561

computador de destino (até 32 caracteres)

C-3 Senha para fazer logon no computador de mc561
destino (até 32 caracteres)

C-4 Nome do perfil para registrar as configuragdes Vendas
(até 16 caracteres)

C-5 Nome da pasta compartilhada no computador de | DesVendas
destino (até 64 caracteres)

C-6 Nome do arquivo dos dados escaneados DadosEsc
(até 64 caracteres)
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